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1 About Qlik NPrinting
Qlik NPrinting is a reporting platform that lets you create reports using your QlikView and Qlik
Sense data, and then distribute them automatically in a range of standard formats.

Qlik NPrinting is an on-premise reporting tool for Qlik Sense Enterprise on Windows and QlikView on
Windows.
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2 Getting started
Get off to a good start by learning Qlik NPrinting fundamentals. Then, you can create report
templates with our tutorials.

2.1 What you can do in Qlik NPrinting
Qlik NPrinting has a responsive web interface for administrative tasks and report design.

A centralized distribution system simplifies scheduled report generation and distribution. Users can access and
subscribe to a complete set of reports.

Features
Qlik NPrinting offers:

l Scheduled and one-time distribution of reports to Qlik Sense hub, folders, email, and NewsStand.
l Server-based client for configuring, scheduling, and distributing reports.
l Online subscription portal for users to view, download, archive, and subscribe to available reports.
l Role-based security at the app level for administrators, developers, and recipients.
l Multi-engine enterprise scalability, and enhanced governance and security.
l Full Microsoft Office integration.

Using different versions of Qlik NPrinting
This table compares the main features of Qlik NPrinting 17 and newer with QlikView NPrinting 16.

Product capability Qlik NPrinting 16 Qlik NPrinting 17 and newer

APIs No Yes

Enterprise scalability No Yes

Multi-developer environment No Yes

Online subscription hub No Yes

Roles based security No Yes

Section access No Yes

Web based architecture No Yes

Bookmark filter Yes No

FTP Support Yes No

Linked fields Yes No

Version comparison
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Product capability Qlik NPrinting 16 Qlik NPrinting 17 and newer

Pretty good privacy (PGP) encryption Yes No

Recipient import wizard Yes No

Send to printer Yes No

Test task Yes No

2.2 Working with apps
Qlik NPrinting apps contain report templates, filters, and connections to Qlik Sense apps or
QlikView documents.

This is different from Qlik Sense apps, which contain data, and use visualizations to explore that data.

Requirements
The Qlik NPrinting Engine configuration must be complete. See: Qlik NPrinting installation (page 155).

Creating apps
Do the following:

1. Log into the Qlik NPrinting web console.

2. On the main menu, click the Apps drop-down, and click Apps.

3. Click the Create app button.

a. Enter a name for this new app.

b. Ensure the Enabled check box is selected. Otherwise, your app will be ignored by the Qlik
NPrinting Engine.

c. Click Create.

You app has been created.

Deleting apps
The user role that you to use to delete an app must have the Delete permission enabled.

Deleting an app will remove all associated reports and filters.

Do the following:

1. On the main menu, click the Apps drop-down, and click Apps.

2. Locate the app you want to delete. Use the View and Filter options if there are many apps.

3. Click on the icon in the Actions column for the app that you want to delete.

4. Select Delete in the menu that appears.
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The app is removed from the Qlik NPrinting Server.

2.3 Creating connections
Before you can create report templates, you must first create source connections from Qlik
NPrinting to QlikView documents or Qlik Sense apps. Each report, filter, and task is linked to one or
more QlikView documents or Qlik Sense apps.

This section describes how to connect specific QlikView documents or Qlik Sense apps to Qlik NPrinting.
If you are installing Qlik NPrinting and trying to connect to a QlikView or Qlik Sense server see:
Connecting Qlik NPrinting with QlikView (page 178) and Connecting Qlik NPrinting with Qlik Sense (page
172).

Connections must be added after the initial creation of a Qlik NPrinting app. You can add new connections, or
modify existing connections for each Qlik NPrinting app. There is no limit to the number of connections you can
add to an app.

Connections are to the Qlik NPrinting Engine, not to the Qlik NPrinting Server. In a production environment the
Qlik NPrinting Engine and Qlik NPrinting Server are installed on separate computers. The firewall rules and DNS
resolution must be configured on Qlik NPrinting Engine computers, not on the Qlik NPrinting Server.

Connecting to QlikView documents
You can connect to any QlikView documents on QlikView servers that you have permission to
access.

This page outlines how to connect specific QlikView documents to Qlik NPrinting. If you are installing
Qlik NPrinting and trying to connect to a QlikView server, or install certificates, see: Connecting Qlik
NPrinting with QlikView (page 178).

Unsupported QlikView objects
The following objects are not supported in Qlik NPrinting:

l Alternate states
l Triggers: sheet, document, and within objects
l Always one selected list box and multi box property
l AND-mode (calculated) fields in filters, cycles, levels, pages
l Buttons that contain "actions" work as triggers
l Containers within a container
l Any third party extension objects
l Alternate identities: such as qvp://<servername>/qwvs/salesdemo.qvw
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l Bundled qmem packages
l WebView mode

If you create connections to QlikView documents that contain these objects, the connection will not work.

For more information on unsupported objects, see Qlik objects that are not supported (page 295).

On-Demand reporting
On-Demand reports cannot connect to multiple QlikView documents.

You cannot create connections to QlikView documents that use the following if you are generating On-Demand
reports:

l Variable selections used from input buttons as triggers to select data
l Input boxes
l Calculated dimensions
l Hidden tabs

Troubleshooting
Qlik NPrinting cannot modify or remove these options. As a result, Qlik NPrinting may not have access to the
entire data set of the connected QlikView document during cache and report generation.

If you want to use QlikView documents with unsupported features, create a copy with the features removed:

Do the following:

1. Create a copy of the QlikView document.

2. Remove all unsupported features from the new QlikView document. Make sure that WebView mode is
turned off.

3. Use the copied QlikView document for reporting purposes.

Requirements
Qlik NPrinting Server and at least one Qlik NPrinting Engine must be installed and activated.

Qlik NPrinting QlikView connections requires a QlikView Server deployment that was installed with the "QlikView
Administrators" group option.

Connection rules for QlikView documents
The following rules apply to connections to QlikView documents:

l You can create connections from a single Qlik NPrinting app to multiple QlikView documents.
l Connections are not shared between Qlik NPrinting apps. If you want to connect the same QlikView

document to multiple Qlik NPrinting apps, you must create a connection for each.
l To create connections, your QlikView documents must be stored in one of the following locations:
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o your local computer
o a shared network folder
o a QlikView server that you have permission to access
o a QlikView cluster

Section access is not fully supported for local QlikView documents. If you connect to a local QlikView
document with section access, report recipients will see all available data, as if section access was not
applied. You must use Qlik NPrinting filters or connect to documents via QlikView Server to ensure users
only receive permitted data.

Types of connection status
The Cache status column shows one of the following values for each configured connection:

l Never generated: the connection has never been opened.
l Pending: Qlik NPrinting is attempting to connect.
l Generating: Qlik NPrinting is connected and importing metadata.
l Generated: connection successful on all Qlik NPrinting engines.
l Error: the connection is failing on all available engines. The Qlik NPrinting scheduler service will try to

connect again two minutes after a failure.

The Connection status column shows one of the following values for each configured connection:

l Connection successful on all NPrinting engines.
l Warning: One or more engines are not working.
l Connection failed on all NPrinting engines.

To learn more about connection status and reloading connection metadata, see: Reloading connection metadata
(page 38).

Testing and troubleshooting
There are several way to resolve a Warning, Error, or Connection failed status. To start, open the connection
you want to troubleshoot, and click the Run verification button. This will give you a list of possible issues. Here
is an example where verification failed because the Document path is incorrect:
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You can also check the following:

l Connection properties: For example, verify the QlikView document path, username, and password.
l Qlik NPrinting Engine installation and configuration: For example, an engine with QlikView Desktop 12

cannot open a document on a QlikView 11.2 server. Check also that QlikView Desktop has an active license
for the Windows user who runs the service.

After resolving any issues, re-launch cache generation, or run a task.

Here are some common causes of connection errors:

l Verify connection errors when setting up a connection to QlikView documents (page 541)
l Connection status error (page 534)
l Connection status not shown in Qlik NPrinting web console (page 534)
l Connection timeouts and long running tasks (page 534)

Connecting to a local QlikView document
Do the following:

1. From the Apps menu, click Connections.
The Connections page appears.

2. Click Create connection to open a new connection window.
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3. In the Name field, enter a name for the connection.
For example, enter Sales Demo.

4. In the App drop-down list, select the Qlik NPrinting app that you want create the connection from.

5. In the Document path field, enter the path to the QlikView document that you want to connect to.
For example, enter C:\NPrintingServer\QlikViewDocuments\Samples\Sales Demo.qvw.
Use the path on the computer where Qlik NPrinting is installed.

Mapped network drives, like Z:\NPrintingServer\QlikViewDocuments, are not supported by Qlik
NPrinting. You must use Universal Naming Convention (UNC) paths, such as
\\ServerName\NPrintingServer\QlikViewDocuments.

6. Ensure that Type is set to Local.

7. If prompted, enter the user name and password for the QlikView document.
If you are connecting to a local QlikView document with Section Access you must enter the credentials of
a user with the ADMIN role, otherwise the cache generation will end with an error. Windows domain users
are not supported. Section Access users must be defined in the script. We suggest you use a user without
filters so the cache will be complete.

8. Click the Run verification button. This ensures your connection is valid.
If the connection is valid, you will see a "Verification successful" message. If not, you will see the following
message: "Errors detected. Check details below."

9. Under Notifications, you can select Send email notification when metadata reload finishes. An email
will be sent to the addresses specified under Settings > Tasks. See: Task execution notifications (page
268).

10. Once your connection settings have been verified, click Create. You will be automatically moved back to
the Connections menu.

11. Click on your new connection. You will see the status Cache status - Generating. This means that Qlik
NPrinting is connecting to QlikView and importing metadata. If you have a large QlikView document, this
may take several minutes.

12. Once the cache status shows Generated, you can create a new report template. If you get an Error status,
check your connection information.
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You will now be able to see your new connection on the Connections screen.

Prerequisites for QlikView Server and QlikView Cluster connections
To generate reports using QlikView Server or QlikView Cluster connections, the following are required:

l Access to at least one QlikView Server.
l The Windows user that runs the Qlik NPrinting Engine Windows service must belong to the QlikView

Administrators Windows group on the QlikView Server computer.
l To configure Qlik NPrinting for NTFS authorization, it must be configured in the Qlik Management

Console. This means that the Windows operating system controls the file (document) access for users and
groups through the NTFS security settings.

l To configure Qlik NPrinting for DMS authorization QlikView controlled file access, see DMS for Qlik
NPrinting (page 225).

If you are using section access as well, the following are also required:

l Connections must be configured to use server authentication.
l A domain account must be configured in user settings, independent of the authentication type enabled in

the Qlik NPrinting general settings.
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Connecting to QlikView documents on the QlikView Server

You need a licensed QlikView Server, and access to the target QlikView document to open a .qvw file.

To connect Qlik NPrinting to a cluster of QlikView Servers, authentication in the QlikView installation
must be managed using a QlikView Administrators Group.

Do the following:

1. From the Apps menu, click Connections.
The Connections page appears.

2. Click Create connection.

3. In the Name field, enter a name for the connection.
For example, enter Sales Demo from Server.

4. In the App drop-down list, select the Qlik NPrinting app that you want to create the connection from.
For example, select Sales Demo.

5. Click the Server button in the Type row.
The qvp:// form appears.

6. In the qvp:// form, insert the QlikView Server address followed by the .qvw file name.
For example, ServerAddress/DocumentName.qvw.

7. If required, select the Connection requires authentication check-box, then select either Server
authentication or Document authentication.

l Server authentication: Enter the domain user credentials that will be used to connect to the
server. Use the following format:
Domain\ Username
Enable the flag for Apply user section access for reports if you want to apply specific users'
section access when generating reports for them.

l Document authentication: Enter the Username and Password of a user with administrative
privileges on the document.

8. Click the Run verification button. This ensures your connection is valid.
If the connection is valid, you will see a "Verification successful" message. If not, you will see the following
message: "Errors detected. Check details below."

9. Once your connection settings have been verified, click Create. You will be automatically moved back to
the Connections menu.

10. Click on your new connection. You will see the status: Cache status - Generating. This means that Qlik
NPrinting is connecting to QlikView and importing metadata. If you have a large QlikView document, this
may take several minutes.

11. Once the cache status shows Generated, you can create a new report template. If you get an Error status,
check your connection information.

You will now be able to see your new connection on the Connections screen.
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Troubleshooting QlikView Server connections
1. Make sure that both QlikView Desktop and QlikView Server are the same version, including SR.

2. In the QlikView Management Console, make sure that the mounted folder is browsable.

3. Using pseudo-URLs in the format qvp://[[username][@]]hostname[:port|;protocol]/docname is not
supported in Qlik NPrinting connections.

4. Check the credentials:

a. Make note of the service account used to run the Qlik NPrinting Engine service.

b. On the machine running the Qlik NPrinting Engine, browse to the QlikView folder.

c. Hold Shift and right-click on Qv.exe.

d. Select Run as different user.

e. Enter the service account credentials noted above.

f. Make sure QlikView Desktop does not open as Personal Edition.

g. Click File > Open in QlikView Server. Open your QlikView document.

h. Note the path and file name in the QlikView Desktop header and use that in the Qlik NPrinting
connection settings.

Connecting to QlikView documents on the QlikView Cluster
Qlik NPrinting can be connected to clusters of QlikView Servers. This enables report production optimization by
balancing the workload between Qlik NPrinting Engines and clusters of QlikView Servers.

To connect Qlik NPrinting to a cluster of QlikView Servers, authentication in the QlikView installation
must be managed using a QlikView Administrators Group.

Requirements

To create a connection to a cluster of QlikView Servers you need:

l At least one active cluster of QlikView Servers.
If you have more than one cluster, you will be able to select the one you want to use.

l QMS and QVS computers that can be reached from Qlik NPrinting Engines.
l Qlik NPrinting Engine services run by a user that is:

l a domain user
l part of a QlikView Administrators security group on all nodes of the cluster
l part of a QlikView Management API security group on the computer where QMS runs.

QlikView Management API security groups are not created during installation, they must
be created and populated manually.

To configure a QlikView Cluster connection, you need the following information that can be found in the Qlik
Management Console:
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l Cluster address and ID found under System > Setup.
l The cluster address is on the Management service > Summary tab.
l The cluster ID can be found by selecting the QVWS server under QlikView Web Servers. The

cluster ID is in the Name field of the General tab.

You will also need the Full document path. This can be found in QlikView Desktop.

The Full document path must be case-sensitive.

Do the following:

1. Launch QlikView Desktop and open your document by selecting File > Open in server. Do not use local
path to open the document.

2. Select Help > Document support info.

3. Under Document Info, find Document. You will see text that begins with qvp://.

4. Remove qvp:// and the server name to get the Full document path.
l If it says qvp://<servername>/SalesDemo2017.qvw, then the Full document path is

SalesDemo2017.qvw.
l If your document is inside sub-folders, they must be part of the Full document path. For example,

if it says qvp://<servername>/AppDemo/Sales/SalesDemo2017.qvw, then the Full document path is
AppDemo/Sales/SalesDemo2017.qvw.

Do the following:

1. From the Apps menu, click Connections.
The Connections page appears.

2. Click Create connection.

3. In the Name field, enter a name for the connection.

4. Entering a Description is optional.

5. In the App drop-down list, select the Qlik NPrinting app that you want to create the connection from.

6. Click the Cluster button in the Type row.
Related forms appear.

7. Insert the address of the QMS in the Address form.

8. Enter the name of the cluster you want to connect to in the Cluster ID.

9. Enter the case-sensitive Full document path.

10. If required, activate the Connection requires authentication flag and enter your Identity.

11. Activate the Apply user section access for reports flag if you want to apply specific users' section access
when generating reports for them.

12. Click the Run verification button. This ensures your connection is valid.
If the connection is valid, you will see a "Verification successful" message. If not, you will see the following
message: "Errors detected. Check details below."
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13. Once your connection settings have been verified, click Create. You will be automatically moved back to
the Connections menu.

14. Click on your new connection. You will see the status: Cache status - Generating. This means that Qlik
NPrinting is connecting to QlikView and importing metadata. If you have a large QlikView document, this
may take several minutes.

15. Once the cache status shows Generated, you can create a new report template. If you get an Error status,
check your connection information.

You will now be able to see your new connection on the Connections screen.

Modifying or deleting a connection

If you try to delete a connection that has associated reports or filters, you will see a warning popup
listing the elements that will become invalid upon deletion.

Do the following:

1. From the Apps menu, click Connections.

2. Click on the connection that you want to modify or delete.

3. a. To modify, make the desired changes and click Save.

b. To delete, click .

This action cannot be undone.

Connecting to Qlik Sense apps
You can connect to Qlik Sense apps that are stored on Qlik Sense servers that you have permission
to access.

This page shows how to connect specific Qlik Sense apps to Qlik NPrinting. If you are:

l Installing Qlik NPrinting and trying to connect to a Qlik Sense server, see Connecting Qlik NPrinting with
Qlik Sense (page 172).

l Trying to publish your reports to the Qlik Sense hub, see Distributing reports to the Qlik Sense hub (page
487)

Unsupported Qlik Sense objects
You should not create connections to Qlik Sense apps that use the following:

l Always one selected value for fields
l Calculated dimensions
l Drill-down dimensions
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l Alternate states
l Sheet triggers

Qlik NPrinting cannot modify or remove these options. As a result, Qlik NPrinting may not have access to the
entire data set of the connected Qlik Sense app during cache and report generation.

If you want to use Qlik Sense app with these unsupported features:

Do the following:

1. Create a copy of the Qlik Sense app.

2. Remove all unsupported features.

3. Use the copied Qlik Sense app for reporting purposes.

For more information on unsupported objects, see: Qlik objects that are not supported (page 295).

On-Demand reporting
You cannot create connections to Qlik Sense apps that use the following if you are generating On-Demand
reports:

l Variable selections used from input buttons as triggers to select data
l Input boxes
l Calculated dimensions
l Hidden tabs

Requirements
l Qlik NPrinting Server and at least one Qlik NPrinting Engine must be installed and activated.
l Qlik Sense certificates exported from the Qlik Management Console (QMC) and installed on all Qlik

NPrinting Engine computers. For more information, see Validating the connection to Qlik Sense (page 173).
l The Qlik NPrinting user creating the connection must have a domain user account that is a member of the

same domain as the Qlik NPrinting server and the Qlik Sense server.
l A working connection to Qlik Sense. For more information, see Connecting Qlik NPrinting with Qlik Sense

(page 172).

Connection rules for Qlik Sense apps
The following rules apply to connections to Qlik Sense apps:

l You can create connections from a single Qlik NPrinting app to multiple Qlik Sense apps.
l Connections are not shared between Qlik NPrinting apps. If you want to connect the same Qlik Sense app

to multiple Qlik NPrinting apps you must create a connection for each.

Types of connection status
The Cache status column shows one of the following values for each configured connection:
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l Never generated: the connection has never been opened.
l Pending: Qlik NPrinting is attempting to connect.
l Generating: Qlik NPrinting is connected and importing metadata.
l Generated: connection successful on all Qlik NPrinting engines.
l Error: the connection is failing on all available engines. The Qlik NPrinting scheduler service will try to

connect again two minutes after a failure.

The Connection status column shows one of the following values for each configured connection:

l Connection successful on all NPrinting engines.
l Warning: One or more engines are not working.
l Connection failed on all NPrinting engines.

Testing and troubleshooting
There are several way to resolve a Warning, Error, or Connection failed status. To start, open the connection
you want to troubleshoot, and click the Run verification button. This will give you a list of possible issues. Here
is an example where verification failed because Qlik Sense certificates were not installed correctly:

You can also check the following:
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l Connection properties: For example, check if the Qlik Sense certificates are present on the Qlik NPrinting
Engine computer. Also, verify the proxy address and app ID.

l Qlik NPrinting Engine installation and configuration: For example, check that the Qlik NPrinting Engine is
running.

After resolving any issues, re-launch cache generation, or run a task.

Here are some common causes of connection errors:

l Verify connection errors when setting up a connection to Qlik Sense apps (page 543)
l Connection status not shown in Qlik NPrinting web console (page 534)
l Connection timeouts and long running tasks (page 534)

Connecting to Qlik Sense apps on a Qlik Sense server
Do the following:

1. Log in to Qlik NPrinting as a user with authorization to perform connection tasks.

2. From the Apps menu, click Connections. The Connections page appears.

3. Click Create connection.

4. In the Name box, enter a name for the connection.

5. In the App drop-down list, select the Qlik NPrinting app that you want to connect to.

6. Click Qlik Sense as your Source.

7. Enter the following information:
l Proxy address: the full computer name of the Qlik Sense server.

The proxy address must be prefixed with HTTP or HTTPS if it is enabled on the Qlik Sense proxy.
HTTPS is the default. You can find this in the Qlik Sense hub, in your browser's address bar, on
your app's overview page. The format is: https://sense_proxy_computer_name.domain_name.

Your proxy address may have a prefix at the end. In this case, the format is:
https://sense_proxy_computer_name.domain_name/prefix.
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l Qlik Sense app id:
This information is available from the Qlik Sense QMC under Apps. If you cannot see the app id

column, click on the at the top right and check "ID".

l Identity: the <Windows domain name>\<user name> of the Qlik Sense user who has access to the
app.
This information is available from the Qlik Sense QMC under Users. You will need the information
in the User directory and User ID fields.
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8. If you want to apply the theme colors from the Sense app to reports created with this connection, click
the Apply Sense app theme check box.
If you make any changes to the Sense app theme, you will need to manually reload the connection to
apply the updated theme.

9. If you want to apply section access for the selected Identity, click the Apply user section access for
reports check box.

10. Click the Run verification button. This ensures your connection is valid.
If the connection is valid, you will see a "Verification successful" message. If not, you will see the following
message: "Errors detected. Check details below."
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11. Under Notifications, you can select Send email notification when metadata reload finishes. An email
will be sent to the addresses specified under Settings > Tasks. See: Task execution notifications (page
268).

12. Once your connection settings have been verified, click Create. You will be automatically moved back to
the Connections menu.

13. Click on your new connection. You will see the status Cache status - Generating. This means that Qlik
NPrinting is connecting to Qlik Sense and importing metadata. If you have a large Qlik Sense app, this may
take several minutes.
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14. Once the cache status shows Generated, you can create a new report template. If you get an Error status,
check your connection information.

You will now be able to see your new connection on the Connections screen.

Modifying or deleting a connection

If you try to delete a connection that has associated reports or filters, you will see a warning listing the
elements that will become invalid upon deletion.
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Do the following:

1. From the Apps menu, click Connections.

2. Click on the connection that you want to modify or delete.

3. a. To modify, make the desired changes and click Save.

b. To delete, click .

This action cannot be undone.

Reloading connection metadata
Connection metadata contains information about the data and structures of linked QlikView
documents or Qlik Sense apps.

Qlik NPrinting automatically uploads metadata when a new connection is created. Metadata must also be
updated whenever you change the data structure or content of QlikView documents or Qlik Sense apps
connected to Qlik NPrinting. This ensures that Qlik NPrinting is aware of these changes.

After the metadata is reloaded, all instances of QV.exe and reporting_web_renderer.exe that are running on Qlik
NPrinting Engines associated with the connection will automatically stop and restart to update them. Existing
reports are not automatically re-run, so they may contain old data. Reports executed after a metadata reload will
show the updated data.

Last cache update times are displayed relative to the time zone of the logged in user. These may be different
than the time zone of the Qlik NPrinting Server. You can change your time zone by clicking on your user name in
the top right, and selecting Settings.

Types of connection status
The Cache status column shows one of the following values for each configured connection:

l Never generated: the connection has never been opened.
l Pending: Qlik NPrinting is attempting to connect.
l Generating: Qlik NPrinting is connected and importing metadata.
l Generated: connection successful on all Qlik NPrinting engines.
l Error: the connection is failing on all available engines. The Qlik NPrinting scheduler service will try to

connect again two minutes after a failure.

The Connection status column shows one of the following values for each configured connection:

l Connection successful on all NPrinting engines.
l Warning: One or more engines are not working.
l Connection failed on all NPrinting engines.
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Troubleshooting
There are several way to resolve a Warning, Error, or Connection failed status. To start, open the connection
you want to troubleshoot, and click the Run verification button. This will give you a list of possible issues. Here
is an example where verification failed because Qlik Sense certificates were not installed correctly:

You can also check the following:

l Connection properties: For example, verify the QlikView document path, username, and password. In Qlik
Sense, check if the certificates are present on the Qlik NPrinting Engine computer.

l Qlik NPrinting Engine installation and configuration: For example, an engine with QlikView Desktop 12
cannot open a document on a QlikView 11.2 server. Check also that QlikView Desktop has an active license
for the Windows user who runs the service.

After resolving any issues, re-launch cache generation, or run a task.

Here are some common causes of connection errors:

l Verify connection errors when setting up a connection to Qlik Sense apps (page 543)
l Verify connection errors when setting up a connection to QlikView documents (page 541)
l Connection status error (page 534)
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l Connection status not shown in Qlik NPrinting web console (page 534)
l Connection timeouts and long running tasks (page 534)

Reloading metadata manually
Do the following:

1. From the main menu, click the Apps drop-down, and click Connections.
Review the entries in the Last cache update column. You should refresh the metadata if the Last cache
update value is - .

2. Click on the connection name to open the connection.

3. Under Notifications, you can select Send email notification when metadata reload finishes. An email
will be sent to the addresses specified under Settings > Tasks. See: Task execution notifications (page
268).

4. Click Reload metadata.
You will see the status:Cache status - Generating. This means that Qlik NPrinting is connecting to Qlik
Sense or QlikView and importing metadata. If you have a large app or document, this may take several
minutes.

5. Once the cache status shows Generated, you can create a new report template. If you get an Error status,
check your connection information.

Your connection metadata has been updated. You can now create or update reports associated with these
connections.
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Reloading metadata via scheduled trigger
You can create triggers to schedule regular metadata reloads.

Do the following:

1. From the main menu, click the Apps drop-down, and click Connections.

2. Click on the connection name to open the connection.

3. Click the Triggers button.

4. Click Create trigger.

5. Type a name for the trigger.

6. Select a Schedule type and Time.

7. Set a Start date and Time zone.

8. Click the Enabled button.

9. Click the Create button.

Your metadata will now reload automatically, based on your settings.

Best practices for metadata reload
Metadata must be updated whenever you change the data structure of QlikView documents or Qlik Sense apps
connected to Qlik NPrinting. This ensures that changes are correctly propagated in the Qlik NPrinting connection
cache and objects available in the cache are up to date with the corresponding QlikView document or Qlik Sense
app.

A scheduled or manual reload must be triggered if:

l Objects in the connected document or app are not showing in Qlik NPrinting Designer when editing
reports.

l Objects in the connected document or app are not showing in the available objects list when creating
QlikEntity reports.

l Filter field values are not showing in suggestions when creating or editing Qlik NPrinting filters.
l Variables from the document or app are not listed when editing variables-related values in Qlik NPrinting.

For example: conditions, folder paths, variables embedded in email messages.

Document and app data can be cached in existing connections and not be updated if subsequent tasks are run
before and after data reload in the QlikView document or Qlik Sense app. Data push is dependent on specific
document configuration.

Reloading metadata allows you to refresh all data connections, ensuring latest version of the data is used during
task execution.

Reloading metadata before running publish tasks is recommended if:

l You have frequent data reloads in your QlikView document or Qlik Sense app.
l You frequently run tasks in Qlik NPrinting that may keep data connections active.

You can reload metadata:
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l Manually
l Using scheduled using triggers
l Using connection reloads API. For more information, see POST /connections/{id}/reload.

2.4 Creating reports
Reports allow you to share Qlik Sense and QlikView visualizations in many formats, such as Excel,
Word, Power Point PixelPerfect, HTML, and PDF. Qlik NPrinting lets you use familiar editing tools to
showcase your complex Qlik objects.

You can base your reports on existing templates, or create your own. Reports can be filtered, so that specific data
is only available to certain users.

Reports can be delivered at scheduled times, or when they are requested by individual users. Final reports are
static files that contain the most recent copies of your QlikView and Qlik Sense data at the time the report was
generated.

Publishing a simple report from a QlikView document
This tutorial will show you how to create and publish a simple Qlik NPrinting PowerPoint report
using QlikView data.

Qlik NPrinting has many features. This tutorial is meant to help newer users create their first report. It does not
outline every report type, design element, or publishing option. At the end of this tutorial, you will have created,
edited, and published a PowerPoint report that is viewable by your selected users.

Other Qlik NPrinting tutorials:

l Publishing a simple report from a Qlik Sense app (page 65)
l Publishing a complex report from a Qlik Sense app (page 85)

Microsoft Office must be installed to edit and create reports in Office file formats.

In this tutorial, you will be:

Accessing a QlikView document
Reports need data. Learn how to download and import a sample QlikView document.

Connecting Qlik NPrinting to a QlikView document
Qlik NPrinting needs to connect to your QlikView document. Learn how to configure Qlik NPrinting so it can
access a sample document, or your existing QlikView data.
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Creating a new Qlik NPrinting report template
Report templates control the layout and output formats of reports. This section will show you how to make a new
one.

Editing the report template
Reports offer many different formatting options. In this section, you will add a title, images, table, chart, and
pages to your report.

Publishing to NewsStand and email
NewsStand is a web console your users can access to view reports. Learn how to publish your report to the
NewsStand and by email.

Accessing a QlikView document
QlikView documents contain the data and visualizations that Qlik NPrinting uses to build reports. There are a few
different ways to access a QlikView document.

l You can download a QlikView document from the Qlik help site, and save it to a folder on your computer.
l You can use your own QlikView document. If you are using your own document to complete this tutorial,

pick a simple one. Qlik NPrinting experiences longer load times with complex QlikView documents.

Connecting Qlik NPrinting to a QlikView document
Now we will create a Qlik NPrinting app and connect it to your QlikView document.

Qlik NPrinting apps contains reports, filters, and connections to Qlik Sense apps or QlikView documents. They let
the Qlik NPrinting Designer access your data so that it can be used in a report.

Do the following:

1. Log into the Qlik NPrinting web console.

2. On the main menu, click the Apps drop-down, and select Apps.

3. Click the Create app button.

a. Enter a name for this new app. For example: Beginner's Tutorial NP App - QV.

b. Ensure the Enabled check box is selected. Otherwise, your app will be ignored by the Qlik
NPrinting Engine.
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c. Click Create.

You will now be able to see Beginner's Tutorial NP App - QV under Apps.

4. From the main menu, click the Apps drop-down, and select Connections.

a. Click the Create connection button.

b. In the Name box, enter a name for the connection: Beginner's Tutorial Connection - QV.

c. In the App drop-down list, select the Qlik NPrinting app that you created previously: Beginner's
Tutorial NP App - QV.

d. Under Source select QlikView.

e. Under Type select Local.

f. Under Document path, type in the location of the QlikView document you want to connect to.
For example: C:\Program Files\QlikView\Examples\Sales Demo.qvw
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Mapped network drives, like Z:\NPrintingServer\QlikViewDocuments, are not supported
by Qlik NPrinting. You must use Universal Naming Convention (UNC) paths, such as
\\ServerName\NPrintingServer\QlikViewDocuments.

g. If your QlikView document requires authentication, ensure that Connection requires
authentication is checked.
See: Prerequisites for QlikView Server and QlikView Cluster connections (page 232).

h. Click the Run verification button. This ensures your connection is valid.

If the connection is valid, you will see a "Verification successful" message. If not, you will see the
following message: "Errors detected. Check details below."
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i. Once your connection settings have been verified, click Create. You will be automatically moved
back to the Connections menu.

j. Your new connection will have a Cache status - Generating status. This means that Qlik NPrinting
is connecting to QlikView and importing metadata. If you have a large QlikView document, this
may take several minutes.

Every time you add new objects to your QlikView document, you must reload your
connection metadata.

k. Once the cache status shows Generated, you can create a new report template. If you get an Error
status, check your connection information.

You will now be able to see your new connection on the Connections screen.

If you have trouble connecting to your QlikView document, see:

l Connecting to QlikView documents (page 21)
l Verify connection errors when setting up a connection to QlikView documents (page 541)Troubleshooting

(page 523)

Creating a new Qlik NPrinting report template
Report templates control the layout and output formats of reports. You can arrange objects and format pages
using the standard options of the report type you choose. For example, a PowerPoint report will have the same
formatting options and interface as a PowerPoint deck.

Do the following:

1. In the Qlik NPrinting web console, click Reports on the main menu.

2. Click the Create report button.

3. Enter a title in the Title field. For example: Beginner's Tutorial NP PowerPoint.

4. From the Type drop-down list, select PowerPoint.

5. From the App drop-down list, select Beginner's Tutorial NP App - QV.
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6. From the Template options, click Empty file.

7. Ensure the Enabled check box is selected. Otherwise, your report will be ignored by the Qlik NPrinting
Engine.

8. Click Create.

You will now be able to see Beginner's Tutorial NP PowerPoint under Reports.

Editing the report template
There are many ways to edit a report template. We will be adding:

l Titles: simple text used to organize your report. They can be altered using standard PowerPoint
formatting.

l Tables: take your QlikView data and present it in tabular form.
l Images: take your QlikView data and present it as a .png.
l Charts: take your QlikView table data and present it as a PowerPoint chart.
l Pages: sub-divide your data by a dimension. They can be applied to tables and images. We will be dividing

Year and Category Name.

This section does not cover everything you can do in the Qlik NPrinting Designer. If you would like to read about
advanced PowerPointreport features, see: PowerPoint reports (page 403).
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Your report preview may look different than the image shown below, depending on how you formatted
it. Some of the objects may have slightly different names, depending on the order they were selected.

Do the following:

1. In the Qlik NPrinting web console, click Reports on the main menu.

2. On the Reports screen, click on your report.

3. Click the Edit template button to open the Qlik NPrinting Designer template editor.

4. The Qlik NPrinting Designer opens. Because you are making a PowerPoint report, you will see the
standard PowerPoint interface. Most PowerPoint formatting features can be applied to your report using
this interface.
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5. Enter a title:

a. On the first slide, type in a title: For example, "Sales Trends by Product Category".

b. Enter a subtitle, or delete the subtitle text box.

You can use PowerPoint formatting options to change the look of these titles. For
example, you can change the font size and color.

6. Add images:

a. On the PowerPoint toolbar, click the Insert tab.

b. Click the New Slide button.

c. Type in a title: for example, "Top Selling Products". Delete the second empty text box.

d. On the left pane, right-click on Images, and select Add objects.
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e. A new window will open. Select Products and Sales by Category for 2014 vs 2013, and click OK.
You can select multiple options by holding down the CTRL button.
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f. Drag SH02 - Products onto the slide.
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g. On the PowerPoint toolbar, click the Insert tab.

h. Click the New Slide button.

i. Type in a title: for example, "Sales by Category: 2013 vs 2014". Delete the second empty text box.

j. Drag CH212 - Sales by Category for 2014 vs 2013 onto the slide.
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7. Add a table:

a. On the left pane, right-click on Tables, and select Add objects.

b. A new window will open. Select Sales by Category: 2013 vs 2014. Click OK.
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c. Drag CH212_1 - Sales by Category for 2014 vs 2013 onto the slide.

8. Add a PowerPoint native chart:

a. On the PowerPoint toolbar, click the Insert tab.

b. Click the New Slide button.

c. Type in a title: for example, "Sales Trends:". Delete the second empty text box.

d. On the left pane, right-click on Tables, and select Add objects.

e. A new window will open. Select CH326 - Sales by YearMonthNum. Click OK.

f. On the PowerPoint toolbar, select the Insert tab.

g. In the Illustrations section, click on Chart .

h. A new window will open. Under Column, select the first bar chart, and then click OK.
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i. An Excel worksheet will open. This is the data source for your chart.
We will need to insert Qlik NPrinting tags onto this sheet and remove some unnecessary data.
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j. On the left pane of the PowerPoint interface, expand the CH326 - Sales by YearMonthNum node.

k. Select the YearMonthNum and Sales tags.
You can select multiple options by holding down the CTRL button.

l. Drag and drop the Year MonthNum tag into the Excel worksheet, into cell A1. This will make it the
y-axis. Drag the Sales tags into cell B1. This will make it the x-axis.

m. Select and delete columns C and D.
The actual numbers are unnecessary, because Qlik NPrinting will use the tags to build the chart.

n. Select and delete rows 3, 4, and 5.
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o. Close Excel.
Your changes will save automatically.

p. You may need to adjust the size of your chart to make it fit on the slide. You can use the sizing
arrows.

q. On the Qlik NPrinting template editor menu, click the File tab. Click Save.

r. Click the Template tab, and click the Preview button to preview your report.
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Your slide show has four slides at the moment.

9. Add pages:

a. Go to the slide where you want to add the page. In this case, the fourth slide.
Pages are only applied to the current slide.

b. On the left pane, right-click on Page, and select Add page to current sheet.

c. A new window will open. Select CategoryName. Click OK.

Note: If you add a second page to a slide, the previous page will be overwritten.

d. Expand the CategoryName_Page - CategoryName node. Drag the CategoryName tag onto the
slide.
This tag will divide your data by category, with each category going on a separate slide. The
<CategoryName> text will change to match the category of each slide. Instead of one slide that
says "Sales Trends:", you will have several slides with unique titles: "Sales Trends: Baby Clothes",
"Sales Trends: Women's Shoes".
The <CategoryName> tag will appear as a new text box. If you cut and paste this new text into the
title text box, you can format it to match the title more easily.
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a. Go to the second slide, "Top Selling Products".

b. On the left pane, right-click on Page, and select Add page to current sheet.

c. A new window will open. Select Year. Click OK.

d. Expand the Year_Page - Year node. Drag the Year tag onto the slide.
It will appear as a new text box. If you cut and paste this new text into the title text box, you can
format it to match the title more easily.

a. On the PowerPoint toolbar, click the Insert tab.

b. Click the Slide Number button.

c. A new window will open. Click the Date and time, Slide number, and Don't show on title slide
check boxes. Click Apply to All.
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10. On the Qlik NPrinting template editor menu, click the File tab. Click Save.

11. Click the Template tab, and click the Preview button to preview your report.
It may take several minutes for your preview to load, depending on the size of your report.
You now have a report with 13 slides. The slides with pages applied have expanded to new pages with
information divided by the page categories you applied.
In this example, slides 2-4 show data filtered by Year, and slides 6-13 show data filtered by
CategoryName.
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Edits done in preview mode will not be saved.

12. If you would like to continue editing, close the preview window, and format your report in the template
editor.

13. When you are finished editing, click Save And Close.

The report template is now saved and ready to be shared with users.

Publishing to NewsStand and email
Reports need to be published in order for users to access them. We will be publishing to NewsStand and by email.
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NewsStand is a web portal that allows users to preview and download reports, and subscribe to automatic
updates. See: NewsStand overview (page 476)

Emails contain your reports as attachments. Their contents can be customized by adding text and images. See:
Distributing reports by email (page 479).

You must configure your SMTP mail server in order to send email from Qlik NPrinting. See: Configuring
SMTP server (page 268).

Do the following:

1. In the Qlik NPrinting web console, click Tasks on the main menu, and select Publish task.

2. Click the Create task button.

a. Enter a name. For example: Publish Beginner's Tutorial NP PowerPoint.

b. Select your app from the drop-down list: Beginner's Tutorial NP App - QV.

c. Leave the default values for the other options. Click Create.

3. Click on the Reports tab.

a. Click the Add report button.
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b. Select Beginner's Tutorial - NP PowerPoint from the Choose report drop-down list.

c. Select PPTX from the Output format drop-down list.

d. Ensure that the Attach to email and Enabled check boxes are selected.

e. Click Add report.

4. Click on the Users/groups tab.

a. Click the Add user or group button.

b. Select a user or group from the Choose recipient drop-down list.
If you would like to learn how to create new users, see: Creating users (page 240).

c. Select the Enabled, NewsStand destination, and Email destination check boxes.

d. Click Add recipient.

5. Click on the Destinations tab.

a. In the NewsStand column, click the Publish for all check box.

b. In the Email column, click the Publish for all check box.

c. Click Save.

6. You will be sent back to the Overview tab.

7. Click the Run now button.
Once the task is completed, a confirmation message will appear at the top of the page.
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Your recipients can now go to the NewsStand in their browsers and view your report. They will also receive a copy
in their email.

In standard installations, you can switch from the Qlik NPrinting web console to your NewsStand by
changing port 4993 to 4994 in your browser bar. For example, if your web console is
https://YourServerName:4993, then your NewsStand is https://YourServerName:4994.
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Publishing a simple report from a Qlik Sense app
This tutorial will show you how to create and publish a simple Qlik NPrinting Excel report using Qlik
Sense data.

Qlik NPrinting has many features. This tutorial is meant to help newer users create their first report. It does not
outline every report type, design element, or publishing option. At the end of this tutorial, you will have created,
edited, and published an Excel report that is viewable by your selected users.

Other Qlik NPrinting tutorials:

l Publishing a simple report from a QlikView document (page 42)
l Publishing a complex report from a Qlik Sense app (page 85)

Microsoft Office must be installed to edit and create reports in Office file formats.

In this tutorial, you will be:

Accessing a Qlik Sense app
Reports need data. Learn how to download and import a sample Qlik Sense app.

Connecting Qlik NPrinting to a Qlik Sense app 
Qlik NPrinting needs to connect to your Qlik Sense app. Learn how to configure Qlik NPrinting so it can access the
sample app, or your existingQlik Sense data.

Creating a new Qlik NPrinting report template
Report templates control the layout and output formats of reports. This section will show you how to make a new
one.
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Editing the report template
Reports offer many different formatting options. In this section, you will add a title, image, table, and level to
your report.

Publishing to NewsStand and email
NewsStand is a web console your users can access to view reports. Learn how to publish your report to the
NewsStand and by email.

Accessing a Qlik Sense app
Qlik Sense apps contain the data and visualizations that Qlik NPrinting uses to build reports. There are a few
different ways to access a Qlik Sense app.
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l You can download a Qlik Sense app from the Qlik help site, and upload it to your Qlik Sense Apps folder.
l You can use your own Qlik Sense app. If you are using your own app to complete this tutorial, pick a

simple one. Qlik NPrinting experiences longer load times with complex Qlik Sense apps.

Connecting Qlik NPrinting to a Qlik Sense app 
Now we will create a Qlik NPrinting app and connect it to your Qlik Sense app.

A Qlik Sense app and a Qlik NPrinting app are very different:

l Qlik Sense app: contains data, and uses visualizations to explore that data.
l Qlik NPrinting app: contains reports, filters, and the connection to a Qlik Sense app or QlikView document.

Qlik NPrinting apps let the Qlik NPrinting Designer access your Qlik Sense data so that information can be used in
a report.

In order to connect Qlik NPrinting to your Qlik Sense apps, Qlik Sense certificates must be installed on
all Qlik NPrinting Engine computers. See: Installing Qlik NPrinting certificates (page 206).

Do the following:

1. Log into the Qlik NPrinting web console.

2. On the main menu, click the Apps drop-down, and click Apps.

3. Click the Create app button.

a. Enter a name for this new app. For example: Beginner's Tutorial NP App.

b. Ensure the Enabled check box is selected. Otherwise, your app will be ignored by the Qlik
NPrinting Engine.

Qlik NPrinting - February 2024 67

2   Getting started



c. Click Create.

You will now be able to see Beginner's Tutorial NP App under Apps.

4. From the main menu, click the Apps drop-down, and click Connections.

a. Click the Create connection button.

b. In the Name box, enter a name for the connection: Beginner's Tutorial Connection.

c. In the App drop-down list, select the Qlik NPrinting app that you created previously: Beginner's
Tutorial NP App.

d. Select Qlik Sense as your Source.

e. Enter the following information:
l Proxy address: the full computer name of the Qlik Sense server. You can find this in the

Qlik Sense hub, in your browser's address bar. The format is: https://sense_proxy_
computer_name.domain_name.

l Qlik Sense app id: This information is available in the Qlik Sense hub, in your browser's
address bar, on your app's overview page.
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l Identity: the <Windows domain name>\<user name> of the Qlik Sense user who has access
to the app.

f. Click the Run verification button. This ensures your connection is valid.
If the connection is valid, you will see a "Verification successful" message. If not, you will see the
following message: "Errors detected. Check details below."
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g. Once your connection settings have been verified, click Create. You will be automatically moved
back to the Connections menu.

h. Click on your new connection. You will see the status: Cache status - Generating. This means that
Qlik NPrinting is connecting to Qlik Sense and importing metadata. If you have a large Qlik Sense
app, this may take several minutes.

Qlik NPrinting - February 2024 70

2   Getting started



Every time you add new objects to your Qlik Sense app, you must reload your connection
metadata.

i. Once the cache status shows Generated, you can create a new report template. If you get an Error
status, check your connection information.

You will now be able to see your new connection on the Connections screen.
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If you have trouble connecting to your Qlik Sense app, see:

l Creating connections (page 21)
l Troubleshooting (page 523)

Creating a new Qlik NPrinting report template
Report templates control the layout and output formats of reports. You can arrange objects and format pages
using the standard options of the report type you choose. For example, an Excel report will have the same
formatting options and interface as an Excel worksheet.

Do the following:

1. In the Qlik NPrinting web console, click Reports on the main menu.

2. Click the Create report button.

3. Enter a title in the Title field. For example: Beginner's Tutorial NP Excel.

4. From the Type drop-down list, select Excel.

5. From the App drop-down list, select Beginner's Tutorial NP App.

6. From the Template options, click Empty file.

7. Ensure the Enabled check box is selected. Otherwise, your report will be ignored by the Qlik NPrinting
Engine.
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8. Click Create.

You will now be able to see Beginner's Tutorial NP Excel under Reports.
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Editing the report template
There are many ways to edit a report template. We will be adding:

l Titles: simple text used to organize your report. They can be altered using standard Excel formatting.
l Levels: sub-divide your data by a dimension. They can be applied to tables and images. We will be dividing

Top 5 Customers by Region.
l Tables: take your Qlik Sense data and present it in tabular form.
l Images: take your Qlik Sense data and present it as a .png.

This section does not cover everything you can do in the Qlik NPrinting Designer. If you would like to read about
advanced Excel report features, see: Excel reports.

Your report preview may look different than the image shown below, depending on how you formatted
it. Some of the objects may have slightly different names, depending on the order they were selected.

Do the following:

1. In the Qlik NPrinting web console, click Reports on the main menu.

2. On the Reports screen, click on your report.

3. Click the Edit template button to open the Qlik NPrinting Designer template editor.
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4. Enter a title:

a. In cell A1, type in a title: For example, "Sales Data".

b. In cell A2, type in a subtitle: "Top 5 Customers by Region".

You can use Excel formatting options to change the look of these titles. For example, you
can change the font size and color. You can also merge several cells together so that the
title is centered with the rest of the report.
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5. Add a level:

a. On the left pane, right-click on Levels, and select Add levels.

b. A new window will open. Select Region. Click OK.

c. Drag Region_Level to cell A3.

d. Insert three rows beneath A3 to ensure you have four empty cells between the <Region_Level>
and </Region_Level> tags.

e. Expand Region_Level in the left pane.

f. Drag and drop Region onto cell A5.
This ensures that each level has a heading.
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6. Add a table:

a. On the left pane, right-click on Tables, and select Add objects.

b. A new window will open. Select Top 5 Customers. Click OK.

c. Right-click on the new node labeled qPyMBp - Top 5 Customers. Click Properties.

d. On the Properties pane, ensure that Keep Source Formats is not selected.

e. Expand qPyMBp - Top 5 Customers. Drag Customer to cell A6, and drag JWaPFv_1 - Sales to B6.
These two table objects should be inside the two levels tags. You can format them the same as a
table by adding a border or background color.

f. Click on cell B6. On the Home tab, go to Number, and select the Accounting Number Format
icon. This ensures that the data from JWaPFv_1 - Sales displays as currency.
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7. Add images:

a. On the left pane, right-click on Images, and select Add objects.

b. A new window will open. Select Top 5 Customers and Total Sales and Margin, and click OK.
You can select multiple options by holding down the CTRL button.
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c. Click on the new node labeled PwvCsy - Total Sales and Margin and drag it to cell D3. Click on
qPyMBp_1 - Top 5 Customers and drag it to cell D7.
Because these are images, trying to format them using Excel formatting options will have no effect.
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8. On the Excel toolbar, click the Page Layout tab.

9. Click the Orientation drop-down, and select Landscape.
Report types with many tables that span length-wise will display more clearly in landscape.

10. On the Qlik NPrinting template editor menu, click the File tab. Click Save.

11. Click the Template tab, and click the Preview button to preview your report.
It may take several minutes for your preview to load, depending on the size of your report.
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Edits done in preview mode will not be saved.

12. If you would like to continue editing, close the preview window, and format your report in the template
editor.

13. When you are finished editing, click Save And Close.

The report template is now saved and ready to be shared with users.

Publishing to NewsStand and email
Reports need to be published in order for users to access them. We will be publishing to NewsStand and by email.
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NewsStand is a web portal that allows users to preview and download reports, and subscribe to automatic
updates. See: NewsStand overview (page 476)

Emails contain your reports as attachments. Their contents can be customized by adding text and images. See:
Distributing reports by email (page 479).

You must configure your SMTP mail server in order to send email from Qlik NPrinting. See:Configuring
SMTP server (page 268).

Do the following:

1. In the Qlik NPrinting web console, click Tasks on the main menu, and select Publish task.

2. Click the Create task button.

a. Enter a name.

b. Select your app from the drop-down list: Beginner's Tutorial NP App.

c. Leave the default values for the other options. Click Create.

3. Click on the Reports tab.

a. Click the Add report button.

b. Select Beginner's Tutorial - NP Excel from the Choose report drop-down list.

c. Select XLS from the Output format drop-down list.

d. Make sure that the Attach to email and Enabled check boxes selected.

e. Click Add report.

4. Click on the Users/groups tab.

a. Click the Add user or group button.

b. Select a user or group from the Choose recipient drop-down list.
If you would like to learn how to create new users, see:Creating users (page 240).

c. Select the Enabled, NewsStand destination, and Email destination check boxes.

d. Click Add recipient.

5. Click on the Destinations tab.

a. In the NewsStand column, click the Publish for all check box.

b. In the Email column, click the Publish for all check box.

c. Click Save.

6. You will be sent back to the Overview tab.

7. Click the Run now button.
A confirmation message will appear at the top of the page.
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Your recipients can now go to the NewsStand in their browsers and view your report. They will also receive a copy
in their email.

In standard installations, you can switch from the Qlik NPrinting web console to your NewsStand by
changing port 4993 to 4994 in your browser bar. For example, if your web console is
https://YourServerName:4993, then your NewsStand is https://YourServerName:4994.
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Publishing a complex report from a Qlik Sense app
This tutorial will show you how to create and publish a complex Qlik NPrinting Excel report using
Qlik Sense data.

Qlik NPrinting has many features. This tutorial is meant to help experienced users create a report. It does not
outline every report type, design element, or publishing option. At the end of this tutorial, you will have created,
edited, and published an Excel report that is viewable by your selected users.

Other Qlik NPrinting tutorials:

l Publishing a simple report from a Qlik Sense app (page 65)
l Publishing a simple report from a QlikView document (page 42)

Microsoft Office must be installed to edit and create reports in Office file formats.

In this tutorial, you will be:

Accessing a Qlik Sense app
Reports need data. Learn how to download and import a sample Qlik Sense app.

Connecting Qlik NPrinting to a Qlik Sense app 
Qlik NPrinting needs to connect to a Qlik Sense app. Learn how to configure Qlik NPrinting so it can access a
sample app, or your existing Qlik Sense data.

Creating a new filter
Filters let you refine your data. Create a filter to control the data your users see.

Creating a new Qlik NPrinting report template
Report templates control the layout and output formats of reports. This section will show you how to make a new
one.
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Editing the report template
Reports offer many different formatting options. You will add titles, Excel tables, tables with subtotals, and levels
to your report.

Publishing to NewsStand and email
NewsStand is a web console your users can access to view reports. Learn how to automate publishing your report
to the NewsStand and by email.

Accessing a Qlik Sense app
Qlik Sense apps contain the data and visualizations that Qlik NPrinting uses to build reports. There are a few
different ways to access a Qlik Sense app:

l You can download a Qlik Sense app from the Qlik help site, and upload it to your Qlik Sense Apps folder.
This tutorial references many values and fields found in this sample app. If this is your first time
performing this tutorial, you may want to use the app provided, not a custom app.

l You can use your own Qlik Sense app. If you are using your own app to complete this tutorial, pick a
simple one. Qlik NPrinting experiences longer load times with complex Qlik Sense apps.

Connecting Qlik NPrinting to a Qlik Sense app 
Now we will create a Qlik NPrinting app and connect it to your Qlik Sense app.

A Qlik Sense app and a Qlik NPrinting app are very different:

l Qlik Sense app: contains data, and uses visualizations to explore that data.
l Qlik NPrinting app: contains reports, filters, and the connection to a Qlik Sense app or QlikView document.

Qlik NPrinting apps let the Qlik NPrinting Designer access your Qlik Sense data so that information can be used in
a report.

In order to connect Qlik NPrinting to your Qlik Sense apps, Qlik Sense certificates must be installed on
all Qlik NPrinting Engine computers. See: Installing Qlik NPrinting certificates (page 206).

Do the following:

1. Log into the Qlik NPrinting web console.

2. On the main menu, click the Apps drop-down, and click Apps.

3. Click the Create app button.

a. Enter a name for this new app. For example: Advanced Tutorial NP App.

b. Ensure the Enabled check box is selected. Otherwise, your app will be ignored by the Qlik
NPrinting Engine.

c. Click Create.
You will now be able to see Advanced Tutorial NP App under Apps.
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4. From the main menu, click the Apps drop-down, and click Connections.

a. Click the Create connection button.

b. In the Name box, enter a name for the connection: Advanced Tutorial Connection.

c. In the App drop-down list, select the Qlik NPrinting app that you created previously: Advanced
Tutorial NP App.

d. Select Qlik Sense as your Source.

e. Enter the following information:
l Proxy address: the full computer name of the Qlik Sense server. You can find this in the

Qlik Sense hub, in your browser's address bar. The format is: https://sense_proxy_
computer_name.domain_name.

l Qlik Sense app id: This information is available in the Qlik Sense hub, in your browser's
address bar, on your app's overview page.

l Identity: the <Windows domain name>\<user name> of the Qlik Sense user who has access
to the app.

f. Click the Run verification button. This ensures your connection is valid.
If the connection is valid, you will see a "Verification successful" message. If not, you will see the
following message: "Errors detected. Check details below."
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g. Once your connection settings have been verified, click Create. You will be automatically moved
back to the Connections menu.

h. Click on your new connection. You will see the status: Cache status - Generating. This means that
Qlik NPrinting is connecting to Qlik Sense and importing metadata. If you have a large Qlik Sense
app, this may take several minutes.

Every time you add new objects to your Qlik Sense app, you must reload your connection
metadata.

i. Once the cache status shows Generated, you can create a new report template. If you get an Error
status, check your connection information.

You will now be able to see your new connection on the Connections screen.
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If you have trouble connecting to your Qlik Sense app, see:

l Creating connections (page 21)
l Troubleshooting (page 523)

Creating a new filter
Static filters let you refine your data according to fields from your Qlik Sense app. In this case, we are going to
create a filter called Wine & Beer from the Product Group field. A table or image with this filter applied will only
display results related to wine and beer, and would ignore all other product types.

Do the following:

1. From the main menu, click the Apps drop-down, and then select Filters.

2. Click Create filter.

3. Enter a Name for your filter. For example: Wine & Beer.

4. Under App, select Advanced Tutorial NP App.

5. Click Create.

6. Click Fields in the filters menu.

7. Click Add field.
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8. Under Connection, select your connection.

9. Under Name, select Product Group.
Leave Override values unchecked.

10. Leave Value is in the Values area. This option forces Qlik NPrinting to select the list of values that you
specify.

11. Start to type the value you want. A list of possible values will appear. In this case, choose Alcoholic
Beverages.

12. Click Create.

Creating a new Qlik NPrinting report template
Report templates control the layout and output formats of reports. You can arrange objects and format pages
using the standard options of the report type you choose. For example, an Excel report will have the same
formatting options and interface as an Excel worksheet.

Do the following:

1. In the Qlik NPrinting web console, click Reports on the main menu.

2. Click the Create report button.

3. Enter a title in the Title field. For example: Advanced Tutorial Excel.

4. From the Type drop-down list, select Excel.

5. From the App drop-down list, select Advanced Tutorial NP App.

6. From the Template options, click Empty file.

7. Ensure the Enabled check box is selected. Otherwise, your report will be ignored by the Qlik NPrinting
Engine.

8. Click the Enable dynamic naming check box. This will let you add variables to your report names.
These field elements can be reordered using the sort-handles on the right.
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9. You must have at least one variable. Choose Report name.

10. Click Add variable. Choose User department.

11. Click Add variable. Choose Custom. Add a hyphen or underscore in the text box that appears.

12. Click Add variable. Choose Date. Select a date format.

13. The Preview box shows your dynamic report name.

14. Click Create.
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You will now be able to see Advanced Tutorial Excel under Reports.

Editing the report template
There are many ways to edit a report template. We will be adding:

l Titles: simple text used to organize your report. They can be altered using standard Excel formatting.
l Levels: sub-divide your data by a dimension. They can be applied to tables and images.
l Tables: take your Qlik Sense data and present it in tabular form. You can create Excel tables, or import

Qlik Sense tables.
l Object filters: refine the data that is displayed in an object, such as a chart or table.

This section does not cover everything you can do in the Qlik NPrinting Designer. If you would like to read about
other Excel report features, see: Excel reports.

Your report preview may look different than the images shown below, depending on how you formatted
it. Some of the objects may have slightly different names, depending on the order they were selected.

Do the following:

1. In the Qlik NPrinting web console, click Reports on the main menu.

2. On the Reports screen, click on your report.

3. Click the Edit template button to open the Qlik NPrinting Designer template editor.

4. In cell A1, type in a title: For example, Quarterly trends and customer sales by region.

You can use Excel formatting options to change the look of these titles. For example, you can
change the font size and color. You can also merge several cells together so that the title is
centered with the rest of the report.
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5. Add a level:

a. On the left pane, right-click on Levels, and select Add levels.

b. A new window will open. Select Region. Click OK.

c. Drag Region_Level to cell A2.

d. Cut and paste the </Region_Level> tag to A17.
Objects placed inside these tags will be organized by region.

e. Expand Region_Level in the left pane.

f. Drag and drop Region onto cell A4.
This ensures that each level has a heading.

6. Add an Excel table:

a. In cell A6, add a subtitle: Quarterly trends.

b. On the left pane, right-click on Tables, and select Add objects.

c. A new window will open. Select Quarterly Trend. Click OK.

d. On the left-hand pane, select TFWPC - Quarterly Trend. This will open the Properties pane,
below.
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e. Clear the Keep Source Formats check box.
This removes Qlik Sense formatting from the table, so you can customize it.

f. Set Show Headers to Show in tag cell.

Column headers will be inserted in the tag cells and data will start in the row below. Formulas and
variables in original Qlik Sense headers will not be replaced.

g. Drag TFWPC - Quarterly Trend into cell A8. Select the cell containing the TFWPC tag, if it is not
already selected.

h. Click the Insert tab on the Excel toolbar.

i. Click the Table icon in the Tables group. Click OK.

j. Go to Table Tools > Design to apply table formatting.
l Font and alignment formatting applied to the heading cell will be applied to all table cells

in the heading row.
l Font and alignment formatting applied to the content cell will be applied to all table cells in

the content rows.
l Number formatting will have no effect.

k. Click Preview on the Qlik NPrinting Designer toolbar to preview the table.
You now have an Excel table that can be sorted and filtered. However, you cannot format numbers.

7. Add a table with subtotals:

a. In cell A11, add a subtitle: Customer sales.

b. On the left pane, right-click on Tables, and select Add objects.

c. A new window will open. Select Customer Sales and Quantity. Click OK.

d. On the left-hand pane, select Customer Sales and Quantity. This will open the Properties pane,
below.

e. Clear the Keep Source Formats check box.

f. Expand the new Customer Sales and Quantity node.

You can only expand the node to reveal column nodes if the object is a straight table or
table box. If you do not see the +, you added a pivot table or a straight table with
calculated columns.

g. Drag Customer - Customer to A13 and JWaPFv - Sales to B13.

h. In cell A15 , type: Region total. In cell B15, add a formula: =SUM(B14).
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Format B15 to display as currency.

8. Add table with subtotals and a filter:

a.a. Add a new sheet to the Excel workbook.

b. Go to the new sheet. In cell A1, add a subtitle: Wine and beer sales by region.

c. On the left pane, right-click on Levels, and select Add levels.

d. A new window will open. Select Region. Click OK.

e. Drag Region_Level to cell A2.

f. Cut and paste the </Region_Level> tag to A17.

g. Expand Region_Level in the left pane.

h. Drag and drop Region onto cell A4.
This ensures that each level has a heading.

i. On the left pane, right-click on Tables, and select Add objects.

j. A new window will open. Select Product Treemap. Click OK.

k. Click on the Product Treemap node. Under Properties > Filter, click the¥. Select the Beer and
Wine filter.
This will ensure that this new table only shows data related to beer and wine products.
Clear the Keep Source Formats check box.

l. Expand the Product Treemap node.

m. Drag Product Type to B5 , Item Desc to C5, and Sales to D5.
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n. In cell C7 , type: Region total. In cell D7, add a formula: =SUM(D6).

o. In cell C10 , type: Total sales. In cell D10, add a formula: =SUM(D6:D8)/2.

p. Select both D7 and D10, and format them to display as currency.

9. On the Qlik NPrinting template editor menu, click the File tab. Click Save.

10. Click the Template tab, and click the Preview button to preview your report.
It may take several minutes for your preview to load, depending on the size of your report. You can stop
preview generation by clicking the Abort button.
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Edits done in preview mode will not be saved.

11. If you would like to continue editing, close the preview window, and format your report in the template
editor.

12. When you are finished editing, click Save And Close.

The report template is now saved and ready to be shared with users.

Publishing to NewsStand and email
Reports need to be published in order for users to access them. We will be publishing to NewsStand and by email.
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NewsStand is a web portal that allows users to preview and download reports, and subscribe to automatic
updates. See: NewsStand overview (page 476)

Emails contain your reports as attachments. Their contents can be customized by adding text and images. See:
Distributing reports by email (page 479).

We will also create a trigger, which will automatically publish your reports according to a schedule.

You must configure your SMTP mail server in order to send email from Qlik NPrinting. See: Configuring
SMTP server (page 268).

Do the following:

1. In the Qlik NPrinting web console, click Tasks on the main menu, and select Publish task.

2. Click the Create task button.

a. Enter a name. For example: Publish Advanced Tutorial.

b. Select your app from the drop-down list: Advanced Tutorial NP App.
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c. Leave the default values for the other options. Click Create.

3. Click on the Reports tab.

a. Click the Add report button.

b. Select Advanced Tutorial Excel from the Choose report drop-down list.

c. Select XLS from the Output format drop-down list.

d. Ensure that the Attach to email and Enabled check boxes selected.

e. Click Add report.

Qlik NPrinting - February 2024 100

2   Getting started



4. Click on the Users/groups tab.

a. Click the Add user or group button.

b. Select a user or group from the Choose recipient drop-down list.
If you would like to learn how to create new users, see: Creating users (page 240).

c. Select the Enabled, NewsStand destination, and Email destination check boxes.

d. Click Add recipient.

5. Click on the Destinations tab.

a. In the NewsStand column, click the Publish for all check box.

b. In the Email column, click the Publish for all check box.

c. Click Save.

6. Customize the email template:

a. Click Email message in the main task menu.

b. In From, select one of the following:
l User: Select the sender email from the drop-down list. You can also use the search form to

filter the list.
l Custom: Enter a valid email address.

c. In the To drop-down list, choose Selected users.

d. Enter a Subject.

e. Select the email Format by clicking on HTML, which supports formatted and dynamic text.

f. Add text to the email body. You can customize it using the formatting buttons.

g. Click Users, and then select tags from the list. They will be replaced with the appropriate value
during email generation.
For example, %%User_Company%% will be replaced with the name of the recipient's company. In
this example, we have added %%User_FullName%%, %%User_Department%%, and %%User_

Company%%.
If your user profiles do not contain this information, the message will contain empty strings. See:
Creating users (page 240).

h. In the Attachments drop-down list, select All reports attached.
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i. Click Save.

7. Create a trigger:

a. Click Triggers in the main task menu.

b. Click Create trigger.

c. Enter a Name: Tutorial Trigger.

d. In the Schedule section, select the Schedule type. For this tutorial, choose: Weekly.
The task will be executed automatically on the specified days of the week.

e. Under Daily frequency, click Once. Leave the default time.

f. In the Start section, you can set the Start date and Time zone of the hours specified in the
trigger. The default start date is the day the trigger is created.
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g. Click Create to save the new trigger in the repository.

8. Go back to the Overview page.

9. Click the Run now button.
A confirmation message will appear at the top of the page.
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Your recipients can now go to the NewsStand in their browsers and view your report. They will also receive a copy
in their email. Since you created a trigger, users will also receive an updated report once a week, according to the
schedule you set.

In standard installations, you can switch from the Qlik NPrinting web console to your NewsStand by
changing port 4993 to 4994 in your browser bar. For example, if your web console is
https://YourServerName:4993, then your NewsStand is https://YourServerName:4994.
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2 Migrating
You can use the migration tool to import your QlikView NPrinting 16 entities into Qlik NPrinting
November 2019 or newer.

2.5 Planning your migration
You must verify that your QlikView NPrinting 16 projects work correctly, and that you have properly
configured your Qlik NPrinting November 2019 or newer installation.

Requirements
l Qlik NPrinting November 2019 (first version with migration tool), or newer.
l QlikView NPrinting 16.3 (first version with project export tool), or newer. See table below.

Upgrading QlikView NPrinting 16 before migration
The migration tool relies on project export functionality that was introduced in QlikView NPrinting 16.3. However,
the required QlikView NPrinting 16 version also depends on the version of QlikView you are running.

QlikView version Current QlikView NPrinting 16 version Need to upgrade to

11.20 16.2 or older QlikView NPrinting 16.3 or newer

11.20 16.3 or newer none

12.10 16.2 or older QlikView NPrinting 16.3 or newer

12.10 16.3 or newer none

12.20 16.6 or older QlikView NPrinting 16.7 or newer

12.20 16.7 or newer none

12.30 16.8 or older QlikView NPrinting 16.9 or newer

12.30 16.9 or newer none

QlikView and QlikView NPrinting 16 compatibility

Upgrading QlikView after migration
After you successfully migrate to Qlik NPrinting November 2019 or newer, you may want to upgrade to a newer
version of QlikView. See: QlikView compatibility (page 127).

As a best practice, you should migrate your QlikView NPrinting 16 projects successfully into Qlik
NPrinting, before upgrading QlikView.
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Limitations

Unsupported features
There are features available in QlikView NPrinting 16 that are not supported in Qlik NPrinting November 2019.
These features are not migrated:

l FTP destinations
l Pretty good privacy (PGP) encryption
l Send to printer
l Test tasks
l Attach external files to email
l Unsupported output formats (.docm, .pptm)
l Compressed generated reports
l Importing external HTML files into email bodies
l Linked fields

These features are partially migrated:

l Bookmark filters

Email tags
The following email tags are not supported in Qlik NPrinting November 2019 or newer:

l %%Recipient_Custom1%%

l %%Recipient_Custom2%%

l %%Recipient_Custom3%%

l %%Link_FTP_Destination%%

l %%Link_FTP_Output_Folder%%

l %%Link_HTTP_URL%%

l %%Link_HTTP_Output_Folder%%

l %%Link_Path_Output_Folder%%

l %%Execution_Time%%

l %%Execution_Date%%

l %%Zip_Password%%

l %%Link_FTP_.+?%%

l %%Link_File_.+?%%

l %%Link_HTTP_.+?%%

l %%EmbedHTTP_.+?%%

They will not be replaced with correspondent values in new email messages. You need to remove them from
email bodies and subjects.
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Checking your QlikView NPrinting 16 projects and entities
You must verify that the projects you wish to migrate work correctly in your QlikView NPrinting 16 installation.
For example, make sure that all report template files are present and work properly. Verify that filters used in
objects, reports, tasks, and users have not been deleted. Any features that are not supported in Qlik NPrinting
November 2019 or newer will not be imported.

Connections
QlikView documents are not included in the project export .zip file. For local connections, you must make sure

the Qlik NPrinting Server can access them. You may need to move them to the correct folder before proceeding.
You can create local connections to QlikView documents or network shared folders, but you must use UNC paths.
For example: \\ServerName\FolderName\QlikViewDocument.qvw.

Connections to QlikView servers using the QVP protocol are imported correctly.

The QlikView NPrinting 16 connection option “Clear all selections” is the default behavior in Qlik NPrinting 2019.
It cannot be modified.

If your QlikView NPrinting 16 connections use environment variables, they are replaced by their values, and the
connections are imported correctly.

Section access
QlikView NPrinting 16 supports section access. You must define users in the section access table of the script. Qlik
NPrinting November 2019 or newer only supports section access with NT security. Qlik NPrinting can open local
.qvw files with a section access table, but it is ignored. You must replace it with filters. Before importing .qvw files
with section access, please read: Prerequisites for QlikView Server and QlikView Cluster connections (page 232).

Reports
QlikView NPrinting 16 reports are converted to the Qlik NPrinting format and stored in the repository.

In QlikView NPrinting 16, macros are supported in all Microsoft Office reports (Excel, Word and PowerPoint). Qlik
NPrinting November 2019 or newer only supports macros in Excel templates (.xlsm). In both cases, macros are
never executed during report generation. The VBA code is copied from the template to the generated report.

Filters
QlikView NPrinting 16 field-based filters are imported and converted. However, QlikView NPrinting 16 field-based
filters work differently in Qlik NPrinting November 2019 or newer. We suggest that you check the results. For
example, in QlikView NPrinting 16, Verify filter is a box that can be unchecked. In Qlik NPrinting November 2019
or newer, it is the default behavior.

Advanced search, variables, and select excluded are supported in both.

Bookmark-based filters are not supported in Qlik NPrinting November 2019 or newer. The filter will be migrated,
but it will contain no fields.

Linked fields
Linked fields are not supported in Qlik NPrinting November 2019 or newer.
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If you are only using QlikView NPrinting 16 linked fields to filter data, you can manually re-create these filters in
Qlik NPrinting November 2019 or newer, using fields from multiple connections. If you are using QlikView
NPrinting 16 linked fields in cycles, levels or pages, you will need to merge the source .qvw files into a unique
.qvw used for reporting. Then use the fields from the merged .qvw in cycles and levels.

Tasks
The migration tool will only import QlikView NPrinting 16 publish tasks. The following tasks are not supported in
Qlik NPrinting November 2019 or newer:

l Reload
l Partial Reload
l Reduce
l Macro

Reloads should be centrally managed using your existing QlikView server. Recipient import tasks are not
migrated, but a new import user task can be manually created in Qlik NPrinting November 2019 or newer.

Schedules are not migrated into triggers. You need to manually recreate them in the migrated publish tasks. See:
Creating publish tasks (page 471).

Recipients and users
QlikView NPrinting 16 recipients are not migrated into Qlik NPrinting November 2019 or newer as users.

Recipients in QlikView NPrinting 16 are only recipients of reports. For example, a recipient can only contain a
destination folder. In Qlik NPrinting November 2019 or newer, there are users that have access to the repository
based on security roles.

In QlikView NPrinting 16, each project file has recipients that can be either the same or different in other projects
in the same installation. In Qlik NPrinting November 2019 or newer, users are shared across the entire
installation. They are common for all apps.

In QlikView NPrinting 16, each recipient has a unique ID. You can create multiple recipients with the same email
address and different filters. In Qlik NPrinting, the email address is the primary key of each user. Therefore, you
cannot create more than one user per email, or add more than one email address to a single user. There is a
workaround using the Qlik NPrinting APIs and the Qlik REST connector:≤ Send out multiple emails for a single
Publish Task in NPrinting 17+.

In Qlik NPrinting November 2019 or newer, you need to create users manually, or import them from LDAP or Excel
files. These, along with the APIs, are the only supported methods of user import. Other previous import methods,
such as a QlikView table, are no longer supported. You should import users after successfully importing your
QlikView NPrinting 16 projects. This way, you can associate users with their authorized apps all at once. A best
practice is to use groups. This way, you can safely delete, update, or add users with import tasks or APIs. But the
group associated with a publish task stays the same.
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Jobs
Qlik NPrinting November 2019 or newer does not have job entities that let you chain tasks. Jobs are not
imported. You can create a sequence of tasks in Qlik NPrinting November 2019 or newer by using APIs:≤ How
To Use NPrinting APIs In A Qlik Load Script.

Conditions
In QlikView NPrinting 16, conditions are associated with reports. In Qlik NPrinting November 2019 or newer,
conditions must be attached to reports in tasks. They are migrated attached to reports in tasks. Conditions can
also be applied at the task level, which can be done manually following the migration.

Exporting your QlikView NPrinting 16 projects
Each QlikView NPrinting 16 project will be exported into a single .zip file that contains the original .nsq file and
the report templates. The migration tool uses the exported .zip file of each project, not the.nsq files directly. A
single QlikView NPrinting 16 project is completely stored in a single .nsq file and related templates.You do not
need to extract the .zip file.

If there is content from the QlikView NPrinting 16 project that you do not want to migrate, remove that content
using the QlikView NPrinting 16 Designer before you export the project.

You should backup your .nsq files before starting the export.

Do the following:

1. Log into the QlikView NPrinting 16 machine.

2. Open the project you want to export.

3. Go to Tools, and click Export Project.

The .nsq file will be exported as a .zip file.

4. Repeat this process for each project you want to migrate.

Checking your Qlik NPrinting November 2019 or newer installation
Make sure you have a properly sized and configured Qlik NPrinting November 2019 or newer installation. See:
Deploying (page 122)

If you have an existing Qlik NPrinting installation, you should create a backup before starting the
migration. See: Backing up Qlik NPrinting (page 193).
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2.6 Using the migration tool
The migration tool will migrate your QlikView NPrinting 16 projects to your new environment.
Project files (.nsq) are exported and imported as .zip files.

This process is for migrating project files from QlikView NPrinting 16 to Qlik NPrinting November 2019 or
later. To move reports between different environments using the same version of Qlik NPrinting, see:
Moving reports between environments (page 278).

You can import QlikView NPrinting 16 projects into Qlik NPrinting November 2019 one project at a time. Each
QlikView NPrinting 16 project will be imported into a new Qlik NPrinting app. See: Working with apps (page 20).
The app name will contain the import date and time. Importing the same QlikView NPrinting 16 project multiple
times will result in many different apps, one for each import. Apps created from the same project are not
overwritten.

If you have an existing Qlik NPrinting installation, you should create a backup before starting the
migration. See: Backing up Qlik NPrinting (page 193).

Requirements
l A QlikView NPrinting 16 project file (.nsq), exported as a .zip file. See: Planning your migration (page 105).
l A Qlik NPrinting user with an Administrator role assigned to them. You can also assign Import NPrinting

16 projects rights to a different role. See: Setting app permissions (page 230).

If you enable this permission, that role gains full control of all apps and task executions. This is
done in order for the user performing the migration to have access and edit rights to the new
Qlik NPrinting app that will be created as a result of this task.

Running the migration tool
The import job will run as a single job until completed. You cannot select individual entities to import. The entire
QlikView NPrinting 16 project will be imported.

Do the following:

1. Log into Qlik NPrinting November 2019 or newer as an Administrator, or a role with Import NPrinting 16
projects rights.

2. In the main menu, go to Admin and, click on Import NPrinting 16 projects.

3. In the top right corner, click on the green Import Project button.
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4. Click on Browse… and select the QlikView NPrinting 16 exported .zip file. You can import one project at a
time.

5. Under Connections found, verify your connection paths. The imported paths to your QlikView documents
may need to be updated. Paths are related to the Qlik NPrinting November 2019 or newer server. Relative
paths are not supported and must be updated before proceeding.
In case of connection errors or warnings, open the connection in the Qlik NPrinting web console and
troubleshoot as usual. For example, you can click the Verify connection button.

6. Click the green Start Importing button on the bottom right.

7. Wait until all connection caches are generated. In case of errors, open the specific connection, correct the
error, and re-generate the cache as usual. See: Connecting to QlikView documents (page 21).
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8. As the migration tool runs, the result of each completed step is displayed. Some rows will have blue icons
that link to the related migrated entity. You can click these to review import status.
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9. Each migrated entity with a Warn or Error status has a detailed list describing the issue. You can edit the
entity to solve any issues and mark it as OK.

10. Once the migration tool stops running, review all messages to ensure your import was successful.
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Logs and troubleshooting
Log messages are visible on the import page. Once the migration has completed, click the Download logs
button to quickly view logs.

To review old logs, go to Admin > Import NPrinting 16 projects and click on the import you want to check.

If you try to import unsupported features, they will be logged as not imported. If your migration has warnings or
errors, see: Troubleshooting your migration (page 114).

2.7 Troubleshooting your migration
This section lists solutions to error messages that may display during migration.

Any text below that is inside curly brackets {} will be replaced with the exact value or name of your entities.

On the main import page, you can click the blue icons to review an entity in a new tab.

If an entity has error or warning messages, solve them, and go back to the import page.
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Main import page
The following messages are only displayed on the main migration page.

Unsupported NSQ file version. Please open the NSQ project with NPrinting 16, then save and export it again.
You are trying to import a QlikView NPrinting 16 project with the .nsq file saved in an old format.

To solve:

1. Open the original .nsq file in a recent QlikView NPrinting 16 version.

2. Save it, even if you did not modify anything, to force the conversion to a supported format

3. Export the project again.

The NPrinting 16 project does not contain any connections.
You are trying to import a QlikView NPrinting 16 project without any connections.

To solve: Check the connections in QlikView NPrinting 16, and export the project again.

The uploaded file is not a valid NPrinting 16 exported project
You are uploading an exported project file (.zip) that does not contain an .nsq file.

To solve: Export the project again in QlikView NPrinting 16.

Filters
Filter variable import failed: {name}
The import of a variable filter failed. Check that the variable {name} exists in the related .qvw.

To solve, try one or more of the following:

l Create the variable in the .qvw and refresh the connection cache.
l Modify the filter, in order to avoid using the variable.
l Delete the filter.

Filter field import failed because linked fields are not supported: {name}
Linked fields are not supported in Qlik NPrinting November 2019 or newer.
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To solve: Manually modify the filter to use the original fields from different connections. The filter will work as
expected, but can not be applied as a level, page, or cycle.

Filter bookmark import failed because QlikView bookmarks are not supported: {name}
Bookmark filters are not supported by Qlik NPrinting November 2019 or newer.

To solve: Manually modify the filter to recreate the bookmark using the original fields.

Fields with 'Lock' applied are not supported. This filter may behave differently than the original: {name}
The QlikView lock field option is not supported in Qlik NPrinting November 2019 or newer.

To solve: Manually update the created filter.

Cannot import field: {name}. This QlikView field is used in multiple fields: {qvId}
QlikView NPrinting 16 filters that use the same field more than once are not supported in Qlik NPrinting
November 2019 or newer.

To solve: Manually update the generated filter.

Cannot import filter variable: {name}. This QlikView variable is used in another filter: {qvId}
QlikView NPrinting 16 filters that use the same variable more than once are not supported in Qlik NPrinting
November 2019 or newer.

To solve: Manually update the generated filter.

Field skipped because it has no values: {name}
You are trying to import a filter without field values, which does not have the Clear all selections option flagged.

To solve: Manually add the field in the newly created filter.

Filter field import failed: {name}
The connection to the field {name} does not exist in the imported QlikView NPrinting 16 project.

To solve, try one or more of the following:

l Manually update the imported filter.
l Delete the filter.
l Update the QlikView NPrinting 16 project, export it, and import it again.

Reports
Report filter import failed: {name}
The import of the filter {name} associated with the report failed because the filter was not found.

To solve: Manually create the missing filter.

Report object filter import failed: {name}
The import of the filter {name}, used in the report as an object filter, failed.

To solve: Manually create the missing filter, and add it as an object filter.
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Report condition import failed: {name}
The import of the condition {name} associated with the report failed.

To solve: Manually create the missing condition, and add it to the report.

Customizing 'Field to add report name' when cycling is not supported: {name}
In Qlik NPrinting 19 November or newer, you cannot add the value of a field to the report file name if it is
different than the field used in the cycle.

To solve: Manually modify how the report file name is created using supported dynamic naming features.

See: Cycling your reports (page 324) and Dynamic report names (page 322).

Filter needs to be verified: {name}
An entity is using the filter {name} that has errors or warning messages.

To solve: Resolve the errors or warning in the filter {name}.

Connection not found: {name}. It is related to the cycle field: {field}
The connection {name} of the field {field} used in a cycle is missing.

To solve: Manually add the cycled field.

Connection not found: {name}. It is related to a variable used in dynamic naming: {variable}
The connection {name} to the variable {variable} used in dynamic naming is missing.

To solve: Manually update the dynamic naming configuration by adding the variable.

QlikView variable used in dynamic naming not found: {name}
The QlikView variable {name} used in dynamic naming is missing.

To solve: Manually update the dynamic naming configuration.

Unsupported variable type: {name}
The type of the variable {name} used in the imported dynamic naming configuration is not supported.

To solve: Open the report and edit the dynamic naming configuration.

QlikView object not found: {name}
The QlikView object {name} used in the report template is missing.

To solve: Recreate the object in the source .qvw and regenerate the connection cache.

Error reading QlikView entity
A generic error occurred while reading a QlikViewentity. The error exists the imported QlikView NPrinting 16
project.

To solve:
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1. Open the entity that generates the error.

2. Update the entity and make sure it is working properly.

No template file was found for this report
The report template file is missing.

To solve:

l Check that the template file is present in the source QlikView NPrinting 16 project. It is a file-based
system, so the template may have been deleted from the original templates folder. In this case, you must
retrieve it from a backup or recreate it in the Qlik NPrinting installation.

l Check that the QlikView NPrinting 16 report contains the correct path to the template included the
filename. The syntax could have been modified to an incorrect value.

l If you find the file in the QlikView NPrinting 16 templates folder, you can manually create the report in
your Qlik NPrinting installation and use it as custom template. Then:

o Open it in the Qlik NPrinting Designer and add the needed QlikView entities in the treeview, or
o Export and import the QlikView NPrinting 16 project again, and verify the template is correct.

Template conversion failed
The report template conversion failed.

To solve:

1. Open the template in Qlik NPrinting Designer.

2. Solve the error messages that appear.

3. Click on Save and Close. This will force the conversion to run again.

Some entities in this report are not present in the connection cache
Some entities used in the template are missing from the connection cache.

To solve:

1. Open the template in Qlik NPrinting Designer to get a detailed list of the missing entities.

2. Solve the list by creating the missing entities in the source .qvw document. Or remove them from the
template.

3. Regenerate the connection cache.

These errors may also appear in the QlikView NPrinting 16 project. For example, if the entities were deleted from
the .qvw, but still used in the template. In this case:

1. Solve the errors in the QlikView NPrinting 16 installation.

2. Export and import it again.

Conditions
Condition needs to be verified: {name}

The imported condition {name} used in a report in a task has warning or error messages.
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To solve: Verify and correct the listed errors.

Connection not found: {name}
The connection {name} used in the imported condition is missing.

To solve: Manually update the condition.

Operator not found: {name}
The imported condition operator {name} is missing.

To solve: Update the condition by setting a supported operator.

Values option not found: {name}
The values option {name} used in the imported condition is missing.

To solve: Open the condition and update it.

QlikView variable not found: {name}
The QlikView variable {name} used in the imported condition is missing.

To solve:

l Change the condition by using an existing variable.
l Create the variable in the source .qvw and refresh the connection cache.

QlikView chart not found: {name}
The QlikView chart {name} used by the imported condition is missing.

To solve: Create the chart in the source .qvw and refresh the connection cache.

Task
Task filter import failed: {name}
The filter {name} used in the imported task is missing.

To solve: Manually create the filter and associate it to the task.

Filter needs to be verified: {name}
An entity is using the filter {name}, which has errors or warning messages.

To solve: Resolve the errors or warnings in the filter.

Report needs to be verified: {name}
You are trying to use the report {name}, which has warning or error messages, in a task.

To solve: Open the report {name} and correct the errors.

Task report import failed: {name}
The report {name} used in the imported task is missing.

To solve:
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1. Check the import logs to see if there was an error during the import of the report.

2. Create the report in your Qlik NPrinting November 2019 installation from scratch. Or use the QlikView
NPrinting 16 template as custom template.

Task report was skipped: {name}. Another report exists with the same settings and output format: {format}
In Qlik NPrinting November 2019 or newer, you cannot add the same report with the same output format and the
same quality more than one time for each task. Only the first report is imported and the rest will be skipped.

Task report import failed: {name}. The output format is not supported: {format}
Some output formats (like Word documents with macros .docm and PixelPerfect reports as .csv) are not
supported by Qlik NPrinting November 2019 or newer.

To solve: Add the report to the task and select one of the supported output formats. See: Report output formats
(page 469).

Task report import failed: {name}. The output format {format} is not supported with {type} reports
You are trying to import the report {name} in a task with an unsupported output format {format}.

To solve: Add the report to the task and select one of the supported output formats. See: Report output formats
(page 469).

The coloration type {type} is not supported for this task report: {name}
Color is the only supported mode in Qlik NPrinting November 2019 or newer.

Multi page advanced setting is not supported for this task report: {name}
Report multi-paging is not supported for the report {name}.

Custom separator is not supported. Comma will be used instead for task report: {name}
The use of custom separators is not supported in Qlik NPrinting November 2019 or newer. They will be replaced
by commas.

Custom page range is not supported for this task report: {name}
Custom page ranges are not supported for the report {name} in the task.

This tag is not supported for the task email: {name}
Qlik NPrinting November 2019 or newer does not support certain email body tags.

To solve: Update the email body accordingly. See: Planning your migration (page 105).

Using an external HTML file as email body is not supported: {name}
You cannot use an external HTML file as an email body.

To solve: Copy the content of the HTML file and paste it in the email body editor.

Attaching external files to the task email is not supported: {name}
External email attachments are not supported.

Email footer image is not supported: {name}
Email footer images are not supported. You cannot add them manually.
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To solve, try one of the following:

l Edit the email body by embedding the image
l Create an HTML body text with the image.

‘Create an archive containing the compressed reports' option is not supported
You cannot create an archive containing the compressed reports.

To solve: Send reports uncompressed.

'Low' and 'Medium' report quality are not supported. 'Normal' will be used instead for this task report: {name}
'Low' and 'Medium' report quality are not supported.

To solve: Manually update the quality setting. See: Image quality (page 302).

'Printer configuration for hard copies' option is not supported
Qlik NPrinting November 2019 or newer cannot send generated reports directly to printers.

The NPrinting 16 task output folder was set to 'Task output folder'
QlikView NPrinting 16 destinations are not imported, you must add them manually to the imported tasks.

The NPrinting 16 task output folder was set to 'Recipient folder'
QlikView NPrinting 16 destinations are not imported, you must add them manually to the imported tasks.

The NPrinting 16 task output folder was set to 'Task folder with recipient subfolder'
QlikView NPrinting 16 destinations are not imported, you must add them manually to the imported tasks.

The NPrinting 16 task output folder was set to 'Custom folder'
QlikView NPrinting 16 destinations are not imported, you must add them manually to the imported tasks.
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3 Deploying
Qlik NPrinting has three components to deploy: Qlik NPrinting Server, Qlik NPrinting Engine, and
Qlik NPrinting Designer.

Qlik NPrinting Server is the central node in your reporting system. It manages user administration, security, and
all other server-side tasks. Qlik NPrinting Engine creates reports based on information from the scheduler. Qlik
NPrinting Designer is Windows-based software that is installed on the computers of developers who create and
modify reports.

Qlik NPrinting is an on-premise reporting add-on product for Qlik Sense on Windows or QlikView on
Windows.

Licensing Qlik NPrinting
Learn the licensing requirements and procedures for connecting Qlik NPrinting to QlikView or Qlik Sense.

Planning your deployment
Plan your Qlik NPrinting deployment by finding out what is required in terms of architecture, deployment
scenarios, and security.

Qlik NPrinting installation
Install Qlik NPrinting components and activate licenses.

Security
Qlik NPrinting leverages internal and external resources to manage access, authentication, authorization, and
data governance.

Backup and restore Qlik NPrinting
Create a complete backup of your Qlik NPrinting installation.

Upgrading Qlik NPrinting
Upgrade Qlik NPrinting to the latest release.

3.1 Planning your deployment
To successfully plan and prepare for your Qlik NPrinting deployment, review the following topics:

System requirements
Check that your environment fulfills the system requirements.
System requirements for Qlik NPrinting Server (page 123)
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System requirements for Qlik NPrinting Engine (page 125)
System requirements for Qlik NPrinting Designer (page 128)

Ports (page 133)
Check that the required ports are available on your system.

Supported browsers and apps (page 130)
Check that your browsers are supported.

Supported languages (page 131)
Check that your language is supported.

Architecture (page 131)
Understand the Qlik NPrinting architecture.

User accounts (page 136)
Understand and set up the various user accounts required to install and run the Qlik
NPrinting services.

Connecting Qlik NPrinting with Qlik Sense (page 172)
Understand how Qlik NPrinting works with Qlik Sense.

Connecting Qlik NPrinting with QlikView (page 178)
Understand how Qlik NPrinting works with QlikView.

Configuring server certificate validation for Qlik Sense connections (page 175)
Understand how Qlik NPrinting uses Qlik Sense certificates for security when connecting to
Qlik Sense, and how to export and install those certificates.

Licensing Qlik NPrinting (page 145)
Ensure that you have your Qlik NPrinting license key available.

Qlik NPrinting installation (page 155)
Once you have reviewed and completed these tasks, you are ready to install Qlik NPrinting.

System requirements for Qlik NPrinting Server
This section lists the minimum hardware and software requirements for Qlik NPrinting Server.

Qlik NPrinting will work on both physical and virtual machines. However, virtualized applications are not
supported. For example, Qlik NPrinting Engine will not work if it is installed on a computer with virtualized
versions of QlikView Desktop and Microsoft Office distributed from a different computer. QlikView Desktop and
Microsoft Office must be installed locally on the same physical or virtual machine where the Qlik NPrinting
components are installed.

For more information on virtual applications, see≤ What is Application Virtualization?
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Requirements
The hardware requirements listed on this page are for configurations where each Qlik NPrinting component is
installed on a different computer. If you install more than one component on the same computer, the minimum
hardware requirements increase.

l Platforms:
o Microsoft Windows Server 2016
o Microsoft Windows Server 2019
o Microsoft Windows Server 2022

l Processors (CPUs): Multi-core x64 compatible processors with a minimum of two cores.
l Memory: 8 GB minimum
l Qlik NPrinting can only be installed on C drives.
l Disk space: 500 MB minimum if audit trail is turned off, or 2.5 GB if audit trail is enabled.

The actual disk space required depends on multiple factors. The size of your database, reports,
and cached files will affect your space requirements. For larger apps and reports, you will need
more than 500 MB of disk space.

l Storage: Only Windows, local or shared, storage is supported.
l Microsoft Internet Explorer is not supported by Qlik NPrinting. However, if Microsoft Internet Explorer

Enhanced Security Configuration is turned on, it may cause errors. For more information, see Microsoft
Internet Explorer Enhanced Security Configuration is blocking QV.exe (QlikView) and reporting_web_
renderer.exe (Qlik Sense) (page 551).

l Server clocks:
Qlik NPrinting Server and Qlik NPrinting EngineWindows server clocks must be synchronized within a
tolerance of 2 seconds. A Windows server synchronizes its clock with the domain controller clock, so, if
Qlik NPrinting Server and Qlik NPrinting Engine are in the same domain, clocks will be in sync. You should
not manually remove this option. If you install Qlik NPrinting Server and Qlik NPrinting Engine on different
Windows server domains, you must ensure that clocks are synchronized within a tolerance of 2 seconds.

l Platform security: TLS 1.2 must be enabled.

License activations request access to the Qlik Licensing Service. Open port 443 and allow outbound calls
to license.qlikcloud.com.
Use of a proxy is supported. For more information about setting up a proxy service in Windows, see
Licensing service proxy Setup (page 148)

Additional software installed
During the Qlik NPrinting Server installation, third-party software is installed if not already present. The following
table notes the installed software and version for each Qlik NPrinting Server version.
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Version Version number PostgreSQL RabbitMQ Erlang .Net framework

IR 24.4.5 13.13-1 3.12.10 25.2.1 4.8.0

SR 1 24.4.7 13.14-1 3.12.10 25.2.1 4.8.0

SR 2 24.4.10 13.14-1 3.12.10 25.2.1 4.8.0

SR 3 24.4.14 13.16-1 3.12.10 25.2.1 4.8.0

SR 4 24.4.19 13.18-1 3.12.10 25.2.1 4.8.0

Additional software installed with Qlik NPrinting Server

The following software is installed during the Qlik NPrinting Server setup, and is unchanged with new service
releases or Qlik NPrinting version upgrades:

l Microsoft Visual C++ 2013 Redistributable x64 (12.0.30501)
l Microsoft Visual C++ 2015-2022 Redistributable x86 (14.36.32532)
l Microsoft Visual C++ 2015-2022 Redistributable x64 (14.36.32532)
l .NET framework: 4.8.0

.NET framework is installed when you install Qlik NPrinting Server, Qlik NPrinting Engine, or Qlik
NPrinting Designer. The installation of .NET framework requires an internet connection. If
.NETframework is not already installed on a computer without an internet connection, the
installation stops. Before you begin the installation of Qlik NPrinting Server, Qlik NPrinting
Engine, or Qlik NPrinting Designer, you must install the .NET framework on computers without
an internet connection.
If an internet connection is not available on a computer with .NET framework already installed,
the installer will skip this part of the installation.

System requirements for Qlik NPrinting Engine
This section lists the minimum hardware and software requirements for Qlik NPrinting Engine.

Qlik NPrinting will work on both physical and virtual machines. However, virtualized applications are not
supported. For example, Qlik NPrinting Engine will not work if it is installed on a computer with virtualized
versions of QlikView Desktop and Microsoft Office distributed from a different computer. QlikView Desktop and
Microsoft Office must be installed locally on the same physical or virtual machine where the Qlik NPrinting
components are installed.

For more information on virtual applications, see≤ What is Application Virtualization?

By default, only one Qlik NPrinting Engine is available for each Qlik NPrinting Server license. If you want to add
additional engines to your Qlik NPrinting environment, you need to purchase them.
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Requirements
These Qlik NPrinting Engine requirements are for configurations where each Qlik NPrinting component is
installed on a different computer. If you install more than one component (for example, the server and the
engine) on the same computer, the minimum hardware requirements increase.

l Platforms:
o Microsoft Windows Server 2016
o Microsoft Windows Server 2019
o Microsoft Windows Server 2022 (as of May 2022 SR1)

l Processors (CPUs): Multi-core x64 compatible processors with a minimum of two cores.
l Memory: 2 GB is required for each core with a minimum of 4 GB of RAM in total.

o QlikView Desktop must have enough memory to manage the QlikView documents that you use as
reporting data sources.

o A MultiDoc report is a report with data from many QlikView documents. If you create MultiDoc
reports, all QlikView documents used as data sources will be opened at the same time.

o Connecting additional Qlik Sense servers will have an impact on Qlik NPrinting Server system
resources. You may need to increase the RAM and CPU usage on Qlik Qlik NPrinting Engine and
Qlik NPrinting Server computers if you connect to multiple Qlik Sense.

l Qlik NPrinting can only be installed on C drives.
l Disk space: 300 MB minimum

The actual disk space required depends on multiple factors. The size of your reports and cached
files will affect your space requirements. For larger apps and reports, you will need more than
300 MB of disk space.

l Storage: Only Windows, local or shared, storage is supported.
l Microsoft Internet Explorer is not supported by Qlik NPrinting. However, if Microsoft Internet Explorer

Enhanced Security Configuration is turned on, it may cause errors. For more information, see Microsoft
Internet Explorer Enhanced Security Configuration is blocking QV.exe (QlikView) and reporting_web_
renderer.exe (Qlik Sense) (page 551).

l Server clocks:
Qlik NPrinting Server and Qlik NPrinting EngineWindows server clocks must be synchronized within a
tolerance of 2 seconds. A Windows server synchronizes its clock with the domain controller clock, so, if
Qlik NPrinting Server and Qlik NPrinting Engine are in the same domain, clocks will be in sync. You should
not manually remove this option. If you install Qlik NPrinting Server and Qlik NPrinting Engine on different
Windows server domains, you must ensure that clocks are synchronized within a tolerance of 2 seconds.

l Platform security: TLS 1.2 must be enabled.
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License activations request access to the Qlik Licensing Service. Open port 443 and allow
outbound calls to license.qlikcloud.com.
Use of a proxy is supported. For more information about setting up a proxy service in Windows,
see Licensing service proxy Setup (page 148)

QlikView compatibility
QlikView Desktop is required for QlikView connection with Qlik NPrinting and must be installed on each Qlik
NPrinting Engine computer.

If using server or cluster connections, QlikView Server and QlikView Desktop must be on the same version.

Qlik NPrinting February 2024 is compatible with the following QlikView versions (initial release and all service
releases supported unless noted):

l QlikView May 2023 (12.80)
l QlikView May 2024 (12.90)

QlikView Desktop Personal Edition is not supported.

QlikView in Qlik Cloud is not supported.

If you are migrating from QlikView NPrinting 16 to Qlik NPrinting November 2019 or newer, you may need to
upgrade your QlikView version. See: Upgrading QlikView NPrinting 16 before migration (page 105).

Qlik Sense compatibility
Qlik NPrinting February 2024 is compatible with the following Qlik Sense versions (initial release and all patches
supported unless noted):

l Minimum supported version is Qlik Sense Enterprise on Windows August 2022.
l Maximum supported version is Qlik Sense Enterprise on Windows November 2024.

No client software is required for connecting Qlik Sense with Qlik NPrinting.

Qlik Cloud is not supported.

Additional software installed
The following software is installed during the Qlik NPrinting Engine setup, unless it is already installed. It must
not be removed:

l PDF-XChange 5.0.269
PDF-XChange is used to create PDFs from QlikEntity reports. PDF-XChange is not required for creating

PDFs from other types of reports. If you do not use QlikEntity templates, you can uninstall PDF-XChange.
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PDF-XChange installed with Qlik NPrinting Engine. It cannot be installed manually outside the
Qlik NPrinting Engine installation as the installation uses custom parameters. If you need to
reinstall PDF-XChange you must uninstall and reinstall Qlik NPrinting Engine.

l .NET framework: 4.8.0

.NET framework is installed when you install Qlik NPrinting Server, Qlik NPrinting Engine, or Qlik
NPrinting Designer. The installation of .NET framework requires an internet connection. If
.NETframework is not already installed on a computer without an internet connection, the
installation stops. Before you begin the installation of Qlik NPrinting Server, Qlik NPrinting
Engine, or Qlik NPrinting Designer, you must install the .NET framework on computers without
an internet connection. If an internet connection is not available on a computer with .NET
framework already installed, the installer will skip this part of the installation.

System requirements for Qlik NPrinting Designer
This section lists the minimum hardware and software requirements for Qlik NPrinting Designer.

The hardware requirements listed on this page are for configurations where each Qlik NPrinting component is
installed on a different computer. If you install more than one component (for example, the server and the
engine) on the same computer, the minimum hardware requirements increase.

Qlik NPrinting will work on both physical and virtual machines. However, virtualized applications are not
supported. For example, Qlik NPrinting Engine will not work if it is installed on a computer with virtualized
versions of QlikView Desktop and Microsoft Office distributed from a different computer. QlikView Desktop and
Microsoft Office must be installed locally on the same physical or virtual machine where the Qlik NPrinting
components are installed.

For more information on virtual applications, see≤ What is Application Virtualization?

Requirements
These Qlik NPrinting Designer requirements are for configurations where each Qlik NPrinting component is
installed on a different computer. If you install more than one component (for example, the server and the
engine) on the same computer, the minimum hardware requirements increase.

l Qlik NPrinting Designer must be the same version as Qlik NPrinting Server.
l Platforms: Both 32-bit and 64-bit architectures are supported for these operating systems.

o These operating systems are supported by Qlik NPrinting. Third-party software may require service
packs to be installed:

n Microsoft Windows 10 build 1607 or later
n Microsoft Windows 11 (as of May 2022 SR1)

o These server operating systems are supported, but we recommend that you install Qlik NPrinting
Designer on client computers and not on servers. Server capacity is not needed when developing
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report templates:
n Microsoft Windows Server 2016
n Microsoft Windows Server 2019
n Microsoft Windows Server 2022 (as of May 2022 SR1)

l Processors (CPUs): No specific needs for Qlik NPrinting Designer. When creating Microsoft Office based
templates, Microsoft Office requirements apply.

l Memory: 1 GB is required. When creating Microsoft Office based templates, Microsoft Office requirements
apply.

l Qlik NPrinting can only be installed on C drives.
l Disk space: 200 MB for installation
l Storage: Only Windows, local or shared, storage is supported.
l Microsoft Office: A valid Microsoft Office license is required. Microsoft Office must be installed locally on

computers where Qlik NPrinting Designer is installed if you plan to create Excel, PowerPoint, or Word
report templates. Both 32-bit and 64-bit architectures are supported:

o Excel 2016, 2019, 2021
o PowerPoint 2016, 2019, 2021
o Word 2016, 2019, 2021
o Microsoft Office 365 Desktop

Local installations and Click to Run are supported for use with Qlik NPrinting Designer.
However, Microsoft Office 365 web and mobile versions are not supported.

You do not need Microsoft Office to manage QlikEntity, HTML, and PixelPerfect report templates.

License activations request access to the Qlik Licensing Service. Open port 443 and allow outbound calls
to license.qlikcloud.com.
Use of a proxy is supported. For more information about setting up a proxy service in Windows, see
Licensing service proxy Setup (page 148)

Additional software installed
The following software is installed during the Qlik NPrinting Designer setup, unless it is already installed and it
must not be removed:

l .NET framework: 4.8.0
.NET framework is installed when you install Qlik NPrinting Server, Qlik NPrinting Engine, or Qlik NPrinting
Designer. The installation of .NET framework requires an internet connection. If .NETframework is not
already installed on a computer without an internet connection, the installation stops. Before you begin
the installation of Qlik NPrinting Server, Qlik NPrinting Engine, or Qlik NPrinting Designer, you must install
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the .NET framework on computers without an internet connection. If an internet connection is not
available on a computer with .NET framework already installed, the installer will skip this part of the
installation.

Troubleshooting

Qlik NPrinting Designer crashes sometimes

Possible cause

Your Windows display is zoomed in. When settings of 125% or 150% are selected,Qlik NPrinting Designer may
crash.

Proposed action

Open your Windows Display Settings in the Control Panel. Set zoom to Smaller – 100% (default).

Supported browsers and apps
Each Qlik NPrinting release is tested for compatibility with the latest publicly available browser
versions. Due to the frequency of browser version updates, Qlik does not include specific browser
version numbers in the system requirements.

Qlik NPrinting Designer, Qlik NPrinting web console, and NewsStand are supported on the following web
browsers:

l Microsoft Edge (Chromium engine only)
l Google Chrome
l Mozilla Firefox (requires hardware acceleration, not supported in virtual environments)

Qlik NPrinting Designer does not run as a stand-alone application. Qlik NPrinting Designer is launched
from the Qlik NPrinting web console.

To launch Qlik NPrinting Designer, you need to be browsing on a Windows machine that already has
Qlik NPrinting Designer installed on it.

For Qlik NPrinting web console and NewsStand, a minimum screen resolution of 1024x768 is required on
desktops and laptops. Mobile and small screen support is not currently available.

Troubleshooting
Microsoft Internet Explorer is not supported by Qlik NPrinting. However, if Microsoft Internet Explorer Enhanced
Security Configuration is turned on, it may cause errors. For more information, see Microsoft Internet Explorer
Enhanced Security Configuration is blocking QV.exe (QlikView) and reporting_web_renderer.exe (Qlik Sense) (page
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Supported languages
Qlik NPrinting is available in the following languages:

l English
l French
l German
l Spanish
l Brazilian Portuguese
l Japanese
l Italian
l Simplified Chinese

Report generation is fully supported for content in these languages. Other languages are not officially supported.
Issues may occur during report generation if content in unsupported languages, particularly those with right to
left script and non-Roman alphabets, is used.

The user interfaces are translated in supported languages for the following:

l Qlik NPrinting web console
l NewsStand
l Qlik NPrinting Designer

The language displayed in the user interface is determined by locale settings, which both users and an
administrators can set. To change the user interface language, see Changing user language (page 258).

Changing the locale settings affects the Qlik NPrinting user interface. Users can also change their browser
language, and report developers can create templates for different languages.

Architecture
Qlik NPrinting is the enterprise class solution for report distribution in QlikView and Qlik Sense
environments.

Qlik NPrinting creates and distributes reports using QlikView documents or Qlik Sense apps as data sources.

Qlik NPrinting Server
The Qlik NPrinting Server consists of the following components services:

l Qlik NPrinting scheduler service
l Qlik NPrinting repository
l Qlik NPrinting web engine
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l Qlik NPrinting messaging service
l Qlik NPrinting audit service

All of these services are installed automatically on a single server when you install Qlik NPrinting Server.

Qlik NPrinting scheduler service
The Qlik NPrinting scheduler service does the following:

l distributes jobs among available engines
l prioritizes jobs
l delivers reports
l schedules jobs

If the Qlik NPrinting scheduler service is restarted, jobs restart from the point where they were stopped.

Qlik NPrinting repository
The Qlik NPrinting repository service stores all the data necessary for Qlik NPrinting to work properly. This
includes: users and their roles, report metadata, connections, and filters. The Qlik NPrinting repository realizes
the persistence of data by using a database server in the background.

Qlik NPrinting web engine
The Qlik NPrinting web engine service manages user authentication and authorization based on user roles. See:
Creating users (page 240)

Qlik NPrinting messaging service
The Qlik NPrinting messaging service manages communication between the Qlik NPrinting Server and Qlik
NPrinting Engines.

Qlik NPrinting audit service
The Qlik NPrinting audit service writes audit logs to the Qlik NPrinting audit database.

Qlik NPrinting Engine
Qlik NPrinting Engines produce reports based on information received from the Qlik NPrinting scheduler service.
Each Qlik NPrinting Engine is multi-threaded to benefit from multi-channel CPUs. You can install multiple Qlik
NPrinting Engines on different computers to distribute the workload and create a high-availability reporting
system. You can only install one Qlik NPrinting Engine per computer.

Qlik NPrinting front end
The Qlik NPrinting front end consists of the following components:

l Web-based user interface
l On-Demand
l NewsStand
l Qlik NPrinting Designer
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Web-based user interface
The web-based user interface is used by administrators and users. It can be accessed via any supported web
browser. For information about which browsers are supported, see Supported browsers and apps (page 130).

On-Demand
On-Demand report generation allows users to request reports without waiting for the next scheduled generation.
See: On-Demand reports (page 490)

NewsStand
NewsStand is a web portal that allows authorized users to view, download, and subscribe to reports.

Qlik NPrinting Designer
Qlik NPrinting Designer is a desktop application that allows developers to create and manage report templates. It
is launched from the web console.

Ports

Qlik NPrinting uses the following Transmission Control Protocol (TCP) port numbers.

Security
l QlikView ports are not encrypted. They are standard QlikView ports.
l Database connections are configured to be local connections only. For example, you can only connect to

the PostgreSQL instance that is running on the same computer. You should not change the PostgreSQL
configuration.

l Firewall rules require that external access to the webengine is closed.
l Connection for certificate exchange is in plain text, but the message itself is encrypted.

Default ports

Additional ports used by RabbitMQ may be in use in your Qlik NPrinting system. For more information,
see≤ Networking and RabbitMQ.

TCP
Port

Security
Description

443 TLS Qlik Sense Hub listen port. Also used for used for Qlik NPrinting licensing service
back end.

2727 TLS Websocket proxy for reporting web renderer.

4242 TLS Qlik Sense Repository Service (QRS) REST API listen port..

4243 TLS Qlik Sense Proxy Service (QPS) REST API listen port. .

Default ports

Qlik NPrinting - February 2024 133

3   Deploying

https://www.rabbitmq.com/networking.html


TCP
Port

Security
Description

4730 Plain text QlikView DSC service port, always open on QlikView Server (QVS).

4747 TLS Qlik Sense Engine Service (QES) listen port and QlikView Server (QVS).

4799 Plain text QlikView Management Service (only for cluster).

4992 Plain text,
local
connections
only

Repository service.

4993 TLS Qlik NPrinting web console proxy. Uses HTTPS protocol.

4994 TLS NewsStand proxy. Uses HTTPS protocol.

4995 Plain text,
local
connections
only

Windows authentication service. This port does not need to be open on the end-
user's computer.

4996 Plain text Web engine service.

4997 Plain text Engine TLS certificates exchange server.

4998 TLS Qlik NPrinting licensing service.

5672 TLS Qlik NPrinting messaging service.

15672 Plain text Qlik NPrinting messaging service management plugin. This is disabled by default
and requires manual intervention for the listener to be activated. This service
should only be enabled for debugging or support.

Firewall rules

TCP
Port

Qlik NPrinting
Server

Qlik
NPrinting
Engines

Notes

4993 Inbound - -

4994 Inbound - -

4996 Block inbound,
loopback allowed

- Only allow listening on loopback interface.

4997 Outbound Inbound -

Minimum firewall rules
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TCP
Port

Qlik NPrinting
Server

Qlik
NPrinting
Engines

Notes

4998 Loopback allowed - Must allow traffic on the loopback interface on Qlik
NPrinting Server.

5672 Loopback allowed - Must allow traffic on the loopback interface on Qlik
NPrinting Server.

5672 Inbound Outbound If Qlik NPrinting scheduler service and Qlik NPrinting Engine
are installed on different machines.

TCP
Port

Qlik NPrinting
Engines

QlikView
Server

QlikView Management
Server

Notes

4730 Outbound Inbound - -

4747 Outbound Inbound - -

4799 Outbound - Inbound Only if a cluster is
used.

QlikView connection rules

TCP Port Qlik NPrinting Engines Qlik Sense Server

443 Outbound Inbound

4242 Outbound Inbound

4243 Outbound Inbound

4747 Outbound Inbound

Qlik Sense connection rules

TCP Port Qlik NPrinting Server Qlik Sense Server

443 Outbound Inbound

4242 Outbound Inbound

4243 Outbound Inbound

4747 Outbound Inbound

Publish reports to Qlik Sense hub connection rules

Changing the default ports
By default, the Qlik NPrinting web console is set to port 4993. The NewsStand is set to port 4994. These can be
changed by editing the webengine.config file. This file is typically located under: C:\Program
files\NPrintingServer\NPrinting\Webengine\webengine.config.
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You should always backup your Qlik NPrinting repository before editing a .config file. For more
information, see Backing up Qlik NPrinting (page 193).

Do the following:

1. Stop the Qlik NPrinting web engine service.

2. Open the webengine.config file in a text editor.

3. Update these strings with your preferred port values:
l <add key="webconsole-proxy-port" value="4993" />

l <add key="newsstand-proxy-port" value="4994" />

4. Save the file.

5. Start the Qlik NPrinting web engine service.

Fore more information about managing ports, see the Microsoft Windows help.

User accounts

You must set up several user accounts in order to successfully install Qlik NPrinting. Windows user
accounts are created and managed with your Windows server administration tools.
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You must create these Windows user accounts before you install Qlik NPrinting:

l Windows Qlik NPrinting Server services administrator
l Windows Qlik NPrinting Engine service administrator
l Qlik NPrinting repository database superuser
l Qlik NPrinting repository database administrator

Each Windows user account must have a password. These passwords may expire in accordance with the
Windows domain security rules settings. If you do not update the passwords for each Windows service
setting, the services will stop working. To avoid this, you can select the Password never expires check
box in the Windows user profile, if your security protocol allows it.

The Qlik NPrinting service account used must be able to authenticate seamlessly in the background
without being prompted for a user name and password. Access will be denied if there are separate
domains and standalone servers.

Windows Qlik NPrinting Server services administrator
The Qlik NPrinting Server services administrator runs the following services:

l Qlik NPrinting scheduler service
l Qlik NPrinting web engine

You should create a dedicated Windows user account to install Qlik NPrinting Server and run the associated
services. This ensures that there are no conflicts with other Windows services on the same computer. If you are
only installing one instance of Qlik NPrinting Engine on the same computer as the Qlik NPrinting Server, you can
use the same Windows user account for all Qlik NPrinting services on that computer. However, it is a good
practice to have different users for different services. Some processes opened by Qlik NPrinting are also opened
by Qlik Sense. It is easier to troubleshoot issues if you can quickly see which user or program caused the error.

You are prompted to enter these credentials on the Service logon credentials screen during the Qlik NPrinting
Server installation. You must also use these credentials when prompted during the activation of Qlik NPrinting
scheduler service and Qlik NPrinting web engine.

Requirements
The Qlik NPrinting Server services administrator must:

l Be a member of the local Administrators group.
l Have Log on as a service rights.

Changing the Qlik NPrinting Server services administrator
Do the following:

1. Stop the Qlik NPrinting scheduler service.

2. Stop the Qlik NPrinting web engine service.
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3. Change the user account on Qlik NPrinting scheduler service and Qlik NPrinting web engine.
These two services must be run by the same user.

4. Start the two services.

Windows Qlik NPrinting Engine service administrator
The Qlik NPrinting Engine service administrator runs the Qlik NPrinting Engine service.

You should create a dedicated Windows user account to install Qlik NPrinting Engine and run the associated
services. This ensures that there are no conflicts with other Windows services on the same computer. If you are
only installing one instance of Qlik NPrinting Engine on the same computer as the Qlik NPrinting Server, you can
use the same Windows user account for all Qlik NPrinting services on that computer. However, it is a good
practice to have different users for different services. Some processes opened by Qlik NPrinting are also opened
by Qlik Sense. It is easier to troubleshoot issues if you can quickly see which user or program caused the error.

You are prompted to enter these credentials on the Service logon credentials screen during the Qlik NPrinting
Engine installation.

Requirements
The Windows service administrator must:

l Be a member of the local Windows Administrators group.
l Be a domain user.
l Have Log on as a service rights.

Limitations
You can only install one instance of Qlik NPrinting Engine on each computer.

Additional Qlik Sense requirements
To connect Qlik NPrinting to Qlik Sense apps:

l Add Qlik Sense server certificates to the Qlik NPrinting Engine. See: Configuring server certificate validation
for Qlik Sense connections (page 175)

l The same Windows user account can be used for all Qlik NPrinting Engine installations if you are only
connecting to Qlik Sense.

l The Windows user account that runs the Qlik NPrinting Engine service must have:
o RootAdmin authorization configured in the QMC.
o A domain user account that is a member of the same domain as the Qlik NPrinting server and the

Qlik Sense server.

Additional QlikView requirements
To connect Qlik NPrinting to QlikView documents:

l You must use a different Windows user account for each Qlik NPrinting Engine instance if you are
connecting to QlikView.

l The Windows user account must belong to the local QlikView Administrator group on all QVS servers used
by Qlik NPrinting.
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l The Windows user account that runs the Qlik NPrinting Engine service must have one of the following:
o A named user Client Access License (CAL) that is manually assigned to the Qlik NPrinting Engine

service user active directory account, on the QlikView Server.
o An active license for QlikView Desktop, which must be installed on the Qlik NPrinting Engine

computer.

QlikView Desktop Personal Edition is not supported. See: Licensing Qlik NPrinting (page
145)

Additional QlikView Cluster requirements
To create a connection to a QlikView Cluster:

l You must use a different Windows user account for each Qlik NPrinting Engine instance if you are
connecting to QlikView.

l The Windows user account that runs the Qlik NPrinting Engine service must have:
o Be part of QlikView Administrators security group in all the nodes of the cluster.
o Be part of QlikView Management API security group on the computer where QMS runs. This group

must be added manually. See the QlikView Server Reference Manual for more information.

Users connecting through the API must be members of the QlikView Management API security
group. The group is not created during the installation. It must be added and populated
manually (for example, with the members of the QlikView Administrators group).

Changing the Qlik NPrinting Engine services administrator
You can change the services user account on all releases, except for:

l November 2018
l February 2019
l April 2019
l June 2019

If you have one of these versions, you will need to upgrade to Qlik NPrinting September 2019 or higher to change
services user accounts.

Do the following:

1. Stop the Qlik NPrinting Engine service.

2. Change the service user account.

3. Start the Qlik NPrinting Engine.

The engine status may not immediately switch online if you have recently upgraded from one of the versions
listed above that do not support the service account change.

Do the following:
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1. In the Qlik NPrinting web console, go to Admin > Engine manager.

2. Remove and recreate the related engine entry.

3. Fill out the certificate form to send the new certificates to the engine.

Qlik NPrinting repository database superuser
The Qlik NPrinting repository database superuser is a role that bypasses all permission checks in the PostgreSQL
database, except the right to log in. It is not a Windows, or Qlik NPrinting user, it is a PostgreSQL user configured
during the installation of the Qlik NPrinting repository.

The Qlik NPrinting repository is installed with Qlik NPrinting Server. You are prompted to enter a password for the
superuser on the Repository database superuser password screen during the Qlik NPrinting Server installation.

You must save the database superuser password, as you will need it to administer your PostgreSQL
installation.

Qlik NPrinting repository database administrator
The Qlik NPrinting repository database administrator is a role that has administrative privileges in the Qlik
NPrinting repository. It is not a Windows, or Qlik NPrinting user, it is a PostgreSQL user configured in the
repository database. This user is used the first time you log into Qlik NPrinting.

These credentials do not provide access to QlikView documents or Qlik Sense apps. The Qlik NPrinting repository
only contains information about the structure of the reporting system.

You are prompted to enter an Administrator username, Email address, and Password to create the Qlik
NPrinting Server administrator on the Administrator credentials screen during the Qlik NPrinting Server
installation.

Requirements
The email address must be compliant with the HTML specification explained by the≤ W3C. You cannot use
comments, quoted strings and special characters: []/();:'"<>

You must save the database administrator credentials, as you cannot retrieve them later.

Troubleshooting

User access is denied with message "Your credentials did not work"

Possible cause

You receive a Windows dialogue that says "Your credentials did not work". You are trying to log into Qlik
NPrinting using the incorrect domain. Your access is denied because your system has separate domains and
standalone servers.

Proposed action

All supported configurations must be implemented within a single Active Directory domain. This includes:
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l Qlik NPrinting Server
l Qlik NPrinting Engine
l QlikView Server
l Windows Qlik NPrinting Server services administrator
l Windows Qlik NPrinting Engine service administrator
l Qlik NPrinting repository database superuser
l Qlik NPrinting repository database administrator

If you are using JWT or SAML, user accounts do not need to be in the same domain, but must be within a domain
that Qlik NPrinting can authenticate within the same Active Directory Forest. For more information, see: JWT
authentication (page 222) and Security Assertion Markup Language (SAML) is an XML-based, open-standard data
format for exchanging authentication and authorization data between parties (for example, between an identity
provider and a service provider). SAML is typically used for web browser single sign-on (SSO). (page 218).

Single engine deployment

In a single engine installation, one engine creates all the requested reports. There is no load
balancing as all requests are managed by one engine. The reporting system stops if the engine
fails. When the system is working again, report creation and distribution starts from the point
where it stopped.

You connect to both a QlikView Cluster and a Qlik Sense cluster at the same time from a single Qlik NPrinting
Engine.

You can install Qlik NPrinting Server, Qlik NPrinting Engine, and Qlik NPrinting Designer on the same
computer, or several different computers.
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Multi-engine deployment

In a multi-engine installation, at least two engines are installed on separate computers. The
scheduler distributes the workload among available engines.

For example, a large report, composed of many different entities, would be split into many different parts that are
sent to different engines. Each engine creates a part, and then the scheduler coordinates the assembly of the
whole report.
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Multi-engine deployment example: Large volume deployment of Excel reports from QlikView

In a multi-engine installation where a large report must be generated in Excel format for a high
volume of users, the performance of the Qlik NPrinting Engines is important.

If you are connecting to QlikView, each Qlik NPrinting Engine windows service requires a separate
dedicated domain service account. For more information, see User accounts (page 136).

In this example, the reports are based on a single QlikView document of approximately 230 MB stored on disk,
and 20 GB of RAM consumption. The QlikView document contains a single large table. Reports must be delivered
to 700 Qlik NPrinting users, each with a single, dedicated filter. The Excel template contains a single table
composed of a set of QlikView document columns filtered by user.

Deployed solution:

l 2 QlikView Server 12.10 SR1 both installed on computers with 20 CPU cores and 256 GB of RAM
l 1 Qlik NPrinting server installed on a computer with 8 CPU cores and 32 GB of RAM
l 3 Qlik NPrinting Engines installed on computers with 12 CPU cores and 32 GB of RAM
l To minimize generation time, the Excel template does not contain any other type of entity such as a level

or chart.
l Reports are delivered to folders so that email server delivery time is not a bottleneck.

Due to anti-spam settings, some SMTP servers may refuse to deliver a high number of emails a short time. If you
want to use your SMTP server to deliver Qlik NPrinting reports, verify its configuration and test its performance.

In this example, the creation and delivery of 700 Excel reports takes approximately 15 minutes.

You can use the information in this page as a guideline to size your installation, but consider them only as
guidelines. A different installation could perform differently.

Supported and unsupported configurations

This section outlines supported and unsupported Qlik NPrinting installation configurations.

Supported configurations
For complete details on supported configurations, see the system requirements pages:

l System requirements for Qlik NPrinting Server (page 123)
l System requirements for Qlik NPrinting Engine (page 125)
l System requirements for Qlik NPrinting Designer (page 128)

Installation
l Qlik NPrinting can only be installed on C drives.
l You can install Qlik NPrinting Server, Qlik NPrinting Engine, and Qlik NPrinting Designer on the same

computer, or several different computers.

Qlik NPrinting - February 2024 143

3   Deploying



l You can import Qlik NPrinting 16 reports into Qlik NPrinting 17 or higher environments. You cannot import
entire projects (.nsq files). For more information, see Using the migration tool (page 110).

l Reporting will work on both physical and virtual machines. In both configurations, virtualized applications
are not supported. For example Qlik NPrinting Engine will not work if it is installed on one computer with
a virtualized QlikView Desktop distributed from a different computer.

Connections
l You can connect a Qlik NPrinting deployment to multiple QlikView and Qlik Sense environments.
l You can only connect to a QlikView Server that was initially configured using the QlikView Administrators

group.

Domains
All supported configurations must be implemented within a single Active Directory domain. This includes:

l Qlik NPrinting Server
l Qlik NPrinting Engine
l QlikView Server
l Qlik Sense Server
l Windows Qlik NPrinting Server services administrator
l Windows Qlik NPrinting Engine service administrator
l Qlik NPrinting repository database superuser
l Qlik NPrinting repository database administrator

Unsupported configurations

Operating systems
l Microsoft Windows is the only supported operating system. For example, you cannot install Qlik NPrinting

Server on a Linux computer.
l Qlik NPrinting cannot be installed on standalone Windows server computers. This is because a standalone

server is one that does not belong to or is not governed by a Windows domain.

Installation
l Qlik NPrinting Engine and Server and Qlik Sense Server should not be installed on the same computer.

There are no known incompatibilities between these two products, but in a production environment, Qlik
NPrinting should be installed on a separate computer (virtual or physical) from Qlik Sense because Qlik
NPrinting Engine and Server will consume all the available resources of the computer they are installed
on. This may lead to Qlik Sense crashing because of a lack of resources.

l Qlik NPrinting Engine and Server should not be installed on the same computer where QlikView Server or
QlikView Publisher are installed.
There are no known incompatibilities between these two products, but in a production environment, Qlik
NPrinting should be installed on a separate computer (virtual or physical) from QlikView Server or
QlikView Publisher because Qlik NPrinting Engine and Server will consume all the available resources of
the computer they are installed on. This may lead to QlikView Server or QlikView Publisher crashing
because of lack of resources.
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l QlikView Desktop and Microsoft Office cannot be distributed as virtualized applications. They must be
installed locally on the same physical or virtual machine where you install the Qlik NPrinting components.

l You can only install one instance of Qlik NPrinting Server, Engine, or Designer on a computer.
l Qlik NPrinting does not support QlikView Server installations which use "Certificates" during the

installation process. The QlikView Administrators group option must be used during QlikView Server
installation in order to connect to Qlik NPrinting.

Domains
l Domain trusts, multiple domains, and cross-domain implementations are not supported. For example,

where Qlik NPrinting Server is deployed on one domain, the Windows user accounts mapped to Qlik
NPrinting users cannot be domain accounts from a different domain that Qlik NPrinting Server is not a
member of.

QlikView NPrinting 16 (Not supported since March 31, 2020)
l QlikView NPrinting 16 and Qlik NPrinting Designer June 2017 or later cannot be installed on the same

computer.
l QlikView NPrinting 16 Server and Qlik NPrinting June 2017 (or later) Server or Engine cannot be installed

on the same computer.
l Qlik NPrinting Designer June 2017 or later cannot manage Qlik NPrinting 16 projects (.nsq files), but you

can import individual Qlik NPrinting 16 reports. For more information, see Using the migration tool (page
110).

For more information about the end-of-life of QlikView NPrinting 16, see≤ NPrinting 16 reaching EOL.

Licensing Qlik NPrinting
Qlik NPrinting can be installed and configured to connect to QlikView documents or Qlik Sense
apps. The licensing requirements and procedures are different depending on if you connect Qlik
NPrinting to QlikView or Qlik Sense.

Qlik NPrinting is an on-premise reporting add-on product for Qlik Sense on Windows or QlikView on
Windows.

You do not need to activate licenses for Qlik NPrinting Designer or Qlik NPrinting Engine. They are activated
automatically based on license information from the Qlik NPrinting Server. See: Licensing Qlik NPrinting Server
(page 147).

Contact Customer Support for more information about customer license codes.
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Qlik NPrinting with QlikView
To start the Qlik NPrinting service and connect to QlikView, you must have one of the following:

l A named user Client Access License (CAL) that is manually assigned to the Qlik NPrinting Engine service
user active directory account, on the QlikView Server.

A valid named user CAL from a production QlikView Server must be used for the Qlik NPrinting
Engine service user account. If the CAL from a test QlikView Server is used, it will cause personal
edition to appear in the QlikView Desktop title bar, and it will not work with Qlik NPrinting.

l A local QlikView Desktop license.

To connect Qlik NPrinting Server to QlikView a fully licensed version of QlikView Desktop is required. You can
activate QlikView Desktop by inserting a license code and control number, or by manually assigning a named user
CAL from a QlikView Server.

Dynamically leased licenses and Personal Edition are not supported. We do not recommend using dynamically
assigned leased licenses, because when a dynamic leased license expires the Qlik NPrinting service stops
working.

A user account with a leased license needs administrative privileges and permission to run as a service. The user
account must be specific to the Qlik NPrinting service. Do not use the same account for other purposes such as
remote desktop connections or server login. See: Activating a QlikView Desktop license (page 151).

If you are configuring multiple Qlik NPrinting Servers you must create a Windows account for each one.

QlikView Desktop licenses for Qlik NPrinting Engine
You can use a license code and control number (local license) or assign a Named CAL from your QlikView server.
You must use a different Windows user for each instance of the Qlik NPrinting Engine service.

A Named CAL license, taken from a QlikView Server, is valid only for a single QlikView Desktop user. In the case of
a multiple Qlik NPrinting Engine installation, you must set a different Windows user and a different QlikView
Desktop Named CAL license for each Qlik NPrinting Engine. If you use the same QlikView Desktop Named CAL
license two or more times, the QlikView Server will disconnect all QlikView Desktops but one, and report
generation will fail.

We do not recommend using shared licenses (also called dynamically-assigned CALs) because when Qlik
NPrinting opens the local QlikView Desktop, the license must be active or the report generation process stops. If
you use assigned CALs, you need to connect the QlikView Desktop to the QlikView Server at least one time, at the
beginning, using the same Windows user and computer as the Qlik NPrinting Engine service.

Qlik NPrinting with Qlik Sense
To start the Qlik NPrinting service and connect to Qlik Sense, you must have the following:

l Qlik Sense certificates exported without password information
l User account with RootAdmin privileges in Qlik Sense
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To connect Qlik NPrinting to Qlik Sense you must have Qlik NPrinting Server and at least one Qlik NPrinting
Engine installed and activated.

Qlik Sense certificates must be installed on each computer where a Qlik NPrinting Engine is installed. See:
Connecting Qlik NPrinting with Qlik Sense (page 172).

The Qlik NPrinting user that creates the connection to Qlik Sense must have RootAdmin authorization in Qlik
Sense.

Licensing Qlik NPrinting Server

You will be prompted to activate your license the first time you open Qlik NPrinting Server.

You do not need to activate licenses for Qlik NPrinting Designer or Qlik NPrinting Engine. They are activated
automatically based on license information from the Qlik NPrinting Server.

By default, only one Qlik NPrinting Engine is available for each Qlik NPrinting Server license. If you want to add
additional engines to your Qlik NPrinting environment, you need to purchase them.

Licensing Qlik NPrinting Server with a LEF (License Enabler File)
Do the following:

1. Open your browser and point it to your Qlik NPrinting Server by opening the URL
https://YourServerName:4993.

Use the https protocol and the port 4993 for the standard installation. For example:
https://localhost:4993

2. Select License key and control number.

3. Insert the License key.

4. Insert the Control number.

5. Enter your User name.

6. Enter your Organization.
The Activate button becomes active once the mandatory fields are completed.

1. Click Activate to activate the license.

You will see a message indicating that the activation was successful, and the License Enabler File (LEF)
information appears at the bottom.

Licensing Qlik NPrinting Server with a signed key
Do the following:

1. Open your browser and point it to your Qlik NPrinting Server by opening the URL
https://YourServerName:4993.
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Use the https protocol and the port 4993 for the standard installation. For example:
https://localhost:4993

2. Select Signed license key.

3. Insert the Signed license key.
The Activate button becomes active once the mandatory fields are completed.

1. Click Activate to activate the license.

You will see a message indicating that the activation was successful, and the signed license key information
appears.

Licensing service proxy Setup

You can handle the communication between the Qlik NPrinting licensing service and the license
back-end with a proxy .

The Qlik NPrinting licensing service is included in Qlik NPrinting February 2020 and later releases and is used
when Qlik NPrinting is activated using a signed key license. The Qlik NPrinting licensing service stores the
information about the license, and communicates with a license back-end service, hosted by Qlik, for product
activations and entitlement management. Port 443 is used for accessing the license back-end service and
retrieving license information.

With Qlik NPrinting February 2020 or later you can configure the communication between Qlik NPrinting licensing
service and the Qlik license back-end to be handled by a proxy.

In Qlik NPrinting, configuration of a proxy for the Qlik NPrinting licensing service is done using command line
parameters. Both HTTP and HTTPS scheme are supported.

With Qlik NPrinting June 2020 or later NTLM and basic authentication capabilities to the licenses service when
communicating over a HTTP tunnel are available. This allows you to require authentication on tunneling proxies
and configure a more secure environment.

Anonymous authentication
Do the following:

1. Navigate to the service.conf file, which by default is located in:
%Program Files%\NPrintingServer\NPrinting\License\license.config

2. Locate the following line and uncomment it:
<!-- <add key="proxy-uri" value="https://localhost:8888" /> -->

3. Modify the value attribute to the proxy address:
<add key="proxy-uri" value="https://example.com:8080" />

4. Save the file and close.

5. Restart the Qlik NPrinting licensing service.

Setting up basic authentication for a proxy
To set up basic authentication for a proxy, do the following:
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1. Stop the Qlik NPrinting license service.

2. Navigate to the service.conf file, which by default is located in:
%Program Files%\NPrintingServer\NPrinting\License\license.config

3. Uncomment the following lines:
<!-- <add key="proxy-uri" value="https://localhost:8888" /> -->

<!-- <add key="proxy-basic-authentication" value="true" /> -->

<!-- <add key="proxy-username" value="username-without-domain" /> -->

4. Set values for proxy-uri and proxy-username.

5. To use a plain text password, uncomment:
<!-- <add key="proxy-password" value="clear-text-password" /> -->

6. Set the value for proxy-password.

7. To use an encrypted password (recommended) uncomment:
<!-- <add key="proxy-encrypted-password" value="script-generated-password" /> -->

8. Open powershell and run the password encryption script located in:
%Program Files%\NPrintingServer\NPrinting\License\lEncrypt-Password.ps1
using the command:
Encrypt-Password.ps1 -password clear-text-password

9. Set the output from the command as the value attribute in the tag.

10. Save the file and close it.

11. Restart the Qlik NPrinting licensing service.

Example configuration:
<appSettings>

<!--=========================================

License options

=========================================-->

<!--To be enabled if proxy tunneling is required-->

<add key="proxy-uri" value="https://localhost:8888" />

<!--NTLM authentication settings for proxy tunneling-->

<!--Enable Basic authentication-->

<add key="proxy-basic-authentication" value="true" />

<!--Enable NTLM authentication-->

<!-- <add key="proxy-ntlm-authentication" value="true" /> -->

<!--Domain for authentication-->

<!-- <add key="proxy-domain" value="windows-domain" /> -->

<!--Username for authentication (without domain)-->

<add key="proxy-username" value="myUser" />

<!--Encrypted password as generated by Encrypt-Password.ps1 -password [user password]-->

<add key="proxy-encrypted-password"

value="ASDHJNCE243454NNJFWEJFJKFSD8U843RJKJCNDWC98RFNSDJVSKJDVR8UFVC9SJV09439FJSDJVOIHVSKV" />

<!--Clear text password, if encrypted version cannot be used-->

<!-- <add key="proxy-password" value="clear-text-password" /> -->

</appSettings>
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Setting up NTLM authentication for a proxy
1. Stop the Qlik NPrinting license service.

2. Navigate to the service.conf file, which by default is located in:
%Program Files%\NPrintingServer\NPrinting\License\license.config

3. Uncomment the following lines
<!-- <add key="proxy-uri" value="https://localhost:8888" /> -->

<!--<add key="proxy-ntlm-authentication" value="true" />-->

<!--<add key="proxy-domain" value="windows-domain" />-->

<!-- <add key="proxy-username" value="username-without-domain" /> -->

4. Set values for proxy-uri, proxy-domain and proxy-username.

5. To use a plain text password, uncomment:
<!-- <add key="proxy-password" value="clear-text-password" /> -->

6. Set the value for proxy-password.

7. To use encrypted password (recommended) uncomment:
<!-- <add key="proxy-encrypted-password" value="script-generated-password" /> -->

8. Open powershell and run the password encryption script located in:
%Program Files%\NPrintingServer\NPrinting\License\lEncrypt-Password.ps1
using the command:
Encrypt-Password.ps1 -password clear-text-password

9. Set the output from the command as the value attribute in the tag.

10. Save the file and close it.

11. Restart the Qlik NPrinting licensing service.

Example configuration:
<appSettings>

<!--=========================================

License options

=========================================-->

<!--To be enabled if proxy tunneling is required-->

<add key="proxy-uri" value="https://localhost:8888" />

<!--NTLM authentication settings for proxy tunneling-->

<!--Enable Basic authentication-->

<!--<add key="proxy-basic-authentication" value="true" />-->

<!--Enable NTLM authentication-->

<add key="proxy-ntlm-authentication" value="true" />

<!--Domain for authentication-->

<add key="proxy-domain" value="domain" />

<!--Username for authentication (without domain)-->

<add key="proxy-username" value="user" />

<!--Encrypted password as generated by Encrypt-Password.ps1 -password [user password]-->

<add key="proxy-encrypted-password"

value="ASDHJNCE243454NNJFWEJFJKFSD8U843RJKJCNDWC98RFNSDJVSKJDVR8UFVC9SJV09439FJSDJVOIHVSKV" />

<!--Clear text password, if encrypted version cannot be used-->

<!-- <add key="proxy-password" value="clear-text-password" /> -->

</appSettings>
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See also:

Licensing service cipher suites (page 209)

Activating a QlikView Desktop license

You can activate or check a QlikView Desktop license.

Do the following:

1. Find the QlikView executable file, typically located in C:\Program Files\QlikView\Qv.exe.

2. Right-click on the file while holding down Shift and Ctrl, and select Run as Different User.

3. Insert the credentials of the Windows user dedicated to the Qlik NPrinting service and check that QlikView
Desktop is activated.

This is one of the most frequent causes of issues with the Qlik NPrinting service.

Licensing Qlik NPrinting offline

You must have an internet connection to activate a license. If you are offline, or if the online
activation fails, the Qlik NPrinting Server will ask you to manually insert the contents of the License
Enabler File (LEF) , Signed License Key (SLK), or Signed License Definition (SLD).

For more information on licensing, see Licensing Qlik NPrinting (page 145).

Using Qlik NPrinting with LEF
If you do not have an LEF file, please contact Customer Support.

Do the following:

1. Open your browser and point it to your Qlik NPrinting Server License activation page by opening the
URL:
https://YourServerName:4993/#/admin/license/offline?username=xxx&organization=yyy
where:

l YourServerName is the name of your Qlik NPrinting Server.
l xxx is your username
l yyy is your organization name

2. Copy and paste the contents of the LEF file in the text box of the License activation form.

3. Click on Activate offline.

You will see a deactivation message and license parameter forms.

Using Qlik NPrinting with SLD with Delayed Sync
No special configuration is needed. For information on generating the SLD, see≤ How to activate Qlik Sense,
QlikView, and Qlik NPrinting without Internet Access.
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Using Qlik NPrinting with offline SLD
Your license must be converted for offline use. Please refer to for obtaining the offline Signed License Definition,
see≤ Request license offline approval - April 2020 and onwards.

Once you obtain the offline license, you must edit the license.config file.

Do the following:

1. Stop the WebEngine, Scheduler, and License services.

2. Open this file: \Program Files\NPrintingServer\NPrinting\License\license.config

3. Add the following tag in the appSettings section: <add key="offline" value="true" />

4. Restart the License, Scheduler, and WebEngine services.

5. In the Qlik NPrinting web console go to Admin > License activation.
If you are updating an existing license, click Change.

6. Select Signed key license format and enter the offline license information.

7. Click Activate.

Offline mode is not compatible with the online signed key format. If Qlik NPrinting is licensed with an online
signed key and the service is set up to run in offline mode, it will reject the existing license.

You can revert this process as needed.

Do the following:

1. Stop the WebEngine, Scheduler, and License services.

2. Remove the tag that was added from the license.config file.

3. Restart the services.

4. In the Qlik NPrinting web console go to Admin > License activation.
If you are updating an existing license, click Change.

5. Select Signed key license format and enter the offline license information.

6. Click Activate.

Performance
The performance of your Qlik NPrinting system will depend on a number of factors. When planning
your deployment you must consider:

l the size of your deployment
l the number of Qlik NPrinting Engines needed
l the type of connections you plan to use
l the number CPU cores required for each Qlik NPrinting Engine
l the amount of RAM required for Qlik NPrinting Engine computers

Performance guidelines
To size your installation, consider the following:

Qlik NPrinting - February 2024 152

3   Deploying

https://community.qlik.com/t5/Knowledge/Request-license-offline-approval-April-2020-and-onwards/ta-p/1713376


l number of Qlik NPrinting Engines
l number of CPU cores for each Qlik NPrinting Engine
l amount of RAM required for Qlik NPrinting Engine computers

Use this information to help you plan your system.

Number of Qlik NPrinting Engines
Increasing the number of Qlik NPrinting Engines associated with a Qlik NPrinting Server will result in a linear
increase in performance. For example, if you move from an installation with two Qlik NPrinting Engines to an
installation with four Qlik NPrinting Engines, the time to create and deliver the same set of reports is divided by
two. The total amount of time necessary to deliver a set of reports can also depend on external factors, such as
the performance of your SMTP server.

Number of CPU cores for each Qlik NPrinting Engine
The performance impact of the number of CPU cores depends on whether the reports are based on connections
to QlikView or Qlik Sense.

When you create reports from Qlik Sense connections, performance increases linearly with the number of CPU
cores added. For example, if you move from a four core CPU to an eight core CPU, the time to create the same set
of reports is divided by two. The total amount of time necessary to deliver a set of reports also depends on
external factors, such as the performance of your SMTP server. There is no upper limit to this relationship if your
connections are exclusively to Qlik Sense apps.

When you create reports from QlikView connections, performance increases linearly with the number of CPU
cores added until you reach twelve cores. If you exceed twelve CPU cores, the increase is no longer linear. The
change in performance occurs because Qlik NPrinting Engine launches an instance of QV.exe for each CPU core
and uses QlikView bookmarks to apply filters. QlikView bookmarks are written to a file, so for each CPU core there
is an instance of QV.exe that needs to read and write to the same file. Conflicts while accessing the bookmark file
can cause a noticeable decrease in performance when you exceed twelve QV.exe instances or twelve CPU cores. If
you plan to connect only to QlikView documents, we recommend that you install Qlik NPrinting Engines on
physical or virtual computers with a maximum of twelve cores. Connections to Qlik Sense apps are not impacted
by this limitation.

Qlik NPrinting can create reports with data from QlikView and Qlik Sense connections at the same time. There are
currently no performance test results available for this scenario.

RAM required for Qlik NPrinting Engine computers
The amount of RAM required for Qlik NPrinting Engine computers depends on the QlikView documents you use to
create reports. On a Qlik NPrinting Engine, each instance of QV.exe opens a single QlikView document. For
example, if your Qlik NPrinting Engine server has four CPU cores it means that it runs four QV.exe instances which
in turn open four QlikView documents. You need enough RAM to adequately manage these four QlikView
documents to ensure good performance.

Deployment examples
The following examples outline some basic architecture and hardware options for scaling an Qlik NPrinting
deployment.
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Single-engine (small)
This example is a minimum specification consisting of a single Qlik NPrinting Server with web engine, scheduler
and repository installed on the same server.

l 1 Qlik NPrinting Server
l 4 CPU cores
l 32 GB RAM

Single-engine (medium)
This example has more CPU cores but also consists of a single NPrinting server with web engine, scheduler and
repository installed on the same server. As demand increases more CPU cores can help to improve performance.

l 1 Qlik NPrinting Server
l 8 CPU cores
l 32 GB RAM

Multi-engine (large)
As your needs increase to produce a larger number of reports, scalability becomes increasingly important. This
example consists of a single NPrinting server but three NPrinting engines to improve performance and scalability.

l 4 servers (1 Qlik NPrinting Server, 3 Qlik NPrinting Engines)
l 12 CPU cores for each server
l 32 GB RAM for each server

See: Multi-engine deployment example: Large volume deployment of Excel reports from QlikView (page 143)

Troubleshooting

Possible cause

There are several factors that may cause performance loss.

Proposed action

l Check the hardware resources of the Qlik NPrinting Engine computer.
l If you are connecting to QlikView documents, make sure that the QlikView computer has enough

resources to manage the source documents.
l Check the QlikView source document:

o Does it take a long time to open it and to apply a filter in the Qlik NPrinting Engine? Save the .qvw
with all charts minimized to decrease the opening time.

o Create a QlikView document or a Qlik Sense app solely for Qlik NPrinting reporting. Clone the
original and remove all unnecessary data.

o Where possible, move calculated fields from charts to a script. Every time you apply a filter, these
fields are recalculated.
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l Report generation time depends on the number of Levels and Pages in the report. Every value in a level
or page is a filter, so you must wait for filter calculation. Use Excel pivot tables in reports, instead of using
levels.

Downloading installation files
The Qlik Download Site provides the files you need to install and upgrade Qlik products. You can
find the site in Qlik Community under Support > Product News > Product Downloads.

Do the following:

1. Go to the≤ Product Downloads.

2. Select Qlik Data Analytics, and then select Qlik NPrinting.

3. Use the filters to narrow your list of possible downloads.

4. Click a download link to start the download.

Example from the Download Site where the files have been filtered on product and release. In this case, it shows available
installation files for Qlik NPrinting release May 2021.

3.2 Qlik NPrinting installation
In a minimal installation, Qlik NPrinting Server, a single Qlik NPrinting Engine, and Qlik NPrinting
Designer can be installed on the same computer.

You must install the Qlik NPrinting Server before you install the Qlik NPrinting Engine. Only a single Qlik NPrinting
Engine can be installed on each computer.

When you install or upgrade your Qlik NPrinting Server, Qlik NPrinting Engines, and Qlik NPrinting
Designer, ensure that they are all the same software version. Mixing versions of Qlik NPrinting
components is not supported.
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1. Installing Qlik NPrinting Server (page 156)

2. Installing Qlik NPrinting Engine (page 162)

3. After you install Qlik NPrinting Engine, you must activate your license on the Qlik NPrinting Server. See:
Licensing Qlik NPrinting Server (page 147)

4. Installing Qlik NPrinting Designer (page 168)

Installing Qlik NPrinting Server
Qlik NPrinting Server must be installed first. The Qlik NPrinting scheduler service that is installed
with Qlik NPrinting Server is required to communicate with the Qlik NPrinting Engine. Servers can
be installed using the user interface or command line interface (CLI).

What is installed
Qlik NPrinting Server installs the following. These must not be uninstalled from the server:

l Qlik NPrinting scheduler service
l Qlik NPrinting repository
l Qlik NPrinting audit service
l Qlik NPrinting web engine
l Qlik NPrinting messaging service
l Qlik NPrinting licensing service
l Qlik NPrinting repo service (PostgreSQL 13.11-2)
l .NET framework: 4.8.0 or higher

.NET framework is installed when you install Qlik NPrinting Server, Qlik NPrinting Engine, or Qlik NPrinting
Designer. The installation of .NET framework requires an internet connection. If .NETframework is not
already installed on a computer without an internet connection, the installation stops. Before you begin
the installation of Qlik NPrinting Server, Qlik NPrinting Engine, or Qlik NPrinting Designer, you must install
the .NET framework on computers without an internet connection. If an internet connection is not
available on a computer with .NET framework already installed, the installer will skip this part of the
installation.

l Erlang OTP 24.0
l Microsoft Visual C++ 2013 Redistributable x64 (12.0.30501)
l Microsoft Visual C++ 2015-2022 Redistributable x86 (14.34.31931)
l Microsoft Visual C++ 2015-2022 Redistributable x64 (14.34.31931)

Requirements
l Check that your environment meets the System requirements for Qlik NPrinting Server (page 123).
l Check that the required Ports (page 133) are available.
l Prepare the User accounts (page 136) required to run the Qlik NPrinting services.
l Understand how Licensing Qlik NPrinting (page 145) is configured, and have your license key available.
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Limitations
l Qlik NPrinting can only be installed on C drives.
l Starting with Qlik NPrinting 17.2.1, the Qlik NPrinting Server setup removes RabbitMQ and replaces it with

the Qlik NPrinting messaging service.
l RabbitMQ cannot be installed on the same computer as Qlik NPrinting Server 17.2.1 or newer.
l You must install the Qlik NPrinting Server before you install the Qlik NPrinting Engines.
l You cannot install Qlik NPrinting Server 17 and newer on the same computer as Qlik NPrinting Server 16.
l Local data such as logs, configuration files, template files, and NewsStand files are stored in

C:\ProgramData\NPrinting. This location is not configurable.
l Any email addresses used to create accounts must be compliant with the HTML specification.

Comments, quoted strings, and special characters like []/();:'"<>, are not allowed. .

Creating a Qlik NPrinting service user
Do the following:

1. Create a user to run your Qlik NPrinting services. The user must be a local Administrator, with Logon as a
Service rights, and should be used exclusively to run Qlik NPrinting services.

a. In Windows Computer Management, go to Local Users and Groups > Users, and click Action >
New User....

b. Enter a User name and Password for the user and click Create.

c. Right-click on the user that you created in the previous step, and click Properties.

d. Click on the Member Of tab and click Add....

e. Enter Administrators in the field and click Check Names. If the name is valid, click OK.

f. From the Windows Control Panel, go to Administrative Tools, and click on Local Security Policy.

g. Go to Local Policies > User Rights Assignment, and click Log on as a service.

h. On the Local Security Setting tab, click Add User or Group....

i. Enter the user that you created in the previous steps and click Check Names. If the name is valid,
click OK.

2. Log into the computer where you plan to install Qlik NPrinting Server as a local Windows administrator.
You can use the account that you created in the previous steps.

a. To verify that you are logged on as a local administrator, go to Control Panel > User Accounts.
You can see the groups that the user belongs to under the name on the contact card.

Downloading the installation file
Download QlikNPrintingServer_x64.exe from the≤ Qlik Download Site
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For more information, see Downloading installation files (page 155).

Installing Qlik NPrinting Server via user interface
Do the following:

1. Double-click QlikNPrintingServer_x64.exe to launch the setup.

2. Click the check box to accept the license agreement, and click Install. If:
l The User Account Control window appears, click Yes to proceed.
l The MicrosoftVisual C++ 2013 window appears, accept the license terms and install it. If you have

an older version installed, click Repair. When the installation is complete, click Close.
l The Windows Security Alert appears, select both check boxes and then click on Allow access.

Erlang needs to communicate over the network, so you must allow the creation of the related
firewall rule.

3. On the Qlik NPrinting repository Service Setup Welcome page, click Next.

4. On the Repository database superuser password screen, enter a password for the Qlik NPrinting
repository database superuser.
Qlik NPrinting installs a PostgreSQL repository database during setup. The database superuser is a
PostgreSQL login role with the highest level of privileges that bypasses all permission checks. You will
need this password to administrate your PostgreSQL installation.

You can proceed without creating a password, but this is not recommended.

5. On the Administrator credentials screen:

a. Enter the following to create a Qlik NPrinting user with administrative privileges:
l Administrator username
l Email address
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l Password
This user is used the first time you log into Qlik NPrinting.

Save these credentials. You cannot retrieve them later.

b. Click Next.

6. Click Install.
A screen indicating that the repository database setup is complete appears.

7. Click Finish.

8. On the Qlik NPrinting Server Welcome page, click Next.

9. On the Installation options screen, select your preferred program shortcut locations and click Next.
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10. On the Service logon credentials screen, type the credentials for the user that you created in Creating:

a. Account: Enter the Domain and User name in this format Domain\User name. You can use the
Browse button to search for the user.

b. Password: Enter the user's Password.

c. Click Test Credentials to verify that the user credentials are valid.
If the log on credentials are validated successfully, the Test Credentials button is grayed out and a
green check mark appears next to it.

d. Click Next.

11. Click Install.

12. Click Finish.
The Setup Successful screen appears.

13. Click Close.

Qlik NPrinting Server installs four Windows services that must be running:

l Qlik NPrintingScheduler
l Qlik NPrintingWeb Engine
l Qlik NPrinting messaging service
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l Qlik NPrintingRepoService

To open the Qlik NPrinting web console, point you web browser to https://YourServerName:4993, and then log in
with the administrator email and password that you set up. To open the NewsStand, point your web browser to
https://YourServerName:4994, and then log in with the same email and password.

You are now ready to install Qlik NPrinting Engine. See: Installing Qlik NPrinting Engine (page 162).

Installing Qlik NPrinting Server via command line

Viewing command line arguments
To display a list of command line arguments, execute the following in the command line:

QlikNPrintingServer_x64.exe /help

QlikNPrintingEngine_x64.exe /help

/quiet install or uninstall means no UI is displayed.

/passive install or uninstall means a minimum UI with a progress bar is displayed, but no wizards or user
interaction.

Install Qlik NPrinting Server
Execute the following command in the command line as an administrator:

QlikNPrintingServer_x64.exe /install {/quiet|/passive} accept-eula=1 service-username="

{DOMAIN\USERNAME}" service-password="{USER_PASSWORD}" database-password="{DATABASE_PASSWORD}"

admin-email="{ADMIN_EMAIL}" admin-username="{ADMIN_USERNAME}" admin-password="{ADMIN_PASSWORD}"

[/log"{PATH_TO_LOG_FILE}"]

Example
QlikNPrintingServer_x64.exe /install /passive accept-eula=1 service-username="qtsel\admin"

service-password="s3cr3t" database-password="s3cr3t" admin-email="admin@qlik.com" admin-

username="Admin" admin-password="admin" /log ".\server.log"
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You are now ready to install Qlik NPrinting Engine. See: Installing Qlik NPrinting Engine (page 162).

Installing Qlik NPrinting Engine
Qlik NPrinting Engine is required to generate reports. You must have at least one active Qlik
NPrinting Engine in your Qlik NPrinting deployment. Engines can be installed using the user
interface or command line interface (CLI).

Qlik NPrinting Server must be installed before you install Qlik NPrinting Engine. The Qlik NPrinting scheduler
service is installed with Qlik NPrinting Server, and is required to communicate with the Qlik NPrinting Engine. You
can install multiple Qlik NPrinting Engines on different computers to distribute the workload and create a high-
availability reporting system. Qlik NPrinting Engine can be installed on the same computer as the Qlik NPrinting
Server or on a different computer.

What is installed
Qlik NPrinting Engine installs the following. These must not be uninstalled from the server:

l Qlik NPrinting Engine service
l .NET framework: 4.8.0

.NET framework is installed when you install Qlik NPrinting Server, Qlik NPrinting Engine, or Qlik NPrinting
Designer. The installation of .NET framework requires an internet connection. If .NETframework is not
already installed on a computer without an internet connection, the installation stops. Before you begin
the installation of Qlik NPrinting Server, Qlik NPrinting Engine, or Qlik NPrinting Designer, you must install
the .NET framework on computers without an internet connection. If an internet connection is not
available on a computer with .NET framework already installed, the installer will skip this part of the
installation.

l PDF-XChange

Requirements
l Check that your environment meets the System requirements for Qlik NPrinting Engine (page 125).
l Check that the required Ports (page 133) are available.
l Prepare the User accounts (page 136) required to run the Qlik NPrinting services.
l Understand how Licensing Qlik NPrinting (page 145) is configured, and have your license key available.

Limitations
l Qlik NPrinting can only be installed on C drives.
l You can install only one Qlik NPrinting Engine on each physical computer or virtual machine.
l The Qlik NPrinting Engine is multi-threaded, so it can use all the server CPU cores. A minimum of two

cores is required.
l If you are connecting to QlikView, QlikView Desktop must be installed locally on the same physical

computer or virtual machine as the Qlik NPrinting Engine. It cannot be accessed as a virtual application.
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l You must install the Qlik NPrinting Server before you install the Qlik NPrinting Engines.
l Ports 4242, 4243 and 4747 must be opened outbound on the Qlik NPrinting Engine computer.
l Local data such as logs, configuration files, template files, and newsstand files are stored in

C:\ProgramData\NPrinting. This location is not configurable.

Creating a Qlik NPrinting service user
Do the following:

1. Create a user to run your Qlik NPrinting services. The user must be a local Administrator, with Logon as a
Service rights, and should be used exclusively to run the Qlik NPrinting services.

a. In WindowsComputer Management, go to Local Users and Groups > Users, and click Action >
New User....

b. Enter a User name and Password for the user and click Create.

c. Right click on the user that you created in the previous step, and click Properties.

d. Click on the Member Of tab and click Add....

e. Enter Administrators in the field and click Check Names. If the name is valid, click OK.

f. From the WindowsControl Panel, go to Administrative Tools, and click on Local Security Policy.

g. Go to Local Policies > User Rights Assignment, and click Log on as a service.

h. On the Local Security Setting tab, click Add User or Group....

i. Enter the user that you created in the previous steps and click Check Names. If the name is valid,
click OK.

If you are connecting to QlikView, you must use a different Windows user account for
each Qlik NPrinting Engine instance.
If you are connecting to Qlik Sense, you can use the same Windows user account for all
Qlik NPrinting Engine installations.

If you are installing an instance of Qlik NPrinting Engine on the same computer as the
Qlik NPrinting Server, you can use the same Windows user account to run all Qlik
NPrinting services on that computer.

This user will require additional permissions configured in Qlik Sense or QlikView to
connect to those servers.

2. If you are connecting Qlik NPrinting to Qlik Sense, you must assign RootAdmin authorization to the user
that runs the Qlik NPrinting Engine service.

a. On the Qlik Sense server, open the QMC and click Users.

b. Select the user that you created in step 1 from the list, and click Edit.

c. Click Add role, ans select RootAdmin from the list.

d. Click Apply.
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3. If you are connecting Qlik NPrinting to QlikView, the user that runs the Qlik NPrinting Engine service must:
l Be a member of the Administrators group on all QVS servers used by Qlik NPrinting.
l Have an active license for QlikView Desktop, which must be installed on the Qlik NPrinting Engine

computer.

QlikView DesktopPersonal Edition is not supported. Licensing Qlik NPrinting (page 145).

4. Log into the computer where you plan to install Qlik NPrinting Engine as a local Windows administrator.
You can use the account that you created in the previous steps.

a. To verify that you are logged on as a local administrator, go to Control Panel > User Accounts.
You can see the groups that the user belongs to under the name on the contact card.

Downloading the installation file
Download QlikNPrintingEngine_x64.exe from the≤ Qlik Download Site

For more information, see Downloading installation files (page 155).

Installing Qlik NPrinting Engine via user interface
Do the following:

1. Double-click QlikNPrintingEngine_x64.exe to launch the setup.

2. Select the check box to accept the license agreement, and click Install.
If the User Account Control window appears, click Yes to proceed.

3. On the Qlik NPrinting Engine Setup Welcome page, click Next.

4. On the Service logon credentials screen, use the credentials for the user that you created in step 1. to
complete the fields as follows:

a. Account - Enter the Domain and User name in this format Domain\User name. You can use the
Browse button to search for the user.

b. Password - Enter the user's Password.

c. Click Test Credentials to verify that the user credentials are valid.
If the log on credentials are validated successfully, the Test Credentials button is grayed out and a
green check mark appears next to it.
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d. Click Next.

5. On the Qlik NPrinting Server node screen, enter the name of the computer where Qlik NPrinting Server
is installed.

a. Click Test Credentials to verify that the server name is valid, and that it can be reached from the
Qlik NPrinting Engine computer.
If the server node is validated successfully, the Test Credentials button is grayed out and a green
check mark appears next to it.

You can enter the domain name of the computer, its IP address, or its DNS name. The Qlik
NPrinting Engine computer must be able to resolve the DNS name if that option is used.
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Firewalls must allow connections on port 5672 between the Qlik NPrinting Engine computer
(outbound) and the Qlik NPrinting Server node (inbound). See: Ports (page 133)

If the Qlik NPrinting Engine is installed on the same computer as Qlik NPrinting Server you can
use the loopback network interface, so that you can insert the IP address 127.0.0.1 or localhost.
In that case it is not necessary to open firewall ports on the public network interface.

6. On the Engine certificate password screen, enter a password to encrypt certificate exchange for TLS
certificates.

The same password must be provided to the Qlik NPrinting Server on the engine configuration
page.

On Qlik NPrinting Server, port 4997 must be open outbound. On all Qlik NPrinting Engines, port
4997 must be open inbound.

7. Click Next to continue.

8. Click Install.

9. Click Finish.
The Setup Successful screen appears.

10. Click Close.

Qlik NPrinting Engine installs the Qlik NPrinting Engine Windows service that must be running.
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Once you have installed Qlik NPrinting Engine successfully, you must:

l License your Qlik NPrinting deployment. See: Licensing Qlik NPrinting (page 145).
l Add at least one Qlik NPrinting Engine to the Qlik NPrinting scheduler service. See: Adding a Qlik NPrinting

Engine (page 170)

Installing Qlik NPrinting Engine via command line

Viewing command line arguments
To display a list of command line arguments, execute the following in the command line:

QlikNPrintingServer_x64.exe /help

QlikNPrintingEngine_x64.exe /help

/quiet install or uninstall means no UI is displayed.

/passive install or uninstall means a minimum UI with a progress bar is displayed, but no wizards or user
interaction.
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Install Qlik NPrinting Engine
Execute the following command in the command line as an administrator:

QlikNPrintingEngine_x64.exe /install {/quiet/passive} accept-eula=1 service-username="

{DOMAIN\USERNAME}" service-password="{USER_PASSWORD}" engine-certs-password="{CERTS_PASSWORD}"

server-hostname="{HOSTNAME}" [/log"{PATH_TO_LOG_FILE}"]

Example
QlikNPrintingEngine_x64.exe /install /passive accept-eula=1 service-username="qtsel\admin"

service-password="s3cr3t" engine-certs-password="s3cr3t" server-hostname="np-server" /log

".\engine.log"

Once you have installed Qlik NPrinting Engine successfully, you must:

l License your Qlik NPrinting deployment. See: Licensing Qlik NPrinting (page 145).
l Add at least one Qlik NPrinting Engine to the Qlik NPrinting scheduler service. See: Adding a Qlik NPrinting

Engine (page 170)

See also:

p Installing Qlik NPrinting Designer (page 168)

Installing Qlik NPrinting Designer
You need to install Qlik NPrinting Designer on all computers that you will use to develop report
templates. It can be installed on Qlik NPrinting Server or Qlik NPrinting Engine computers, or on
another computer.

Qlik NPrinting Designer retrieves information from the Qlik NPrinting repository. It can only be launched from Qlik
NPrinting web console. You must install Microsoft Office if you want to develop Excel, Word or PowerPoint
templates. No additional software is required to develop QlikEntity, PixelPerfect, or HTML templates with Qlik
NPrinting.

Qlik NPrinting Designer installs Microsoft .NET Framework 4.8.0. It must not be uninstalled.

.NET framework is installed when you install Qlik NPrinting Server, Qlik NPrinting Engine, or Qlik NPrinting
Designer. The installation of .NET framework requires an internet connection. If .NETframework is not already
installed on a computer without an internet connection, the installation stops. Before you begin the installation
of Qlik NPrinting Server, Qlik NPrinting Engine, or Qlik NPrinting Designer, you must install the .NET framework
on computers without an internet connection. If an internet connection is not available on a computer with .NET
framework already installed, the installer will skip this part of the installation.

Limitations
l Qlik NPrinting can only be installed on C drives.
l Qlik NPrinting Designer must be the same version as Qlik NPrinting Server.
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l You cannot run Qlik NPrinting Designer as a stand-alone application. Qlik NPrinting Designer must be used
with Qlik Sense or QlikView.

l To move from one version of Qlik NPrinting Designer to another, you must uninstall the older version
before installing Qlik NPrinting Designer. See: Uninstalling Qlik NPrinting Designer (page 185).

The Qlik NPrinting Designer installer will not automatically prevent an upgrade to run on the
system, but uninstalling and reinstalling Qlik NPrinting Designer is required for full functionality.

l You cannot install Qlik NPrinting Designer 17 on the same computer as the Qlik NPrinting Designer 16.
l Qlik NPrinting Designer is not compatible with Microsoft Office 365 web or mobile. It is compatible with

Microsoft Office 365 desktop.
l Local data such as logs, configuration files, template files, and newsstand files are stored in

C:\ProgramData\NPrinting. This location is not configurable.

Before you install, check that your environment meets the system requirements. .

Downloading the installation file
Download QlikNPrintingDesigner_x64.exe from the≤ Qlik Download Site

For more information, see Downloading installation files (page 155).

Installing Qlik NPrinting Designer
Do the following:

1. Double-click QlikNPrintingDesigner_x64.exe to launch the setup.

2. On the Qlik NPrinting Designer Setup Welcome screen, click Next.

3. Accept the terms in the license agreement and click Next.

4. On the Destination Folder screen, click Change if you want to install to a folder other than the default,
and click Next.

5. On the Ready to Install the Program screen, click Install.

6. If the User Account Control window appears, click Yes to proceed.

7. Click Finish.

Multi-engine sites
A single Qlik NPrinting scheduler service can manage multiple Qlik NPrinting Engines to distribute
the workload resulting in a high-availability reporting system.

In a multi-engine environment, report creation is distributed among engines, allowing many reports to be created
at the same time. If an engine fails, the Qlik NPrinting scheduler service will redistribute the workload to the other
active engines.
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You can install a single Qlik NPrinting Engine on each computer. The Qlik NPrinting Engine is multi-threaded so it
can use all available CPUs and cores. By default, only one Qlik NPrinting Engine is available for each Qlik
NPrinting Server license. If you want to add additional engines to your Qlik NPrinting environment, you need to
purchase them.

Engine manager
The Engine manager provides a single web interface to add, remove, monitor, and manage Qlik NPrinting
Engines. You can find it in the Qlik NPrinting web console, under the Admin menu.

Requirements
You must open the following ports:

l Outbound on the Qlik NPrinting Engine computer: 5672
l Inbound on Qlik NPrinting scheduler service computer: 5672, 4993, and 4994
l Outbound on Qlik NPrinting Server and inbound on all Qlik NPrinting Engines: 4997

Qlik NPrinting Engine status
A Qlik NPrinting Engine can be in the following states:

l Offline: the Qlik NPrinting Engine is configured but cannot accept new jobs.
l Online: the Qlik NPrinting Engine is ready to accept new jobs.
l Error: the Qlik NPrinting Engine has an issue.

Troubleshooting
If your QlikView Desktop installation on the Qlik NPrinting Engine computer does not have a valid license
activated, you will receive an error.

To resolve this error, activate QlikView Desktop for the user who runs the Qlik NPrinting Engine service, and then
re-activate the Qlik NPrinting Engine from the web console. See: Licensing Qlik NPrinting (page 145).

Adding a Qlik NPrinting Engine

You can add as many Qlik NPrinting Engines as you want to your Qlik NPrinting installation. You
must configure each new Qlik NPrinting Engine so that the Qlik NPrinting scheduler service can
distribute new jobs to it.

You must install the Qlik NPrinting Engine before you can use the Engine manager to add a new engine. For
detailed installation instructions, see Installing Qlik NPrinting Engine (page 162). You must enter the domain
computer name of the Qlik NPrinting scheduler service during the Qlik NPrinting Engine installation. If you don't
enter this information, you must uninstall and reinstall the Qlik NPrinting Engine.
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Requirements

You must open the following ports:

l On the Qlik NPrinting Engine computer: outbound port 5672
l On Qlik NPrinting scheduler service computer: inbound ports 5672, 4993 and 4994
l On Qlik NPrinting Server: outbound port 4997
l On all Qlik NPrinting Engines: inbound port 4997

You cannot add a Qlik NPrinting Engine that is already connected to a Qlik NPrinting scheduler service. A Qlik
NPrinting Engine that is already connected to a Qlik NPrinting scheduler service will appear as offline, and cannot
be used by the new connection.

Adding a new engine
Do the following:

1. From the Admin menu, select Engine manager.

2. Click Add engine.

3. Enter a Qlik NPrinting Engine Name.
For example, enter Engine 2.

4. Enter a Description.
This field is optional but can be helpful during system maintenance.

5. Ensure that the Enable check box selected.
If the check box is not selected, the new Qlik NPrinting Engine will be saved, but it will be ignored by the
Qlik NPrinting scheduler service.

6. Enter the domain name of the computer where the Qlik NPrinting Engine is installed.
For example, enter engine2.
To determine the computer name, open the System properties page and use the Computer name
parameter, without the domain name. You cannot use the IP address.

7. Click Add engine.

8. On the Edit engine page under Certificates, enter the Password you created during the Qlik NPrinting
Engine installation, and click Send certificates.

If multiple Qlik NPrinting Engines are added to the deployment, each engine must be configured
with the password used during the installation for that specific machine.

The new Qlik NPrinting Engine, appears in the list.

If the operation is successful, the engine status will be Offline and it will change to Online after few seconds.

Enabling and Disabling a Qlik NPrinting Engine
You can enable or disable Qlik NPrinting Engine using the Engine manager.

The Qlik NPrinting scheduler service will not use a disabled Qlik NPrinting Engine.
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To enable or disable a Qlik NPrinting Engine, log into the Qlik NPrinting Server web interface, and do the
following:

1. From the Admin menu, select Engine manager.

2. Select or deselect the Enabled check box.
A green box with a check mark indicates the Qlik NPrinting Engine is enabled.

Deleting a Qlik NPrinting Engine

When you delete a Qlik NPrinting Engine in Engine manager it can no longer be used.

We recommend disabling an Qlik NPrinting Engine to avoid this. See: Enabling and Disabling a Qlik NPrinting
Engine (page 171).

Do the following:

1. From the Admin menu, select Engine manager.

2. In the Engine manager page, click on the Qlik NPrinting Engine name to open the Edit engine page.

3. Click in the upper right corner.

4. Confirm the deletion when prompted.

The Qlik NPrinting Engine is deleted. This action cannot be undone.

Connecting Qlik NPrinting with Qlik Sense
You must connect your Qlik NPrinting installation to one or more Qlik Sense servers if you want
Qlik Sense charts in your reports. You can designate one Qlik Sense hub to receive Qlik NPrinting
reports.

The Qlik NPrinting Server folder with the Qlik Sense certificates (C:\Program
Files\NPrintingServer\Settings\SenseCertificates) is kept during upgrades, but is deleted if you uninstall Qlik
NPrinting.

This page outlines how to connect to a Qlik Sense server. To connect specific Qlik Sense apps to Qlik
NPrinting in order to create reports, see: Connecting to Qlik Sense apps (page 30).

Requirements
For Qlik Sense version compatibility, see Qlik Sense compatibility (page 127).

l In the QMC, you must give RootAdmin authorization to the Windows user that runs the Qlik NPrinting
Engine Windows service. That Windows user must also be a domain user. See: User accounts (page 136).
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l Microsoft Windows NTML authentication on the Qlik Sense proxy. SAML and JWT are not supported. If
your virtual proxy uses SAML or JWT authentication, you need to add a new virtual proxy with NTLM
enabled for Qlik NPrinting connections. The following must be correctly set up:

o A Qlik Sense proxy.
o A Qlik Sense virtual proxy.
o A link between the proxy and virtual proxy.
o The Qlik Sense virtual proxy must be reachable from the Qlik NPrinting Engine machines to retrieve

data to create reports. It must be reachable from the Qlik NPrinting Server to publish to the Qlik
Sense hub.

Limitations
l Connecting additional Qlik Sense servers will have an impact on Qlik NPrinting Server system resources.

You may need to increase the RAM and CPU usage on Qlik NPrinting Engine and Qlik NPrinting Server
computers if you connect to multiple Qlik Sense servers. See: Performance (page 152).

l Publishing to multiple Qlik Sense hubs it is not supported.
l Qlik Sense Desktop is not supported.

Validating the connection to Qlik Sense
Qlik NPrinting must validate the connection to Qlik Sense using certificates.

Certificates must be installed on the Qlik NPrinting scheduler service computer in order to distribute reports from
Qlik NPrinting to the Qlik Sense hub. Certificates must also be installed on all Qlik NPrinting Engine computers in
order to create connections to Qlik Sense apps. If the Qlik NPrinting scheduler service and Qlik NPrinting Engine
are installed on the same computer, you only need to install the certificates once.

Exporting the certificates from the QMC
Do the following:

1. Log into the QMC as a Qlik Sense administrator or a user with a RootAdmin access.

2. Select Certificates on the QMC start page or from the menu.
The Export page for Certificates is displayed.

3. In the Machine name box, type the full computer name of the Qlik NPrinting Server computer that you are
creating the certificates for: MYMACHINE.mydomain.com or the IP address.

4. Leave the Certificate password box empty.

5. Select .pfx file format in the Export file format for certificates drop-down list.

6. Click Export certificates in the action bar.

7. When the export is finished, the dialog Certificates exported is displayed. Certificates will be exported
to this disk location displays the target directory.
The default is: C:\ProgramData\Qlik\Sense\Repository\Exported Certificates\QlikNPrintingServerName

8. Go to this directory. You should see three files: client.pfx, server.pfx, and root.cer. These are the files that
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need to be installed in your Qlik NPrinting deployment.

If you are connecting to multiple Qlik Sense servers, you will need to repeat the export process for each server,
and rename the certificate files.

Installing Qlik Sense client certificates

This process is mandatory for all Qlik NPrinting deployments that connect to Qlik Sense data or hubs.

You need the client.pfx file that was exported during Exporting the certificates from the QMC (page 173). If you are
installing certificates from multiple Qlik Sense servers, the client.pfx file must be renamed with a unique name.
For example: YourQlikNPrintingServerName.pfx. Repeat this process for each Qlik NPrinting Engine. Each different
client.pfx must be given a unique name.

The certificate export process must be repeated on each Qlik Sense server you want to connect to Qlik NPrinting
Server and Qlik NPrinting Engine.

Do the following:

1. Receive the exported and renamed Qlik Sense certificates from your Qlik Sense system administrator.

2. Log into the Qlik NPrinting Server running the Qlik NPrinting scheduler service, as the Windows Qlik
NPrinting Server services administrator.

3. Add the certificates to C:\Program Files\NPrintingServer\Settings\SenseCertificates. Qlik NPrinting will
automatically identify the correct one to be used for each connection.

You should only keep active Qlik Sense certificates used by Qlik NPrinting connections in the
C:\Program Files\NPrintingServer\Settings\SenseCertificates folder.
We recommend that you remove any certificates that are not in use.

4. Repeat this process on each Qlik NPrinting Engine running the Qlik NPrinting Engine service, using the
Windows Qlik NPrinting Engine services administrator.

Additional user access allocation in Qlik Sense is not required for a user to view reports in the Qlik Sense hub.
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Configuring server certificate validation for Qlik Sense connections

This process is mandatory if you are Turning on server certificate validation (page 177) Turning on
server certificate validation is optional, but recommended.

Server certificate validation ensures that Qlik NPrinting only connects to trusted Qlik Sense servers for data
retrieval (getting data or images from a Qlik Sense app) and report publishing to Qlik Sense hubs. Installing these
certificates allows Qlik NPrinting to validate the connection to Qlik Sense.

Server certificate validation is tuned on by default for new Qlik NPrinting installations. If you upgrade
from previous Qlik NPrinting versions, this feature is turned off by default, to avoid disrupting any
previously configured Qlik Sense tasks. In this case, server certificate validation must be enabled
manually.

Requirements
l Installation locations: The Qlik Sense root.cer file must be installed on Qlik NPrinting Server and Qlik

NPrinting Engine machines, by someone logged in as the corresponding Windows Qlik NPrinting Server
services administrator or Windows Qlik NPrinting Engine services administrator (if certificates are being
installed for the Current user and not for Local machine).

l Fully Qualified Domain Names (FQDN): When Apply Qlik Sense server certificate validation is enabled,
only Fully Qualified Domain Names (FQDN) can be used to connect to Qlik Sense servers for both data
retrieval and report publishing.
All Qlik Sense connections and Qlik Sense hub proxy addresses must contain the full address: http
(s)://mysenseserver.mydomain.com/with_proxy_prefix_if_used.
The shorter address cannot be used: http(s)://mysenseserver/with_proxy_prefix_if_used. If a Qlik
Sense connection does not use FQDN proxy addresses, it must be manually changed by a Qlik NPrinting
Administrator.

Installing server certificates
You need the root.cer file that was exported during Exporting the certificates from the QMC (page 173). This is the
file that you need to install on the Qlik NPrinting Server and your Qlik NPrinting Engine machines. Server
certificates must be installed on:

l The Qlik NPrinting Server computer when Qlik Sense hub is used as a report publishing destination.
l Every Qlik NPrinting Engine machine if connections to Qlik Sense are used. Installing certificates on the

Engine machines is not required if QlikView is used exclusively to fetch data

If you are installing the certificates on a Qlik NPrinting Server, you must be logged in as a Windows Qlik
NPrinting Server services administrator. If you are installing the certificates on a Qlik NPrinting Engine
machine, you must be logged in as a Windows Qlik NPrinting Engine services administrator.

Do the following:
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1. Log into a Qlik NPrinting Server or Qlik NPrinting Engine with the correct services administrator account.

2. Double-click on the root.cer file you already copied and click Install Certificate….
This starts the Certificate Import Wizard.

3. The first dialog box will suggest that you install the certificate only for the Current User. This is either the
Server or Engine Windows service user account. If you choose Local Machine, the certificate will be
available to all users. Click Next.

4. Choose Place all certificates in the following store and then click Browse….

5. Select Trusted Root Certification Authorities and then click OK. Click Next.

6. Review your selections. They should match the image below, especially Certificate Store Selected by
User: Trusted Root Certification Authorities.
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7. Click Finish.

8. A Security Warning dialogue may appear. If so, read it and click Yes.

You will see a message informing you that the import was successful. Ensure that all Qlik NPrinting connections
and, if used, the Qlik Sense publish to hub proxy address, use FQDN. For more information, see Requirements
(page 172).

Once you have installed the certificates on the required Qlik NPrinting Server and Qlik NPrinting Engine
machines, you are ready to manually enable the feature.

Turning on server certificate validation

If you are installing Qlik NPrinting for the first time, you can skip this section, because server certificate
validation will be turned on by default.
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After you turn on server certificate validation, if the corresponding Qlik Sense root.cer certificate files were not
properly installed on Qlik NPrinting Server and each Qlik NPrinting Engine machine, any configured task that uses
a Qlik Sense connection will fail when executed.

Do the following:

1. Log into Qlik NPrinting web console as an Administrator.

2. In the top menu, go to Admin > Settings >Task.

3. In the Security section, click the Apply Qlik Sense server certificate validation checkbox.

4. Click the Update button.

Once this feature is turned on, a message will appear at the bottom of every Qlik Sense connection page and Qlik
Sense hub destination setup page.

Sense hub destination setup page with note at the bottom explaining that server certificate validation will be applied.

Connecting Qlik NPrinting with QlikView
You must connect your Qlik NPrinting installation to QlikView if you want QlikView charts in your
reports.

QlikView documents can be saved in local folders, on network shared folders, or on a QlikView Server.

This page outlines how to connect to a QlikView server. To connect specific QlikView documents to Qlik
NPrinting in order to create reports, see: Connecting to QlikView documents (page 21).

Requirements

QlikView Desktop
QlikView Desktop is required on the Qlik NPrinting Engine computer. QlikView Server and QlikView Desktop must
be the exact same version, including the release number. QlikView Desktop must be installed locally on the same
physical or virtual computer as the Qlik NPrinting Engine. QlikView Desktop is not required if you are only
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connecting to Qlik Sense apps.

For QlikView version compatibility, see QlikView compatibility (page 127).

Your Qlik NPrinting version must be equal to or higher than your QlikView version.

QlikView Server
To generate reports using QlikView Server connections, the following are required:

l Access to at least one QlikView Server.
l The Windows user that runs the Qlik NPrinting Engine Windows service must belong to the QlikView

Administrators Windows group on the QlikView Server computer.
l To configure Qlik NPrinting for NTFS authorization, it must be configured in the Qlik Management

Console. This means that the Windows operating system controls the file (document) access for users and
groups through the NTFS security settings.

l To configure Qlik NPrinting for DMS authorization QlikView controlled file access, see: JWT authentication
(page 222).

QlikView Cluster
To generate reports using QlikView Cluster connections, the following are required:

l Access to at least one QlikView Server.
l The Windows user that runs the Qlik NPrinting Engine Windows service must belong to the QlikView

Administrators Windows group on the QlikView Server computer.
l To configure Qlik NPrinting for NTFS authorization, it must be configured in the Qlik Management

Console. This means that the Windows operating system controls the file (document) access for users and
groups through the NTFS security settings.

l To configure Qlik NPrinting for DMS authorization QlikView controlled file access, see: JWT authentication
(page 222).

To create a connection to a QlikView Cluster, the user that runs the Qlik NPrinting Engine service must:

l Be a domain user.
l Be part of QlikView Administrators security group in all the nodes of the cluster.
l Be part of QlikView Management API security group in the computer where QMS runs.

Section access
If you are using section access, the following are required:

l Connections must be configured to use server authentication.
l A domain account must be configured in user settings, independent of the authentication type enabled in

the Qlik NPrinting general settings.
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Section access is not fully supported for local QlikView documents. If you connect to a local QlikView
document with section access, report recipients will see all available data, as if section access was not
applied. You must use Qlik NPrinting filters or connect to documents via QlikView Server to ensure users
only receive permitted data.

Licensing
To start the Qlik NPrinting service and connect to QlikView, you must have one of the following:

l A named user Client Access License (CAL) that is manually assigned to the Qlik NPrinting Engine service
user active directory account, on the QlikView Server.

l A local QlikView Desktop license.

Users connecting through the API must be members of the QlikView Management API security group. The group is
not created during the installation and must be added and populated manually, for example, with the members
of the QlikView Administrators group.

Limitations
You cannot use the same user to run a QlikView service and Qlik NPrinting service.

Differences between QlikView server and local QlikView connections
There are benefits to connecting to a QlikView server:

l Better performance
l More stability
l Section access
l Increased security
l Automatic data refreshes (no need to trigger a metadata reload)

Installing Qlik NPrinting and Qlik Sense on the same computer
Installing Qlik Sense and Qlik NPrinting on the same computer is not a supported configuration. In
a production environment, Qlik NPrinting Server and Qlik NPrinting Engine will consume all of the
available resources of the computer that they are installed on. If Qlik Sense is installed on the same
computer as Qlik NPrinting Qlik Sense may crash due to a lack of available resources, and no
reports will be delivered. Currently, Qlik NPrinting Server, Qlik NPrinting Engine and Qlik Sense do
not have an internal system to limit their usage or resources.

There are no known incompatibilities between Qlik NPrinting and Qlik Sense, but in a production
environment, Qlik NPrinting requires a separate computer (virtual or physical) from Qlik Sense.
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In some circumstances, such as for demonstrations, you may choose to install the Qlik NPrinting Server, Qlik
NPrinting Engine, and Qlik Sense on the same computer. It is also possible to run Qlik Sense and Qlik NPrinting
together on an AWS (Amazon Web Service) computer by doing some additional configuration.

We do not recommend using this configuration for a proof of concept, because it could return false results. The
concurrent usage of resources by Qlik NPrinting and Qlik Sense could cause the system to fail. This does not
happen in a correctly configured production environment.

To limit the effects of contextual usage of resources:

l Assign more hardware resources (more RAM, more CPUs) to a virtual machine.
l Reboot the computer often so that resources are released.

These suggestions do not completely resolve this problem.

Do the following:

1. Install Qlik Sense.
Installing Qlik Sense Enterprise on Windows

2. Install Qlik NPrinting Server and Qlik NPrinting Engine.
Installing Qlik NPrinting Server
Installing Qlik NPrinting Engine
Qlik NPrinting Designer can be installed on the same computer (virtual or physical) as Qlik Sense, Qlik
NPrinting Engine, or on a different one.

3. Install the Qlik Sense certificates.
Installing Qlik Sense certificates
You only need to install the client.pfx certificate. You must use the same Windows account set in the Qlik
NPrinting Engine Windows service.

4. From the Qlik NPrinting web console, connect the Qlik NPrinting Engine with the Qlik NPrinting scheduler
service local node.
Adding a Qlik NPrinting Engine

5. Create a Qlik NPrinting connection to a Qlik Sense app.
Creating connections
Remember to use the computer name, because using localhost is not supported. To find the correct
computer name of an AWS (Amazon Web Services) computer, see Additional configuration for AWS
computers (page 181).

Additional configuration for AWS computers
For all Qlik NPrinting connections to Qlik Sense, the proxy address must be the address of the Certificate
Authority created by Qlik Sense.

To find the address of the Certificate Authority on the AWS (Amazon Web Services) computer, do the following:

1. Open a command prompt.

2. Run mmc.exe.
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3. In the File menu, click on Add/Remove snap in.

4. Select Certificates in the Snap-in column

5. Click Add.

6. Select Computer account.

7. Click Next.

8. Click Finish.

9. Click Ok.

10. Expand the Certificates (Local Computer) node by clicking on the symbol.

11. Select Personal.

12. The computer name you require appears in the Issued By column and it ends with -CA. For example, you
may find an Issued By value like ip-123-31-38-88.ec2.internal-CA, so you must use ip-123-31-38-
88.ec2.internal as the computer address to connect to.

When creating a Qlik NPrinting connection to Qlik Sense, the computer address must be preceded by https://.

The above steps are mandatory because on AWS (Amazon Web Services) computers Qlik Sense produces its
certificates by using a specific network interface, which is not the public Amazon computer name, or the
computer name.

Uninstalling Qlik NPrinting Server
You can uninstall the Qlik NPrinting Server using the user interface or the command line interface
(CLI).

Configuration files
The Qlik NPrinting uninstallation process deletes the app.conf proxy configuration files:

l %ProgramData%\NPrinting\newsstandproxy\app.conf
l %ProgramData%\NPrinting\webconsoleproxy\app.conf

If you re-install Qlik NPrinting, either in the same computer or in another, you will need to re-apply all the edited
settings.

You can keep a copy of the files to record which configuration options were changed. Do not overwrite any
app.conf configuration file with an older version as some configuration options may be different. You can
overwrite the app.conf configuration files only if the replacement is from the same release of Qlik NPrinting.

The proxy configuration files for Qlik NPrinting 17.3, including service releases, had the following paths:

l %ProgramFiles%\NPrintingServer\proxy\newsstandproxy\src\qlik.com\newsstandproxy\conf\app.conf
l %ProgramFiles%\NPrintingServer\proxy\webconsoleproxy\src\qlik.com\webconsoleproxy\conf\app.conf

Stopping Qlik NPrinting Windows services
Qlik NPrinting services must be stopped before you uninstall Qlik NPrinting Server, because the services could be
using files that must be removed.
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Do the following:

1. Open services.msc.

2. Scroll-down the list until you find the Qlik NPrinting services.

3. Stop the Qlik NPrinting Windows services (by right-clicking them, and then clicking Stop) in the following
order:

1. Only if it is installed, stop Qlik NPrintingEngine

2. Qlik NPrintingScheduler

3. Qlik NPrintingWebEngine

4. Qlik NPrintingRepoService

5. Qlik NPrinting messaging service

4. Close services.msc.

Uninstalling Qlik NPrinting Server via user interface
1. In Windows, open the program uninstaller from the Control Panel.

2. Right-click Qlik NPrinting Server, and then select Uninstall.

3. Click Uninstall to proceed.

4. Click Close.

All Qlik NPrinting Windows services are uninstalled and no longer appear under services.

Uninstalling Qlik NPrinting Server via command line

Viewing command line arguments
To display a list of command line arguments, execute the following in the command line:

QlikNPrintingServer_x64.exe /help

QlikNPrintingEngine_x64.exe /help

/quiet install or uninstall means no UI is displayed.

/passive install or uninstall means a minimum UI with a progress bar is displayed, but no wizards or user
interaction.

Uninstall Qlik NPrinting Server
Execute the following command in the command line as an administrator:

QlikNPrintingServer_x64.exe /uninstall {/quiet|/passive}

Example
QlikNPrintingServer_x64.exe /uninstall /passive

Uninstall Erlang OTP and Microsoft .NET Framework 4.6.2 via user interface
Do the following:

1. In Windows, open the program uninstaller from the Control Panel.

2. Scroll down the list until you find Microsoft .NET Framework 4.6.2.
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3. Right-click on it and select Uninstall.

4. Repeat the process for Erlang OTP.

Uninstalling Qlik NPrinting Engine
You can uninstall the Qlik NPrinting Engine using the user interface or the command line interface
(CLI).

Stopping Qlik NPrinting Engine Windows service
Qlik NPrinting Engine service must be stopped before you uninstall Qlik NPrinting Engine, because the service
could be using files that must be removed.

Do the following:

1. Open services.msc.

2. Scroll-down the list until you find the Qlik NPrinting Engine service.

3. Select the service Qlik NPrinting Engine.

4. Right-click on it and select Stop.

5. Close services.msc.

Uninstalling Qlik NPrinting Engine via user interface
Do the following:

1. In Windows, open the program uninstaller from the Control Panel.

2. Scroll down the list until you find Qlik NPrinting Engine.

3. Right-click on it and select Uninstall.

4. Click Uninstall to proceed.

Uninstalling Qlik NPrinting Engine via command line

Viewing command line arguments
To display a list of command line arguments, execute the following in the command line:

QlikNPrintingServer_x64.exe /help

QlikNPrintingEngine_x64.exe /help

/quiet install or uninstall means no UI is displayed.

/passive install or uninstall means a minimum UI with a progress bar is displayed, but no wizards or user
interaction.

Uninstall Qlik NPrinting Engine
Execute the following command in the command line as administrator:

QlikNPrintingEngine_x64.exe /uninstall {/quiet|/passive}

Example
QlikNPrintingEngine_x64.exe /uninstall /passive
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Uninstalling Qlik NPrinting Designer
To uninstall Qlik NPrinting Designer, you must log in as a Windows administrator.

Uninstall Qlik NPrinting Designer
Do the following:

1. In Windows, open the program uninstaller from the Control Panel.

2. Scroll down the list until you find Qlik NPrinting Designer.

3. Right-click on it and select Uninstall.

Uninstall Microsoft .NET Framework
Microsoft .NET Framework is widely used, so before you uninstall it make sure that it is not used by other
software installed on your computer. The Qlik NPrinting Designer uninstall does not remove Microsoft .NET
Framework. It must be uninstalled separately.

Do the following:

1. In Windows, open the program uninstaller from the Control Panel.

2. Scroll down the list until you find Microsoft .NET Framework [version].
[version] will be a number, for example: 4.8.

3. Right-click on it and select Uninstall.

4. Select the radio button to Remove .NET Framework from this computer.

5. Click Continue when the warning message appears.

Uninstall PDF-XChange 2012
PDF-XChange 2012 is the PDF virtual printer installed by Qlik NPrinting Engine.

PDF-XChange is used to create PDFs from QlikEntity reports. PDF-XChange is not required for creating PDFs from
other types of reports. If you do not use QlikEntity templates, you can uninstall PDF-XChange.

Do the following:

1. In Windows, open the program uninstaller from the Control Panel.

2. Scroll down the list until you find PDF-XChange 2012.

3. Right-click on it and select Uninstall.

4. Confirm that you want to remove PDF-XChange 2012 by clicking Yes. Wait until the uninstall finishes.

5. You can restart the computer immediately by clicking on Yes or later by clicking on No. You must restart
the computer in order to complete the PDF-XChange 2012 uninstall.

Uninstalling Qlik NPrinting (complete uninstallation)
Before starting, back up the NPrinting repository. See Backing up Qlik NPrinting (page 193) for details.

Configuration files
The Qlik NPrinting uninstallation process deletes the app.conf proxy configuration files:
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l %ProgramData%\NPrinting\newsstandproxy\app.conf
l %ProgramData%\NPrinting\webconsoleproxy\app.conf

If you re-install Qlik NPrinting, either in the same computer or in another, you will need to re-apply all the edited
settings.

You can keep a copy of the files to record which configuration options were changed. Do not overwrite any
app.conf configuration file with an older version as some configuration options may be different. You can
overwrite the app.conf configuration files only if the replacement is from the same release of Qlik NPrinting.

The proxy configuration files for Qlik NPrinting 17.3, including service releases, had the following paths:

l %ProgramFiles%\NPrintingServer\proxy\newsstandproxy\src\qlik.com\newsstandproxy\conf\app.conf
l %ProgramFiles%\NPrintingServer\proxy\webconsoleproxy\src\qlik.com\webconsoleproxy\conf\app.conf

Uninstall Qlik NPrinting
Do the following:

1. Disable any antivirus or malware protection software that may prevent complete uninstallation of the
product. It can be enabled with proper exclusions later for production.

2. Open the Microsoft Windows Control Panel and navigate to Program and Features. Uninstall the
following programs, in this order:

1. Qlik NPrinting Server

2. Qlik NPrinting Designer

3. Qlik NPrinting Engine
To uninstall a program, right-click the program and select Uninstall. Wait until the uninstall finishes.

3. To avoid possible errors during Qlik NPrinting re-installation on the same computer, it may be necessary
to perform manual steps to complete the uninstallation of Erlang and Rabbit. See Qlik NPrinting re-
installation errors (page 550)for details.

Uninstall Microsoft .NET Framework 4.6.2
Do the following:

1. Open the Microsoft Windows Control Panel and navigate to Program and Features.

2. Scroll down the list until you find Microsoft .NET Framework 4.6.2.

3. Right-click on it and select Uninstall. Wait until the uninstall finishes.

3.3 Planning your upgrade
You must follow one of the approved upgrade paths to ensure that the Qlik NPrinting repository is
rendered compatible with the newer version of Qlik NPrinting. If you try to upgrade Qlik NPrinting
without following an approved upgrade path, the installer will stop the procedure and display an
error message.
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As a best practice, you should update your Qlik NPrinting deployment regularly, to ensure you are using a
supported version.

You must back up your data before you proceed. Data can become damaged if a problem occurs during the
upgrade. If data is damaged, a backup is required to restore the repository. For more information, see Backup
and restore Qlik NPrinting (page 192).

If you want to import QlikView NPrinting 16 entities into Qlik NPrinting November 2019 or newer. For
more information, see Migrating (page 105).

If you are upgrading from a version older than February 2018, all QlikView and Qlik Sense metadata caches will be
marked as "not generated". This is due to a breaking change in the format of the metadata cache. All connection
caches must be regenerated before you can edit a template or create a new connection.

Upgrading from April 2018 or newer
You can upgrade from Qlik NPrinting April 2018 (18.9.5) or later using the Qlik NPrinting setup program. For more
information, see Upgrading Qlik NPrinting (page 189).

If you want to upgrade to May 2022 or later you must start from April 2018 or later.

Upgrading from September 2018 SR2 or older
If you are upgrading from September 2018 SR2 or older you must:

1. Open port 4997 outbound on Qlik NPrinting Server and inbound on all Qlik NPrinting Engines.

2. Reinstall all your Qlik NPrinting Engine and provide a password for certificate exchange.

3. Open the Engine manager in the Web Console.

4. Open the detail page for each Engine and send the certificate after inserting the same password you used
during the engine’s re-installation.

Qlik NPrinting Engines stay offline until the certificate exchange is performed.

Upgrade paths from version 17.3 to Qlik NPrinting June 2017 or newer
The following information applies if you are upgrading to Qlik NPrinting June 2017 or later.

To upgrade to Qlik NPrinting June 2017 or later you must start from any previous version of Qlik NPrinting in the
17.3 series or later. You cannot upgrade to Qlik NPrinting June 2017 or later from a version older than 17.3. For
example, if you have installed Qlik NPrinting 17.1 you must first upgrade to 17.2 and then to 17.3 before
upgrading to Qlik NPrinting June 2017 or later.

Upgrade paths from version 17.2 to version 17.3
The following information applies if you are upgrading Qlik NPrinting to version 17.3 or 17.3.1.
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Qlik NPrinting 17.3 has increased the number of supported upgrade paths. To upgrade to Qlik NPrinting 17.3.0
you must start from any version of Qlik NPrinting in the 17.2 series. You cannot upgrade to Qlik NPrinting 17.3
from a version older then 17.2. For example, if you have installed Qlik NPrinting 17.1 you must first upgrade it to
17.2 before upgrading to 17.3.

The following upgrade paths are supported:

Current Qlik NPrinting version Upgrade to

17.2.0 Qlik NPrinting 17.3.0

17.2.1 Qlik NPrinting 17.3.0

17.2.2 Qlik NPrinting 17.3.0

17.2.3 Qlik NPrinting 17.3.0

17.3.0 Qlik NPrinting 17.3.1

 Upgrade paths

You must upgrade to version 17.3.0 before you can upgrade to version 17.3.1.

Upgrade paths from version 17.0 to 17.2
The following information applies if you are upgrading Qlik NPrinting to a version earlier than 17.3.

A Qlik NPrinting feature release must be upgraded to the next successive feature or service release. A Qlik
NPrinting service release must be upgraded to the next successive service release. You cannot upgrade a service
release directly to next major feature release. For example, from 17.0.1 you must upgrade to 17.0.2, then to
17.0.3, etc, without skipping any releases.

If the installed version is the final service release before a major feature release, you can upgrade it to the next
feature release. For example, 17.0.5 is the final service release of the 17.0 series and you can upgrade it to 17.1.

You can not skip a major feature release. For example, you can not upgrade directly from 17.0.5 to 17.2. The
previous feature release 17.1 must be installed before upgrading to 17.2.

Qlik NPrinting messaging service upgrade
Starting with Qlik NPrinting 17.2.1, the Qlik NPrinting Server upgrade removes RabbitMQ and replaces it with the
Qlik NPrinting messaging service. It is not possible to keep RabbitMQ installed on the same computer as Qlik
NPrinting Server 17.2.1 or later.

Repository database backups
The Qlik NPrinting upgrade process will attempt to close the Qlik NPrinting Windows services and stop the
processes automatically. However, under some circumstances, not all services and processes are stopped
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successfully. If you attempt to upgrade Qlik NPrinting with the services and process still running, it can result in
repository data being lost. Therefore, it is important to check that the services are stopped before proceeding
with an upgrade, and close them manually if necessary.

The Qlik NPrinting upgrade process creates two backups of the repository :

l Backup before updating the repository.
The name is composed by concatenating a timestamp (YearMonthDayTime) with the fixed string _
nprinting17.2.0.0_backup_old.zip (for example 201611180947162456_nprinting17.2.0.0_backup_old.zip).

l Backup after updating the repository.
The name is composed by concatenating a timestamp (YearMonthDayTime) with the fixed string _
nprinting17.2.1.0_backup_new.zip (for example 201611180947162456_nprinting17.2.1.0_backup_new.zip).

Both backup files are stored in the folder %ProgramData%\NPrinting by default.

For example, if you are upgrading from Qlik NPrinting 17.2.0.0 to 17.2.1.0, Qlik NPrinting creates a backup
201611180947162456_nprinting17.2.0.0_backup_old.zip before making any changes to the repository database,
and a backup 201611180947162456_nprinting17.2.1.0_backup_new.zip after upgrading the repository database. If,
for any reason, you want to re-install Qlik NPrinting 17.2.0.0, you must restore the backup 201611180947162456_
nprinting17.2.0.0_backup_old.zip.

We strongly recommend that you also manually create a backup before upgrading.

Upgrading Qlik NPrinting
You can upgrade from Qlik NPrinting April 2018 (18.9.5) or later using the Qlik NPrinting setup
program. When upgrading, the previous version is completely replaced by the new version.

To upgrade from versions older than April 2018, see Planning your upgrade (page 186)

You cannot upgrade from QlikView NPrinting 16 using the setup program. To upgrade from QlikView
NPrinting 16, see Planning your migration (page 105).

Configuration files
The content of the following files is overwritten during the upgrade process:

l NewsStand proxy configuration file
%ProgramFiles%\NPrintingServer\proxy\newsstandproxy\src\qlik.com\newsstandproxy\conf\app.conf

l Qlik NPrinting web console proxy configuration file
%ProgramFiles%\NPrintingServer\proxy\webconsoleproxy\src\qlik.com\webconsoleproxy\conf\app.conf

If you have made custom configurations in either of these files in your existing Qlik NPrinting deployment, you
must recreate them manually after an upgrade.
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We recommend recreating custom configurations in the files after upgrading instead of copying the Qlik
NPrinting app.conf files from a previous deployment and using them in the upgraded installation
because the upgraded files could include some different settings. You can compare a copy of the
existing Qlik NPrintingapp.conf files with the upgraded versions to ensure that no custom configurations
are lost.

When you upgrade to Qlik NPrinting April 2018 or later the following new folders are created automatically:

l %ProgramData%\NPrinting\newsstandproxy\
l %ProgramData%\NPrinting\webconsoleproxy\

A copy of the app.conf file, with everything commented, is inserted in each folder. Settings that are not
commented in the app.conf files have a higher priority than the old files, so they will overwrite the same settings
in the older files. After the first upgrade the settings in the new app.conf files will be kept.

Upgrading via user interface
Do the following:

1. Confirm that you have a current backup of the repository.

You must back up your data before you continue. Data can be damaged if a problem occurs
during the upgrade, so it is necessary to have backup to restore the repository from . See
Backup and restore a repository.

2. Open Windows Services.

3. Stop the following Qlik NPrinting services by right-clicking them, and then clicking Stop:
l Qlik NPrinting Engine
l Qlik NPrinting Scheduler
l Qlik NPrinting WebEngine
l Qlik NPrinting MessagingService
l Qlik NPrinting RepoService
l Qlik NPrinting License Service

4. Close Windows Services.
Windows stops the services only after you close this program, so do not keep it open.

Proceed only when you are sure that all the services mentioned are stopped or the repository
may be damaged. If any of these services are left running during upgrade, the upgrade can fail,
and it may be necessary to restore data from backup.

5. Open the Windows Task Manager, then do the following:

a. Browse to the Processes tab.

b. Click on Show processes from all users to be sure to see all working processes.
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c. If any of the following processes is running, terminate it by right clicking on it and choosing End
process tree:

l Qlik.NPrinting.Engine.exe
l Qlik.NPrinting.Scheduler.exe
l Qlik.NPrinting.WebEngine.exe
l Qlik.NPrinting.Cefsharp.exe. If you see more than one process with this name, select the

one owned by the Windows user of the Qlik NPrinting services.
l webconsoleproxy.exe
l newsstandproxy.exe
l Qlik.NPrinting.License.exe
l licenses.exe

Proceed only when you are sure that all previous processes are stopped or the repository
may be damaged.

If you attempt to upgrade Qlik NPrinting while the Windows services and process are
running, it can result in a installation failure, so it is important to check before
proceeding, and stop them manually if necessary.

6. Install Qlik NPrinting as described in Installing Qlik NPrinting.

7. Check all Qlik NPrinting services are running after the upgrade is complete. It may be necessary to start
them manually.

When you install or upgrade your Qlik NPrinting Server, Qlik NPrinting Engines, and Qlik NPrinting
Designer, ensure that they are all the same software version. Mixing versions of Qlik NPrinting
components is not supported.

Upgrading via command line

Viewing command line arguments
To display a list of command line arguments, execute the following in the command line:

QlikNPrintingServer_x64.exe /help

QlikNPrintingEngine_x64.exe /help

/quiet install or uninstall means no UI is displayed.

/passive install or uninstall means a minimum UI with a progress bar is displayed, but no wizards or user
interaction.

Upgrade Qlik NPrinting Server
Execute the following command in the command line as an administrator:
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QlikNPrintingServer_x64.exe /install {/quiet|/passive} accept-eula=1 service-username="

{DOMAIN\USERNAME}" service-password="{USER_PASSWORD}" [/log"{PATH_TO_LOG_FILE}"]

Example
QlikNPrintingServer_x64.exe /install /passive accept-eula=1 service-username="qtsel\admin"

service-password="s3cr3t" /log ".\server.log"

Upgrade Qlik NPrinting Engine
Execute the following command in the command line as an administrator:

QlikNPrintingEngine_x64.exe /install {/quiet/passive} accept-eula=1 service-username="

{DOMAIN\USERNAME}" service-password="{USER_PASSWORD}" engine-certs-password="{CERTS_PASSWORD}"

server-hostname="{HOSTNAME}" [/log"{PATH_TO_LOG_FILE}"]

Example
QlikNPrintingEngine_x64.exe /install /passive accept-eula=1 service-username="qtsel\admin"

service-password="s3cr3t" engine-certs-password="s3cr3t" server-hostname="np-server" /log

".\engine.log"

Troubleshooting - Canceling an upgrade
The rollback that follows a Qlik NPrinting Server or Qlik NPrinting Engine upgrade cancellation may corrupt the
related Qlik NPrinting installation. A rollback is triggered by errors or by clicking the cancel button during the
upgrade execution. After a corruption caused by a rollback, services may be uninstalled or cannot be started. You
will need to restore the Engine and Server.

Restoring Qlik NPrinting Server to its original status
Do the following:

1. Retrieve a recent backup.

2. Uninstall Qlik NPrinting Server. For more information, see: Uninstalling Qlik NPrinting Server (page 182)

3. Perform a clean installation of the same Qlik NPrinting Server as the backup.

4. Restore the backup.

Restoring Qlik NPrinting Engine to its original status
Do the following:

1. Uninstall Qlik NPrinting Engine. For more information, see:Uninstalling Qlik NPrinting Engine (page 184)

2. Perform a clean installation of Qlik NPrinting Engine.

3.4 Backup and restore Qlik NPrinting
We recommend that you create regular backups to ensure that your Qlik NPrinting deployment can
be recovered in the event of a system failure or when a node in your deployment needs to be
moved or replaced.

When you create a backup of your Qlik NPrinting deployment, the key component that you are backing up is the
Qlik NPrinting repository. For more information, see Architecture (page 131).
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A Qlik NPrinting backup can only be restored to an installation of the exact same version of Qlik
NPrinting because Qlik NPrinting repository structures may differ between versions of Qlik NPrinting.

If you want to upgrade and migrate your data between versions of Qlik NPrinting, you must follow the
instructions for upgrading. For more information, see Upgrading Qlik NPrinting (page 189).

Qlik NPrinting is delivered with a utility, Qlik.Nprinting.Manager.exe, that is used to create backups and restore
deployments. The Qlik.NPrinting.Manager.exe file is installed by default, and is located in %Program
Files%\NPrintingServer\Tools\Manager. This tool is a console application and must be executed from a command
prompt. The resulting backup contains a Qlik NPrinting repository database dump file, and related files in a .zip
archive.

Backing up Qlik NPrinting
Qlik NPrinting is delivered with a utility, Qlik.Nprinting.Manager.exe, that is used to create backups
and restore deployments.

Qlik.NPrinting.Manager.exe is installed by default, and is located in %Program
Files%\NPrintingServer\Tools\Manager. This tool is a console application and must be executed from a command
prompt. The resulting backup contains a Qlik NPrinting repository database dump file, and related files in a .zip
archive.

Accessing the command line help
Enter one of the following commands to see the command line help for the Qlik.NPrinting.Manager.exe:

l Qlik.Nprinting.Manager.exe --help for general help
l Qlik.Nprinting.Manager.exe backup --help for help with backups
l Qlik.Nprinting.Manager.exe restore --help for help with restoring from a backup

Before you begin:

l Check to see if Qlik NPrinting Engine is installed on the Qlik NPrinting Server computer where you are
creating the backup.

l Verify the location of your PostgreSQL installation, typically C:\Program Files\NPrintingServer\pgsql\bin.
l Verify that you know the superuser password for the PostgreSQL database.
l Delete, move, or rename any existing backup files if this is not the first backup created, as the tool will not

overwrite an existing file with the same name.

Do the following:

1. On the computer that hosts your Qlik NPrinting Server installation, open the Windows Service Manager
(services.msc), and stop the following services in the order listed, by right-clicking on the service then
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selecting Stop:

a. Qlik NPrintingEngine (if installed on the computer)

b. Qlik NPrintingScheduler

c. Qlik NPrintingWebEngine

Qlik NPrintingRepoService must be running to create a backup.

2. Using Windows Explorer, create a folder to store the backups in, for example C:\NPrintingBackups.

3. Open a Windows command prompt (cmd.exe) as administrator, and navigate to the folder where
Qlik.NPrinting.Manager.exe is installed. The default location is %Program
Files%\NPrintingServer\Tools\Manager. For example:
cd C:\Program Files\NPrintingServer\Tools\Manager

4. Enter Qlik.Nprinting.Manager.exe backup -f followed by the full path to the backup folder
that you created in step 2, then concatenate -p followed by the full path to the PostgreSQL bin folder.
Also concatenate the option --pg-password followed by the repository database superuser password
that you defined during setup. For example:
Qlik.Nprinting.Manager.exe backup -f C:\NPrintingBackups\NP_Backup.zip -p

"C:\Program Files\NPrintingServer\pgsql\bin" --pg-password secretPassword

Adding the repository database superuser password into the command line is optional. If you do
not enter the superuser password, it will be read from the Qlik NPrinting configuration files.

Quotation marks are necessary when you have spaces in the path.

5. Read the messages displayed on the console carefully as they provide important status and error
information.
When the backup is complete, you will see a .zip file named NP_Backup.zip in the folder that you created
in step 2 above, for example C:\NPrintingBackups.

6. Verify that your backup was successful by navigating to the folder that you created in step 2 above, and
checking that the .zip file is there.

Before you create a new backup, you must delete, move, or rename any existing backup file, as the tool
will not overwrite an existing file with the same name.

Backing up the Qlik NPrinting audit trail
You can backup your Audit trail (page 272) with the Qlik.Nprinting.Manager.exe.

If you need to backup your Qlik NPrinting deployment, see Backing up Qlik NPrinting (page 193).
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Qlik.NPrinting.Manager.exe is installed by default, and is located in %Program
Files%\NPrintingServer\Tools\Manager. This tool is a console application and must be executed from a command
prompt. The resulting backup contains a Qlik NPrinting audit trail database dump file, and related files in a .zip
archive.

Accessing the command line help
Enter one of the following commands to see the command line help for the Qlik.NPrinting.Manager.exe:

l Qlik.Nprinting.Manager.exe --help for general help
l Qlik.Nprinting.Manager.exe audit-backup --help for help with backups
l Qlik.Nprinting.Manager.exe audit-restore --help for help with restoring from a backup

Before you begin:

l Check to see if Qlik NPrinting Engine is installed on the Qlik NPrinting Server computer where you are
creating the backup.

l Verify the location of your PostgreSQL installation, typically C:\Program Files\NPrintingServer\pgsql\bin.
l Verify that you know the superuser password for the PostgreSQL database.
l Delete, move, or rename any existing backup files if this is not the first backup created, as the tool will not

overwrite an existing file with the same name.

Do the following:

1. On the computer that hosts your Qlik NPrinting Server installation, open the Windows Service Manager
(services.msc), and stop the following services in the order listed, by right-clicking on the service then
selecting Stop:

a. Qlik NPrintingEngine (if installed on the computer)

b. Qlik NPrintingScheduler

c. Qlik NPrintingWebEngine

d. Qlik NPrintingAuditService

Qlik NPrintingRepoService must be running to create a backup.

2. Using Windows Explorer, create a folder to store the backups in, for example C:\NPrintingBackups.

3. Open a Windows command prompt (cmd.exe) as administrator, and navigate to the folder where
Qlik.NPrinting.Manager.exe is installed. The default location is %Program
Files%\NPrintingServer\Tools\Manager. For example:
cd C:\Program Files\NPrintingServer\Tools\Manager

4. Enter Qlik.Nprinting.Manager.exe audit-backup -f followed by the full path to the backup
folder that you created in step 2, then concatenate -p followed by the full path to the PostgreSQL bin
folder. Also concatenate the option --pg-password followed by the repository database superuser
password that you defined during setup. For example:
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Qlik.Nprinting.Manager.exe audit-backup -f C:\NPrintingBackups\NP_Audit_

Backup.zip -p "C:\Program Files\NPrintingServer\pgsql\bin" --pg-password

secretPassword

Quotation marks are necessary when you have spaces in the path.

5. Read the messages displayed on the console carefully as they provide important status and error
information.
When the backup is complete, you will see a .zip file named NP_Backup.zip in the folder that you created
in step 2 above, for example C:\NPrintingBackups.

6. Verify that your backup was successful by navigating to the folder that you created in step 2 above, and
checking that the .zip file is there.

Before you create a new backup, you must delete, move, or rename any existing backup file, as the tool
will not overwrite an existing file with the same name.

Restoring Qlik NPrinting from a backup
Qlik NPrinting is delivered with a utility, Qlik.Nprinting.Manager.exe, that is used to create backups
and restore deployments.

Qlik.NPrinting.Manager.exe is installed by default, and is located in %Program
Files%\NPrintingServer\Tools\Manager. This tool is a console application and must be executed from a command
prompt. The resulting backup contains a Qlik NPrinting repository database dump file, and related files in a .zip
archive.

Command line help
To see the command line help for the Qlik.NPrinting.Manager.exe, enter one of the following commands:

l Qlik.Nprinting.Manager.exe --help for general help
l Qlik.Nprinting.Manager.exe backup --help for help with backups
l Qlik.Nprinting.Manager.exe restore --help for help with restoring from a backup

Do the following:

1. On the computer where you want to restore your Qlik NPrinting Server deployment, open the Windows
Service Manager (services.msc). Verify that the following services are stopped:

a. Qlik NPrintingEngine (if installed on the computer)

b. Qlik NPrintingScheduler

c. Qlik NPrintingWebEngine
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2. If an engine is configured on a remote machine:

a. Log into the engine machine.

b. Open the Windows Service Manager.

c. Ensure that the following service is stopped: Qlik NPrintingEngine.

3. Open a Windows command prompt (cmd.exe) as administrator, and navigate to the folder where
Qlik.NPrinting.Manager.exe is installed. The default location is %Program
Files%\NPrintingServer\Tools\Manager. For example:
cd C:\Program Files\NPrintingServer\Tools\Manager

4. Enter Qlik.Nprinting.Manager.exe restore -f followed by the full path to the backup.zip file,
then concatenate -p followed by the full path to the PostgreSQL bin folder. Also concatenate the option
--pg-password followed by the repository database superuser password that you defined during
setup. For example:
Qlik.Nprinting.Manager.exe restore -f C:\NPrintingBackups\NP_Backup.zip -p

"C:\Program Files\NPrintingServer\pgsql\bin" --pg-password secretPassword

Restore overwrites the installed repository and resets to the version stored in the backup. If you
created new entities after the backup was created, they will be lost.

Quotation marks are necessary when you have spaces in the path.

5. Read the messages displayed on the console carefully as they provide important status and error
information. They indicate if the restore was successful, and help to troubleshoot errors.
If no errors occur, you are ready to restart your services.

6. Open the Windows Service Manager (services.msc), and start the following services in the order listed, by
right-clicking on the service then selecting Start:

a. Qlik NPrintingWebEngine

b. Qlik NPrintingScheduler

c. Qlik NPrintingEngine (if installed on the computer)

d. Qlik NPrintingEngine (if installed on a remote machine)

Restoring Qlik NPrinting audit trail data from a backup
Qlik NPrinting is delivered with a utility, Qlik.Nprinting.Manager.exe, that is used to create backups
and restore deployments.

Qlik.NPrinting.Manager.exe is installed by default, and is located in %Program
Files%\NPrintingServer\Tools\Manager. This tool is a console application and must be executed from a command
prompt. The resulting backup contains a Qlik NPrinting audit trail database dump file, and related files in a .zip
archive.

Command line help
To see the command line help for the Qlik.NPrinting.Manager.exe, enter one of the following commands:
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l Qlik.Nprinting.Manager.exe --help for general help
l Qlik.Nprinting.Manager.exe audit-backup --help for help with backups
l Qlik.Nprinting.Manager.exe audit-restore --help for help with restoring from a backup

Do the following:

1. On the computer where you want to restore your Qlik NPrinting Server deployment, open the Windows
Service Manager (services.msc), and verify that the following services are stopped:

a. Qlik NPrintingEngine (if installed on the computer)

b. Qlik NPrintingScheduler

c. Qlik NPrintingWebEngine

d. Qlik NPrintingAuditService

2. Open a Windows command prompt (cmd.exe) as administrator, and navigate to the folder where
Qlik.NPrinting.Manager.exe is installed. The default location is %Program
Files%\NPrintingServer\Tools\Manager. For example:
cd C:\Program Files\NPrintingServer\Tools\Manager

3. Enter Qlik.Nprinting.Manager.exe audit-restore -f followed by the full path to the
backup.zip file, then concatenate -p followed by the full path to the PostgreSQL bin folder. Also
concatenate the option --pg-password followed by the repository database superuser password that
you defined during setup. For example:
Qlik.Nprinting.Manager.exe audit-restore -f C:\NPrintingBackups\NP_Audit_

Backup.zip -p "C:\Program Files\NPrintingServer\pgsql\bin" --pg-password

secretPassword

Restore overwrites the installed repository and resets to the version stored in the backup. If you
created new entities after the backup was created, they will be lost.

Quotation marks are necessary when you have spaces in the path.

4. Read the messages displayed on the console carefully as they provide important status and error
information. They indicate if the restore was successful, and help to troubleshoot errors.
If no errors occur, you are ready to restart your services.

5. Open the Windows Service Manager (services.msc), and start the following services in the order listed, by
right-clicking on the service then selecting Start:

a. Qlik NPrintingWebEngine

b. Qlik NPrintingScheduler

c. Qlik NPrintingEngine (if installed on the computer)

d. Qlik NPrintingAuditService
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3.5 Security
Qlik NPrinting leverages internal and external resources to manage access, authentication,
authorization, and data governance.

Platform security
All communication between Qlik NPrinting services and web clients use web protocols using Transport Layer
Security (TLS). TLS uses digital certificates to encrypt information exchanged between services, servers, and
clients. Encrypted information flows through tunnels requiring two certificates to secure the connection; a server
certificate to identify the correct server and a client certificate to allow the client to communicate with the
identified server.

The operating system security system controls access to certificates, storage, memory, and CPU resources. Qlik
NPrinting uses these controls to protect the platform by only allowing authorized users and processes access to
required resources.

For more information about certificates, see Certificates (page 201).

Authentication
Authentication in Qlik NPrinting deployments can be managed by proxy service. Upon verification, Qlik NPrinting
transfers the user to the Qlik NPrinting Server or NewsStand. For more information about authentication, see
Authentication (page 216).

Authorization
Attribute based access control provides a comprehensive framework to govern user capabilities within the
platform. Data reduction through section access dynamically manages the data which users view and select in
applications.

Document Metadata Service (DMS) integrates fully with the existing Directory Service Provider (for example,
Active Directory, other LDAP) where Group Membership has been recorded – this is a mechanism by which
QlikView Server can re-use existing enterprise accounts and group structures.

For more information about managing role based access controls, see Role based security (page 227).

For more information about section access, see Prerequisites for QlikView Server and QlikView Cluster connections
(page 232).

Platform security
Qlik NPrinting supports TLS (Transport Layer Security) a cryptographic protocol that provide
communications security over a computer network. TLS is sometimes referred to as SSL (Secure
Sockets Layer). TLS uses certificates signed by trusted certification authorities (CA). This also avoid
security warning messages on the web browser.
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Cryptography basics
This is an overview of cryptography basic concepts that you must know in order to use TLS certificates with Qlik
NPrinting.

Symmetric-key cryptographic algorithms use the same key for both encryption and decryption. The key is shared
between the parties that communicate and must be secret.

Asymmetric cryptography algorithms (or public key cryptography), use instead a pair of keys: one public and one
private. The public key may be disseminated widely, and the private key is known only to the owner. If you
perform an encryption or decryption with one key you can reverse it by using the other key. Which key you use
depends on whether you are trying to do a digital signature or an encryption.

The process to implement an asymmetric encryption algorithm is composed by the following steps:

l generate the public and the private key
l distribute the public key
l encrypt
l decrypt

RSA (Rivest, Shamir and Adleman), used in Qlik NPrinting, is an asymmetric encryption algorithm. RSA is used to
transmit encrypted shared keys for symmetrical cryptography which is faster.

A public certificate is an electronic public document used to prove the ownership of a public key. A public
certificate includes information about the key, information about its owner's identity, and the digital signature of
an entity that has verified that the content of the certificate is correct. If the signature is valid, and the user trusts
the signer, then the user knows that the public certificate can be used to communicate with its owner.

PEM is an ASCII text format for public certificates. It is portable across platforms.

A public key infrastructure (PKI) is a system for the creation, storage, and distribution of digital certificates which
are used to verify that a particular public key belongs to a certain entity. A PKI includes a certificate authority (CA)
that stores, issues and signs third party digital certificates. A certificate authority (CA) could be a company that
sells you public certificates. OpenSSL is the simplest tool for PKI. OpenSSL is also open source and you can use it
for free.

X.509 is a standard format for public key certificates, for example the ones used by Qlik NPrinting. An X.509
certificate does not contain the private key.

Transport Layer Security (TLS) is a cryptographic protocol that provides communication security over a computer
network. Sometimes TLS is still called with the older name SSL (Secure Soket Layer). TLS connections are secured
by using symmetric cryptography with a secret and unique key for each section negotiated at the beginning of
the communication. The identity of the communicating parties can be verified by using public-key cryptography.
Public certificates are an important component of the TLS because they prevent an attacker from impersonating
other server.
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Certificates

A certificate is a data file that contains keys that are used to encrypt communication between a
client and a server in a domain. Certificates also confirm that the domain is known by the
organization that issued the certificate.

A certificate includes information about the keys, information about the identity of the owner, and the digital
signature of an organization that has verified that the content of the certificate is correct. The pair of keys (public
and private keys) are used to encrypt communication.

Qlik products use certificates when they communicate with each other. They also use certificates within
products, for communication between components that are installed on different computers. These are standard
TLS certificates.

The organization that issues the certificate, the certificate authority, is said to “sign” the certificate. You can
arrange to get certificates from a certificate authority, to show your domain is known. You can also issue and sign
your own (“self-signed certificates”).

Common errors
Because it generally important for security to know whether a site is known, browsers will display error messages
related to certificates and might block communication.

Some common errors are related to the certificate authority. For example, if there is no certificate authority or if
the certificate has expired, the default level of security in most browsers will stop communication with a message
about “unsigned certificates”, “expired certificates”, or similar terms. If your security administrators know that
the certificate is still good, you can create an exception so the error is ignored for that certificate.

Other common errors are related to how the domain is named. For example, companyname.com is a different
domain from www.companyname.com, and localhost is a different domain from a server name. A fully qualified
domain name is an unambiguous name for a domain. For example, a server at companyname.com might be
named mktg-SGK, and can be referred to that way, but the fully qualified domain name is mktg-
SGK.companyname.com. (This is called whitelisting.)

Encryption and keys
The kind of encryption used in certificates in Qlik products requires a pair of keys (asymmetric encryption). One
key, the public key, is shared. The other key, the private key, is used only by the owner.

PEM is an ASCII text format for public certificates. It is portable across platforms.

You can get certificates and key pairs from certificate authorities or you can generate them. To get a certificate
signed, you will need to also generate a signing request.

Installing OpenSSL
By using OpenSSL you can generate you private and public keys, the certificates and the certificate signing
requests to be send to a certification authority. OpenSSL is an open source project and you can use it for free.
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OpenSSL official website provides detailed information about how to use it. The following are basic instructions
to use OpenSSL with Qlik NPrinting.

Before you begin, you must install OpenSSL.

Do the following:

1. Download a binary distribution of OpenSSL for your operating system.

Compiling your own version, and checking the gpg keys in the tags, is a more secure alternative.

The OpenSSL project does not distribute any code in binary form, and does not officially
recommend any specific binary distributions but you can find an informal list at
https://wiki.openssl.org/index.php/Binaries. We will use Win64OpenSSL_Light-1_1_0e.exe
downloadable from the page https://slproweb.com/products/Win32OpenSSL.html.

2. Before start the installation, close all Windows command prompts.

3. Double click on Win64OpenSSL_Light-1_1_0e.exe to start the installation.

4. If a security warning appears, click on Run.

5. It the use account control appears, click on Yes.

6. Click on Next, accept the license agreement and click on Next again.

7. Don't change the default installation folder and click on Next.

8. Use the default start menu folder and click on Next.

9. In Copy OpenSSL DLL to windows select the option on to The Windows system directory an click on Next.

10. Click on Install.

11. Click Finish to exit setup.

Managing keys and certificates

Qlik NPrinting encryption requires a X.509 certificate file in PEM format. You can generate a self-
signed certificate, or get one signed from a certification authority (CA). A single certificate covers
both the NewsStand and the Qlik NPrinting web console, because they have the same domain
name.

Limitations
l Certificates generated using CNG compatible algorithms are not compatible with the On-Demand Add-on.

Generating a public and private RSA key pair in PEM format
Do the following:

1. Open a Windows command line prompt.

2. Move to the OpenSSL binary folder. Default command is: cd C:\OpenSSL-Win64\bin
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You can customize the folder if it is necessary. Files will be created in this folder, then you will move them
into the final folder.

3. Run the command: openssl genrsa -out NPrinting.key 4096.

genrsa is the option to generate an RSA private key. 4096 is the size of the generated private key in bits.

4. If you only want to export the public certificate in PEM format, run the command: openssl rsa -in

NPrinting.key -outform PEM -pubout -out NPrintingPublic.pem.

pubout is the OpenSSL option to extract the public key from and RSA private key.

The certificate key must not be passphrase protected.

The private key should not be disclosed to anyone, nor sent to the certificate authority. Back it
up and store it in a safe place. You can distribute the public key file if needed.

5. Before sharing your public key file, we suggest that you visually inspect it to be sure that you are sending
the correct file:

a. Open the file NPrinting.key in a text editor. NPrinting.key is your private key and it starts with: ----

-BEGIN RSA PRIVATE KEY-----. Keep it secret.

b. Open the file NPrintingPublic.pem in a text editor. NPrintingPublic.pem is your public key and it
starts with: -----BEGIN PUBLIC KEY-----. You can share this file.

Private key security
Qlik NPrinting operates 24/7. This means that the private key must be stored on the file system unencrypted.
Protecting the private key with a password is not feasible because an administrator must enter the password
every time the service is restarted. You can protect the private key file by giving access rights only to the
administrators. The private key file is only used for TLS and it never leaves the server.

Generating a self-signed certificate
A self-signed certificate is an identity certificate that is signed by the entity owning the certificate. This entity uses
its own private key to certify its identity. Using a self-signed certificate lets you sign your certificate by yourself.

You can use a self-signed certificate if:

l You intend to use HTTPS (HTTP over TLS) to secure your web servers.
l You do not require that your certificates are signed by a certificate authority (CA).

For example, you can use a self-signed certificate if your web servers are used only inside your local network.

Do the following:

1. Open a Windows command line prompt.

2. Move to the OpenSSL binary folder. Default command is cd C:\OpenSSL-Win64\bin. Files will be created
in this folder, then you will move them into the final folder.

3. To create the self-signed certificate run the following command:
openssl req -newkey rsa:4096 -nodes -keyout NPrinting.key -x509 -days 365
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-out NPrinting.crt
Where:

l req is the PKCS#10 certificate request and generating utility.
l The -x509 option tells req to create a self-signed certificate.
l The -days 365 option specifies that the certificate will be valid for 365 days.

To skip the interactive questions, use the -subj followed by your domain information within quotation
marks.
For example:
-subj "/C=US/ST=New York/L=Brooklyn/O=Example Brooklyn Company/CN=mywebsitedomain.com".

The private key should not be disclosed to anyone, nor sent to the certificate authority. Back it up and
store it in a safe place.
You can distribute the public key file.

Buying a certificate from a certification authority
Your certificates must be signed by a certification authority (CA) if you need to avoid security warnings in case
your web server is publicly reachable via web browsers. There are numerous certification authorities. The CA you
choose will have their own specific instructions to follow. Some steps on generating and implementing CA-signed
certificates are common to all certification authorities. The following sections outline these common steps.

Generating a certificate signing request
To obtain a CA-signed certificate, you must generate a certificate signing request (CSR). A CSR contains your
public key and other additional information. This information will be included in the signed certificate. A CSR
never contains the private key.

Do the following:

1. To generate the CSR and the private key run the following command:
openssl req -new -newkey rsa:4096 -nodes -keyout NPrinting.key -out

NPrinting.csr

2. You will be prompted to answer the interactive questions.
To skip the interactive questions, use the -subj followed by your domain information within quotation
marks.
For example:
-subj "/C=US/ST=New York/L=Brooklyn/O=Example Brooklyn Company/CN=mywebsitedomain.com".

For any custom procedure needed for creating the CSR, refer to the certification authority's instructions .

Common Name field
The name in the Common Name field (CN) must be the Fully Qualified Domain Name (FQDN) of the host that will
use the certificate.

For example:
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l If the URL of your NewsStand is https://yourcompany.com:4994, the FQND is yourcompany.com (the port is
not part of the FQDN).

l The URL https://www.yourcompany.com:4994 is considered different from https://yourcompany.com:4994.
If you want both URL addresses to be valid host names, you must generate two certificates, one
containing the FQDN www.yourcompany.com, and one containing the FQDN yourcompany.com.

Merging signed certificates with server certificates
When using a certificate signed by a certification authority (CA), you must create a PEM file certificate bundle
containing:

l the server certificate
l any intermediates
l the CA-signed certificate

Make sure to apply the following order for the concatenation:

1. Domain certificate

2. Intermediate certificates (one or multiple)

3. Root certificate

Once you have created the certificate bundle, use it together with your private key to set up the proxy. Files
containing a certificate and matching private key for the server must be provided.

Do the following:

In this example, the certificate for your domain is NPrinting.crt.

1. Open a Windows command line and enter the following:

more NPrinting.crt >> NPrinting.public.pem

more RSADomainValidationSecureServerCA.crt >> NPrinting.public.pem

more RSAAddTrustCA.crt >> NPrinting.public.pem
more AddTrustExternalCARoot.crt >> NPrinting.public.pem

Where:

l NPrinting.crt is the domain certificate.
l NPrinting.public.pem is the certificate bundle that will be used to set up the proxy.
l RSADomainValidationSecureServerCA.crt and RSAAddTrustCA.crt are intermediate

certificates.
l AddTrustExternalCARoot.crt is the root certificate.

2. Use NPrinting.public.pem as a certificate file and the private key to set up the proxy.
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See also:
p ≤ How to configure a .pfx certificate for use with Qlik NPrinting web console and the NewsStand

Installing Qlik NPrinting certificates

You can install a self-signed or CA-signed Qlik NPrinting certificate.

To generate certificates, see: Private key security (page 203). The certificate file name is NPrinting.crt and the
private key file name is NPrinting.key. You can rename them, but this is not recommended.

Installing certificates on Qlik NPrinting Server June 2017 or later
Do the following:

1. Copy the certificate NPrinting.crt and the related private key NPrinting.key into the appropriate folders:

a. For the NewsStand: %ProgramData%\NPrinting\newsstandproxy\.
Typical path is C:\ProgramData\NPrinting\newsstandproxy\.

a. For the Qlik NPrinting web console: %ProgramData%\NPrinting\webconsoleproxy\.
Typical path is C:\ProgramData\NPrinting\webconsoleproxy.

2. Change both proxy configuration files to refer to the new certificate file:

a. Edit the NewsStand proxy configuration file: %ProgramData%\NPrinting\newsstandproxy\app.conf.
Uncomment by removing the # and change or add the following lines to:
http.sslcert=${ProgramData}\NPrinting\newsstandproxy\NPrinting.crt. Change the certificate file
name if necessary.
http.sslkey=${ProgramData}\NPrinting\newsstandproxy\NPrinting.key. Change the private key file
name if necessary.
${ProgramData} is the Windows ProgramData environment variable with the notation for the
configuration file. As alternative you can insert your full path, for example
C:\ProgramData\NPrinting\newsstandproxy\NPrinting.crt.

b. Edit the Qlik NPrinting web console proxy configuration file:
%ProgramData%\NPrinting\webconsoleproxy\app.conf.

Uncomment by removing the # and change or add the following lines to:
http.sslcert=${ProgramData}\NPrinting\webconsoleproxy\NPrinting.crt. Change the certificate file
name if necessary.
http.sslkey=${ProgramData}\NPrinting\webconsoleproxy\NPrinting.key. Change the private key file
name if necessary.
${ProgramData} is the Windows ProgramData environment variable with the notation for the
configuration file. As alternative you can insert your full path, for example
C:\ProgramData\NPrinting\webconsoleproxy\NPrinting.crt.

3. You must stop and restart the Qlik NPrinting web engine service because new certificates are read only
during the service start-up process.
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Checking the installation
Connect to the Qlik NPrinting web console and ask to your browser to display certificate details to verify that the
web site is using the certificates you installed:

l If you used CA-signed certificates the browser warning message disappears.
l If you used a self-signed certificate you still have the warning message. To remove the warning message

from all browsers, you need to add the self-signed certificates to the trusted roots of your local computer.
Refer to official Microsoft documentation related to your operating system to perform this action Manage
Trusted Root Certificates.

TLS cipher suites

A cipher suite is a set of algorithms used to encrypt network communication. Qlik NPrinting
components support a variety of cipher suites, to allow for different security protocols.

Qlik NPrinting does not set a specific secure cipher suite as mandatory, in order to guarantee compatibility with
different operating systems and platforms.

Qlik NPrinting proxy cipher suites
The proxy configuration parameter tls.ciphersuites lets you manage a custom set of cipher suites in the Qlik
NPrinting proxy.

The proxy configuration files are:

l %ProgramData%\NPrinting\webconsoleproxy\app.conf
l %ProgramData%\NPrinting\newsstandproxy\app.conf

These files contain the list of customizable configuration properties, all commented by default. These files do not
change when you upgrade to new versions of Qlik NPrinting. Therefore, this configuration property is not
immediately visible when you upgrade from older versions. This ensures you do not lose your settings.

Limitations
l The Qlik NPrinting proxy supports a limited set of cipher suites. The list may change after a product

upgrade in order to include new algorithms or deprecate others.
l Some of the supported cipher suites are considered TLS 1.2 unsecure by the HTTP/2 protocol. They must

be placed in the list of custom values after any non-blacklisted cipher. Otherwise, the proxy cannot be
started, and you will see this error:
"http2: TLSConfig.CipherSuites index %index% contains an HTTP/2-approved cipher suite
(%ciphername%), but it comes after unapproved cipher suites. With this configuration, clients that don't
support previous, approved cipher suites may be given an unapproved one and reject the connection."

l Note that %index% and %ciphername% are variables that will show:
o %index%: the name of the index.
o %ciphername%: the name of the cipher suite that caused the issue.

l These cipher suites are mandatory:
o TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256 (HTTP/2 RFC required)
o TLS_ECDHE_ECDSA_WITH_AES_128_GCM_SHA256 (to support ECDSA-only servers)
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If they are removed, the proxy cannot be started, and you will see this error: "http2:
TLSConfig.CipherSuites is missing an HTTP/2-required AES_128_GCM_SHA256 cipher"

Supported cipher suites
TLS_ECDHE_RSA_WITH_CHACHA20_POLY1305

TLS_ECDHE_ECDSA_WITH_CHACHA20_POLY1305

TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256

TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384

TLS_ECDHE_ECDSA_WITH_AES_128_GCM_SHA256

TLS_ECDHE_ECDSA_WITH_AES_256_GCM_SHA384

TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA256

TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA

TLS_ECDHE_ECDSA_WITH_AES_128_CBC_SHA256

TLS_ECDHE_ECDSA_WITH_AES_128_CBC_SHA

TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA

TLS_ECDHE_ECDSA_WITH_AES_256_CBC_SHA

TLS_RSA_WITH_AES_128_GCM_SHA256

TLS_RSA_WITH_AES_256_GCM_SHA384

TLS_RSA_WITH_AES_128_CBC_SHA256

TLS_RSA_WITH_AES_128_CBC_SHA

TLS_RSA_WITH_AES_256_CBC_SHA

// RC4-based cipher suites are disabled by default

TLS_RSA_WITH_RC4_128_SHA

TLS_ECDHE_RSA_WITH_RC4_128_SHA

TLS_ECDHE_ECDSA_WITH_RC4_128_SHA

// black-listed by default

TLS_ECDHE_RSA_WITH_3DES_EDE_CBC_SHA

TLS_RSA_WITH_3DES_EDE_CBC_SHA

Accessing the custom cipher suites list
Do the following:

1. Stop the QlikNPrintingWebEngine service.

2. To customize the Qlik NPrinting web console, open webconsoleproxy\app.conf. To customize the
NewsStand, open newsstandproxy\app.conf.

3. Uncomment or add tls.ciphersuites.

4. Enter the comma-separated list of cipher suites to support as value from most to least preferred.

5. Save the file.

6. Restart the QlikNPrintingWebEngine service.

Example
Set only the cipher suites considered secure by the RFC 7540 standard.

# set a custom set of supported cipher suites ordered from most to least preferred

tls.ciphersuites = "TLS_ECDHE_RSA_WITH_CHACHA20_POLY1305,TLS_ECDHE_ECDSA_WITH_CHACHA20_

POLY1305,TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256,TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384,TLS_ECDHE_

ECDSA_WITH_AES_128_GCM_SHA256,TLS_ECDHE_ECDSA_WITH_AES_256_GCM_SHA384"
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Qlik NPrinting messaging service cipher suites
These are the cipher suites supported by Qlik NPrinting messaging service for TLS communication between Qlik
NPrinting scheduler service and Qlik NPrinting Engines. They are supported by RabbitMQ and TLS 1.2.

If you want to disable TLS connections with client certificate authentication and use simple authentication, see:
Configuring the messaging service for simple authentication (page 215).

Limitations
l Due to a limitation in the certificates used to connect to Qlik NPrinting messaging service, only some TLS

1.2 cipher suites can be used.
l Cipher suites based on Cipher Block Chaining (CBC) mode, even if supported by the product, are not

considered secure. It is recommended that you use cipher suites that rely on Galois/Counter Mode (GCM),
if supported by your operating system.

l While it is possible to restrict cipher suites accepted by Qlik NPrinting Messaging service when customizing
the RabbitMQ config file, this method may cause errors. Instead, it is recommended that you disable weak
cipher suites at the Microsoft Windows operating system level using IIS Crypto or a similar product. Be
sure to leave at least one of the following cipher suites enabled (along with other needed cipher suites).
For more information, see How to use IIS Crypto GUI to enable or disable cipher suites on a Microsoft
Windows OS machine (page 210).

Supported cipher suites
TLS_ECDHE_RSA_AES128_GCM_SHA256

TLS_ECDHE_RSA_AES256_GCM_SHA384

Licensing service cipher suites
The license service configuration parameter cipher-suites lets you manage a custom set of cipher suites in the
licensing service.

Limitations
l The licensing service configuration file is reset when you upgrade to a new version of Qlik NPrinting.

Therefore, a change to the cipher-suites parameter must be done again after an upgrade.
l The licensing service supports a limited set of cipher suites. The list may change after a product upgrade

in order to include new algorithms or deprecate others.
l These cipher suites are mandatory:

o TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256 (HTTP/2 RFC required) 
o TLS_ECDHE_ECDSA_WITH_AES_128_GCM_SHA256 (to support ECDSA-only servers)

Supported cipher suites
TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256

TLS_ECDHE_RSA_WITH_AES_256_GCM_SHA384

TLS_ECDHE_ECDSA_WITH_AES_128_GCM_SHA25

TLS_ECDHE_ECDSA_WITH_AES_256_GCM_SHA384

TLS_ECDHE_RSA_WITH_CHACHA20_POLY1305

TLS_ECDHE_ECDSA_WITH_CHACHA20_POLY1305

TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA

TLS_ECDHE_ECDSA_WITH_AES_128_CBC_SHA

TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA
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TLS_ECDHE_ECDSA_WITH_AES_256_CBC_SHA

TLS_RSA_WITH_AES_128_GCM_SHA256

TLS_RSA_WITH_AES_256_GCM_SHA384

TLS_RSA_WITH_AES_128_CBC_SHA

TLS_RSA_WITH_AES_256_CBC_SHA

TLS_ECDHE_RSA_WITH_3DES_EDE_CBC_SHA

TLS_RSA_WITH_3DES_EDE_CBC_SHA

Accessing the custom cipher suites list
Do the following:

1. Stop the services QlikNPrintingScheduler, QlikNPrintingWebEngine, and QlikNPrintingLicenseService.

2. Open the configuration file %ProgramFiles%\NPrintingServer\NPrinting\License\license.config.

3. Uncomment or add the cipher-suites parameter.

4. Enter the comma-separated list of cipher suites to support as value from most to least preferred.

5. Save the file.

6. Restart the services.

Example
Set only the cipher suites considered secure by the RFC 7540 standard.

<!--Add a custom comma-separated list of cipher suites as shown below-->

<add key="cipher-suites" value="TLS_ECDHE_RSA_WITH_AES_128_GCM_SHA256,TLS_ECDHE_ECDSA_WITH_AES_

128_GCM_SHA256" />

Qlik NPrinting Server and Engine cipher suites to connect to a Qlik Sense server
These are the cipher suites supported by Qlik NPrinting Server and Qlik NPrinting Engine service for TLS
communication between Qlik NPrinting and Qlik Sense. At least one of these must be enabled on all:

l Qlik NPrinting Server machines
l Qlik NPrinting Engine machines
l Qlik Sense machines (including all Sense nodes) which connect to Qlik NPrinting

Please note that Qlik NPrinting uses these cipher suites to publish reports to Qlik Sense servers. For more
information, see Distributing reports to the Qlik Sense hub (page 487)

Supported cipher suites
TLS_ECDHE_RSA_AES128_GCM_SHA256

TLS_ECDHE_RSA_AES256_GCM_SHA384

How to use IIS Crypto GUI to enable or disable cipher suites on a Microsoft Windows OS machine
Do the following:

1. Download IIS Crypto 3.3 or a more recent version from Nartac Software downloads.

2. Execute it with admin privileges, and then go to the "Cipher Suites" on the sidebar on the left.
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3. Enable the requested cipher suites listed above for all Qlik NPrinting components. If not present, you can
add them using the appropriate button.
This step will only work if these cipher suites are supported by your operating system.

4. Click Apply.

5. Reboot the machine.

Session expiration

Qlik NPrinting web console uses HTTP cookies to handle sessions. Cookies are pieces of data
related to user behavior on a website. They are stored on the user's computer. For example, cookie
data could contain login or authentication information.

By default, all cookies generated previously are no longer valid when a user logs out of Qlik NPrinting. The user
must to log in again if they want to access Qlik NPrinting.

If the user is using other instances of Qlik NPrinting or NewsStand, these instances will also be inaccessible.
Closing the browser does not invalidate session cookies. The user must choose to log out.

You can change the default session expiration rules or remove them completely.

Customizing session expiration
The default value session means that expiration is handled by the browser or by forcing a logout. You can change
this value and enter a custom period.

Do the following:

1. Open the proxy configuration files.

a. For the NewsStand: %ProgramData%\NPrinting\newsstandproxy\.
Typical path is C:\ProgramData\NPrinting\newsstandproxy\.

b. For the Qlik NPrinting web console: %ProgramData%\NPrinting\webconsoleproxy\.
Typical path is C:\ProgramData\NPrinting\webconsoleproxy.

2. Edit the session.expires field in the proxy configuration file. Valid time units are: "ns", "us" (or "µs"),
"ms", "s", "m", "h".
For example: session.expires=24h means that the session will expire after 24 non-use hours.

Disabling session expiration after logout
Do the following:

a. Open the webengine.config file located in: %Program
Files%\NPrintingServer\NPrinting\WebEngine\webengine.config.

b. Uncomment this line: <add key="auth-session-expiration-on-logout-off" />.

c. User sessions will no longer expire after logout.

Configuring X-Frame-Options

Qlik NPrinting supports X-Frame-Options HTTP response headers.
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The X-Frame-Options header is a security measure that prevents Qlik NPrinting web console and NewsStand from
being embedded in a <frame> or <iframe>. Enabling X-Frame-Options HTTP response headers defends against
Cross-Frame Scripting (XFS), clickjacking, and other forms of attack.

XFS headers profiles
The following table illustrates different XFS headers restriction profiles based on X-Frame-Options settings.

Configurations XFS header

xfs.headers.enabled=false None

xfs.headers.enabled=true

xfs.headers.option=DENY
X-Frame-Options: DENY

Content-Security-Policy: frame-ancestors 'none'

xfs.headers.enabled=true

xfs.headers.option=SAMEORIGIN
X-Frame-Options: SAMEORIGIN

Content-Security-Policy: frame-ancestors 'self'

xfs.headers.enabled=true

xfs.headers.option=ALLOW-FROM

xfs.headers.allowed_url=https://domain.com

X-Frame-Options: ALLOW-FROM https://domain.com

Content-Security-Policy: frame-ancestors domain.com

[XFS headers restriction profiles]

Configuring your X-Frame-Options header

Opening the proxy file
To configure X-Frame-Options, you must edit the proxy configuration files for Qlik NPrinting web console and
NewsStand. The default locations of these files are:

l NewsStand proxy configuration file:

%ProgramData%\NPrinting\newsstandproxy\app.conf

l Qlik NPrinting web console proxy configuration file:

%ProgramData%\NPrinting\webconsoleproxy\app.conf

You must stop the Qlik NPrinting web engine service before changing any configuration.

Enabling XFS headers
To enable or disable XFS headers, edit the following setting:

Setting: xfs.headers.enabled

Values options:

l true

l false

Default value: true
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Setting XFS header options
To set specific XFS header options, edit the following setting:

Setting: xfs.headers.option

Values options:

l DENY

l SAMEORIGIN

l ALLOW-FROM

Default value: DENY

Allowing a specific URL address
You can indicate a specific URL allowed to use responses inside a frame. This setting must configured when
ALLOW-FROM is used for xfs.headers.option. You can insert multiple URLs by inserting a space between each
URL.

Setting: xfs.headers.allowed_uri

Example: xfs.headers.allowed_uri=https://domain.com

Default value: undefined

You must restart the Qlik NPrinting web engine service to make your changes effective.

Configuring HTTP Strict Transport Security (HSTS)

HTTP Strict Transport Security (HSTS) lets your web servers declare that web browsers can only
interact with them using secure HTTPS connections. This helps protect against protocol downgrade
attacks and cookie hijacking.

The server communicates this to the user agent via an HTTPS response header field named "Strict-Transport-
Security". It can be enabled in the proxy configuration files. You can also specify how long these security settings
should last.

Configuring HSTS headers
Do the following:

1. Stop the QlikNPrintingWebEngine service.

2. Open the proxy files:

a. To customize the Qlik NPrinting web console, open webconsoleproxy\app.conf. Typical path is
C:\ProgramData\NPrinting\webconsoleproxy.

b. To customize the NewsStand, open newsstandproxy\app.conf.Typical path is
C:\ProgramData\NPrinting\newsstand.
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3. Configure the following strings:

a. hsts.header.enabled: Default value is false. Set to true to enable HSTS.

b. hsts.header.maxage: The time, in seconds, that the browser should remember that a site should
only be accessed using HTTPS. Default value is 63072000 (two years).

4. Restart the QlikNPrintingWebEngine service.

See also:

p Configuring X-Frame-Options (page 211)
p TLS cipher suites (page 207)
p Session expiration (page 211)

Enabling HTTP

By default, Qlik NPrinting is configured to use HTTPS for connections with its user interfaces. Qlik
NPrinting can be enabled to use HTTP for its connections, but HTTPS is the recommended
configuration.

If you use HTTP instead of HTTPS the data transmitted will not be encrypted. This can pose a security
risk. See: Configuring HTTP Strict Transport Security (HSTS) (page 213).

You can enable HTTP for the NewsStandand Qlik NPrinting web console.

Enabling HTTP for the NewsStand
This procedure enables the use of HTTP for connections with the NewsStand.

Do the following:

1. Connect to the computer where Qlik NPrinting Server is installed with a user with administrator rights.

2. Stop the Qlik NPrinting web engine Windows service.

3. Open the NewsStand configuration file %ProgramData%\NPrinting\newsstandproxy\app.conf in your
preferred text editor.

4. Change the default value of #http.ssl=true to http.ssl=false. Delete the # character at the beginning of the
string.

5. Change the default value of #cookie.secure=true to cookie.secure=false. Delete the # character at the
beginning of the string.

6. Save the configuration file.

7. Restart the Qlik NPrinting web engine Windows service.

8. Open the NewsStand by opening the URL http://YourServer:4994.

Using https:// in the URL does not work after changing the configuration to enable HTTP.
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Enabling HTTP for the Qlik NPrinting web console
This procedure enables the use of HTTP for connections with the Qlik NPrinting web console.

Do the following:

1. Connect to the computer where Qlik NPrinting Server is installed with a user with administrator rights.

2. Stop the Qlik NPrinting web engine Windows service.

3. Open the NewsStand configuration file %ProgramData%\NPrinting\webconsoleproxy\app.conf in your
preferred text editor.

4. Change the default value of #http.ssl=true to http.ssl=false.

5. Change the default value of #cookie.secure=true to cookie.secure=false.

6. Save the configuration file.

7. Restart the Qlik NPrinting web engine Windows service.

8. Open the Qlik NPrinting web console by opening the URL http://YourServer:4993.

Using https:// in the URL does not work after changing the configuration to enable HTTP.

Supported protocols for connecting Qlik NPrinting to Qlik Sense Server 
The following are the supported scenarios for connecting Qlik NPrinting to Qlik Sense Server:

l If Qlik Sense Server is configured to use HTTPS protocol, Qlik NPrinting connection must use HTTPS as
well.
Qlik NPrinting connection/Qlik Sense Server: HTTPS/HTTPS.

l If Qlik Sense Server is configured to use HTTP protocol, Qlik NPrinting connection can use either HTTPS or
HTTP.
Qlik NPrinting connection/Qlik Sense Server: HTTPS/HTTP.
Qlik NPrinting connection/Qlik Sense Server: HTTP/HTTP.

If Qlik Sense Server is configured to use HTTPS protocol, using an HTTP protocol for Qlik NPrinting
connection is not supported. This scenario causes the connection between Qlik NPrinting and Qlik Sense
Server to fail. A server using HTTPS protocol cannot accept an HTTP connection for security reasons.

If your Windows log in does not work after enabling HTTP, delete your browser's cookies and try again.

Configuring the messaging service for simple authentication

If you want to disable TLS connections with client certificate authentication and use simple
authentication, you must manually edit the configuration files.

Do the following:
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1. Stop the following services:
l Qlik NPrinting Engine
l Qlik NPrinting scheduler service
l Qlik NPrinting web engine
l Qlik NPrinting messaging service

2. Edit each of the following files by adding the line <add key="use-rabbit-plain"/>:
l \Program Files\NPrintingServer\NPrinting\Engine\engine.config
l \Program Files\NPrintingServer\NPrinting\Scheduler\scheduler.config
l \Program Files\NPrintingServer\NPrinting\WebEngine\webengine.config

3. Open C:\ProgramData\NPrinting\RabbitMQ\advanced.config and search for the Authentication section.

The modifications needed to reconfigure rabbitMQ are listed in the file comments.

a. Modify TCP listeners to enable plain connection on port 5672.

b. Remove TLS listener on port 5672.

c. Enable PLAIN and AMQPLAIN authentication mechanisms.

4. Restart all services

Authentication
Authentication in Qlik NPrinting deployments is managed by the Qlik NPrinting web engine, which
verifies user identities before allowing access to the Qlik NPrinting Server or NewsStand.

The standard entry points for Qlik NPrinting web console and NewsStand are configured to use HTTPS for
connections with their web interfaces. Traffic is encrypted using TLS and certificates. HTTPS is the recommended
configuration, because it is more secure. However, Qlik NPrinting can be configured to use HTTP in environments
that requires it, like when it should work behind a reverse proxy. For more information about HTTP, see: Enabling
HTTP (page 214).

Qlik NPrinting supports the use of username and passwords or Kerberos and NTLM as integrated authentication
methods. They are managed internally by the Qlik NPrinting web engine.

The default authentication module requires that the proxy that handles the authentication is part of the
Microsoft Windows domain where Qlik NPrinting is installed.

Windows login
To enable Windows login, open the user profile and add the domain\username.

Do the following:

1. From the Admin menu, click Users.

2. Select the user you wish to edit.
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3. Fill in the Domain account field: Enter the domain and user name.
A user must have an associated domain account to use the following features:

l Receive reports in Qlik Sense hub.
l Create On-Demand reports in QlikView.

The user's Windows Active Directory user account must be associated as the domain account.

You can disable Windows login by going to Admin > Settings > Authentication.

Kerberos
If you want to use Kerberos authentication, you need to make sure that browsers used to access Qlik NPrinting
are configured to support Kerberos. See: Kerberos authentication (page 217).

External authentication
Qlik NPrinting supports the following external authentication methods, managed by the Qlik NPrinting web
engine:

JSON Web Token (JWT)
JWT is an open standard for secure transmission of information as a JavaScript Object Notation (JSON) object.
JWT enables single sign-on (SSO), which minimizes the number of times a user has to log on to cloud applications
and websites. For more information about JWT authentication, see: JWT authentication (page 222).

Security Assertion Markup Language (SAML)
Qlik NPrinting supports SAML V2.0. For more information, see: Security Assertion Markup Language (SAML) is an
XML-based, open-standard data format for exchanging authentication and authorization data between parties (for
example, between an identity provider and a service provider). SAML is typically used for web browser single sign-on
(SSO). (page 218).

Kerberos authentication

Qlik NPrinting supports the use of Kerberos and NTLM. If you want to use Kerberos authentication,
you need to ensure that browsers used to access Qlik NPrinting are configured to support Kerberos.

The default authentication module requires that the proxy that handles the authentication is part of the
Microsoft Windows domain where Qlik NPrinting is installed.

Enabling Kerberos authentication in Qlik NPrinting
To enable Kerberos authentication in Qlik NPrinting, you must edit the webengine.config file installed by default
with Qlik NPrinting Server.

Do the following:

1. Open the webengine.config file located in:
%Program Files%\NPrintingServer\NPrinting\WebEngine\webengine.config
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2. Uncomment the following line
+ <!--<add key="win-auth-use-negotiate" value="true" />-->

3. In the domain controller, for the domain where Qlik NPrinting is installed, add the required SPN for the
service and users.

Use the SetSPN utility to set the SPN for Kerberosauthentication. For example: setspn -S HTTP/np-

server domain\username, where np-server is the name of the Qlik NPrinting Server and
domain\username is the user for whom Kerberos is enabled.

This enables Negotiate authentication, that requires Kerberos authentication. If Kerberos authentication is not
available, it will fall back to NTLM if NTLM is enabled. To disable the fallback to NTLM, you must configure it in
the domain controller.

Security Assertion Markup Language (SAML) single sign-on (SSO)

Security Assertion Markup Language (SAML) is an XML-based, open-standard data format for
exchanging authentication and authorization data between parties (for example, between an
identity provider and a service provider). SAML is typically used for web browser single sign-on
(SSO).

How SAML works
The identity provider (IdP) is used for authentication. When the identity provider has asserted the user identity,
the service provider (SP) can give the user access to their services. Because the identity provider has enabled
SSO, the user can access several service provider sites and applications without having to log in at each site.

The SAML specification defines three roles:

l Principal: Typically a user
l IdP: The identity provider
l SP: The service provider

The principal requests a service from the SP, which requests and obtains an identity assertion from the IdP.
Based on the assertion, the SP decides whether or not to perform the service requested by the principal.

SAML in Qlik NPrinting
Qlik NPrinting supports SAML 2.0 by:

l Implementing a service provided it can integrate with external identity providers
l Supporting HTTP Redirect Binding and HTTP POST Binding for SAML responses
l Supporting SAML properties for access control of resources and data

Limitations
l Qlik NPrinting does not sign the SAML authentication request. This means that identity providers that

require the SAML authentication request to be signed are not supported.
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l SAML response encryption is not supported, so encrypted messages or attributes are not read by Qlik
NPrinting.

l SAML single logout is not supported.

You must enable Windows authentication to use the Qlik NPrinting On-Demand Add-on on QlikView Web
server and Qlik Sense.

If you only want to use JWT authentication, then you must install the Qlik NPrinting On-Demand Add-on
on a QlikView Server configured on a Microsoft IIS Web Server.

Installing On-Demand Add-on on a Microsoft IIS hosted QlikView AccessPoint (page 490)

Qlik NPrinting web console and NewsStand configurations
Since Qlik NPrinting web console and NewsStand have different web addresses you must setup two different
SAML connections to make both work.

Identity provider initiated SSO
With identity provider initiated SSO, the user logs in directly to the identity provider, which performs the SSO
authentication.

When the authentication flow starts from the identity provider, the user is redirected to the Qlik NPrinting
dashboard for Qlik NPrinting web console, or to the NewsStand home page.

Service provider initiated SSO
With service provider initiated SSO, the user starts at the service provider site. Instead of logging in at the service
provider site, SSO authentication is initiated with the identity provider. In this authentication process, Qlik
NPrinting plays the role of a service provider. Based on your SAML configuration, the Qlik NPrinting login page
displays a button for each of your identity providers. When you click a button, you are redirected to the identity
provider site for authentication. If you are already logged in the identity provider directs you to the Qlik NPrinting
dashboard.

Metadata
The service provider (Qlik NPrinting) needs configuration information from an identity provider. This information
is available as an identity provider metadata file that can be downloaded and delivered to the service provider for
easy configuration. The identity provider metadata is uploaded from the Qlik NPrinting SAML configuration page.

Not all identity providers support downloading metadata files. If download is not supported, the metadata file
can be created manually.

Qlik NPrinting provides the identity provider with service provider metadata, that is downloaded from the SAML
configuration list page. The metadata includes the following information:

l Assertion consumer service (ACS) URL
l Entity ID

Qlik NPrinting requires the following information in the identity provider metadata:
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l Certificate
l Entity ID
l HTTP-Redirect location

When reading the certificate to verify the SAML response signature, Qlik NPrinting will use the first
certificate with the "signing" attribute. If the IdP metadata provided contains more than one certificate
with the "signing" attribute, and it does not use the first one to sign responses, the signature verification
will fail. You must remove the unused certificate from your IdP metadata file before uploading it to Qlik
NPrinting.

Configuring Security Assertion Markup Language (SAML) single sign-on (SSO)

With SAML configured, you can enable a single sign-on (SSO) solution that minimizes the number of
times a user must log on to cloud applications and websites.

Requirements
l Configure Qlik NPrinting.
l Configure the identity provider (IdP) by uploading the Qlik NPrinting metadata, or manually extracting the

required information.
l Upload the identity provider (IdP) metadata to Qlik NPrinting.
l Access Qlik NPrinting from the buttons on the login page, or the identity provider (IdP) console.
l Any static strings in the user directory need to be inside square brackets [ ]. For example: [DOMAIN]

You must enable Windows authentication to use the Qlik NPrinting On-Demand Add-on on QlikView Web
server and Qlik Sense.

If you only want to use JWT authentication, then you must install the Qlik NPrinting On-Demand Add-on
on a QlikView Server configured on a Microsoft IIS Web Server.

Installing On-Demand Add-on on a Microsoft IIS hosted QlikView AccessPoint (page 490)

Configuring Qlik NPrinting
Do the following:

1. Log in to Qlik NPrinting as an administrator.

2. Go to Admin > Settings and click on the SAML tab.

3. Click the Add configuration button.

4. Enter a Name for your SAML configuration.

5. Select either WebConsole or NewsStand from the Portal drop-down.

6. Enter the URL of your Qlik NPrinting web console or NewsStand in the Service Provider URL field. For
example, https://myserver.mydomain:4993.
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This must be a fully qualified domain name.

7. Enter an Entity ID, for example OktaWebConsole.

This is used to configure your identity provider.

Do not upload the identity provider metadata yet. You can upload the metadata after you
complete the identity provider configuration.

8. Select the radio button for your preferred authentication method, either Authenticate user by
Domain\Name or Authenticate user by email and enter the name for the attribute that is used to
exchange communication between the identity provider (IdP) and Qlik NPrinting.

9. Click Save.

10. Click on the name of the configuration you created.

11. Click on Download SP Metadata.

You have now created a SAML configuration and downloaded an IdPmetadata.xml file that you can use when
configuring the IdP.

Configuring the identity provider (IdP)
Identity provider configuration is specific to the IdP that you choose. There is some information contained in the
Qlik NPrinting metadata that you will need to complete your configuration regardless of your choice of IdP. Some
identity providers allow you to upload the file, and automatically setup some of the configuration information,
while others don’t. If your identity provider does not allow this, you can read the required information from the
Qlik NPrinting metadata file and manually configure the IdP. If your IdP does not support metadata upload, you
will required the following information from the Qlik NPrinting metadata:

l IdP Entity ID, as a property under the EntityDescriptor tag
l The Assertion Consumer Service URL, as the Location property of the AssertionConsumerService tag
l The Assertion Consumer Service Index as the index property of the AssertionConsumerService tag

Uploading the identity provider IdP metadata
As soon as the identity provider IdP configuration is complete, you can upload the IdP metadata to your Qlik
NPrinting SAML configuration. Not all IdPs allow you to download a metadata file. If your IdP does not allow
downloads, you must create a new file and with content provided by your identity provider.

Once you have the IdP metadata.xml file (the file name can be anything you choose, but the file extension must
be .xml), you can upload it in the Qlik NPrinting SAML configuration page. This is required to complete the SAML
configuration.

Do the following:
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1. Log in to Qlik NPrinting as an administrator.

2. Go to Admin > Settings and click on the SAML tab.

3. Select the configuration that you created in the first procedure.

4. Click the Browse button to upload the IdP XML metadata file.

5. Navigate to the location where your metadata.xml file is stored and select it.

6. Click Save.

Accessing Qlik NPrinting via SSO
You can access Qlik NPrinting via SSO by going to the login page clicking on the identity provider IdP button. You
can also access Qlik NPrinting directly from the identity provider by clicking on the Qlik NPrinting app, if your
identity provider supports this feature.

JWT authentication

JSON Web Token (JWT) is an open standard for secure transmission of information between two
parties as a JavaScript Object Notation (JSON) object.

JWT verifies that the service credentials are true and lets the service act on behalf of whichever user, bypassing
user credentials authentication.Because JWT enables single sign-on (SSO), it minimizes the number of times a
user has to log on to cloud applications and websites.

JWT structure
A JWT consists of three parts: a header, a payload, and a signature.

Header
The header usually consists of two parts: type (typ) and algorithm (alg). The algorithm is used to generate
the signature.

Example:

{

"typ": "JWT",

"alg": "RS256"

}

RS256 indicates that RS256 - RSA signature with SHA256 is used to sign this token.

Payload
The payload is a JSON object that consists of the claims that you want to make. Claims are statements about an
entity (usually the user) and additional metadata. You must have either an email attribute, or the domain and
name attributes defined.

Example:

{

"email":"jde@company.com",

"exp": 1472034208

}
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Example:

{

"name":"jde",

"domain":"company",

"exp": 1472034208

}

Signature
The signature is used to verify the identity of the JWT sender and to ensure that the message has not been
tampered with. The signature is the encoded header and payload, signed with a secret key. In the normal case,
X.509 certificates are used to generate and validate the signature.

Authentication is performed by verifying the signature. If the signature is valid, access is granted.

Supported signature algorithms
The following signatures are supported in Qlik NPrinting:

l RS256 - RSA signature with SHA256
l RS384 - RSA signature with SHA384
l RS512 - RSA signature with SHA512

Example: Accessing Qlik NPrinting with a signed JWT
The following example shows the steps involved in gaining access using a signed JWT.
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1. A JWT is generated, including a set of claims, and is signed with the private key for the configured
certificate.

2. A request is sent to the proxy including the signed JWT in the HTTP Authorization header.

3. The proxy injects the configured attribute mappings and forwards the call to the backend service.

4. The client will receive a session and subsequent calls are not required to include a JWT.

a. If the calls do include a JWT it will be validated, and if it is invalid the user will be rejected access.

b. If the user in the JWT is different from the user stored for the session, the user will obtain a new
session.
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Standard fields
The following fields inside a JWT claim are used by Qlik NPrinting:

l Expiration time (exp): identifies the expiration time after which the JWT is not accepted.
l Not before (nbf): identifies the starting time on which the JWT is accepted.

You can have other fields configured in your JWT token, however only those listed above are considered
by Qlik NPrinting.

Limitations
The following limitations exist:

l Encrypted JWTs are not supported.

l Only the following signing algorithms are supported:
o RS256 - RSA signature with SHA256
o RS384 - RSA signature with SHA384
o RS512 - RSA signature with SHA512

Configuring JWT authentication

Configure JWT authentication and authorization to enable single sign-on (SSO), and minimizes the
number of times your users have to log on.

Do the following:

1. Log on to Qlik NPrinting as an administrator.

2. Click Admin, and select Authentication settings.

3. Enable JWT authentication using the associated toggle.

4. In the JWT certificate field, add the JWT .X509 public key certificate in PEM format.

5. Select either Match user by Domain\Name or Match user by email.

a. If you select Match user by Domain\Name:
l Enter the JWT attribute name for the attribute describing the user ID in the JWT attribute

for user ID field.
l Enter the JWT attribute name for the attribute describing the user directory.

b. If you select Match user by email, enter the JWT attribute for email.

6. Click Update authentication settings to save your changes.

DMS for Qlik NPrinting

Qlik NPrinting supports connections to QlikView deployments configured with either Document
Metadata Service (DMS) or NTFS authentication.

Qlik NPrinting - February 2024 225

3   Deploying



DMS integrates fully with the existing Directory Service Provider (for example, Active Directory, other LDAP) where
Group Membership has been recorded. This allows QlikView Server to re-use existing enterprise accounts and
group structures. The permitted users or groups are recorded in a meta file that resides next to the QlikView
document, and it is managed using QMC.

DMS is required when the authenticated user identity is not a Windows user account. The DMS permissions are
explicitly assigned using QMC, or may be assigned using QlikView Publisher distribution tasks.

To enable On-Demand reports on a QlikView Server with DMS configured, see Installing On-Demand Add-on on a
Microsoft IIS hosted QlikView AccessPoint (page 490).

You must enable Windows authentication to use the Qlik NPrinting On-Demand Add-on on QlikView Web
server and Qlik Sense.

If you only want to use JWT authentication, then you must install the Qlik NPrinting On-Demand Add-on
on a QlikView Server configured on a Microsoft IIS Web Server.

Installing On-Demand Add-on on a Microsoft IIS hosted QlikView AccessPoint (page 490)

Reverse proxy authentication

Qlik NPrinting Designer supports reverse proxy environments. Users will have an extra log in step
before they can edit report templates.

Reverse proxies add extra layers of security by being an intermediary for associated servers contacted by any
client. They can hide the existence and characteristics of origin servers.

When users try to connect to Qlik NPrinting Server, a dialogue window with an embedded browser will open, and
let them authenticate manually. Cookies are collected so users will not have to complete this extra step each
time, only when the cookies expire.

Do the following:

1. Open the Qlik NPrinting home page.
A dialogue window with gateway log in opens.

2. Enter your log in credentials.
You can now access the Qlik NPrinting web console.

3. In the main menu, click on Reports.

4. Click on the report you want to edit, and then click Edit template.
The Qlik NPrinting Designer will try to connect to the Qlik NPrinting Server. The Qlik NPrinting Designer is
not authenticated in the reverse proxy, so the request will fail.

5. A dialogue box with an embedded web browser will open. Type in your log in credentials for the reverse
proxy gateway.
Qlik NPrinting Designer saves the cookies that will allow it to communicate with the server through the
reverse proxy. The saved cookies will be used for future connections. When they expire, you will have to
log in to the proxy again.
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Authorization
Qlik NPrinting manages user-based security where all allowed actions are based on user roles. You can create
users, add filters and groups, and assign roles to the users.

Security management
The basic concepts of security in Qlik NPrinting include how to create roles, and how to add apps and actions to
those roles. The available entities, and user and admin actions, are listed, and adding and applying a role to a
user is described in detail.

Creating users with filters and groups
Create a new Qlik NPrinting user, configure the user's identity, and add user details for use in email messages.
Add a user to a group, and add filters and roles to that user.

Creating groups for users
Groups are lists of users. The reports received by users in the same group are based on the same templates, but
the data received by any particular user is based on the filters applied to that user.

Put the users who need to receive the same reports into a group. One user can be a member of many groups.

Importing users with filters and groups
Import users, with related filters and groups, from external Excel files. Create the Excel file and structure the
information contained in the file, including the necessary syntax. Create the import task and its mandatory fields,
and set the actions that you require for the task.

Role based security

Qlik NPrinting manages user based security.

Users must log into the NewsStand in order to have access to their published reports. Users are allowed to do
actions based on assigned roles, so you can create roles and re-use them. By default, users are not associated
with any roles. You can set authorizations at a granular level.

Definitions
l Action: A specific action associated with an entity. For example, Subscribe, Edit, and Run are actions

associated with reports.
l Role: A list of associations; App - Entity - Action or Entity - Action.

For example, Sales Demo - Reports - Create; the role with this association can create new reports in the
Sales Demo app. Also, for example, User - canCreate; the role with this association can create new users.

Basic concepts
l The default super user is created during the installation process with a user name of your choice. The

admin user can perform all actions, and is associated with the administrator role for all apps. The admin
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user cannot be deleted or removed from the administrator role.
l You must give permission to perform actions. By default, a user cannot perform any actions.
l Each user must be associated with one or more roles. You can allow different actions for a user for specific

apps. For example, Role1 can be allowed to create reports in App1, but not in App2.
l Some permissions do not depend on the apps. For example, creating users is not related to apps, while

creating connections is app-related.
l You can only give permissions, as opposed to specifying restrictions. For example, you can allow Role1 to

create reports into App1. You cannot explicitly forbid this.
l The Create and Edit options allow you to create and edit entity properties. Specific actions will have

matching actions. For example, Create/Edit a connection does not imply the reload metadata action.
Similarly, Create/Edit a report does not imply the template edit action.

List of entities that you can enable

Apps section:
l Apps
l Connections
l Filters
l Conditions
l Reports
l Publish Task
l Published Reports
l Destination
l On-Demand reports

Users section:
l Users
l Groups

Admin section:
l Security
l Settings
l Engines
l Import tasks
l Task executions
l On-Demand requests
l Audit

Managing roles

You can assign predefined security roles, or create custom ones.
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There are four predefined roles:
l Administrator
l Developer
l NewsStand User
l User

You can associate one or more roles to a user. Creating new roles lets you customize authorization profiles for
your reporting system. For example, you can make it so certain users can only view the reports of a particular
app.

You can give a role the rights to do specific actions on an entity type, but you cannot set rights to a single entity.
For example, you can design a role that gives the right to view all reports related to a particular app. You cannot
give a role rights to view only some of the reports available in an app.

The Administrator, Developer, and NewsStand User roles are system roles and have default
permissions that cannot be changed. They are enabled automatically and cannot be disabled.

The User security role can be edited or used as a template for custom roles. By default, this role
contains minimal permissions and is not enabled. You can enable it by going to Admin > Security roles.

Risks related to import task permissions

You can grant security roles permission to view, create, edit, delete, and run import tasks. Import tasks
let you create and edit Qlik NPrinting users, including adding administrative roles to the .xlsx import file.
This means that users with permission to edit import tasks can grant administrative roles to themselves
and other users. Import task run permission is not required to run import tasks, because edit privileges
let you create and enable import task triggers.

A user with permission to read import files can retrieve administrative credentials if present in the file. A user with
edit rights can alter the result of the next import task execution that uses the .xlsx file.

Creating a new role
Do the following:

1. Click Admin in the main menu.

2. Select Security roles from the drop-down list.

3. Click Create role.

4. Enter a Name for the new role.

5. Enter an Description (optional).

6. Leave the Enabled check box selected.
If you deselect the flag, the role will be saved, but ignored by the Qlik NPrinting Engine.

7. Under Actions > Apps, select an app from the Available items list.

8. Move the selected app to the Selected items list.
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A role must have at least one associated app. You can also check All apps to authorize users with the
assigned role to use all available apps.

Setting app permissions
You can set different permissions related to apps, connections, filters, reports, publishing tasks, published
reports, and destinations. The permissions are applied only to the added apps. It is possible to create very
specific actions for a single app.

Under Actions > Apps:

l Apps: users can View, Edit, or Delete the associated apps.
l Connections: users can View, Edit, Create, or Delete connections to the selected apps. Reload metadata

allows users to run a cache refresh. We recommend enabling this option for developers.
l Filters: users can View, Edit, Create, or Delete filters in selected apps.
l Conditions: users can View, Edit, Create, or Delete conditions.
l Reports: users can View, Edit, Create, Delete, Preview, Edit template or Subscribe
l Publish tasks: users can View, Edit, Create, Delete, or Run now.
l Published reports: users can access reports in NewsStand. Users can Preview, or Download a published

report.
l Destination: users can View, Edit, Create, or Delete destinations related to apps.
l On-Demand reports: users can Create On-Demand reports

Setting user profile permissions
You can allow roles to perform the following actions on user profiles.

Under Actions > Users:

l Users: View, Edit, Create, or Delete user profiles.
l Groups: View, Edit, Create, or Delete groups.

Setting administrator permissions
You can allow roles to perform the following Admin actions.

Under Actions > Admin:

l Security: users can View, Edit, Create, or Delete security related entities.
l Settings: users can View or Edit settings.
l Engines: users can View, Edit, Create,or Delete engines.
l Import tasks: users can View, Edit, Create, or Delete import tasks. Select Run Now to give users the

ability to import tasks without waiting for the next scheduled execution.
l Task executions: users can View or Abort tasks.
l On-Demand requests: users can View, Abort, or Delete requests.
l Audit: users can Export audit trail logs.
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When finished, save the role in the repository by clicking Create.

Copying roles
If you are making a new role that is very similar to an existing role, you can save time by copying the original. For
example, you may want to make a new role that is similar to the Developer role, but has some rights exceptions.

Do the following:

1. Click Admin in the main menu.

2. Select Security roles from the drop-down list.

3. Click the Actions gear icon next to the role you want to clone.

4. Click Copy in the drop-down list.

5. A new form will open. The copied role can be edited the same as a new role, described above.

When you finish, save the role in the repository by clicking Create.

Adding roles to user profiles
You can add or remove user roles at any time. To set permissions for the user, you must first create a role, and
then associate it with the user.

Do the following:

1. Click Admin in the main menu.

2. Select Users from the drop-down list.

3. Click on the user name in the list.

4. Move it to the Selected items list.

5. Confirm and save to the repository by clicking on the Update user roles button.

Section access

You can configure section access in Qlik NPrinting when generating reports from QlikView
documents or Qlik Sense apps. Section access support is handled differently for local connections,
and for server and cluster connections.

Qlik NPrinting uses the domain account matched to the Qlik NPrinting user to apply section access during report
creation. The domain account must have section access assigned before the publish task runs. Users with
incorrect section access will receive an error saying that report generation failed.

Section access adds performance overhead to task executions, such as publish tasks. The Qlik NPrinting
Server must create connections for each report recipient that has section access. If a report has many
recipients, your task executions might slow down significantly.

You can use Qlik NPrinting filters instead of section access to reduce task execution time. For
information about creating filters, see Filters (page 304).
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Connecting to local QlikView documents with section access

Section access is not fully supported for local QlikView documents. If you connect to a local QlikView
document with section access, report recipients will see all available data, as if section access was not
applied. You must use Qlik NPrinting filters or connect to documents via QlikView Server to ensure users
only receive permitted data.

Do the following:

1. Open the Apps drop-down list, and then select Connections.

2. Click Create connection.

3. Enter a Name for the connection.

4. Enter a description (optional).

5. Select an App from the drop-down list.

6. Ensure the Source is set to QlikView.

7. Select Local in the document Type.

8. Enter the complete path to reach the .qvw in the Document path field.

9. Ensure the Connection requires authentication check box is selected.

10. Enter the Username and Password.

11. Click Create.

Connecting to QlikView Server and QlikView Cluster connections

Prerequisites for QlikView Server and QlikView Cluster connections
To generate reports using QlikView Server or QlikView Cluster connections, the following are required:

l Access to at least one QlikView Server.
l The Windows user that runs the Qlik NPrinting Engine Windows service must belong to the QlikView

Administrators Windows group on the QlikView Server computer.
l To configure Qlik NPrinting for NTFS authorization, it must be configured in the Qlik Management

Console. This means that the Windows operating system controls the file (document) access for users and
groups through the NTFS security settings.

l To configure Qlik NPrinting for DMS authorization QlikView controlled file access, see DMS for Qlik
NPrinting (page 225).

If you are using section access as well, the following are also required:

l Connections must be configured to use server authentication.
l A domain account must be configured in user settings, independent of the authentication type enabled in

the Qlik NPrinting general settings.

Creating a new connection to a server document
Do the following:
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1. Open the Apps drop-down list, and then select Connections.

2. Click Create connection.

3. Enter a Name for the connection.

4. Select an App from the drop-down list.

5. Ensure the Source is set to QlikView.

6. Select Server in the document Type.

7. Enter the complete path to reach the .qvp in the qvp:// field.

8. Ensure the Connection requires authentication check box is selected

9. Select Server authentication and enter the Identity.

10. Click Create.

Creating a new connection to a cluster document
Do the following:

1. Open the Apps drop-down list, and then select Connections.

2. Click Create connection.

3. Enter a Name.

4. Select an App from the drop-down list.

5. Ensure the Source is set to QlikView.

6. Select Cluster in the document Type

7. Enter the cluster Address, Cluster ID and Document name.
The cluster address and ID can be found in the Qlik Management Console under System > Setup. The
cluster address is in the Management service > Summary tab. The cluster ID can be found by selecting
the QVWS server under QlikView Web Servers, and the ID is in the Name field of the General tab.

8. Ensure the Connection requires authentication check box is selected.

9. Enter the server authentication Identity.

10. Click Create.

User configuration
Do the following:

1. Open the Admin drop-down list, and then select Users.

2. Click the Name of the user that needs to receive reports with section access applied.

3. Configure the Domain account field with a valid user that has access to the document.

4. Click Save.

Connecting to Qlik Sense apps with section access

Requirements
l The Qlik Sense app and individual app objects must be published. For more information, see Publishing.
l All report recipients must have permission to access the Qlik Sense app.
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l Section access must be configured accurately in the load script.

Report recipients that have section access must have rights to export data, or the report creation fails
for these users. In such cases, you can replace section access with Qlik NPrinting filters and security
roles to give specific users the right to export data and publish reports.

Since Qlik NPrinting must create connections for each report recipient that has section access, using the
filters and security roles instead of section access reduces task execution time. For information about
creating filters, see Filters (page 304).

Do the following:

1. Create a new connection to a Qlik Sense app or open an existing one.
For more information, see Creating connections.

2. Select the Apply user section access for reports check box to apply section access for the selected
Identity.

3. Click Create or Save to confirm.

See also:
l Section Access Management
l Managing security with section access
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4 Administering
You can administer the entire reporting system from the web console. You can manage engines,
schedule reports, manage users, and many other activities.

4.1 Admin settings
Administrators can configure many components from the Admin > Settings page in the Qlik
NPrinting web console.

System
Qlik NPrinting uses server- side settings to derive hostnames. Web Console and NewsStand system URLs must be
set to the public address in order to access certain security features. We strongly recommend that you fill out
these fields:

l Web Console URL: used to create links in password reset emails and email notifications.
l NewsStand URL: used to create password reset emails.

Authentication
You can enable or disable the following authentication types:

l Qlik NPrinting authentication
l Windows authentication

See: Windows authentication
l JWT authentication

See: JWT authentication (page 222)

SAML
You can add or edit SAML configurations. See: Configuring Security Assertion Markup Language (SAML) single sign-
on (SSO) (page 220).

NewsStand
You can customize the NewsStand:

l Title: Changes the webpage title that displays on browser tabs. The default is NewsStand.
l Logo: Replaces the NewsStand image link in the top left corner.
l Primary color: Changes the color of plain text. This does not affect menu items or column headers.
l Link color: Changes the color of link text.
l Header color: Changes the background color of the top menu.
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Email
You can setup your SMTP server. You must fill out this section if you want to send reports via email. See:
Configuring SMTP server (page 268).

Report

PixelPerfect security
You can enable or disable PixelPerfect script execution.

PixelPerfect scripts allow privileged access to protected resources, which could result in security issues. You
should only enable these scripts if you trust your reports.

Default templates
You can upload default templates for all report types, except QlikEntity.

On-Demand
You can add or edit trusted origins.

Adding a server as a trusted origin
If you are creating On-Demand reports in Qlik Sense or a QlikView Web Server hosted QlikView AccessPoint, you
must add these servers as a trusted origin in Qlik NPrinting web console.

For each server path used to access the Qlik NPrinting web console, you must add a trusted origin. For example, if
your server can be accessed through a local domain, a shortened host, or fully qualified URLs, a trusted origin
must be added for each of those server paths.

How you enter the server paths in the Address field of the trusted origin depends on your security configuration.

Configuration 1: SSL security not setup with Qlik NPrinting web console
A trusted origin is required for each server path used to log onto the Qlik NPrinting web console. For example, if
your server is qlikserver1 and has an IP address of 192.168.0.101, you would add the following trusted origins:

l http://qlikserver1
l http://qlikserver1.domain.local
l http://192.168.0.101

Configuration 2: SSL security setup with Qlik NPrinting web console and third-party
A trusted origin is required for each server path used to log onto the Qlik NPrinting web console. URLs must use
HTTPS. For example, if your server is qlikserver1 and has an IP address of 192.168.0.101, you would add the
following trusted origins:

l https://qlikserver1
l https://qlikserver1.domain.local
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l https://192.168.0.101

Adding a trusted origin
Do the following:

1. In Qlik NPrinting, click Admin > Settings.

2. Click On-Demand Settings.

3. Click Add trusted origin.

4. After Name, enter a name for the trusted origin.

5. After Description, enter a description for the trusted origin.

6. After Address, enter the URL for the QlikView Server.
The URL must be the base URL (scheme and host) only. For example, http://qlikserver1 rather than
http://qlikserver1/qlikview/index.htm.

7. Click Create.

Task
You can decide what happens when reports or variables do not render. You can also choose to receive task
notification emails.

Requirements
Before you can set up task notifications via email, make sure that the NewsStand and Qlik NPrinting web console
URL settings are configured. If you do not configure the URLs, links in the notification emails will not work. See:
System.

Error handling: reports
By default, if report generation fails, recipients still receive scheduled emails. Instead of the report, users see an
error message and instructions to contact an administrator. Administrators can disable this behavior so that
emails are not sent when reports fail. Report failure appears as an error in the log files.

If you disable this behavior, emails are still sent if at least one report was created successfully.

For example:

You have 3 users in a single task. The task has 2 reports for each user, which are sent via e-mail.

l User A: report generation successful.
l User B: one report fails to generate.
l User C: all reports fail to generate.

In this case:

l User A receives the email with the two attachments.
l User B receives the email with a single attachment. There will be no mention of the report that failed.
l User C will not receive any email.

Do the following:
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1. In the main menu, go to Admin > Settings.

2. Click the Task button.

3. Under Email distribution errors, go to When a publish task cannot generate one or more reports.
Choose from the following options:

l Recipients will receive successful reports, with a message listing reports that failed
l Recipients will receive successful reports, with no error message

If all reports fail, recipients will not receive an email.

4. Click Update.

Error handling: variables
Administrators can set what happens if variables in an email do not resolve.

Do the following:

1. In the main menu, go to Admin > Settings.

2. Click the Task button.

3. Under Email distribution errors, go to When a publish task cannot resolve a variable tag. Choose from
the following options:

l Send the email with the tag as is
l Send the email with the tag removed
l Do not send the email

4. Click Update.

Task execution notifications
You can receive notifications if tasks end with success, errors, or warnings. Notifications can be sent to multiple
email addresses.

Do the following:

1. In the main menu, go to Admin > Settings.

2. Click the Task button.

3. Under Notifications, you can choose to send emails if tasks end with:
l Errors
l Warnings
l Success

4. Under Email configuration, you must add:
l Sender address
l Sender name
l To

5. You can choose to add a CC or BCC.
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You can use semicolons to add multiple To, CC, or BCC addresses.

6. Click Update.

7. If you want to receive notification emails for a task, they need to be enabled. Open the task, go to the
bottom of Overview, and select Send task notifications.

Security
You can enable or disable server certificate validation. For more information, see Configuring server certificate
validation for Qlik Sense connections (page 175).

Do the following:

1. In the main menu, go to Admin > Settings.

2. Click the Task button.

3. Under Security, click the Apply Qlik Sense server certificate validation checkbox.

4. Click Update.

Qlik NPrinting web console Task settings page
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4.2 Users
Users can access Qlik NPrinting reports. Users can be created, or imported from Excel files or LDAP
sources.

Users can be assigned security roles, or organized into groups.

Creating users
You have to add and configure users before you can send them reports. You can add users
manually, or import them.

For more information on importing users, see: Importing users (page 243).

Administering new users
You must have sufficient admin rights to view, edit, create, or delete users. You can do the following once you
have created users:

l Configure delivery and filtering information.
l Manage distribution groups. Users will automatically receive reports if they belong to a distribution group

associated with a publish task.
l Activate and de-activate user accounts. Users who are de-activated will not receive reports, even though

they may be associated with a publish task.
l Set security information including roles, passwords, and link to a domain account.
l Define a locale and a time zone that is specific for each user.

Creating a new user manually
Do the following:

1. From the Admin menu, click Users.

2. Click Create user.

Configuring user identity
Do the following:

1. Configure the following fields in the Overview tab:
l Email: Enter a unique and valid email address that the user will use to log on.
l Name: Enter an identifier for the user that will be used in Qlik NPrinting. For example, you will see

the list of user names when you add a user to a Publish task.
l Password: Enter a password. Password strength is displayed under the field. The border will be

red if the password is not complex enough. This is for information purposes only, and will not stop
the user creation process.
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Valid password characters are letters, numbers, and the following special characters: $ & + , :
; = ? @ # | ' < > . - ^ * ( ) % !

l Confirm password: Enter the password again.
l Domain account: Enter the domain and user name if you want to associate the user with a domain

account.
A user must have an associated domain account to use the following features:

l Receive reports in Qlik Sense hub.
l Create On-Demand reports in QlikView.

The user's Windows Active Directory user account must be associated as the domain
account.

l Time zone: Select a time zone for the user. The scheduled subscriptions for the user will be run
according to the time zone.

l Locale: Select a locale for the user. This sets the user interface language for Qlik NPrinting web
console, NewsStand, and Qlik NPrinting Designer.

l Enabled: Deselect the check box it if you want to save the user but keep the account inactive.
l Report security: These passwords are used to view and edit encrypted reports. Enter a Password

to open, a Password to write, or both (optional).

2. Click Create.

The Details, Groups, Filters and Roles tabs become enabled.

Configuring user details
Do the following:

1. Configure the following fields in the Details tab. All these fields may be used in HTML email messages.
They can be set manually, or imported using Import task:

l Nickname
l Title
l Company
l Job Title
l Department
l Office

2. Click Save.

Configuring report distribution
Do the following:

1. Configure the following fields in the Distribution tab.These fields determine where reports are sent. They
can be set manually, or imported via Excel.

l Folder: Enter the path to a distribution folder where the user can find their reports (optional).
l Subfolder: Enter the name for a subfolder (optional). It can be combined with a manually typed.
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l Alternate email 1: Enter alternate email addresses, separate by semicolons (optional). These
could be used for To, CC, or BBC fields.

l Alternate email 2: Enter alternate email addresses, separate by semicolons (optional). These
could be used for To, CC, or BBC fields.

l Alternate email 3: Enter alternate email addresses, separate by semicolons (optional). These
could be used for To, CC, or BBC fields.

2. Click Save.

Configuring user groups
You can add the user to one or more groups.

Do the following:

1. From the User menu, click the Groups tab.

2. Select one or more groups from the list in the Available items column.

3. Move the groups into the Selected items column.

4. Click Update user groups to save your selections.

You cannot create new user groups from this page. To create new user groups, go to the Admin menu and click
Groups.

Creating new groups
Groups are lists of users. You can put users who need to receive the same reports into a group. One user can be a
member of many groups.

Reports received by users in the same group are based on the same templates. The data received by any
particular user is based on the filters applied to that user.

Do the following:
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1. Select Admin in the main menu.

2. Click Groups.

3. Click Create group.

4. Enter a name for the group.

5. Enter a description (optional).

6. Select users in Available items.

7. Select one or more users from the list in the Available items column.

8. Move the users into the Selected items column.

9. Click Create to save.

Setting user filters
You can add filters to users manually. All reports sent to them will have data filtered accordingly.

Do the following:

1. From the User menu, click the Filters tab.

2. Select the filter you want to add, then click > to move it from the Available items to the Selected items
list.
You can use Shift or Ctrl to make multiple selections.

3. Click Update user filters to save your selections.

Defining user roles
Roles define the rights of users. You have to assign one or more roles to each user.

Do the following:

1. From the User menu click the Roles tab.

2. Select one or more roles in the Available items column.

3. Move the roles into the Selected items column.

4. Click Update user roles to save your selections.

Importing users
You can import users, with related filters and groups, from Excel files, LDAP sources, or a
combination of both.

We recommend that you have one import task per set of users, groups, and filters. You can have different sources
for the same entities. For example: one Excel file for managers and one Excel file for vendors, where both files
have a common group or filter. Both of these sources should be attached to the same import task. You can
change the path of your Excel and LDAP sources when needed.

You should run import tasks one at a time. If you run several import tasks simultaneously, conflicts may arise,
and the tasks may fail.
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You can update Qlik NPrinting group, user, and filter information daily in a file with the same name, and
load it to the same recipient import task path location.

Limitations
There are some limitations when importing:

l You cannot import filters using LDAP. You must use an Excel file.
l You cannot import alternate emails using LDAP. You must use an Excel file.
l If you need to create or delete security roles, you must do so manually in the Qlik NPrinting web console.

See: Setting app permissions (page 230)
l You can import from LDAP forests, trees, and domains that are different from the Qlik NPrinting server.

However, cross-memberships between forests is not supported.
l When importing users from LDAP, locale and time zone values are not available. Users imported this way

will default to English and UTC. You can set different locale and time zone values by importing users from
an Excel file, or changing them manually. Importing the same users again via LDAP will not overwrite
locale and time zone values.

There are some limitations when importing users via Excel:

l If groups, roles, or filters added in the row do not exist, they will be ignored.
l If the name of a filter, user, or role contains commas, use double quotes as delimiters. Example: "Jeremy

Martinson, Jr."
l If a field value contains double quotes, leading/trailing spaces, or "{", "}" you must start and end the

string with double quotes. Double quote characters must be inserted twice in order to differentiate them
from escape quotes.
Example:

o [Country]={" Italy, France ", "Germany",Spain} => " Italy, France

","Germany","Spain"

o [Country]={"""Italy"""} => ""Italy""

o [Country]={"{Sweden}"} => {Sweden}

l In order to import a field with leading/trailing spaces, you must start and end the string with square
brackets.
Example: [ Country ]={Italy}, CountryBorn ={Italy} => " Country "={Italy}, "CountryBorn"={Italy}

l You cannot insert "[", "]" as field names.
l You can delete existing filter fields by adding fields (values, numeric values, or formula columns) with a

valid name and an empty values list. The Update filters if modified check box must be selected.
Example:

o [Country] => input ignored
o [Country]={} => filter field with name country removed
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Import syntax in Excel documents
You must create an Excel file with the following exact names on the worksheets and columns. You cannot re-
order or remove columns. You cannot re-arrange or remove worksheets.

Import filter syntax
The first worksheet contains filter definitions. If a value or formula contains commas, use double quotes as
delimiters. For example: [SalesmanName]={"Jeremy Martinson, Jr.", Tom Lindwall}.

If a filter uses the Select excluded feature to exclude values, add <excluded> at the end. For example:
[CategoryName]={Babywear, Men´s Wear, Women's Wear}<excluded>

The <override> attribute can be used when importing filter fields from Excel with the override values flag
enabled. For example:

l [Country]={Sweden}<override>

l [Country]={"France"}<override,excluded>

Property Required? Description Example

Name Required The name of the filter. Quarterly Sales

Description Optional The purpose of the filter. Sales from the current
quarter.

App Required The name of the app associated with the
filter. The app must exist on the server.

SalesDemoApp

Enabled Required Set to TRUE if you want to create an active
filter. Set to FALSE to create an inactive filter
that will be ignored during report
generation.

TRUE

Connection Required The name of the connection. By specifying
this, you can create different filters based on
fields with the same names from different
connections in the same app. The
connection must exist on the server.

SalesDemoConnection

Values Optional Use to filter string values. List them in the
form: [field name]={value1,value2,...}. To add
values for more than one field, separate
them with a comma. To exclude values, add
<excluded> at the end.

[Country]=

{Italy,Germany,Spain},

[CategoryName]=

{Babywear, Men´s Wear,

Women's Wear}

Numeric
Values

Optional Use to filter numeric values. List them in the
form: [field name]={value1,value2,...}.

CategoryID={1.0,"5",8.2}

Filters
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Property Required? Description Example

Formulas Optional Use to calculate values to filter by using
QlikView formulas. List them in the form:
[field name]={formula1,formula2,...}.

Year={Year(now()), Year

(now())-1,Year(now())-2}

Advanced
Search

Optional Use to filter values by using QlikView or Qlik
Sense advanced search expression. List them
in the form: [field name]=
{advancedformula1,advancedformula2,...}.

ProductName=

{=ProductName like

'*Shoes*'}

Variables Optional Use to create a variable-based filter.
Separate multiple entries with commas.

[VariableName]={FixedValue} to set a variable
to a fixed value.

[VariableName]={"=Formula()"}<evaluate> to
use a formula to calculate the value of a
variable.

vSales= Sum(Sales)

Import user syntax
The second worksheet contains user definitions.

In the Alternate email fields, you can add more than one email address, separated by colons. Your email
provider determines how many addresses can be added to each field.

Property Required? Description Example

Email Required The user's unique email address. It
will be used to log in.

john_brown@qlik.com

Username Required The unique user name that is
displayed in the interface to
identify the user.
If you import a user with the same
name as an existing user, the
import will overwrite the existing
user. If you import a user with the
same name as an existing entity
(group, role) that is not a user, you
will get an error. The same error
will happen if you import a group
with the same name as an existing
user.

John Brown

Users
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Property Required? Description Example

Password Required The password the user uses to log
in to Qlik NPrinting.

testpass

Domain Account Optional The unique domain account
assigned to the user.
A user must have an associated
domain account to use the
following features:

l Receive reports in Qlik
Sense hub.

l Create On-Demand reports
in QlikView.
The user's Windows Active
Directory user account
must be associated as the
domain account.

JohnBrown33

Enabled Required Set to TRUE if you want to create
an active user. Set to FALSE to
create an inactive user that will be
ignored during report generation.

TRUE

Time Zone Required Report publishing is scheduled
according to the time zone of the
user. You must type the name as it
appears in the Qlik NPrinting
interface.

Europe/Rome

Locale Required The display language of Qlik
NPrinting. There are eight options:
En (English), Es (Spanish), Fr
(French), De (German), Pt
(Portuguese), Ja (Japanese), It
(Italian), Zh (simplified Chinese).

It

Description Optional The description of the user. Account manager, Vicenza.

NickName Optional The user's nickname. JoBrown

Title Optional The user's title. Mr.

Company Optional The user's company. Qlik

Job Title Optional The user's job title. Account Manager

Department Optional The user's department. Sales
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Property Required? Description Example

Office Optional The user's office. 1st floor, Vicenza

Folder Optional Report destination folder that the
user can assess.

C:\QlikReportingTraining\Output\

Sub Folder Optional Report destination sub-folder that
the user can assess.

John Brown

Alternate email
1

Optional Report destination email. Can
contain multiple addresses,
separated by semicolons.

john.brown@qlik.com

Alternate email
2

Optional Report destination email. Can
contain multiple addresses,
separated by semicolons.

j.br@qlik.com

Alternate email
3

Optional Report destination email. Can
contain multiple addresses,
separated by semicolons.

salestraining@qlik.com,
salestraining@qlik.eu

Read Password Optional The password needed to open
reports. Credential authentication
will be disabled for the user if no
password is specified.

password33

Write Password Optional The password needed to edit
reports. Credentials
authentication will be disabled for
the user if no password is
specified.

password44

Filters Optional The list of filters the user can
access, separated by commas.

Quarterly Sales

Groups Optional The list of groups the user is a
member of, separated by commas.

Marketing Team, Sales Team

Roles Optional The list of the user's security roles,
separated by commas.

Developer, Administrator

Import group syntax
The third worksheet contains group definitions.
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Property Required? Description Example

Name Required The name of the group. Marketing
Team

Description Optional The purpose of the group. Global
Marketing
Team

Enabled Required Set to TRUE if you want to create an active group. Set
to FALSE to create an inactive group that will be
ignored during report generation.

TRUE

Groups

Import syntax in LDAP sources

Connection syntax

Property Required? Description Default value

Connection path Required The URI used to
connect to the
directory
server. To
support SSL,
specify the
protocol as
LDAPS instead.
Currently,
LDAPS is only
supported for
Active
Directory. You
can add a
distinguished
name (DN) to
change the
starting
container: ldap
[s]://[server
address[:port]/]
[dn]

ldap://company.domain.com

Connection
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Property Required? Description Default value

User name Optional The user ID
used to connect
to the directory
server. If this is
empty, the user
running the
repository is
used to log on
to the directory
server.

-

Password Optional The password
for the user.

-

User directory name Required The name of
the UDC
instance (to be
compared to
the domain
name of an
Active
Directory). If
you leave this
field empty, it
will be
populated with
the correct
domain name
in Active
Directory
servers, or with
the first DC
component of
the
distinguished
name.

-

Entry attributes syntax
The entry attributes should reflect the attributes names of your LDAP server.
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Property Required? Description Default value

Type Required The types that can
be imported are:
users, groups, and
roles.

objectClass

User identification Required The attribute value
of the directory
entry that
identifies a user. A
value that the
attribute specified
by Type can
assume.

inetOrgPerson

Group identification Required The attribute value
of the directory
entry that
identifies a group.
A value that the
attribute specified
by Type can
assume.

group

Role identification Required The attribute value
of the directory
entry that
identifies a role. A
value that the
attribute specified
by Type can
assume.

group

Account name Required The attribute that
specifies the
unique name that
the user uses to
log in.

sAMAccountName

Email Required The attribute
name that holds
the emails of a
directory entry
(user).

mail

Entry attributes
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Property Required? Description Default value

Display name Required The attribute that
holds the full
name of a
directory entry
(user, group, role).

name

Group membership Required The attribute that
indicates the
direct groups that
a directory entry is
a member of.
Indirect group
membership is
resolved during
user
synchronization.

memberOf

Members of directory entry Required The attribute
name that holds a
reference to the
direct members of
this directory
entry.

member

Role membership Required The attribute that
indicates the
direct security
roles that a
directory entry
holds. Indirect
group roles are
resolved during
the user
synchronization.

memberOf

Advanced syntax

Property Required? Description
Default
value

Timeout (seconds) Optional The timeout for reading data from the data source. 240

Advanced
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Property Required? Description
Default
value

Page size of
search

Optional Determines the number of posts retrieved when reading
data from the data source. When the specified number of
posts have been found, search is stopped and the results
are returned. When search is restarted, it continues where
it left off.

If the user synchronization is unsuccessful, try
setting the value to '0' (zero), which is equal to
not doing a paged search.

2000

Alternative group
path

Optional The distinguished name for using a different directory
entry as staring point for group search.

-

Alternative role
path

Optional The distinguished name for using a different directory
entry as staring point for role search.

-

Additional user
filters

Optional The LDAP query used to retrieve the users in the directory. -

Additional group
filters

Optional The LDAP query used to retrieve groups in the directory. -

Additional role
filters

Optional The LDAP query used to retrieve roles in the directory. -

Active directory
Active directory users should change the User identification value from inetOrgPerson to user or person. The
default behavior is to import all groups. If you would like to import a specific group, use the Alternative group
path or Additional group filters fields.

Merging import source data
Merge policy refers to the rules to apply when merging data from an import step with the results of previous
steps. The synchronization in the Qlik NPrinting repository of import source data merge results do not use a
merge policy. They are based on your import task settings. See: Creating an import task (page 255).

User merge key
This specifies the user field used to identify when a user retrieved from import sources is referring to an existing
user. The algorithm used to merge the user data is based on entity and associations merge policies. In order to
match the imported entities against the Qlik NPrinting repository, the Username is always used, so this merge
key is not considered.
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Entity merge policy
This specifies the algorithm used to merge the data retrieved from different import sources that are referring to
the same entity (user, group or filter). It is not applied to fields that are mapping an association to another entity
(user filters, roles and groups, and filter fields).

The supported values are Overwrite, Update missing, and Ignore. The data retrieved from a previous import
source are:

l Overwrite: removed and replaced by the most recent import. Columns that exist in a previous step, but
not the latest step, are not changed.

l Update missing: ignored, except for values not present in previous import tasks, which are added. This
applies to missed columns, not empty cells.

l Ignore: ignored.

Association merge policy
This specifies the algorithm used to merge data retrieved from different import sources that are referring the
same entity (user, group or filter). It is applied to fields that are mapping an association to another entity (user
filters, roles and groups, and filter fields).

Supported values are Overwrite, Merge, and Ignore. The list of entities retrieved from a previous import steps
are:

l Overwrite: removed and replaced by the most recent import. Columns that exist in a previous step, but
not the latest step, are not changed.

l Merge: merged.
l Ignore: ignored.

Assigning import rights to a security role
To import users, you must log into Qlik NPrinting web console as a user with Import task rights in at least one
security role. Users with an Administrator role have Import task rights. If you apply the Administrator role to a
user, they will also have all other administrative privileges.

You can also assign import rights to a security role, without giving it other administrative authority.

Do the following:

1. Log into Qlik NPrinting web console as a user with the Administrator security role.

2. In the Qlik NPrinting main menu, click the Admin drop-down menu.

3. Click Security roles.

4. Click on the role you want to give Import task rights.

5. Click on the Apps tab.

6. Scroll to the Import task rights check boxes.

7. Select the check box to the left of Import task to assign all import task rights to the role.
You can also select only specific rights by selecting the appropriate check boxes.

8. Click Save.

Qlik NPrinting - February 2024 254

4   Administering



Creating an import task
Do the following:

1. In the Qlik NPrinting main menu, select Tasks, and then select Import Task.

2. Click Create import task.

3. Insert the Name of the task. For example: Import Users.

4. Ensure the Enabled check box is selected. Otherwise, your task will be ignored by the Qlik NPrinting
Engine.

5. Under Sources, click Add Source. In the drop-down menu, select Import from Excel or Import from
LDAP.

6. The next steps will depend on the source type:

a. Excel: Add the Import file path (on server) of the Qlik NPrinting Server where the Excel file is
saved.
For example: C:\ProgramData\NPrinting\Imports\NP_Web_Imports.xlsx. This is not the file path on
your local computer.
You can also use a remote computer network path. The Windows user that runs the Qlik NPrinting
scheduler service must have access to the remote folder from the Qlik NPrinting Server. See:
Import syntax in Excel documents (page 245).

b. LDAP: Add the Connection path of the LDAP source.
You can fill in the other fields as needed. See: Import syntax in LDAP sources (page 249).

7. Ensure the Enabled check box is selected. Otherwise, your source will be ignored by the Qlik NPrinting
Engine.

8. Click Add Source to add another source.

9. Click , on the right, to delete a source. Click to duplicate it.

10. Under Settings, select the check boxes that specify how you want to handle merge conflicts:
l Create users if not present
l Update users if modified
l Remove users not present in newest import sources

Only users added in a previous run of the same import will be removed. Other users, like those
added manually, will not be removed.

l Replace existing user associations (filters, roles, and groups)
Existing user associations will be removed if not present in the import file. They will be replaced
with associations in new file.

l Remove groups not present in newest import sources
Only groups added in a previous run of the same import will be removed. Other groups, like those
added manually, will not be removed.

l Create filters if not present
l Update filters if modified
l Remove filters not present in newest import sources

Filters added in a previous run of the same import will be removed. Other filters, like ones added
manually, will not be removed.
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l Replace existing filter fields
Existing filter fields will be removed if not present in the import file. They will be replaced with
filter fields from the import file.

11. Under Notifications, you can select Send task notifications. An email will be sent to the addresses
specified under Settings > Tasks. See: Task execution notifications (page 268).

12. Click Create.

Running the import task
The green bar at the top of the form confirms that the task was created successfully. There are different ways of
running the task.

Do one of the following:

l Click Run now to import users, filters, and groups immediately.
l Click Test now to test the task. This runs a dummy import, and generates a .txt file with the results. This

way you can check for merge conflicts before running an import.
l Click the Triggers button to schedule the execution of the task. See: Creating a distribution schedule (page

475).

Checking task status
On the Import filters and recipients task main page, you can see the status of your import tasks.

l Last execution: shows the date and time of the last execution.
l Last execution status: if a task ran successfully, it will show as Completed. Otherwise, it will show as

Failed.
l Last execution progress: shows how far an active task has progressed.
l Last import log: click the Download link to see the latest logs associated with the task.

If an error occurs during the import, the log file will show the error message in the current locale of the
computer where the import was executed. The import for all users will halt at the first error, and the entire
import is rolled back. The log file download contains a log line for each import action. The task execution
logs only contain the main logs, such as errors and progress information.
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l Enabled: if this check box is not selected, your task will be ignored by the Qlik NPrinting Engine.

l Actions: Click the to edit, delete, run, or test the task.

Check the imported users on the Users page to see newly created users. You can check that associated filters
were created by opening the Filters tab.

Changing user passwords
Users can send requests to change their passwords. Administrators can change the password of
any user.

Administrators
Do the following:

1. Click Admin in the main menu.

2. Select Users from the drop-down list.
The list of available users appears. You can filter the list by typing the user name in the search form.

3. Click on the user name to open its profile.

4. Select the Change password check box.
The form to enter the new password appears.

5. Enter and confirm the new password.

6. Click Save.

You must implement your password policy manually. For example: there is no way to remind users to change
their password once a month.

Users
You can change your user password at any time. The SMTP server must be configured because you will receive
email confirmations.

Password reset rules
l If you make a second password reset request, the first request is deleted and the link becomes invalid.
l You have to wait one minute to make a second request to reset your password, in order to avoid email

spam.
l You have to use the password reset link within one hour. After that, you have make the request again.

Request password reset
Do the following:

1. Open the NewsStand with your preferred web browser. The URL is https://YourServer:4994.

2. Click Forgot your password?

3. Enter your email address.

4. Click Reset password.
A message requests that you check your email for further instructions.
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Reset password
Do the following:

1. Check your email for a message with the subject line, Qlik NPrinting password reset request. If you do
not see the email, check your spam folder.

2. Click on the reset password link, or copy and paste it into your web browser.

3. Enter and confirm your new password.

4. Click Reset password.
A message indicates that your password has been reset. You will also receive a confirmation email.

Changing user language
Users can change the language displayed in the user interface of Qlik NPrinting, NewsStand, and Qlik NPrinting
web console.

This procedure sets the user interface language for Qlik NPrinting web console, NewsStand, and Qlik NPrinting
Designer.

Do the following:

1. Log into NewsStand by entering a web address in your browser, such as https://<server name>:4993. The
exact address you enter depends on how NewsStand has been deployed in your organization.

2. On the Admin menu, click Settings.

3. On the Locale menu, click your desired language.

4. Click Save.

5. The NewsStand page will be refreshed in the selected language.

4.3 Tasks
Tasks can distribute reports to specific recipients, schedule data imports, or refresh connections.
You can create specific tasks for individual users or groups.

Qlik NPrinting has five types of task:

l Import filters and recipients
l Publish reports
l Generate connection caches
l Search field values
l On-Demand requests

You can monitor and abort active tasks on the Task executions (page 262) page. On-Demand tasks can be
administered on the Managing On-Demand requests (page 508) page.
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Publish tasks
Qlik NPrinting apps contain tasks. Tasks can be used to distribute reports to specific recipients, or
schedule data imports.

You need to have an Administrator, Developer, or custom role to create publish tasks. You can manage tasks from
the Publish tasks page.

To learn about import tasks, see: Importing users (page 243).

Creating a new publish task
Do the following:

1. Select Tasks from the main menu, and click Publish task.

2. Click Create task.

3. Enter a name for the task. For example, the name of the user associated with the task.

4. Select an app from the drop-down list.

5. Leave Days to keep, Reports to keep, and Enabled at their default values.

6. Under Report security, you can input a Password to open, a Password to write, or both.
This step is optional. Users will need to input these passwords to access reports attached to this task.

7. Click Create.

Adding a report to a task
Do the following:

1. Go to the Reports tab, and click Add report.

2. Select a report from the Choose report drop-down list.

3. Select a report format from the Output format drop-down list.

4. Select image resolution from the Quality drop-down list.

5. Leave the Attach to email and Enabled check boxes selected.

6. Click Add report.

Assigning a user to a task
Do the following:

1. Go to the Users/groups tab, and click Add user or group.

2. Click the Choose recipient drop-down list and select the user that should be assigned the task.

3. Select the Enabled, NewsStand destination, and Email destination check boxes.

4. Click Add recipient.
The user is now listed in Users/Groups.

Assigning filters to a task
Do the following:
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1. Go to the Filters tab.

2. Use the arrow buttons to move filters to the Selected items box. These filters will be applied to the task.

3. Click Update task filters.

Setting a destination
You can set NewsStand and email as destinations. All the users added in NewsStand have access to the reports
that are associated with their profile.

Do the following:

1. Go to the Destinations tab.

2. Enable the NewsStand check box for all users that should access reports via NewsStand.

3. Enable the Email check box for all users that should receive reports via email.

4. Click Save.

Creating an email
See: Distributing reports by email (page 479)

Creating triggers
Triggers manage the automatic execution of tasks.

Do the following:

1. Go to the Triggers tab, and click Create trigger.

2. Enter a name for the new trigger.

3. Set the Schedule type and Start date.

4. Select a Time zone.

5. Click Create.

To learn more about triggers, see: Creating a distribution schedule (page 475).

Adding conditions to a task
You can add conditions only to reports already inserted into tasks. It is not possible to add conditions directly to
reports. A report is generated only if related conditions are satisfied.

Do the following:

1. Go to the Conditions tab, and click Add condition.

2. Select True or False in the Expected result drop-down menu. If you select True the report will be created
when the condition is verified. If you select False the report will be created when the condition is not
verified. This is useful because, for example, you can add two different report with the same condition and
set one true and the other false. So if the condition is satisfied the first report will be distributed,
otherwise the second report will be distributed.

Qlik NPrinting - February 2024 260

4   Administering



3. To add anther condition, click the plus symbol, or click Add condition. You can add how many conditions
you want.

4. Click Save.

To learn more about how Conditions work, see: Conditions (page 313).

Running a task
You can now run the task you have created.

Do the following:

1. Go to the Overview tab.

2. Click Run now.
A confirmation message appears at the top of the page.

To learn more about how tasks work, see: Task executions (page 262).

Running multiple tasks
You can run several tasks at once. You do not have to wait for the next scheduled execution.

Do the following:

1. In the top menu bar select Tasks, and then click Publish task.
The Publish tasks page shows all available tasks and related information, including the date and time of
task creation, and the most recent update. You can perform actions on multiple tasks at the same time. At
the bottom of the list, you can set how many tasks to display at a time.

2. Select one or more boxes to the left of the task names.
To select all tasks, click the top or bottom box.

3. At the bottom of the list, click the Choose action drop-down. The following actions are available:
l Enable: Enables the selected tasks.
l Disable: Disables the selected tasks. The tasks are stored in the repository, but they are ignored by

the scheduler.
l Delete: Removes the selected tasks from the repository. You cannot restore a deleted entity.
l Run now: Starts the execution of the selected tasks.

4. Select Run now.
Click Go.
This will schedule all selected tasks for execution. A green message for each task appears above the task
list.

Filtering visible tasks
You can filter tasks by View, App, or Date range. You can also search by task name.

The View drop-down list has the following options:
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l All tasks: All tasks are visible. This is the default option.
l Corporate subscriptions: Shows only corporate tasks.
l All subscriptions: Shows all subscribed tasks.
l My subscriptions: Shows only tasks subscribed to by the logged on user.
l Enabled: Shows only enabled tasks.
l Disabled: Shows only disabled tasks.

The App drop-down list contains all enabled apps.

There are two Date range drop-down lists:

l Created:
o Created
o Last updated

l All time:
o All time
o Today
o Yesterday
o This week
o This month
o Last 7 days
o Last 30 days
o Custom: Lets you set a specific date range.

To search by name, type the name of task you are looking for into the search form on the right. The list of tasks
will be dynamically filtered.

Task executions
The Task executions page shows details related to Qlik NPrinting Server tasks.

You can open the Task executions page by clicking on Admin and selecting Task executions.

Task execution times are displayed relative to the time zone of the logged in user. These may be different than
the time zone of the Qlik NPrinting Server. You can change your time zone by clicking on your user name in the
top right, and selecting Settings.

Execution phases
A publish task has three phases:

1. Content resolution: Qlik NPrinting gets data needed to create a report from QlikView or Qlik Sense.

2. Content production: Qlik NPrinting creates the report.

3. Publish: the report is delivered according to your task settings.
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These steps are executed in order for each combination of report and user. They are performed in parallel for
different reports and many reports can be executed at the same stage at the same time.

Filtering tasks
By default, all in-progress or finished tasks are displayed. You can filter tasks by View, Task type, or Date range.
You can also search by task name. Clicking the black triangles next to the header titles of any column will sort
column items alphabetically.

The View drop-down list has the following options:

l All executions
l In progress
l Finished

The Task type drop-down list has the following options:

l Import filters and recipients
l Publish report
l Generate connection cache
l Generate report template: this task is related to migrating QlikView NPrinting 16 report templates. See:

Using the migration tool (page 110).
l Search field value: If you press the Search button while adding an uncached field, Qlik NPrinting will

start a task to retrieve the non-cached values.

There are two Date range drop-down lists:

l Created:
o Created
o Last updated

l All time:
o All time
o Today
o Yesterday
o This week
o This month
o Last 7 days
o Last 30 days
o Custom: Lets you set a specific date range.

To search by name, type the name of task you are looking for into the search form on the right. The list of tasks
will be dynamically filtered.
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Task execution status

Field Description

Task name The name of the task.

Task type The type of task.

Status A blinking status means that the task is running. A fixed status means that the
task has finished, or stopped with Warning, Failed, or Aborted.

Progress Percentage of publishing completion. Progress will remain at 0% during content
resolution and content production. It will start to increase when publishing
starts, or when a condition evaluation returns false. This means that some
reports will not be produced and will be counted as finished.

Created Date and time task was created.

Last updated Date and time task was last updated.

Task execution fields

You can change the number of visible rows by clicking on the numbered buttons at the bottom of the page.

There are several types of Status:

l Warning (only blinking): some reports are created correctly, but some have problems.
The task is still running.

l Warning (only fixed): some reports are created correctly, but some have problems.
The task has been completed with a Warning status.

l Failed: all reports have problems.
l Running (only blinking): everything is going well, but the task is still in execution.
l Completed (only fixed): all reports have been correctly created and delivered.
l Queued: task is waiting to start its execution.
l Aborted: task execution was manually stopped because the user pressed the Abort button in the task

detail page.

Task execution details
Click on a task name to open its details page . The details page is divided into three sections:

l Overview
l Statistics
l Logs

When opening this page, you need to wait until all logs are loaded. This could take several seconds.

Overview
This section contains basic information about the task:
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l Task name
l Task type
l Status
l Progress
l Created
l Last updated

Statistics
The second section shows the task's statistics.

Field Description

Elapsed time Time since the task started or since the latest task restart. It is updated only when
there are timed updates on the task. If the task is blocked, the elapsed time will not
be updated. Visible for all type of tasks.

Started resolutions The number of reports that have started the content resolution step. Visible only for
publish report tasks.

Finished resolutions The number of reports which have finished the content resolution step. Visible only
for publish report tasks.

Started productions The number of reports that have started the content production step. Visible only
for publish report tasks.

Finished productions The number of reports which have finished the content production step. Visible only
for publish report tasks.

Started publishing The number of reports that have started the publishing step. Visible only for publish
report tasks.

Finished publishing The number of reports that have finished the publishing step. Visible only for
publish report tasks.

Report failures The number of reports that failed any of the execution steps. Visible only for publish
report tasks.

Task execution statistics

Logs
The last section of the task details page contains detailed logs. Each log is comprised of:

Field Description

Date and time Date and time of log generation in the Qlik NPrinting Server time zone.

Level The log level is an hint about the severity of the event recorded. The values Error or Warn
mean that something went wrong and we suggest to investigate. The value Info means that
the event ended correctly.

Task log fields
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Field Description

Description Detailed description of the logged action.

Retrieving the report from the ID in the logs
Report IDs are not resolved in the logs of the task execution details page. Report names are not visible and you
will need to retrieve them.

Do the following:

1. Open the task details page.

2. Select and copy the report ID that you want to resolve.

3. Go to the publish task page.

4. Open the publish task related to the original log.

5. Open one of the available reports

6. Replace the last part of the URL (the string on the right side of last backslash) by pasting the copied report
ID.

7. Press Enter.

Aborting a task
You can stop the execution of a task at any time.

Do the following:

1. Click on the name of the task.

2. Click on the Abort button in the upper right corner.

3. The execution of the task is stopped and shows an Aborted status.

Changing task settings
Administrators can set what happens when reports or variables do not render. They can also choose to receive
task notification emails.

Requirements
Before you can set up task notifications via email, make sure that the NewsStand and Qlik NPrinting web console
URL settings are configured. If you do not configure the URLs, links in the notification emails will not work.

Do the following:

1. In the main menu, go to Admin > Settings.

2. Click the System button.

3. Enter the Qlik NPrinting web console URL including port number in Web Console URL. You can copy the
URL including port number from the Qlik NPrinting web console browser address bar.

4. Enter the NewsStand URL including port number in NewsStand URL.

5. Click Update.
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Error handling: reports
By default, if report generation fails, recipients still receive scheduled emails. Instead of the report, users see an
error message and instructions to contact an administrator. Administrators can disable this behavior so that
emails are not sent when reports fail. Report failure appears as an error in the log files.

If you disable this behavior, emails are still sent if at least one report was created successfully.

For example:

You have 3 users in a single task. The task has 2 reports for each user, which are sent via e-mail.

l User A: report generation successful.
l User B: one report fails to generate.
l User C: all reports fail to generate.

In this case:

l User A receives the email with the two attachments.
l User B receives the email with a single attachment. There will be no mention of the report that failed.
l User C will not receive any email.

Do the following:

1. In the main menu, go to Admin > Settings.

2. Click the Task button.

3. Under Email distribution errors, go to When a publish task cannot generate one or more reports.
Choose from the following options:

l Recipients will receive successful reports, with a message listing reports that failed
l Recipients will receive successful reports, with no error message

If all reports fail, recipients will not receive an email.

4. Click Update.

Error handling: variables
Administrators can set what happens if variables in an email do not resolve.

Do the following:

1. In the main menu, go to Admin > Settings.

2. Click the Task button.

3. Under Email distribution errors, go to When a publish task cannot resolve a variable tag. Choose from
the following options:

l Send the email with the tag as is
l Send the email with the tag removed
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l Do not send the email

4. Click Update.

Task execution notifications
You can receive notifications if tasks end with success, errors, or warnings. Notifications can be sent to multiple
email addresses.

Do the following:

1. In the main menu, go to Admin > Settings.

2. Click the Task button.

3. Under Notifications, you can choose to send emails if tasks end with:
l Errors
l Warnings
l Success

4. Under Email configuration, you must add:
l Sender address
l Sender name
l To

5. You can choose to add a CC or BCC.

You can use semicolons to add multiple To, CC, or BCC addresses.

6. Click Update.

7. If you want to receive notification emails for a task, they need to be enabled. Open the task, go to the
bottom of Overview, and select Send task notifications.

4.4 Configuring SMTP server
Qlik NPrinting can distribute your reports by attaching them to email messages.

First, you need to set SMTP parameters, including outgoing mail server address, and port number. You may need
to set user name and password parameters if the server requires authentication.

Best practices
When you set up a SMTP server for distributing Qlik NPrinting reports via email, consider the following best
practices for configuration and troubleshooting:

l Check the attachment size limit of the SMTP server and modify or disable it if possible. Qlik NPrinting
reports can be considerably large in size and can sometimes exceed the attachments size limit set by
SMTP providers.
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Some SMTP providers impose size limits on email attachments. The maximum allowed size
varies among providers. If the size of an attached file exceeds the limit, the email is not
delivered. A warning is added in the logs.

l Some SMTP providers limit the number of emails that a user can send during a given period of time. If a
user sends more emails than the set limit, emails exceeding the limit are not delivered. Modify or disable
such setting where possible.

l Check the SMTP server anti-spam setting and verify that emails can be successfully sent to all Qlik
NPrinting users. If the SMTP server only lets you send emails to an allowlist of users, make sure that all
required Qlik NPrinting users are registered in the allowlist.

l Add the IP of your Qlik NPrinting server and the Qlik NPrinting default sender address to the SMTP server
allowlist, if necessary.

l If the SMTP server only allows the delivery of emails within an organization, grant Qlik NPrinting users the
right to send emails outside the organization, if necessary.

l If you want to configure custom sender addresses, your SMTP server settings must allow users to send
emails using email addresses other than their assigned email address.

l When using a SMTP server cluster, make sure that the authentication is correctly distributed from the
SMTP proxy to all the servers that are part of the cluster.

l When encountering issues with email delivery, check the Qlik NPrinting scheduler service log files and the
SMTP server log files with the help of your SMTP server administrator.

Email settings
Do the following:

1. From the top menu, click on Admin, and then select Settings.

2. Click Email.

3. Enter a name and description for the email settings.

4. Enter the address of the outgoing SMTP mail server in the Address text box.

5. Enter the port number.

6. Select the check box for:
l Use TLS (transport layer security) if your SMTP server requires you to use Transport Layer

Security. The default ports are 25 and 587.
l Use SSL (Secure Sockets Layer) if your SMTP server requires the whole session to be encrypted

using SSL. The default port is 465.
l Disable certificate validation: If you do not want to validate certificates.

7. Specify the Username and Password required for authentication.

8. Configure the Default sender email address to use when sending email messages.

9. Enter a Test email address and click Send test email to verify that the SMTP configuration works. An
email with a time stamp is sent to the specified address to confirm.

10. Click Update.
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4.5 Logging
Qlik NPrinting has detailed log files, which let log analysts view events logged by different services.
For example, it is possible to follow a request spread into different tasks and joined back to create
a response.

When you need to troubleshoot a problem, start by checking rows with errors in the log files. You will usually find
useful error messages to help you understand the origin of the issue. You should include the log files in your
support requests.

Overview
Log files are saved in %ProgramData%\NPrinting\Logs. They are divided into three families:

l nprinting_scheduler.log (contains the log of Qlik NPrinting scheduler service)
l nprinting_webengine.log
l nprinting_engine.log

When a file becomes too big to be easily managed, Qlik NPrinting creates a new file and adds a progressive
integer suffix to the old file. So the file with no suffix is the current file, and the files with suffixes are the older
files. A larger suffix indicates older files. For example:

l \NPrinting\Logs (newest file)
l \NPrinting\Logs.1
l \NPrinting\Logs.2 (oldest file)

These files are not rotated on a daily basis. You have to manually delete old files to save disk space. The number
of files kept depends on the settings in the following config files:

l C:\Program files\NPrintingServer\NPrinting\Engine\Qlik.NPrinting.Engine.config (Engine Service)
l C:\Program files\NPrintingServer\NPrinting\Scheduler\Qlik.NPrinting.Scheduler.config (SchedulerService)
l C:\Program files\NPrintingServer\NPrinting\Webengine\Qlik.NPrinting.Webengine.config (WebEngine

Service)

You can change these settings by editing these strings:

<maxSizeRollBackups value="3" />

<maximumFileSize value="10MB" />

For example: If you change the value of maxSizeRollBackups to 10 in Qlik.NPrinting.Engine.config, Qlik NPrinting
will keep 11 files (current file + 10 archived files). If you change the value of maximumFileSize to 20MB, log files
will reach double their default maximum size before triggering the creation of a new file.

Note that there are two sections: one for normal log files and one for _dev files (when debug level is enabled).
You must customize the appropriate section, or both.
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Log files structure
All log files have the following fields:

l Product Assembly Name
l Product Version
l Class Name
l Timestamp
l Severity
l Hostname
l User name
l User ID
l WebEngine Request ID
l Connection ID
l Task ID
l Execution ID
l Report ID
l Request ID
l Transformation ID
l Message
l Exception
l Stacktrace

Log files are tab-separated value files, so they can be imported as tables.

Changing log details level

You should always backup your Qlik NPrinting repository before editing a .config file. For more
information, see Backing up Qlik NPrinting (page 193).

The log level is set to INFO by default. You can change the log level to DEBUG of a Windows service.

Do the following:

1. Open the appropriate configuration file with a text editor:
l C:\Program Files\NPrintingServer\NPrinting\Engine\Qlik.NPrinting.Engine.exe.config
l C:\Program Files\NPrintingServer\NPrinting\Scheduler\Qlik.NPrinting.Scheduler.exe.config
l C:\Program Files\NPrintingServer\NPrinting\WebEngine\Qlik.NPrinting.WebEngine.exe.config

Where C:\Program Files\NPrintingServer is the Qlik NPrinting Server installation path. Adapt it to your
installation if necessary.
If you want to view Qlik NPrinting On-Demand logs, you need to set Qlik.NPrinting.Engine.exe.config to
DEBUG.
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2. Search for:
<root>

<level value="INFO" />

<appender-ref ref="LogFileAppender" />

<!--Uncomment the row below and set the level value above to obtain the logs in the file

nprinting_engine_dev.log-->

<!--<appender-ref ref="LogFileAppenderDev" />-->

<appender-ref ref="LogFileAppender" />

</root>

3. Change level value to "DEBUG":
<root>

<level value="DEBUG" />

<appender-ref ref="LogFileAppender" />

<!--Uncomment the row below and set the level value above to obtain the logs in the file

nprinting_engine_dev.log-->

<!--<appender-ref ref="LogFileAppenderDev" />-->

<appender-ref ref="LogFileAppender" />

</root>

4. Uncomment: <!--<appender-ref ref="LogFileAppenderDev" />-->

5. Save the edited files.

6. Restart the corresponding Windows service.

When you change a log level to DEBUG, a new log file is created. The new log file has the same name as the log
file with INFO details level followed by _dev. For example:

l nprinting_scheduler_dev.log
l nprinting_webengine_dev.log
l nprinting_engine_dev.log

The default log files will still be present and will continue to only have INFO level information.

4.6 Audit trail
Audit trail provides access to a history of all executed events and procedures on your system. This
provides insight into systems information and system integrity and is used for many reasons
including compliance, records of change to system including user access, investigation into
anomalous system or user behavior and more.

The following actions are logged as part of the audit trail:

l Authentication events (Success & Denied) for system access points (Qlik NPrinting Web Admin,
NewsStand, API)

l Qlik NPrinting web administration system configuration
(Create, update and delete events for Qlik NPrinting entities and settings. This includes events from
import functions for users and filters, Qlik NPrinting 16 projects and Qlik NPrinting reports.)

l Qlik NPrinting report execution outcome (Who, Where)
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Inclusive of scheduled and On-Demand reports
l NewsStand events

Installed files

Qlik NPrinting audit database
A separate dedicated database for audit logging is created with Qlik NPrinting Server. This database is created by
default with a dedicated user and a randomly generated password. The database is deleted when Qlik NPrinting
is uninstalled, so the data needs to be exported before uninstalling if you want to maintain the archive.

Qlik NPrinting audit service
The Qlik NPrinting audit service is installed with Qlik NPrinting Server. The service must be active to write logs to
the Qlik NPrinting audit database. The service writes errors to the log file located in
%PROGRAMDATA%\NPrinting\Logs\nprinting_audit.log if it fails to write data to the database.

Using the Audit trail
Audit trail logs are consumed via the public REST API https://ServerName:4993/api/v1/audit/logs that provides
data as text files separated by tabs.

Do the following:

1. Open the Qlik NPrinting web console in your browser.

2. Log in as a user that has a role with Audit rights.
See: Setting app permissions (page 230)

3. Insert the name of your server in https://ServerName:4993/api/v1/audit/logs then paste it in your browser.
A text file will start downloading. Each field will be in a different tab.

4. You can open the file in a text editor, import to Excel, or upload it to a Qlik Sense app.

Filtering Audit trail data
Audit trail data can be filtered via API by:

l date
l app id
l user id
l target
l target id
l data type

The resulting CSV contains only filtered rows. All fields are string types. Fields names are case sensitive.
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Field Description Example

start The start date and time in the format: yyyy-
mm-ddThh:mm:ssZ

/api/v1/audit/logs?start=2020-10-09T14:53:32Z

Target The target name to filter on. /api/v1/audit/logs?target=NewsstandReport

TargetId The ID of the target to filter on. /api/v1/audit/logs?targetId=b6ae90de-c8ec-4e66-
ad6f-d9f71eeec2b2

AppId The ID of the app to filter on. /api/v1/audit/logs?appId=ab53ef11-3cdc-45af-
9403-b788eba2b004

UserId The ID of the user to filter on. /api/v1/audit/logs?userId=ffe2a664-5698-4189-
a989-bc8f16ee146f

DataType The data type to filter on. /api/v1/audit/logs?dataType=SettingsAudit

Filter fields

Logged events
Here are some of the event types that are logged:

l Report distribution events
o Reports published on the NewsStand
o Reports published to folder
o Reports published to Qlik Sense hub
o Reports send via email

l NewsStand events
o NewsStand reports events
o Subscription events

l Engines events
l Audit Windows service events
l Users events
l Authentication and security events

o Authentication
o Permissions
o Password reset

l Publish tasks and On-Demand events
o Licenses events
o Conditions events

Output file
The output file contains the following information:
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Variable Description

EventTime The ISO 8601 date when the event has happened.

Source The source of event, usually a service.

Event The standard code of the logged event.

Target The object or underlying resource that is being changed. For example: user, app, report.

TargetId The ID of the target object.

TargetName The name of the target object.

Action The change performed on the target. For example: created, updated, read.

AppId The ID of the app where the action is performed.

UserId The ID of the user who performed the action.

UserName The name of the user who performed the action.

IpAddress The IP address which originated the web request.

Description A human readable description of the event.

Data Additional information about the event as a .json object.

DataType Schema for the Data object.

Output file columns

Configuring audit trail for Qlik NPrinting
You can activate and deactivate writing to audit logs.

Audit trail for Qlik NPrinting is disabled by default. Enabling audit trail for Qlik NPrinting may impact
performance. The performance impact will affect importing users and filter operations the most.

You can set retention policy for audit logs in the database. Once the database logs reach the set parameters they
will be deleted to ensure consistent performance. The following are the parameters:

l Max days - The maximum number of days to keep logs.
l Max size (GB) - The maximum amount of space the database will use.

To configure audit trail for Qlik NPrinting do the following:

1. Go to Settings and select the Audit tab.

2. Select Enable event logging.

3. Enter the Max days to keep event logs.

4. Enter the Max size (GB) to set the maximum amount of space the database will use.

The cleanup will happen to logs that meet either condition (Max days or Max size (GB)), they do not
need to meet both.
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When the maximum size limit is met:

l Events exceeding the limit are deleted from the event audit table
l The database may reuse space from deleted rows or effectively shrink disk usage depending on

the specific disk usage and table fragmentation.

While this means that the total disk usage will not grow after cleanup, a certain time lapse may be
needed to have an effective disk space reduction.

Exporting audit trail for Qlik NPrinting data
Qlik NPrinting audit trail data can be exported using a public API. For more information, see see the API reference
documentation in the≤ Qlik Developer portal.

Before you can export Qlik NPrinting audit trail data, you must enable the associated permission for specific
roles.

1. From the Admin menu, select Security roles.

2. Choose the role that you want to enable exporting audit trail data for.

3. In the Actions column for the selected role, click Settings and select Edit.

4. On the Roles page under Actions, click the Admin tab.

5. Select the checkbox for Audit and Export to enable exporting audit data for the role.

6. Click Save.
Users with the associated role can now use the API to export audit trail data.

4.7 Managing entities
All existing objects in the Qlik NPrinting Server are referred to as entities. Tasks, users, groups,
connections, filters, apps, and reports are all entities.

Edit a single entity
You have two options to edit an entity:

l Click the name of the entity.

l Click in the Actions column, and then select Edit.

Make your edits and save.

Delete a single entity
You have two options to delete an entity:

l Click in the Actions column, and then select Delete.

l Click the name of the entity, and then click in the upper right corner.
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Deletion is irreversible. Removing an entity will also delete all entities that depend on it. For example, if
you remove an app you will also remove all its connections, tasks, and so on.

Enable or disable an entity
You can enable or disable single entities by clicking the check box in the Enabled column.

The Qlik NPrinting Scheduler ignores a disabled entity.

Manage multiple entities
When you work with filters, users, and publish tasks, you can enable, disable, or delete multiple entities at the
same time.

Do the following:

1. Select the check boxes to the left of the entity names that you want to manage.
You can select the first or the last check box to select all.

2. Click Choose action, and then select the action you want to perform.

3. Click Go.

Special actions
Some entities have special actions, in addition to enable, disable, and delete:

Entity Edit Reload metadata Run now View Copy

Apps Yes No No No No

Connections Yes Yes No No No

Filters Yes No No No No

Reports Yes No No No No

Publish tasks Yes No Yes No No

Import tasks Yes No Yes No No

Users Yes No No No No

Groups Yes No No No No

Roles Yes No No Yes Yes

System roles No No No Yes Yes

Engines Yes No No No No

Special actions
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4.8 Moving reports between environments
Many users have several Qlik NPrinting environments, such as a test and a production
environment. You can export a report from one environment and import it into another.

Exporting a report creates a .zip file containing your Qlik NPrinting Designer template, applied filters, cycles, and
dynamic names. The .zip file does not contain your app or connection information. Apps and connections must
be present in the secondary environment before you start importing reports.

Both environments must have the same version of Qlik NPrinting (including SR) installed. To migrate
from an old version of Qlik NPrinting to a new one: Planning your migration (page 105).

Exporting a report
Do the following:

1. Select Report in the top menu.

2. Click on the report you would like to export.

3. Click the Export button.
You will be asked to password protect the file. This is optional.

4. Press Download.

You will have a .zip file in the folder that receives files downloaded from your web browser.

Checking connections in the secondary environment
In order to successfully import a report, connections in the secondary environment must match those from the
original report. This includes:

l All objects used in the report template.
l All fields used in cycles.
l All fields used in filters that are associated with the original report, or added as object filters in the

template.
l All variables used in dynamic naming.
l All entities used, if you are importing a Qlik entity report.

QlikView and Qlik Sense ids are used when comparing objects between the two environments.

The import will not be performed if there is no connection that contains all required objects. If you receive an
error message, you can check your Qlik NPrinting WebEngine log file to get the list of objects that are missing
from the target app.

Replacing an existing report
Do the following:
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1. Select Report in the top menu.

2. Click on the report you would like to replace.

3. Click the Replace button.

4. Choose the Qlik NPrinting app you want to connect to the report template you are importing.

5. Click Browse... and select the .zip file you exported previously.

6. Type in the password, if applicable.

7. Click Next.

8. Choose a Connection. Click Next.

9. Choose Filters. Click Next.

10. Click Confirm.

You have successfully replaced the report. If there are any errors, see the log file. For more information, see:
Logging (page 270)

Importing a new report
Do the following:

1. Select Report in the top menu.

2. Click the Import report button.

3. Choose the Qlik NPrinting app you want to connect to the report template you are importing. If you would
like to create a new app, see: Working with apps (page 20).

4. Click Browse ... and select the .zip file you exported previously.

5. Type in the password, if applicable.

6. Click Next.

7. Click Confirm.

You will now be able to view this report template under Reports.

Importing user filters from imported reports
When you import reports into Qlik NPrinting, the filters associated with users are not included, for performance
reasons. Importing all of the filters associated with thousands of users would take a long time, and could cause
Qlik NPrinting to stall.

You can change this behavior by uncommenting the line <!-<add key="include-user-filters" />-> in the
webengine.config file. The import filter dialog will then import all filters you have stored in the repository. This
could take a very long time, depending on the number of stored filters.

If you do not want to edit the webengine.config file, you can manually import a specific user filter along with your
report. There are two ways to do this:

l Remove the filters association from all users.
l Create a new filter, not linked to any user, with the same fields and values.
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4.9 Report security
You can make sure that your users only work with the reports they have permission to access by
implementing password protection at the user, task, or report level. Reports can have read
protection, write protection, or both.

Requirements
Reports with read protection cannot be opened without the correct password. Reports with write protection
cannot be edited without the correct password. A document can have read protection, write protection, or both.
Enabling passwords has no effect on documents produced in Qlik NPrinting Designer preview. You can also
choose to leave your documents password free.

Valid password characters are letters, numbers, and the following special characters: $ & + , : ; = ? @ #

| ' < > . - ^ * ( ) % !

Limitations

Password protection
Qlik NPrinting leverages the native password protection features of the output document type. For example,
Microsoft Word lets you password protect documents. Qlik NPrinting can access this feature. It does not add new
features to your reports. This means that some output formats, like .jpg, cannot be password protected because
they do not support passwords.

You can password protect the following report output types. The original template type does not matter:

l .pptx
l .doc, .docx
l .xls, .xlsx, .xlsm
l .pdf

See: Report output formats (page 469)

If you password protect cycled reports, the reports will be password protected, but not the .zip archive.

Password protected reports will display differently in the NewsStand. Reports with read protection will display a
default placeholder image, instead of the normal thumbnail. The NewsStand preview feature will not work on
these documents. When you click them, you will see your browser's download prompt.

There is no automated mechanism to manage passwords. For example, if it is your company policy to change
user passwords every 90 days, you will have to manually change them, or run a new user import task.
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Sensitivity and AIP labels

Sensitivity labels or Azure Information Protection (AIP) labels are not supported in Microsoft Office report
template files. For more information, see Limitations (page 283).

Adding user level passwords
Users will be able to use these passwords to access reports assigned with user level password protection. These
passwords are different than the ones used to log in to the Qlik NPrinting web console or the NewsStand.

Do the following:

1. From the top menu, click Admin, and select Users.

2. Choose the user you want to assign a password, or create a new one.

3. Under Report security, you can input a Password to open, a Password to write, or both.

4. Click Save.

The selected user can now access reports with their assigned user passwords.

You can also configure user password settings when you import users. See: Importing users (page 243).

Adding task level passwords
Each document in the same publish task can be accessed with the same set of passwords. Any user with these
passwords can open every report attached to the task.

Do the following:

1. From the top menu, click Tasks, and select Publish task.

2. Choose the task you want to password protect, or create a new one.

3. On the Overview tab, under Report security, you can input a Password to open, a Password to write,
or both.

4. Click Save.

All the reports associated with this task are now password protected.

Adding report level passwords
You can also add a different password for each report in a task. These can be different than the password set for
the task.

Do the following:

1. From the top menu, click Tasks, and select Publish task.

2. Choose the task that contains the report you want to password protect.

3. Click the Reports tab. Choose the report you want to password protect, or add a new one.
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4. Under Report security, click the Password protection drop-down. Choose from the following:
l No passwords: report can be opened and edited by anyone.
l User passwords: report can be opened and edited by entering a user password.
l Task passwords: report can be opened and edited by entering a task password.
l Use the following passwords: report can be opened and edited by entering a report-specific

password.
When you choose this option, you will be prompted to define report level passwords.

5. Click Save.

This individual report is now password protected.
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5 Common report features
There are Qlik NPrinting Designer features and functionality that are common across all report
types.

5.1 Working in Qlik NPrinting Designer
l Qlik NPrinting Designer Properties pane (page 284)
l Previewing reports in the template editor (page 328)
l Adding report templates (page 327)
l Reports with multiple connections (page 330)
l Conditions (page 313)
l Filters (page 304)

5.2 Images
l Image dimensions (page 296)
l Image quality (page 302)

5.3 Report naming
l Report names (page 321)
l Dynamic report names (page 322)

5.4 Cycling
l Cycling your reports (page 324)
l Enabling QlikView cycle group fields (page 326)

5.5 Qlik objects
l Working with Qlik objects (page 292)
l Variables (page 317)
l Qlik Sense and QlikView formulas (page 318)
l Importing QlikView and Qlik Sense cell values (page 319)
l Using Qlik Sense third-party extensions (page 332)

5.6 Limitations
l Report templates should only be edited by one person at a time. While it is possible for two people to

open a report template in Qlik NPrinting Designer, it is not supported.
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l Generated reports can be a maximum of 512 MB.
l Qlik NPrinting Designer must be the same version as Qlik NPrinting Server.
l Sensitivity labels or Azure Information Protection (AIP) labels are not supported in Microsoft Office report

template files. This includes the following formats:
l Excel
l PowerPoint
l Word

If your template contains any of these labels, the data restriction they provide is ignored, report
generation proceeds as usual, and generated reports will not contain any of sensitivity or AIP labels. If
sensitivity or AIP labels are required for output, you can add them manually to the reports after they are
generated.

5.7 Troubleshooting

Qlik NPrinting Designer crashes sometimes

Possible cause

Your Windows display is zoomed in. When settings of 125% or 150% are selected, Qlik NPrinting Designer may
crash.

Proposed action

Open your Windows Display Settings in the Control Panel. Set zoom to Smaller – 100% (default).

5.8 Qlik NPrinting Designer Properties pane
The Properties pane lets you customize chart objects in Excel, Word, PowerPoint, and HTML report
templates.

The Properties pane will display different settings, depending on:

l the object type you have currently selected (in the left-hand pane, not the template)
l the report type you are working on
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Property All objects Tables Images Levels

Name Yes No No No

Description Yes No No No

Connection Yes No No No

Keep Source Formats No Yes Yes Yes

Custom Rows No Yes No No

Expand range No Yes No No

Filter No Yes Yes No

Show Headers No Yes No No

Wrap text No Yes No No

Max Height and Max Width No No Yes No

Stretch No No Yes No

Properties pane settings
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Name
The name of the object. This is the object ID.

Description
The object description retrieved from QlikView or Qlik Sense.

Connection
The Qlik Sense or QlikView connection that contains the object.

Keep Source Formats
Keep Source Formats is available for all fields in the Pages and Levels node, and for fields and objects in the
Tables node. By default, Qlik NPrinting tries to keep original chart object formats. You can remove original
formats and apply your own by clearing the Keep Source Formats check box.

By removing Keep Source Formats from tables, you can apply Excel, PowerPoint, Word, HTMLor features and
numeric formats to the columns in the report. By removing Keep Source Formats from pages and levels, you can
apply formats to the cells in the report. To apply graphical formats, you do not need to remove Keep Source
Formats. After clearing Keep Source Formats, the Format option appears. You can use this to specify a custom
numeric format.

Limitations
If you apply Keep Source Formats to Qlik Sense columns only the following formats are kept:

l URLs
l color of text (foreground color) in tables
l background color of tables

All other formatting options (such as table borders, text alignment inside cells, text formatting) are not
supported.

Custom fonts may not render properly in reports. See: Fonts do not display properly in reports (page 550).

Tables
Tables or columns from tables exported from QlikView or Qlik Sense can be presented with the same formatting
as the original document or app. However, you may also want to customize this information.

For example: after clearing the Keep Source Formats check box, you can apply formatting to a table as a whole
or to component columns. Both numerical and time/date data are numerical entities. When Keep Source
Formats is deactivated for a column, a row presenting a new Format field appears. You can set specific
formatting for the column data by entering a code. Examples are #,##0.00, 0,00%, € #,##0.

You need to clear Keep Source Formats if you want to change column or row sizes.

Deactivating Keep Source Formats
The following lists the results of the various combinations of choices for different templates:
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Without setting a format code in the format field
l Excel: the Excel format is applied to the cell containing the field tag.
l Word and PowerPoint: the relative format is applied to the entity at the point of field tag embedding.
l HTML: the inline style set for the field tag container (div, span, p, th, td, li, etc.) is applied.

By entering a format code in the format field
l Excel: the code in the Format field defines the numerical or time/date format, while graphic style is

controlled by the Excel format tools applied to the cell containing the field tag (color, font, size, style,
justification, etc.)

l Word and PowerPoint: both the relative format and the format field are applied to the entity or container
at the point of field tag embedding

l HTML: both the inline style set and the format field are applied for the field tag container

For a field used in a level
Time, date, or numerical type of data is determined by the QlikView tag associated with the field. This can be
determined by opening the QlikView document in QlikView and pressing Ctrl + Alt + D, selecting the Tables tab,
and looking in the Tags column of the Fields list next to the Field name. If $date or $timestamp, or both, appear,
then the field is a time/date type. These tags are associated automatically on Reload.

Format field
The following sections list the effects that the elements have that are used to compose the formatting code. This
code is entered into the Format field that appears after deactivating Keep Source Formats.

Specifier Represents

0 Digit placeholder. If the value being formatted has a digit in the position where '0' appears in
the format string, then that digit is copied to the output string. Otherwise, a '0' is stored in that
position in the output string.

# Digit placeholder. If the value being formatted has a digit in the position where '#' appears in
the format string, then that digit is copied to the output string. Otherwise, nothing is stored in
that position in the output string.

. Decimal point. The first '.' character in the format string determines the location of the decimal
separator in the formatted value; any additional '.' characters are ignored. The actual character
used as a decimal separator in the output string is determined by the DecimalSeparator global
variable or its TFormatSettings equivalent.

, Thousand separator. If the format string contains one or more ',' characters, the output will
have thousand separators inserted between each group of three digits to the left of the decimal
point. The placement and number of ',' characters in the format string does not affect the
output, except to indicate that thousand separators are wanted. The actual character used as a
thousand separator in the output is determined by the ThousandSeparator global variable or its
TFormatSettings equivalent.

Floating point numbers
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Specifier Represents

E+ Scientific notation. If any of the strings 'E+', 'E-', 'e+', or 'e-' are contained in the format string,
the number is formatted using scientific notation. A group of up to four '0' characters can
immediately follow the 'E+', 'E-', 'e+', or 'e-' to determine the minimum number of digits in the
exponent. The 'E+' and 'e+' formats cause a plus sign to be output for positive exponents and a
minus sign to be output for negative exponents. The 'E-' and 'e-' formats output a sign character
only for negative exponents.

'xx'/"xx" Characters enclosed in single or double quotation marks are output as such and do not affect
formatting.

; Separates sections for positive, negative, and zero numbers in the format string.

Specifier Displays

c Displays the date using the format given by the ShortDateFormat global variable, followed by
the time using the format given by the LongTimeFormat global variable. The time is not
displayed if the date-time value indicates midnight precisely.

d Displays the day as a number without a leading zero (1-31).

dd Displays the day as a number with a leading zero (01-31).

ddd Displays the day as an abbreviation (Sun-Sat) using the strings given by the ShortDayNames
global variable.

dddd Displays the day as a full name (Sunday-Saturday) using the strings given by the LongDayNames
global variable.

ddddd Displays the date using the format given by the ShortDateFormat global variable.

dddddd Displays the date using the format given by the LongDateFormat global variable.

e (Windows only) Displays the year in the current period/era as a number without a leading zero
(Japanese, Korean, and Taiwanese locales only).

ee (Windows only) Displays the year in the current period/era as a number with a leading zero
(Japanese, Korean, and Taiwanese locales only).

g (Windows only) Displays the period/era as an abbreviation (Japanese and Taiwanese locales
only).

gg (Windows only) Displays the period/era as a full name (Japanese and Taiwanese locales only).

m Displays the month as a number without a leading zero (1-12). If the m specifier immediately
follows an h or hh specifier, the minute rather than the month is displayed.

mm Displays the month as a number with a leading zero (01-12). If the mm specifier immediately
follows an h or hh specifier, the minute rather than the month is displayed.

Time/date page
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Specifier Displays

mmm Displays the month as an abbreviation (Jan-Dec) using the strings given by the
ShortMonthNames global variable.

mmmm Displays the month as a full name (January-December) using the strings given by the
LongMonthNames global variable.

yy Displays the year as a two-digit number (00-99).

yyy Displays the year as a four-digit number (0000-9999).

h Displays the hour without a leading zero (0-23).

hh Displays the hour with a leading zero (00-23).

n Displays the minute without a leading zero (0-59).

nn Displays the minute with a leading zero (00-59).

s Displays the second without a leading zero (0-59).

ss Displays the second with a leading zero (00-59).

z Displays the millisecond without a leading zero (0-999).

zzz Displays the millisecond with a leading zero (000-999).

t Displays the time using the format given by the ShortTimeFormat global variable.

tt\ Displays the time using the format given by the LongTimeFormat global variable.

am/pm Uses the 12-hour clock for the preceding h or hh specifier, and displays 'am' for any hour before
noon, and 'pm' for any hour after noon. The am/pm specifier can use lower, upper, or mixed
case, and the result is displayed accordingly.

a/p Uses the 12-hour clock for the preceding h or hh specifier, and displays 'a' for any hour before
noon, and 'p' for any hour after noon. The a/p specifier can use lower, upper, or mixed case, and
the result is displayed accordingly.

ampm Uses the 12-hour clock for the preceding h or hh specifier, and displays the contents of the
TimeAMString global variable for any hour before noon, and the contents of the TimePMString
global variable for any hour after noon.

/ Displays the date separator character given by the DateSeparator global variable.

: Displays the time separator character given by the TimeSeparator global variable.

'xx'/"xx" Characters enclosed in single or double quotation marks are displayed as such, and do not
affect formatting.

Changing currency separation symbols
Some regions use periods to format currency, and some use commas. For example: $347.89 or € 347,89. You can
change the decimal separator used in report output files.

Do the following:
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1. Log into the Qlik NPrinting Engine computers via RDP as the Windows users that runs the Qlik NPrinting
Engine service.

2. Change the region settings in the Control Panel.

3. Restart the Engine service.

This process must be repeated on all Qlik NPrinting Engine computers.

Custom rows
The Custom rows setting appears if you add a table to the template. You can choose to only display certain
specific table rows. For example, if you input 1-4, users will only see the first four rows of the table in their
reports.

Expand range
The Expand Range setting only appears if you add a table to an Excel template. If the Expand Range check box
is flagged (default), Qlik NPrinting will add an adequate number of rows under the table or column tags to avoid
overlap with table tags placed underneath. If the Expand Range option is cleared, Qlik NPrinting will not add
rows under the table or column tags. You must manually manage the position of other table tags. However, Excel
formulas can be added to the table, because the references will be kept.

Filter
You can add object filters to tables and images.

Show Headers
The Show Headers property appears if you add a table. It has three options:

l Hide: Qlik NPrinting will not add headers. You can type them manually, or obtain dynamic headers using
variables and Excel formulas.

l Show in tag cell: column headers will be inserted in the tag cells and data will start in the row below.
Formulas and variables in original QlikView or Qlik Sense headers will not be replaced.

l Show above tag cell: column headers will be inserted in the row above tag cells. Data will start on the
row with the tags. Use this option when column headers in the original connection use variables or
formulas and you want them to be reported in the table.

If you add an entire table object to the template, Qlik NPrinting will add the object tag (for example: <CH123>).
The only way to control column headers is the Show headers setting.

If you add columns individually from a table, Qlik NPrinting will create Excel text cells with the headers, even if
you set Hide. You can keep and format the headers, or you can delete them and set Show Headers to other
values.

Wrap text
This setting will wrap text in table cells.
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Max Height and Max Width
You can set a max height and max width for images. In QlikView connections, the Max Width and Max Height
parameters define the output image size in pixels. They can be explicitly set in Excel templates. They can be
implicitly retrieved by the image placeholder, in Word and PowerPoint templates. When these parameters can be
explicitly set, (0,0) means “Auto”.

In Qlik Sense connections, the Max Width and Max Height parameters define the output image size in pixels.
They can be explicitly set in Excel templates. They can be implicitly retrieved by the image placeholder, in Word
and PowerPoint templates. When these parameters can be explicitly set, (0,0) means “Auto”, which is what is
captured by the snapshot. This means your Data Displayed parameters are considered to also be the output
image size.

See: Image dimensions (page 296).

Stretch
You can resize images using the Stretch property. This setting behaves differently depending on your connection
type.

HTML and QlikEntity report templates do not have the stretch image option.

QlikView connections
The Stretch option can be set to the following:

l Don't Fit: Image will be the same size as it is in QlikView. Template settings will be ignored. Image may
overlap other content.

l Fit Inside (default): Image height and width are reduced until both fit the settings in the template. Aspect
ratio is kept. Image may become compressed and information may be missing.

l Fit Width: Image is reduced until width is the same as Max Width set in the template. Image height is
adjusted to preserve aspect ratio. Max Height is ignored.

l Fit Height: Image is reduced until height is the same as Max Height set in the template. Image width is
adjusted to preserve aspect ratio. Max Width is ignored.

l Stretch: Image dimensions are increased or decreased until both height and width are the same as set in
the template. Aspect ratio is not maintained.

Qlik Sense connections
You can use the Stretch option can be set to the following:

l Don’t Fit: Max Width and Max Height measures are ignored. Data Displayed size, whether customized or
chosen automatically, is the final output size.

l Fit Inside: the chart’s aspect ratio is set by the Data Displayed values. The image will fit both Max Width
and Max Height values. The image will not be padded with a transparent or blank area to reach Max
Width and Max Height size.
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l Fit Width: the chart’s aspect ratio is set by the Data Displayed values. The image will fit the Max Width
measure. The image will not be cut to reach Max Width and Max Height size.

l Fit Height: the chart’s aspect ratio is set by the Data Displayed values. The image will fit the Max Height
measure. The image will not be cut to reach Max Width and Max Height size.

l Stretch: the aspect ratio set by Data Displayed is not kept. Instead, Qlik NPrinting tries to show either the
same amount or more data while filling the entire Max Width and Max Height area. The image will not be
deformed or padded with a blank area.

5.9 Working with Qlik objects
Qlik Sense and QlikView have many different object types: bar charts, pivot tables, KPIs, maps, and
more. How these objects can be used in Qlik NPrinting reports depends on the type of connection,
and the type of object.

In order for Qlik objects to appear in your reports, you need to have a working connection to your Qlik Sense app
or QlikView document. See: Creating connections (page 21).

How Qlik objects are exported into Qlik NPrinting
Qlik objects are exported into Qlik NPrinting. They may not look exactly the same, or behave the same way. For
example, bar charts export as static images. You cannot manipulate an image of a bar chart the same way as a
bar chart.

These are the main ways Qlik objects can be displayed in Qlik NPrinting reports:

l Text: simple text that can be formatted differently depending on report type. An Excel report will have
different formatting options than a PixelPerfect report.

l Tables: take your Qlik Sense and QlikView data and present it in tabular form.
l Images: take your Qlik Sense and QlikView data and present it as a graphic (.png).
l Levels: sub-divide your data by a dimension. Levels can be applied to tables and images. For example, you

could divide your top customers by region.

You can import your Qlik Sense app theme settings when configuring a connection by selecting Apply Sense app
theme, and the theme will be applied to Qlik objects displayed in Qlik NPrinting reports created using that
connection.

Images
QlikView chart objects are exported as images using the native QlikView image function.

Qlik Sense chart objects are exported as images as follows:

1. Visualization is opened in an in-memory browser window.

2. Image dimensions and dots per inch (DPI) settings are applied according to the report template.

3. A snapshot is taken of the rendered image.

4. The image is exported as a .png into your generated report or preview.
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Only the visible part of a visualization will be exported. For example, you export a Qlik Sense table that has scroll
bars as an image. You will see the scroll bars and the window area that they specify, but not the entire table. To
see how an object will appear in a report, open a Qlik Sense browser window on the Qlik NPrinting Engine
machine. Next, apply the same size and resolution used in the report template.

You can adjust the amount of chart data taken in the initial snapshot in the Qlik NPrinting Designer by changing
the Data Displayed values.

Older versions of Qlik NPrinting (June 2018 and earlier) exported QlikView charts differently. You can revert to this
older method.

You can export a visualization extension (custom object), if the visualization extension is set up to allow
it, and the security rules for your installation of Qlik Sense allow it.

Qlik objects that are partially supported
Some objects are not fully supported, because they are too complex.

A quick way to check if an object type is supported is to try and add it to the left-hand pane in Qlik NPrinting
Designer. Qlik NPrinting Designer will only add supported objects.

For example: you are connected to a QlikView document that contains a bar chart, a pivot table, and a gauge
chart. In Qlik NPrinting Designer, go to the left-hand pane, right-click on Levels, and select Add levels. A window
will open, listing the bar chart. The pivot table and gauge chart will not be listed, as they are not supported as
levels. They would appear if you added them under Images.

If a supported object does not appear in the Qlik NPrinting Designer, it could be because it was added in Qlik
Sense or QlikView, but the metadata cache was not refreshed in Qlik NPrinting. See: Reloading connection
metadata (page 38).

The following tables outline current restrictions:

Object Cannot be used as Can be used as

Pivot tables Levels, text Images, tables

Container objects Levels, tables, text Images

Object filters Levels, text Images, tables

Gauge charts Levels, text Images, tables

QlikView restrictions

QlikView embedded image files in QlikView tables are not supported in Qlik NPrinting tables. They will render
correctly if the QlikView table is added as an image in Qlik NPrinting. You may also be able to use levels to display
these types of images. See: Excel reports with levels (page 344).
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Object Cannot be used as Can be used as

Gauge charts Levels, text Images, tables

KPIs Levels, text Images, tables

Text and images Levels, text Images, tables

Maps Levels, tables, text Images

Pivot tables Levels, other restrictions Tables, text, images

Filter panes Levels, tables, text Images

Histograms Tables Images

Sense extensions Text Images, tables, levels

Qlik Sense restrictions

Text can mean single cells, a title, or the textual part of an object.

Qlik Sense pivot table limitations
Qlik Sense pivot tables are supported as images, text, and tables. However, there are some features and
behaviors that are not supported:

l Levels
l Partial expansion of rows and columns
l Foreground colors and background colors
l Hyperlinks (will display as plain text)
l Expanding or shrinking the size of the table. The desired pivot table size must be saved in the Qlik Sense

app, before you open the report in Qlik NPrinting Designer. If you change the size or layout of the table in
Qlik Sense, you will need to reload your Qlik Sense connection cache in Qlik NPrinting.

Paging limitations
PowerPoint reports have a Paging node. The following objects can be added as pages:

l Fields (with no calculated dimensions)
l Straight tables

Objects in Qlik Sense containers
If a supported object is inside a Qlik Sense container, it can be used normally. For example, if you put a KPI in a
container, you can use it as an image or table. The fact that it is inside a container has no effect.

Qlik Sense custom and extended sheets
Qlik Sense custom size sheets and extended sheet features will not be maintained on export.
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Qlik objects that are not supported
Some objects are not supported in Qlik NPrinting. These are:

l Uncertified Qlik Sense extensions
l Always one selected value for fields
l Calculated conditions
l Calculated dimensions
l Drill-down dimensions
l Alternate states
l Sheet triggers
l Dashboard bundle If you are experiencing issues, verify that you are using a compatible version of Qlik

Sense. Your Qlik NPrinting version must be equal to or higher than your Qlik Sense version.
l Visualization bundleIf you are experiencing issues, verify that you are using a compatible version of Qlik

Sense. Your Qlik NPrinting version must be equal to or higher than your Qlik Sense version.
l Qlik Sense objects that connect to external servers, usually as additional data sources (Qlik GeoAnalytics,

analytic connections)
l Qlik Sense charts with Chart suggestions enabled. To include charts created using chart suggestions in

Qlik NPrinting reports, disable Chart suggestions.
l Qlik Sense objects with Assistance mode enabled cannot use in the Add title feature in Qlik NPrinting

Designer. If you disable Assistance mode, and refresh the connection, then you can add titles.
l Qlik Sense tables that have a "Show column if" condition set on one or more of their columns cannot be

used with the following functionality: levels, single column export, and keep source formats.
l Qlik Sense dynamic views: You can connect Qlik NPrinting to a Qlik Sense app containing dynamic views.

However, after a dynamic view refresh, the connection will stop working.

You can use QlikView objects that have calculated dimensions or null values as levels. However, you
cannot nest other objects inside them, except for fields from that sheet object. Qlik Sense visualizations
with calculated dimensions cannot be used as levels.

Troubleshooting
If your objects are not appearing in your reports correctly, there could be an issue with your connections, or with
your Qlik Sense app or QlikView document.

Qlik Sense sheets can be used as images in report templates. However, if your sheet contains
unsupported objects, parts of the image will be blank.
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See also:
l Creating connections (page 21)
l Image dimensions (page 296)
l Image quality (page 302)

5.10 Image dimensions
You can change the size of objects exported as images from QlikView and Qlik Sense. You can also
change how much data is shown in each image.

This page applies to Excel, Word, PowerPoint, and HTML reports. Microsoft Office reports maintain image
dimensions as defined at the moment the image is dropped into the report template.

If an image does not look correct in Qlik NPrinting Designer preview, refresh the connection cache. It may have
changed in Qlik Sense or QlikView, but the metadata cache was not refreshed in Qlik NPrinting. See: Reloading
connection metadata (page 38).

Limitations
l HTML and QlikEntity report templates do not have the stretch image option.
l If you add an image from QlikView, and then add filters, the image may become distorted due to changes

in dimensions.

l

Qlik Sense sheets can be used as images in report templates. However, if your sheet contains
unsupported objects, parts of the image will be blank.

Adding one chart with multiple image sizes
When you use the Images node to add a Qlik object, that image can be used multiple times in your report.
However, it will be the same size every time. An image object cannot have two different formatting properties. If
you want to show the same chart in a report, but in different sizes, you will need to add it twice using the Images
node.

For example, you want to add Sales by Country as an image to your report. You want to use it as a thumbnail on
one page, and you want it large enough to display all its data on another. Add the object using the Images node:
CH304 - Sales by Country. In the Properties pane, set Stretch to Fit Inside, and reduce the image dimensions
so it can be used as a thumbnail. Go back to the Images node, and add the same object. It will have a slightly
different name: CH304 - Sales by Country_1. In the Propertiespane, set Stretch to Fit Width, so that the image
fills the entire width of the report page.

Changing image size of QlikView charts
When you generate a preview or report, QlikView charts are resized in QlikView according to template
specifications, and then a screenshot is taken. This screenshot is what you see in a generated report. You can
change the size and aspect ratio of chart images in the Properties pane.
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Max Width and Max Height
The Max Width and Max Height parameters define the output image size in pixels. They can be explicitly set in
Excel templates. They can be implicitly retrieved by the image placeholder, in Word and PowerPoint templates.
When these parameters can be explicitly set, (0,0) means “Auto”.

Stretch parameters
The Stretch option can be set to the following:

l Don't Fit: Image will be the same size as it is in QlikView. Template settings will be ignored. Image may
overlap other content.

l Fit Inside (default): Image height and width are reduced until both fit the settings in the template. Aspect
ratio is kept. Image may become compressed and information may be missing.

l Fit Width: Image is reduced until width is the same as Max Width set in the template. Image height is
adjusted to preserve aspect ratio. Max Height is ignored.

l Fit Height: Image is reduced until height is the same as Max Height set in the template. Image width is
adjusted to preserve aspect ratio. Max Width is ignored.

l Stretch: Image dimensions are increased or decreased until both height and width are the same as set in
the template. Aspect ratio is not maintained.

Changing how QlikView charts are exported
The export behavior was different if you were using:

l Qlik NPrinting June 2018 and earlier
l QlikView 12.20 SR6 and earlier

QlikView would screenshot the chart, and then it would be resized. You can revert to this older behavior in newer
versions of Qlik NPrinting by editing the QlikView.config file.

Do the following:

1. Stop the Qlik NPrinting Engine service.

2. Open the QlikView.config configuration file.
The default path is: C:\Program Files\NPrintingServer\NPrinting\Engine\QlikView.config

3. Find the useAdvancedImageExport flag.

4. Remove the comment characters. Change <useAdvancedImageExport value="true" /> to
<useAdvancedImageExport value="false" />.

5. Save the file and restart the service.

6. Repeat this process on all engine servers.

Example: PowerPoint report with different QlikView chart sizes
This example shows the different image dimension options in a PowerPoint report template, but is relevant to
Excel and Word reports.
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If you are creating an Excel report, image sizes will be in pixels, not centimeters. Images cannot be
manually re-sized in Excel.

Adding an image with the Don't Fit property
Do the following:

1. Create a PowerPoint report using the Sales Demo document, and then open the Template Editor.

2. On the left pane, right-click on Images, and select Add objects.

3. Select CH304 - Sales by Country.
The original object is 9.16 cm high x 14.93 cm wide.
If the Properties pane is not open, right-click on the object node in the Template Editor, and then select
Properties.

4. Click the Stretch Value cell and select Don't Fit from the drop-down list.

5. Drag and drop CH304 - Sales by Country into the template.

6. Select the CH304 - Sales by Country image.

7. In the PowerPoint ribbon, go to Picture Tools and then Format.

8. Expand the Size tool by clicking on the icon in the lower right corner of the Size group.

9. Clear the Lock aspect ratio check box.

10. Change the Height to 8.75 cm and the Width to 20 cm.

Adding an image with the Fit Inside property
Do the following:

1. On the PowerPoint ribbon, click the Home tab .

2. Click the New Slide icon.

3. On the left pane, right-click on Images, and select Add objects.

4. Add CH304 - Sales by Country to the template again.

5. This image will be automatically named CH304_1 - Sales by Country.

6. In the Properties panel, set the Stretch property to Fit Inside .

7. Drag and drop CH304_1 - Sales by Country into the template.

8. Select the CH304_1 - Sales by Country image.

9. In the PowerPoint ribbon, go to Picture Tools and then Format.

10. Expand the Size tool, and clear the Lock aspect ratio check box.

11. Change the Height to 8.75 cm and the Width to 20 cm.

Adding an image with the Fit Width property
Do the following:

1. On the PowerPoint ribbon, click the Home tab .

2. Click the New Slide icon.
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3. On the left pane, right-click on Images, and select Add objects.

4. Add CH304 - Sales by Country to the template again.
This image will be automatically named CH304_2 - Sales by Country.

5. In the Properties panel, set the Stretch property to Fit Width.

6. Drag and drop CH304_2 - Sales by Country into the template.

7. Select the CH304_2 - Sales by Country image.

8. In the PowerPoint ribbon, go to Picture Tools and then Format.

9. Expand the Size tool, and clear the Lock aspect ratio check box.

10. Change the Height and Width to 12.7 cm.

11. Click on Close at the bottom right of the window.

Adding an image with the Fit Height property
Do the following:

1. On the PowerPoint ribbon, click the Home tab .

2. Click the New Slide icon.

3. On the left pane, right-click on Images, and select Add objects.

4. Add CH304 - Sales by Country to the template again.
This image will be automatically named CH304_3 - Sales by Country.

5. In the Properties panel, set the Stretch property to Fit Height.

6. Drag and drop CH304_3 - Sales by Country into the template.

7. Select the CH304_3 - Sales by Country image.

8. Select Format under Picture Tools.

9. Expand the Size tool, and clear the Lock aspect ratio check box.

10. Change the Height and Width to 12.7 cm.

Adding an image and adjusting it manually
Do the following:

1. On the PowerPoint ribbon, click the Home tab .

2. Click the New Slide icon.

3. On the left pane, right-click on Images, and select Add objects.

4. Add CH304 - Sales by Country to the template again.
This image will be automatically named CH304_4 - Sales by Country.

5. In the Properties panel, set the Stretch property to Fit Inside.

6. Drag and drop CH304_4 - Sales by Country into the template.

7. Select the CH304_4 - Sales by Country image.

8. Adjust the image size to fill the slide by dragging a corner handle, and then repositioning the image until it
fills the slide appropriately.

Previewing the report
You can now see how the five different sizing options display your image differently.
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Do the following:

1. Click on Preview. You will see the following:

a. Slide 1 - Don't fit
The image is the same size as it was in the QlikView document, 9.16 cm x 14.93 cm. Qlik NPrinting
has ignored the height and width settings.

b. Slide 2 - Fit Inside
The image has the height specified in height setting, 8.75 cm, and the width has been adjusted
proportionately to 14.26 cm.

c. Slide 3 - Fit Width
The image width has been reduced to the specified 12.7 cm width, and the height has been
adjusted proportionately to 7.79 cm.

d. Slide 4 - Fit Height
The image height and width may be equal to or less than the original image dimensions. Even
though the height was set to 12.7 cm, the height remains 9.16 cm and the width remains 14.93 cm.

e. Slide 5 - Fit Inside with manually re-size
The image is the same size as the original, 9.16 cm x 14.93 cm. The image is positioned in the top
left corner.

Changing image size of Qlik Sense charts
By default, Qlik Sense charts exported into Qlik NPrinting will look exactly as they do in the connected Qlik Sense
app. For example, you have a large bar chart which contains twelve months of data, that can be viewed using
scroll bars. You reload the connection metadata when the chart is displaying data from February to June. If you
add this chart as an image in Qlik NPrinting Designer, that image will only show February to June data, like a
snapshot.

Data Displayed parameters
Under the Properties pane, you can use Data Displayed Width (px) and Data Displayed Height (px) to adjust
how much chart data is displayed in the image. These two parameters decide how much data should be captured
by Qlik NPrinting when exporting a chart from Qlik Sense, regardless of the chart’s final size in the report. Using
the same example, if you want to see bar chart data from January to December, you can do so by adjusting Data
Displayed. You could also choose to only display January. These parameters define the “original” chart size: the
size of the snapshot of the chart we want to export.

If you have edited your Qlik Sense app, you must regenerate the connection cache if you want to see updated
Data Displayed parameters .

The default Data Displayed size is (0,0), which means “Auto”. Both parameters must be greater than 0, otherwise
they will be ignored.

Max Width and Max Height
The Max Width and Max Height parameters define the output image size in pixels. They can be explicitly set in
Excel templates. They can be implicitly retrieved by the image placeholder, in Word and PowerPoint templates.
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When these parameters can be explicitly set, (0,0) means “Auto”, which is what is captured by the snapshot. This
means your Data Displayed parameters are considered to also be the output image size.

Stretch parameters
You can use the Stretch option can be set to the following:

l Don’t Fit: Max Width and Max Height measures are ignored. Data Displayed size, whether customized or
chosen automatically, is the final output size.

l Fit Inside: the chart’s aspect ratio is set by the Data Displayed values. The image will fit both Max Width
and Max Height values. The image will not be padded with a transparent or blank area to reach Max
Width and Max Height size.

l Fit Width: the chart’s aspect ratio is set by the Data Displayed values. The image will fit the Max Width
measure. The image will not be cut to reach Max Width and Max Height size.

l Fit Height: the chart’s aspect ratio is set by the Data Displayed values. The image will fit the Max Height
measure. The image will not be cut to reach Max Width and Max Height size.

l Stretch: the aspect ratio set by Data Displayed is not kept. Instead, Qlik NPrinting tries to show either the
same amount or more data while filling the entire Max Width and Max Height area. The image will not be
deformed or padded with a blank area.

Example: Excel report with different Qlik Sense chart sizes
These examples were made using the same Qlik Sense chart. They were all put into an Excel report, with different
Data Displayed, Max Width, Max Height, and Stretch values.

The example has three chart images, from left to right:

1. Data Displayed: Auto, Output: Auto

2. Data Displayed: 800x400 px, Output: Auto

3. Data Displayed: 1920x1080 px, Output: 500x500 px, Stretch

The second example has two chart images, from left to right:

1. Data Displayed: 1920x1080 px, Output: 1000x1000 px, Stretch

2. Data Displayed: 400x800 px, Output: Auto
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Changing image size in PixelPerfect reports
PixelPerfect reports have different image Stretch options:

l Normal: The image is displayed with its original dimensions.
l StretchImage: The image is stretched to fill both the control's width and height.
l AutoSize: The control's dimensions are auto-adjusted to the image size.
l ZoomImage: The image is proportionally resized, so that it fits the control.
l Squeeze: If the control's dimensions exceed the image size, the image is centered and shown full-size.

Otherwise, the image is resized to fit into the control's dimensions.
l Tile: The original image is replicated within the picture control starting from the upper-left corner. The

replicated image is clipped if it does not fit in the picture control which contains it.

5.11 Image quality
You can change the image quality of Qlik Sense and QlikView objects by adjusting their dots per
inch (DPI) in your published reports.

This means you can create a PowerPoint report with high-quality images that will look good on a large screen
during a presentation. After the presentation, you could share a second version with lower-quality images (and a
smaller file size) via email. There is no need to create a second report. You can add the same report to two
different publish tasks with different image quality settings. You could also create one publish task with two
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instances of the same report, and give each report different image quality. When you set your email destination,
you can choose which report to attach. However, creating a single publish task means that every other
destination (NewsStand, hub) will receive both reports.

Changes in image quality take effect after you distribute your report to the NewsStand, hub, folder, or other
destination. In the NewsStand, the image quality of a report is displayed in a column on the right. Published
reports export all images as .png, regardless of source.

You can also set the image quality of On-Demand reports.

Limitations
l QlikView objects cannot be re-sized or given a DPI value before exporting to Qlik NPrinting. Instead, Qlik

NPrinting uses an up-scaling algorithm to get a more defined image. This is not an issue with Qlik Sense
objects.

l If you publish one report with two different image quality levels to a folder, the newer file will overwrite
the older one. This can be avoided by applying a Friendly name when adding the report to a task. See:
Dynamic report names (page 322).

l The following report output format combinations cannot have their quality changed:
l Excel to .tiff
l PixelPerfect to .gif
l PixelPerfect to .jpeg
l PixelPerfect to .png
l PixelPerfect to .tiff

Setting image quality in publish tasks
Do the following:

1. In the main menu bar, click Tasks, and then select Publish task.

2. Create a new publish task, or click an existing publish task to edit it.

3. Click Reports.

4. Use the Quality dropdown menu to select one of the following:

a. Normal: 96 DPI

b. High: 192 DPI

c. Very High: 384 DPI

5. Click Save.

Once you publish your report, you will be able to see the difference in image quality.

Configuring image quality in On-Demand reports
You can update the scheduler.config file to change the image quality of your On-Demand reports. This is a single
setting for all reports generated via On-Demand. You cannot select the image quality for the generation of a
specific report.
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You can set your On-Demand reports to have higher image quality, the same as from a publish task. As soon as
you change this, all On-Demand reports will be affected. This will also affect report previews in Qlik NPrinting
Designer. Task reports will not be affected.

The report type and output format combinations that are not supported in tasks are still not supported in this
case. For example, you cannot set an image quality level on a report from a task if you are exporting a
PixelPerfect report as a .jpeg. If you try to run an On-DemandPixelPerfect report setting this flag to "Veryhigh", it
will look the same as a "Normal" report.

The following combinations are not supported:

l Excel to .tiff
l PixelPerfect to .gif, .jpeg, .png, .tiff
l QlikEntiy to .csv, .skv, .tab, .tiff

Do the following:

1. Open the scheduler.config configuration file.

2. Find the following string: <add key="ondemand-image-quality" value="Normal" />

"Normal" is the default value.

3. Change value to: "Normal", "High", or "Veryhigh". These are case sensitive, and have the following DPI
values:

a. Normal: 96 DPI

b. High: 192 DPI

c. Veryhigh: 384 DPI

4. Save the file.

See also:

p Image dimensions (page 296)

5.12 Filters
Filters let you refine your data. You can add filters to tasks, reports, objects, and users. They can be
static or dynamic.

Types
Here are a few ways you can use filters:

l Task: filter a publish task to only share data from the current quarter.
l Report: filter a report to only display information related to the top 5 sellers.
l Object: filter a pie chart that details grocery sales to only show fruit sales.
l User: filter a user group to only see data related to their geographic location.
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Static filters are selected from a list of QlikView or Qlik Sense field values. You must manually edit the filter to
change values.

Dynamic filters use QlikView or Qlik Sense expressions and searches. Expressions must use QlikView or Qlik Sense
rules and syntax, and return a single value. Expressions are evaluated, and the results are used to filter data.
Searches leverage the various kinds of search available in QlikView or Qlik Sense.You do not have to modify
dynamic filters to gain new values.

Filter evaluation
Filters are verified before generating each report. Task, user, and report filters are checked against document
data. If they are invalid, you will see an error stating that filters cannot be applied on the Task executions page.
This happens before the calculation of report conditions, and before report generation. Qlik NPrinting will resolve
filters by applying them in a sequence where the initial state has no selections on any field.

If you have a single filter, it is evaluated as follows:

1. Clear all selections for all fields, with Override values selected.

2. Calculate the expressions for each field with evaluated values.

3. Apply selections based on values and searches to all fields.

When you have multiple filters, they are evaluated in the following sequence:

1. All task filters are applied one at time, according to their sort order.

2. All user filters are applied one at time, according to their sort order.

3. All report filters are applied one at time, according to their sort order.

4. All object filters are applied one at time, according to their sort order.

Rules
Qlik NPrinting filter rules provide predictable behavior with a limited number of options:

l Evaluated values are calculated first, in order to have static values to manage.
l Filters will not necessarily overwrite past selections. There is no strict hierarchy.
l Each filter will be analyzed in sequence: task -> user -> report -> object.
l The values of filter fields at different levels will be intersected.
l If the intersection gives an empty result, the filter chain will become invalid.
l There is no limit to how many task, report, object, or users filters you can apply in an app. However, only

one object filter can be applied to a single object.
l If the application of a filter results in an impossible selection, a specific error is returned: "Cannot apply

filter {0} to current document data. Requested fields with evaluates are: {1}",

There is one specific flag that allows you to change these behaviors: Override values. This flag, which is related
to specific fields of a filter, allows you to clear the selections on a certain field on a certain level of the chain. You
can also add other values instead.

Qlik NPrinting - February 2024 305

5   Common report features



Field selections and variables settings within a filter do not effect each other. But they will effect the
filters that follow in the evaluation chain.

Examples of filtering results
These examples show filters assigned to specific entities for different values of the same field, with Override
values selected or de-selected:

Example 1
l Task filter: Country = Italy, Spain
l User filter: -
l Report filter: Country = Italy, Germany
l Resulting filter: Country = Italy

Example 2
l Task filter: Country = Italy, Spain
l User filter: Override values = Checked for Country
l Report filter: Country = Italy, Germany
l Resulting filter: Country =Italy, Germany

Example 3
l Task filter: Country = Italy, Spain
l User filter: Country = Italy, Germany
l Report filter: Override values = Checked for Country
l Resulting filter: Country = All countries

Example 4
l Task filter: Country = Italy
l User filter: -
l Report filter: Country = Germany
l Resulting filter: empty

Example 5
l Task filter: Country = Italy
l User filter: Override values=True for Country
l Report filter: Country =Germany
l Resulting filter: Germany

Selecting values
In the Values drop-down menu you can select from:
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l Value is: use this option if you want to select a string. For example, if you want to select USA in the
Country field.

l Numeric value is: in QlikView and Qlik Sense, all field values are potentially dual values. A field value can
have both a numeric value and a textual value. For example, a date that could have a numeric value of
40908 and the textual representation "2011-12-31". Use this option if you want to select a numeric value.

l Evaluate value: use this option if you want to insert an expression that needs to be evaluated. It must
return a single value.

l Advanced Search: use this option if you want to select values using a QlikView or Qlik Sense advanced
search.

If the Fully cached notification appears on the right, it indicates that the Qlik NPrinting cache contains all values
of a field. This means that when you start typing in the Values dialog box, Qlik NPrinting searches all the values
that match your string.

The Qlik NPrinting cache only stores the first 1000 values from QlikView fields with a large amount of distinct
values. In this case, the Fully cached green label does not appear. You will instead see a Search button on the
right side of the value field. Type the string, or part of the string, that you want to find. Click Search to force Qlik
NPrinting to look for the string in the connected QlikView document. When there is a large amount of distinct
values, you have to manually insert the whole value that you want to filter.

Creating a static filter
Do the following:

1. Select Apps, and then select Filters.

2. Click Create filter.

3. Enter a Name for your filter.

4. Select an app from the App drop-down list.

5. Click Create.

6. Click Fields in the filters menu.

7. Click Add field.

8. Under Connection, select your connection.

9. Under Name, select a field name.

10. You can choose to Override values: if you select this check box, all selections applied by other filters on
the same field will be removed and replaced by the values of the field set in current filter. If Override
values is not selected, a new filter will be created by the intersection of field values from different filters
applied on the selected field.

You can clear all selections on a field by creating a filter with empty values for that field and
selecting the Override values check box.

Adding values to a field
Do the following:
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1. Choose a value type from the drop-down list:
l Value is
l Numeric value is
l Evaluate value
l Advanced Search

2. Depending on the value type, you can choose from a list, start typing a string, or type an expression. See:
Selecting values (page 306)

3. If you want to add a second value, click Add value.
A new empty row appears.

4. Add your second value.

5. Click Create.

Creating a filter with Select excluded values
When you create a filter, you can exclude specific values, using the Select excluded check box. For example, you
may want to exclude data from certain years, or geographic regions. This is similar to the Select excluded
operation in Qlik Sense and QlikView.

Do the following:

1. Select Apps, and then select Filters.

2. Click Create filter.

3. Enter a Name for your filter.

4. Select an app from the App drop-down list.

5. Click Create. Click Fields in the filters menu.

6. Click Add field. Under Connection, select your connection.

7. Under Name, select a field name.

8. Choose a value type.

9. Select the values you want to exclude.
For example, if the field was Country, you could exclude Sweden and Italy.

10. Click the Select excluded check box.

11. Click Create.

Creating a dynamic filter with evaluated values
You can use QlikView and Qlik Sense expressions to calculate values to be used in filters. Each expression must
return a single value, and use QlikView or Qlik Sense syntax. For example, you can use an expression to calculate
the value of the previous year and compare it with the Year field in a filter.

Do the following:

1. Create a new filter.

2. Click the Values tab, and select Evaluate value from the drop-down.
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This option sends your expression to QlikView or Qlik Sense, which will evaluate the result and return it to
be used in the filter.

3. Enter an expression in the Value box.
For example, to retrieve the value of the last year, enter =Year(now())-1.

4. You can click Add value to add another expression. Adding many values for the same field creates a
logical "OR" association. The filter will keep data that matches one or both values.

5. Click Create.

Creating a dynamic filter with advanced search
You can use QlikView and Qlik Sense advanced search to select a set of values to use in filters.

Several types of advanced search are supported:

l Text: all values that match the text exactly are selected.
l Wildcard: *, ? and ^ can be used as wildcards in a text search.

o *: placeholder for 0 or more undefined characters.
o ?: placeholder for one undefined single character.
o ^: placeholder that specifies that the next character is the beginning of a word.

l Numeric: if a search starts with < or > it will be evaluated as a numeric search
l Expression: if a search starts with an = it will be evaluated as an expression search. The result of the

expression is interpreted as a Boolean:
o 0=false
o Any other value=true

Your advanced search results are intersected with the values selected on the field in previous filters if Override
Values is not used. The value set generated from an expression search depends on the current selections, similar
to how evaluated values are calculated. If you want to ignore the current selections in an app or document, you
should use:

l Qlik Sense: Set analysis and set expressions
l QlikView: Set analysis and set expressions

There are dynamic search types that are not supported. The following may return unexpected results:

l Normal: searches that match the inserted text with the beginning of a word in a field value. You will
receive more accurate results with a wildcard search: *^text to search*.

l Fuzzy: searches that begin with ~. In QlikView and Qlik Sense, fuzzy search selects the first value in the list
shown on screen. In Qlik NPrinting, it selects every value in the list.

l Compound: searches that enclose search text between ( ) and using operators like |, & and ^ to mix the
other search types.

Do the following:
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1. Create a new filter.

2. Go to the Values area, and select Advanced search from the drop-down.
This option will perform a search on the selected field in QlikView and Qlik Sense and return it to be used
in the filter.

3. Enter one of the supported searches in the Value box.
For example, to retrieve data from every year except the current one, enter =Year<Year(now()).

4. You can click Add value to add another advanced search. Adding many values for the same field creates a
logical "OR" association. The filter will keep data that matches one or both values.

5. Click Create.

Creating a variable-based filter
You can use a variable in a filter, and set the value of the variable directly during report generation. This
temporarily overwrites the original value that the variable has in QlikView or Qlik Sense.

Variable-based filters can be static or dynamic. They can be added to reports, tasks, users, and objects.

For example: You can create two different reports that have the same chart object, but that show different results
depending on the variable value. Or, you could create one report with two publish tasks, with different variable-
based filters.

Do the following:

1. Create a new filter.

2. Click the Values tab, and click Create variable.

3. Select a connection from the drop-down menu. Under Name, select a dimension.

4. Under Value, type in an existing dimension.
Click the Evaluate check box if you want the variable to be evaluated before it is applied.

5. Click Create.

Adding filters to a report
You have to create filters before you can add them to reports, tasks, objects or users. You cannot create a new
filter from inside another entity.

Do the following:

1. Create a new report, or open an existing one.

2. Click Filters in the main menu.

3. Select the filters you want from the Available items.

4. Click to move the filters into the Selected Items column.

5. Click Add filters.
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Applying a filter to an object
Object filters are useful when you want to filter a specific table or image. For example, if you have a report with
no filters, but you want to add a table that only displays last year's sales, you would apply an object filter.

Objects can only have a single filter. If you need to add a complex filter to an object, you must create a unique
filter before you edit the report template.

Do the following:

1. On the Reports screen, click on your report.

2. Click the Edit template button to open the Qlik NPrinting Designer template editor.

3. On the left pane, right-click the type of object you would like to filter, and select Add objects.
You can filter tables and images.

4. A new window will open. Select the object you would like to filter, and click OK.

5. Drag your new object from the left pane to your report template.

6. On the Properties pane, go to Filters and click the¥.

7. A new window will open. Select the filter you would like to use, and click OK.

If you accidentally pick the wrong filter, you can click the eraser icon next to the¥ to remove all
filters from an object.

8. Click Preview.
Your report object will only show information related to the filter.

Importing object filters associated with users
Object filters associated with users are not automatically included in Qlik NPrinting Designer, for performance
reasons. Importing all of the filters associated with thousands of users would take a long time, and could cause
Qlik NPrinting to stall.

You can change this behavior by editing the webengine.config file.

You should always backup your Qlik NPrinting repository before editing a .config file. For more
information, see Backing up Qlik NPrinting (page 193).

Do the following:

1. Open the webengine.config file.

2. Uncomment the line <!-<add key="include-user-filters" />->.

3. Close and reopen Qlik NPrinting Designer.

4. The list of filters will now upload all filters you have stored in the repository.
This could take a very long time, depending on the number of stored filters.

If you do not want to edit the webengine.config file, you can manually import a specific user filter. There are two
ways to do this:
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l Remove the filters association from all users.
l Create a new filter, not linked to any user, with the same fields and values.

Configuring report behavior
You can configure how a report handles object filter errors for charts and tables in your templates. Open the
report, scroll down to Error handling, and select from these two options:

l Generate report. Invalid content will be replaced with placeholder images.
Invalid charts are replaced with placeholder images. They have a grey background and black overlay text
that says "Invalid selections". These images are scaled according to maximum size settings in your report
template. Invalid tables are replaced with empty tables with no overlay text.

l Do not generate report. Report generation will fail until issue is resolved.
The entire report will fail to generate. Users will not be able to view it.

In Qlik NPrinting April 2018 and later, the default behavior for new reports is to add placeholder images. If you are
using Qlik NPrinting February 2018 or older, and update to a newer version, your reports will keep the pre-
existing report failure behavior.

Configuring empty content
Empty content is displayed as placeholder images. They have black overlay text that says "Invalid selections".
This overlay text can be changed.

You should always backup your Qlik NPrinting repository before editing a .config file. For more
information, see Backing up Qlik NPrinting (page 193).

Do the following:

1. Open the scheduler.config configuration file.

2. Find the "empty-content-text" tag. Uncomment this line, and edit the value.

3. Restart the Qlik NPrinting scheduler service.

The change is applied to all empty content placeholder images.

Troubleshooting

The folder containing my cycled reports shows reports with the FAILED label

Possible cause

Your reports contain incompatibility filters.

Proposed action

Check the filters associated with the report. For example, you have 2 filters:
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l The first contains → Year: 2012, 2013
l The second contains → Year: 2014

If you use both filters, the intersection between the filters will produce an empty set.

My reports fail to generate

Possible cause

Your report uses the same dimension in the task, user, report, and object filter hierarchy.

Proposed action

Change or remove any filters that use the same dimension.

5.13 Conditions
Conditions let you control report generation and distribution on a data basis. You can add multiple
conditions to any report or task. Reports are generated and tasks are run only when all their
conditions are satisfied. Each condition can be composed of one or more rules.

If an error occurs during report condition evaluation (before results are produced), the error is reported
to the user the same way as errors that occur during report generation. Both result in an error message
added to the emails sent to users.

Overview
A condition is a set of one or more expressions with one or two operands and one operation. Operands can be
fixed values, variables, or expressions. A condition is associated with an app, while the rules within the condition
will be bundled to a specific connection of the app. Only the object types that appears in the list during
conditions creation can be used.

There are two places that a condition may be applied:

l Publish task report
l Publish task

Sending reports on a conditional basis has many advantages. For example, you can be informed when key events
in the data happen. You can save computational resources by not distributing unnecessary reports.You can create
and manage reports with data from multiple QlikView documents or Qlik Sense apps in a consistent way since
filters, reports, and conditions manage multiple connections at the same time. For example, you can:

l Compare the value of an existing QlikView variable with another variable, an expression or a constant
value. Available comparisons are: equal to, not equal to, greater than, greater than or equal to, less than,
less than or equal to.

l Check that a certain QlikView chart contains values at run time.
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l Distribute a sales report with data from different QlikView documents, select the same year on all
documents by applying a filter, and add a condition that checks whether all the charts in the different
documents have data.

Conditions and filters
Publish task report conditions and publish task conditions affect when filters are applied.

When you apply a condition to the publish task via the Conditions button:

l If you have applied a task filter, this filter will be applied when evaluating the condition.
l If you have applied a report filter or user filter, the filter will not be applied when evaluating the condition.

When you apply a condition to a publish task report:

l Task filters, report filters, and user filters are always applied when evaluating the condition.

If section access is enabled, task conditions are evaluated with the identity set for the connection in the
connections page. Report conditions are evaluated using the identity of the recipient of the report.

If you cycle reports that contain conditions and filters, they will be evaluated in this order: Task filter > user filter
> report filter > condition. Conditions are not evaluated separately for each report in the cycle. For example:

1. You have a report filter: YEAR 2012, 2013.

2. Add a cycle on YEAR.

3. Add a report condition (evaluated with the filter applied).

4. Execution flow is as follows:

a. YEAR 2012, 2013 filters are applied.

b. Condition is evaluated.

c. If the condition is met, a report is produced for YEAR 2012, and one is produced for YEAR 2013.

Limitations
If a chart used in the condition is deleted from the document, you will receive a warning message on the
condition rule page. Invalid conditions used on tasks cause generation failures. If an invalid condition is applied
to a task, the task fails immediately. If it is used as a report condition, only the related reports generation fails.

Evaluation of a condition will be bypassed when an invalid filter is used on a report task. A failure in condition
evaluation is treated like a failure in report generation and a generic email containing an error message will be
sent.

Creating a condition
Before you create a new condition, you should make sure that any related connection caches are up-to-date.

1. Click Apps, then select Conditions.

2. Click on the Create condition button in the upper right corner.

3. Enter a descriptive Name.
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4. Enter a Description (optional).

5. Open the App drop-down menu and select the app in which you want to create the new condition.

6. Leave the Enabled check box selected.

7. Click on Create.

Adding a rule
1. Click on the Rules button.

2. Click on the Add rule button in the upper left corner.

3. Enter a descriptive Name.

4. Open the Connection drop-down menu, and choose a connection.

5. The Values section of the page will appear.

Setting chart-based conditions
You set your conditions in the Values section. You can create conditions that check if a chart has or does not have
certain values. Make sure that the charts are available in the QlikView document or Qlik Sense app.

1. Select Chart from the first column on the left.

2. Select the chart from the central drop-down menu. You can use the Search form to filter the list.

3. Choose a condition between has values and has no values. The condition has values is true when the
chart contains values with the filters applied at the moment of the evaluation of the condition.

4. Click on Create.

5. To add another rule, click the plus symbol, or click Add condition.

Setting variable-based conditions
You can create conditions that compare a QlikView or Qlik Sense variable with another variable, the result of an
evaluated expression, or a fixed value. Make sure that the variables are available in the QlikView documentor Qlik
Sense app..

1. Select Variable from the first column on the left.

2. Select a variable from the Select variable drop-down menu.

3. Choose the relational operator from the drop-down menu.

4. Select the type to compare:

1. Variable. Select the second variable from the drop-down menu on the right.

2. Expression. Insert an expression that will be evaluated before the comparison. The expression
must return a single value.

3. Constant. Type a constant. No evaluation will be done.

5. Click on Create.

6. To add anther rule, click the plus symbol, or click Add condition.
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Adding conditions to a task

If there is a report or user filter, the filter will not be applied when Qlik NPrinting evaluates conditions
added to a task.

Do the following:

1. In the main menu, go to Tasks > Publish tasks, and open the task you want to edit.

2. Click on the Conditions button in the upper right of the screen.

3. The list of conditions applied to the task will appear.

4. Click on the Add condition button on the right.

5. Select the condition from the Choose condition drop-down menu.

6. You can reduce the list by using the Search form.

7. Select True or False in the Expected result drop-down menu. If you select True the task will be executed
when the condition is verified. If you select False the task will be executed when the condition is not
verified.

8. Click on Add condition to confirm and exit.

9. The new condition appears at the end of the list.

10. To add another condition click on Add condition again. You can add as many conditions as you want.

Adding condition to a report in a task
You can add conditions to reports already inserted into tasks. It is not possible to add conditions directly to
reports. A report is generated only if all related conditions are satisfied.

Do the following:

1. Open the Publish task.

2. Open the Reports list, then add the report you want to apply conditions to or open it if it is in the list.

3. Select the condition you want to apply from the Condition drop-down menu in the bottom of the page.

4. Select True or False in the Expected result drop-down menu.
l If you select True the report will be created when the condition is verified.
l If you select False the report will be created when the condition is not verified.

This is useful because you can add two different reports with the same condition, and set one True
and the other False. So if the condition is satisfied the first report will be distributed, otherwise the
second report will be distributed.

5. To add anther condition, click the plus symbol, or click Add condition.

6. Click Save.

Removing a condition
You can delete conditions from the main Conditions window, or from the window of the condition itself.
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See also:
l Cycling your reports (page 324)
l Filters (page 304)

5.14 Variables
Qlik Sense and QlikView variables can be used to customize Qlik NPrinting reports and emails.

A variable in Qlik Sense or QlikView is a static value that can be:

l a string of text
l a number
l a date
l the evaluated result of an expression

Expressions are identified by an equal sign = at the beginning. When you use a variable in an app or document,
any change made to the variable is applied everywhere the variable is used.

Variables can contain complex expressions, user information, or company details. For example, you could have a
variable that calculates weekly sales figures by region. You could use a variable in place of a product name that
may change in the future. A user name variable could be used to personalize company emails. These types of
variables make your reporting more consistent and easier to maintain.

You can also use variables to make email distribution lists.

Best practices for variables used in Qlik NPrinting
Variables in Qlik Sense and QlikView are often used in combination with dollar-sign expansions. You should do
this when you want to use a variable like a placeholder, instead of a true variable. Variable dollar-sign expansions
work by replacing their "text" with the static value of the variable.

For example, you have these two variables in Qlik Sense or QlikView:

l vSales defined as: Sum(Sales)
l vSales2 defined as: =Sum(Sales)

An expression like =$(vSales) can be used in a Qlik Sense chart as a measure or in a QlikView chart as an
expression. When the Qlik engine evaluates this expression, it will replace the content of the dollar-sign
expansion $(vSales) with the static value of vSales. The static value of vSales is Sum(Sales). So the
evaluated final expression will be =Sum(Sales).

Suppose that the total Sum(Sales) is 1560. If you write an expression like =$(vSales2), the Qlik engine will
evaluate it, as in the case before, and replace the content of the dollar-sign expansion $(vSales2) with the
static value of vSales2. The static value of vSales2 is 1560, because it was defined as an expression. So the
evaluated final expression will be 1560.

This means that without a dollar-sign expansion, vSales is a variable that contains the text of Sum(Sales).
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If you insert these expressions as two different measures in a Qlik Sense chart or expressions in QlikView, you
would see the following results:

Dim $(vSales) $(vSales2)

A 350 1560

B 470 1560

C 740 1560

Results

As you can see, =$(vSales) results in the partial sum for a dimension value, while =$(vSales2) results in
the total sum.

Qlik NPrinting will always consider the static value of the variable, and never its dollar-sign expansion. If you
want to evaluate an expression in a variable that does not begin with an = sign, you must change its definition in
QlikView or Qlik Sense. If you cannot do that, you must create a second variable that can be defined as the dollar-
sign expansion of the original one: vSales3 defined as =$(vSales). If you are using the Qlik NPrinting Designer,
you do not have to create another variable. You can use a formula to expand the original variable instead.

Error handling
Administrators can set what happens if variables in an email do not resolve.

Do the following:

1. In the main menu, go to Admin > Settings.

2. Click the Task button.

3. Under Email distribution errors, go to When a publish task cannot resolve a variable tag. Choose from
the following options:

l Send the email with the tag as is
l Send the email with the tag removed
l Do not send the email

4. Click Update.

5.15 Qlik Sense and QlikView formulas
You can create QlikView and Qlik Sense formulas and add them to reports in Qlik NPrinting.
Formulas must follow QlikView or Qlik Sense formula rules and syntax.

Formulas can be added to Excel, PowerPoint, Word, HTML and PixelPerfect reports. They can be formatted the
same as plain text.

You can insert formulas in levels. The formula will be evaluated for each level.
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Formula evaluation
Formulas are applied with and without numerical and time formatting. Qlik NPrinting sends the formula to
QlikView or Qlik Sense for evaluation. Any numerical or time formatting must be applied by QlikView or Qlik
Sense at the moment the formula is evaluated to its unique value. The value is exported from with whatever
numerical or time formatting has been applied, and will not be altered by any attempt to apply similar formatting
in the template.

Requirements

Formulas used in Qlik NPrinting must evaluate to a unique value.

Note that =getCurrentSelections() returns a unique string. It is composed by merging the selected values with a
separator, but the function is allowed because this is a single string.

You cannot add an Aggr() formula, for example Aggr(Count(DISTINCT CustomerID), Salesman), because it returns
multiple values. You can resolve this by concatenating the result of the Aggr(), for example concat(Aggr(Count
(DISTINCT CustomerID), Salesman), ' - ').

Adding a formula
Do the following:

1. Open an existing report, or create a new one.

2. Right-click the Formulas node, and then select Add formula.

3. Enter a name in the window that opens.

4. Enter your formula. For example: NumericCount (OrderID).
The calculated result is visible in the bottom part of the Edit Formula window.

5. Click OK.
You can add additional formulas if desired.

6. Drag the formula node tokens onto empty cells or areas of the template.

5.16 Importing QlikView and Qlik Sense cell values
You can use any cell value or group of cell values from QlikView or Qlik Sense objects in Excel,
Word, PowerPoint, HTML, or PixelPerfect reports.

Overview
Cells are imported into Qlik NPrinting report templates from documents and apps based on their position. For
example, you can import the cell that is in the third column of the first row.

In QlikView connections, cell #1 selects the value from the total row (at the top). In Qlik Sense connections, cell #1
selects the first value of the table (excluding the total row).
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If you change something in the original app or document, you will have to update your Qlik NPrinting report
template. Cells work on a positional basis and cannot follow changes in the source objects. These have to be
managed. For example, Qlik NPrinting will not automatically update cell nodes if you switch column 2 and
column 3 in Qlik Sense.

You can use Excel formatting tools to apply custom formats to cells if you clear Keep Source Formats in
the Properties pane. You can also re-build a object cell-by-cell, or part of it, and add Excel formulas to
calculations.

Inserting cell values into an Excel report
The following example shows how to insert QlikView cell values into an Excel report template. You will insert the
same chart object with the same cell position four times, but with different formatting.

Specifying cells from a QlikView document
Do the following:

1. Open an existing Excel report template, or create a new one.

2. Create a new cell:

a. In the left-hand pane, right-click the Cells node, and select Add cells. A new window opens.

b. Click the browse icon ... to the right of the Object field.

c. Select a chart object from the list. Click OK.

d. Qlik NPrinting automatically fills the Name field. The first number after the name indicates the cell
row. The second number indicates the cell column. You can change the name if needed.

e. The Description field is optional.

f. In the Top Row field, enter the number 1 .
If the Bottom Row field now also contains the number 1: you are selecting cells from only one row.
Row 0 is the row of QlikView object titles, so row 1 is the first data row.

g. In the Left Column field, enter the number 1 .
If the Right Column field now also contains the number 1: you are selecting cells from only one
column. Column 0 is the first column on the left of the source QlikView object.

h. Keep the Keep Source Formats box selected. Click OK.

3. Repeat steps a-g. Clear the Keep Source Formats box.

4. Repeat steps a-g. Clear the Keep Source Formats box and add the format code "$ #,##0.00" to the Format
field.

5. Repeat steps a-g. Clear the Keep Source Formats box. You will use Excel formatting tools to format the
cell containing this cell value.

Adding the cell values to the template
Do the following:
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1. Drag each cell value node token onto an empty cell in the template.

2. Format the fourth cell value you created using Excel formatting options.
For example: change the font size and color.

3. Click Preview. You will see the same cell value formatted four ways:

a. A cell formatted the same as the original document.

b. A cell with no formatting.

c. A cell with the custom format "$ #,##0.00" applied by Qlik NPrinting.

d. A cell with custom Excel formats applied by you.

4. Close the preview. You can continue to edit the template if necessary.

5. Click Save and Close to save the template and close the Template Editor.

5.17 Report names
Qlik NPrinting reports can have three different types of names. They can be static or dynamic.

l Title: The name given to the report during report creation.
l Friendly name: A name that can optionally be added to a report when adding it to a publish task.

For information about assigning friendly names, see: Creating publish tasks (page 471).
l Dynamic name: A name containing static and variable elements that is enabled during report creation.

For information about assigning dynamic names, see: Dynamic report names (page 322).

Depending on what names are given to the report, different components of Qlik NPrinting may apply the names
differently.

Displayed report names
The tables below explains which names Qlik NPrinting uses when displaying reports.

Report name combinations Preview NewsStand
Download
NewsStand

Email
attachment

Report title x x Report title Report title Report title Report title

Report title Dynamic
name

x Dynamic
name

Report title Dynamic
name

Dynamic name

Report title x Friendly
name

Report title Friendly name Friendly name Friendly name

Report title Dynamic
name *

Friendly
name

Dynamic
name

Friendly name Dynamic
name

Dynamic name

Preview, Newstand, email attachments
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Report name combinations

Embed
report
name in
email

Hub
Download

hub
Folder

Report title x x Report
title

Report title Report title Report title

Report title Dynamic name x Report
title

Dynamic
name

Dynamic
name

Dynamic
name

Report title x Friendly name Report
title

Friendly
name

Friendly
name

Friendly
name

Report title Dynamic name
*

Friendly name Report
title

Dynamic
name

Dynamic
name

Dynamic
name

Email, Hub, Folder

When dynamic name contains the report name variable

%ReportName% variable Preview NewsStand
Download
NewsStand

Email
attachment

with Friendly name configured Report
title

Friendly name Friendly name Friendly name

without Friendly name configured Report
title

Report title Report title Report title

Preview, NewsStand, email attachments

%ReportName% variable

Embed
report
name in
email

Hub
Download

hub
Folder

with Friendly name configured Report
title

Friendly
name

Friendly
name

Friendly
name

without Friendly name configured Report
title

Report
title

Report title Report
title

Email, Hub, Folder

5.18 Dynamic report names
Descriptive report names help your users quickly access the information they need.
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Dynamic report naming allows you to set standard naming protocols with static and variable elements. Variable
elements include date and time values, user data, and the values of QlikView and Qlik Sense variables.

For example, a sales report may have the static element SalesReport and the variable elements "date" and "top-
selling product." It would be published to the NewsStand as: SalesReportNovember252017Pacifiers.xlsx.

You can also add custom fields. This is a good way to add corporate information, numerical codes, or hyphens to
your report names.

Due to Windows file systems limitations, you cannot attach files with file names longer than 255
characters to Qlik NPrinting emails. If you attach a file with a name that is too long, recipients will see a
message listing which reports failed to be generated. The following error message is added to the Qlik
NPrinting logs: "Path with value name is exceeding windows limitations, the fully qualified file name
must be less than 260 characters."

Enabling dynamic naming
1. Select Reports in the Qlik NPrinting main menu, and then click Create report.

2. Enter the information for the report you want to create in the Title, Description, Type, and App fields.

3. Select the Enable dynamic naming check box.

4. The Dynamic Name section appears. This allows you to add or delete different elements to your report
name. These field elements can be reordered using the sort-handles on the right.

5. When you have finished adding elements to the report name, click Create to create the report.
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Dynamic naming elements
Select the element you want to use from the drop-down list in the first field of the Dynamic name section.

Date and time values are localized according to the time zone set in the user profile.

The following elements are available:

Element Description

Custom Custom text conforming to Windows file name standards. Type the required text in the
second field.

Date Date that report generation is started. The format of the date can be selected from the drop-
down list in the second field.

Time Time of day that report generation is started. The format of the time can be selected from
the drop-down list in the second field.

Report name The Friendly name given to the report when adding the report to a Publish task. The
default is the report Title, but this can be changed in the Friendly name field.

User name The Username of the user creating the report. Derived from the user's details. The variable
appears in the second field.

User company The Company of the user creating the report. Derived from the user's details. The variable
appears in the second field.

User
department

The Department of the user creating the report. Derived from the user's details. The variable
appears in the second field.

User office The Office of the user creating the report. Derived from the user's details. The variable
appears in the second field.

Qlik variable Select the required variable from the drop-down list in the second field. The available
variables depend on the app chosen for the report.

Dynamic naming elements

The complete report name is displayed in the Preview field at the bottom of the Dynamic name section. Variable
values are represented by the name of the variable.

5.19 Cycling your reports
You can generate multiple versions of a report broken down by dimension, such as year or region.
Instead of one report, several reports are generated in a .zip file. If you have more than one cycle
field, you will get as many reports as the combination of all cycle fields.

For example, you have a Qlik NPrinting Excel report called SalesData that you want to cycle by country and year.
Your data covers 3 countries and 2 years, so you will get 6 reports in your .zip file:
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1. SalesData_Country1_Year1.xlsx

2. SalesData_Country1_Year2.xlsx

3. SalesData_Country2_Year1.xlsx

4. SalesData_Country2_Year2.xlsx

5. SalesData_Country3_Year1.xlsx

6. SalesData_Country3_Year2.xlsx

Once created, the .zip file will be sent to every selected report destination, the same as a standard report. Report
cycling works with all distribution methods.

If your reports contain conditions and filters, they will be evaluated in this order: Task filter > user filter > report
filter > condition. Conditions are not evaluated separately for each report in the cycle

Limitations

There is currently no limit to how many cycles you can select. However, you should choose a maximum
of 3 cycles. You should not start a report cycle if your report dimensions contain many values. For
example, if your data covers 10 years, 196 countries, and 50 products, report cycling will try to generate
98,000 files. This could take hours or days to generate.

Some SMTP providers impose size limits on email attachments. The maximum allowed size varies
among providers. If the size of an attached file exceeds the limit, the email is not delivered. A warning is
added in the logs.

Due to Windows file systems limitations, you cannot attach files with file names longer than 255
characters to Qlik NPrinting emails. If you attach a file with a name that is too long, recipients will see a
message listing which reports failed to be generated. The following error message is added to the Qlik
NPrinting logs: "Path with value name is exceeding windows limitations, the fully qualified file name
must be less than 260 characters."

Creating a new report cycle
Do the following:

1. Click the Reports tab.

2. Choose a report, and click the Enable cycle check box.
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Once you choose Enable cycle, dynamic report naming becomes mandatory. The fields you
choose to cycle through will be automatically included in the report name, but this can be
customized under Dynamic name. See: Dynamic report names (page 322).

3. Under Cycle, select a Connection and Field to cycle. We recommend choosing 3 or fewer Fields.

4. Click Save.

The next time your report is distributed, it will be as a .zip file containing multiple files.

Troubleshooting

The folder containing my cycled reports shows reports with the FAILED label

Possible cause

Your reports contain incompatibility filters.

Proposed action

Check the filters associated with the report. For example, you have 2 filters:

l The first contains → Year: 2012, 2013
l The second contains → Year: 2014

If you use both filters, the intersection between the filters will produce an empty set.

My reports fail to generate

Possible cause

Your report uses the same dimension in the task, user, report, and object filter hierarchy.

Proposed action

Change or remove any filters that use the same dimension.

5.20 Enabling QlikView cycle group fields
QlikView charts with cycle groups applied as dimensions can be added to Qlik NPrinting reports.

If a chart with cycle group fields is added as a table, you can select which field of the cycle group to display. To
show different active fields, you need to add the same chart again, and set a different active field. You can add
the same chart as an image or a level, but cannot choose to display a specific field.

Selecting a cycle group field in Qlik NPrinting tables
You can set one active field per table.

Do the following:
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1. Open the report in Qlik NPrinting Designer.

2. On the left pane, right-click on Tables, and select Add objects.

3. A new window will open. Select the QlikView chart that contains a cycle group dimension.

4. On the left pane, expand your chart to show the dimensions available. Click on the dimension with cycle
group you want to use.

5. Go to the Properties window, and open the Use This Group Field drop-down menu.

6. Select the active field that you want to use.

See also:

p Non-hierarchic groups (cyclic)

5.21 Adding report templates
You can import an Office, HTML, or PixelPerfect file as a template for other reports. This lets you
incorporate information and layouts that comply with your corporate standards, or design reports
for specific recipients.

You can load a file in Report settings to be used as the default template when creating a report, or select a
custom file as a template when in the Create report form.

Loading a default template
Do the following:

1. From the top menu, click on Admin, and then select Settings.

2. Click Report settings.

3. Select the type of template you wish to load from the five available and click Choose a file.

4. Locate the file you want to load and highlight it. Click Open to load the file.

5. Click on Update to save the configuration.

The file name appears in the field next to the type of template you have chosen. This file will be used as the
default template for that report type, selectable when creating a new report.

To reset the configuration and use an empty template , click on Reset.

Create report options
When creating a report three options are available when determining the template to be used.

l Empty file creates a copy of an empty file of the type required and saves it to the repository as the
template.
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l Default template creates a copy of the current default template, specified in Report settings for the
report type, and saves it to the repository.

l Custom allows you to upload a file and save it to the repository as the template to be used.

5.22 Previewing reports in the template editor
You can preview your reports while working on them in the template editor. You can preview them
in their original report format, or choose an alternative. Preview mode applies report, object, and
user filters.

Previewing your reports
Do the following:

1. In the Qlik NPrinting web console, click Reports on the main menu.

2. On the Reports screen, select your report.

3. Click the Edit template button to open the Qlik NPrinting Designer template editor.

4. Click the Template tab, and then click the Preview button to preview your report.
A progress bar shows how long it will take to generate the preview. It may take several minutes,
depending on the size of your report.

5. You can continue to edit your report while the preview loads. However, these changes will not be reflected
in the preview.
You can click the Abort button on the preview progress bar, and then restart preview to see changes you
have made.

6. When you are finished editing, click Save And Close.

Previewing in different output formats
You may want to issue your report in a format that is different from its initial template. For example, you may
have an Excel report you want to distribute in both .xlsx and .pdf format. You can preview the report in both
formats.

Qlik entity reports cannot be altered in the template editor, and therefore cannot be previewed.

Each report type has different output format options:

l Excel: .xlsx, .xls, .xlsm, .tiff, .pdf, .html
l Word: .docx, .doc, .html, .pdf
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l PowerPoint: .pptx, .pdf
l HTML: .html, .htm
l PixelPerfect: .pdf, .html, .xls, .xlsx, .png, .gif, .jpeg, .tiff

Excel macros (in .xls and .xlsm files) will not run in Qlik NPrinting Designer if your Microsoft Office trust
settings disable macros. This is the default setting in Excel. You can change this in Excel by going to
Options > Trust Center > Trust Center Settings > Macro Settings.

Do the following:

1. Click the Template tab, and then click the Preview icon drop-down menu to see the choice of output
formats valid for your report.

2. Select the output format you want to preview.

A preview of the report is generated in the format of your choice.

Verifying user filters applied when previewing
When generating a report preview, Qlik NPrinting applies report and object filters. Task filters are not applied,
because there is no task involved in a template preview.

User filters are also applied, based on your Qlik NPrinting app connection settings. You should check your
connection settings to make sure preview mode is applying the correct user filters.

Do the following:

1. From the main menu, click the Apps drop-down, and then click Connections.

2. Select the connection your report is using.

3. Review your connection settings:

a. QlikView connections
l If the Connection requires authentication check box is not selected, the preview process

uses the Windows user who is running the Qlik NPrinting Engine Windows service.
l If the Connection requires authentication check box is selected, but the Apply user

section access for reports check box is not, the preview process uses the Identity
specified in the connection.

l If the Connection requires authentication and Apply user section access for reports
check boxes are both selected, the preview process uses the Windows domain user. This is
the user who is running the Qlik NPrinting Designer.

b. Qlik Sense connections

Qlik Sense connections always require authentication.

l If the Connection requires authentication check box is selected, but the Apply user
section access for reports check box is not, the preview process uses the Identity
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specified in the connection.
l If the Connection requires authentication and Apply user section access for reports

check boxes are both selected, the preview process uses the Windows domain user. This is
the user who is running the Qlik NPrinting Designer.

5.23 Reports with multiple connections
Reports can contain objects from more than one QlikView document or Qlik Sense app.

On-Demand requests only work with reports based on a single connection. MultiDoc reports are not
supported.

Creating a new connection
Do the following:

1. Select Apps from the Qlik NPrinting main menu, and then select Connections.

2. Click Create connection.

3. Enter a Name for the connection.

4. Select an app from the App drop-down list.

5. Add the connection information:
l For Qlik Sense apps: Connecting to Qlik Sense apps (page 30)
l For Qlik Sense apps: Connecting to Qlik Sense apps (page 30)

6. Click Create.
The generation of the cache starts automatically.

7. While the first connection generates, create a second connection.

8. Enter a Name, and select the same Qlik NPrinting app from the dropdown.

9. Add the connection information for your second connection.

10. Click Create.

Once both connections are Generated, you can start editing your report.

Creating a new Excel report
Do the following:

1. Select Reports in the Qlik NPrinting main menu, and then click Create report.

2. Enter a Title.

3. Select Excel from the Type drop-down list.

4. Select an app from the App drop-down list.

5. Leave Enabled check box selected.
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If you clear the Enabled check box, the report will persist in the repository but will not be generated. This
can be useful during the development of the report. You can select Enabled when the development of the
report is complete. You may also want to clear Enabled to prevent the generation of a report that you
want to save for the future.

6. Click Create to create the report.

7. Click Edit template to open the Template Editor.

Adding an object from Budget to the template
Do the following:

1. Right-click the Tables node, and select Add objects.

2. Open the Connection drop-down list in the Select Objects window and select Budget.

3. Find and select the CH332 - Top 5 Products object in the objects list.
You can use Search to find the object name or ID.

4. Click OK.
You can also double-click the object row to add it to the node of the preview.

5. Drag the CH332 - Top 5 Products node onto a cell on the template, for example, B6.
The object tag, <CH332>, is replaced by its content in the QlikView document when the report is
generated.

Adding an object from Sales Demo to the template
Do the following:

1. Right-click the Tables node, and select Add objects.

2. Open the Connection drop-down list in the Select Objects window and select Sales Demo.

3. Select CH317 - Top 5 Products from the list.

4. Click OK.

5. Drag the CH317 - Top 5 Products node onto cell B10 in the template.

Running a preview
You can check the final report, filled with your data, at any time during development.

Do the following:

1. Click the Preview icon in the ribbon bar to get a preview in the default output format.

2. Open the drop-down menu by clicking the small arrow under the lens to select a different output format
among the ones available.

The report is populated with two tables from two distinct QlikView documents.

Saving the template
Do the following:
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1. Click the small disk icon in the upper left corner of the window title bar to save the template.
Save frequently because there is no auto-save feature.

2. When you have finished editing the report template, click Save and Close to save the template and close
the Template Editor.

See also:

p How to create Excel reports

5.24 Using Qlik Sense third-party extensions
You can use Qlik Sense third-party extensions inside Qlik NPrinting reports as images, tables, and
levels.

Requirements
All objects that have been added to a sheet can be used as images. Qlik NPrinting does not distinguish between
native visualizations and extensions. However, for a third-party extension to render correctly, the JavaScript
implementation of the extension needs to fulfill certain requirements. In particular, the extension must
implement the "finished rendering" notification.

A third-party extension can be used as a table if:

l The object contains exactly one hypercube.
l The hypercube is either straight or stacked.

A third-party extension can be used as a level if:

l The properties of the object contain exactly one hypercube.
l The hypercube is either straight or stacked.
l The hypercube has at least one dimension.
l The hypercube contains no calculated or grouped dimensions.

Qlik NPrinting does not support the exporting or printing of visualization extensions that use:

l External resources.
l External and undocumented JavaScript modules or APIs.

Setting up a "finished rendering" notification
To export your third-party extension as an image, you must use the paint method to inform Qlik NPrinting that
the extension has finished rendering. Otherwise, you could have blank or partially rendered images.

// ...,

paint : function() {

return qlik.Promise.resolve();

}

// ...
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6 Excel reports
Excel reports let you export QlikView and Qlik Sense charts to Excel workbooks. You can easily
make new calculations or add pivot tables.

Excel reports can be generated and shared in the following output formats: xlsx, .xls, .xlsm, .tiff, .pdf, .html.

Excel macros (in .xls and .xlsm files) will not run in Qlik NPrinting Designer if your Microsoft Office trust
settings disable macros. This is the default setting in Excel. You can change this in Excel by going to
Options > Trust Center > Trust Center Settings > Macro Settings.

6.1 Formatting
As the default, Qlik NPrinting attempts to keep the original QlikView or Qlik Sense formatting when you create a
new report template. Alternatively, you can apply Excel formatting. Select the chart object in the Qlik NPrinting
Designer and clearing the Keep Source Formats check box in the Properties pane. Then you can customize
fonts, column width, and table properties like in any Excel document.

6.2 Tables
You can add QlikView and Qlik Sense table objects and apply Excel table functions. For example, you can apply
Excel table formatting. You can use entire QlikView or Qlik Sense tables or select specific columns.

Font and alignment formatting applied from the Excel ribbon to the heading cell will be applied to all table cells
in the heading row. Font and alignment formatting applied from the ribbon to a content cell will be applied to all
table cells in content rows. Number formatting will have no effect.

6.3 Images
You can import charts as images. The original image formatting is kept, as the default setting. For example, if the
original QlikView object has a side scroll bar, you will see it in the report. You can also import entire QlikView
sheets as images. Data included in objects that are imported as images cannot be edited in the final report.

Images can be embedded side-by-side. You must manually adjust the space between them to avoid overlap. Qlik
NPrinting does not automatically add space or columns between images.

6.4 Levels
Levels take chart objects and cycle them through the values of a field. The results for each level field value are
displayed in order. You can add levels to images, tables, and fields.
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For example, you have a Qlik Sense app with a table listing each product you have sold in a year. You can add
that table to a Qlik NPrinting report, and add a level for the Product Category field. Your generated report will
have a different table for each Product Category, instead of one large table.

6.5 Formulas
You can use the Formulas node to add QlikView and Qlik Sense formulas. You can input Excel formulas directly in
template cells.

6.6 Excel charts
You can use Qlik data to add a native Excel chart to your reports.

6.7 Excel pivot tables
You can create Excel pivot tables from QlikView or Qlik Sense straight tables.

6.8 Creating Excel reports
In this tutorial, you will create a new Excel report template with two tables and an image. You will
use the Page feature to produce a new worksheet for each value of a field.

You can select multiple objects or values by holding CTRL or Shift. For example, you can select multiple
objects when adding objects from a list, or when dragging and dropping many columns onto the
template.

What you will do
You will:

1. Create a new Excel report template.

2. Add a table object.

3. Create a custom table column by column.

4. Add an object as an image.

5. Use the Page feature to generate a new worksheet for each different sales office.

Creating a new Excel report template
Do the following:

1. Select Reports in the Qlik NPrinting main menu, and then click Create report.

2. Enter a Title for the report.
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3. Select Excel from the Type drop-down list.

4. Select an app from the App drop-down list.

5. Select a Template from the options available:
l Empty template - uses an empty template
l Default template - use the default template (only available if a default template has been set in

Report settings.
See Load an Office, HTML or PixelPerfect file as a template

l Custom - Choose a file to use as a template.

6. Leave the Enabled check box selected. If you clear it, the report will be saved, but ignored by the
scheduler.

7. Click Create to create the report.

8. Click Edit template to open the Template Editor.

Adding a table
Do the following:

1. Right-click the Tables node, and select Add objects.

2. Select Sales by Country from the objects list. Click OK.
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3. Drag and drop the CH304 - Sales by Country tag onto an empty cell.

Customize the formatting on an entire table
This causes the contents of all cells in all columns of the table to be exported from QlikView or Qlik Sense without
formatting. You can apply new formatting using the Excel ribbon.

Do the following:

1. On the left-hand pane, select the table you want to customize.

2. Go to the Properties pane.

3. Clear the Keep Source Formats check box.
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4. Use the Excel ribbon to customize the table.
For example, change font size or color.

Adding a table column by column
You can create a custom table by adding columns individually. They do not have to be in the same order as the
original Qlik Sense or QlikView table.

Do the following:

1. Expand the CH304 - Sales by Country node.

You can only expand the node to reveal column nodes if the object is a straight table or table
box. If you do not see the +, you added a pivot table or a straight table with calculated columns.

2. Drag and drop the column tags into cells one at a time.
This creates a tags for each selected column with its title as a text cell that you can format.
You can move the tags in the Excel template to obtain the column order you prefer.

Customize formatting on specific columns in a table
If you want to keep the source formatting for the majority of columns, leave the Keep Source Formats box
selected for the table as a whole. You can disable Keep Source Formats on individual columns. This causes the
content of all cells in the selected column to be exported from QlikView or Qlik Sense without formatting. You can
apply formatting using the Excel ribbon.

Do the following:

1. Expand the table node by clicking the + on the left.

2. Select the column that you want to customize.

3. In the Properties pane, clear the Keep Source Formats check box.
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4. Select the column in the template, and then apply formatting as desired.

Adding an image
Do the following:

1. Right-click the Images node, and select Add objects.

2. Select Sales by Country from the objects list. Click OK.
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3. Drag and drop the CH304_1 - Sales by Country tags onto any cell below the tables.

Previewing the report
Do the following:

1. Click Preview.
Excel launches and displays your report.

2. You will see an Excel report with one sheet. That sheet will have the same Qlik object as an image, a table,
and a table added column by column.
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3. Close the preview window.

Applying Pages
The Pages node lets you produce a report with a separate worksheet for each value of a field. For example, a
different worksheet for each sales office.

Do the following:
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1. Right-click the Page node icon in the left pane.

2. Select Add page to current sheet.

3. Select SalesOffice from the list. Click OK.

4. Click the + on the left to expand the SalesOffice page node.

5. Drag the SalesOffice node tag onto a cell in the template.
You can format the cell using Excel formatting features.

6. The worksheet name changes to <SalesOffice_Page> on the bottom tab. When the report is generated,
this will be replaced with the related value of each worksheet.
You can edit the worksheet name by adding text. For example: <SalesOffice_Page> office.
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Your report will now be produced with a different worksheet for each sales office.

Preview and save
Do the following:
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1. Click Preview.

2. You will see a report with sales office as a title, two tables, and an image. There are now several worksheet
tabs, one for each office.

3. Click Save and Close to save the template and close the Template Editor.
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To avoid having selected cells in your generated reports, always select a cell away from your report
elements just before saving and closing the Template editor.

See also:
l Excel reports with levels (page 344)
l Creating calculated columns and rows with Excel formulas (page 361)

6.9 Excel reports with levels
You can use levels to group the data in your report by a dimension. Levels can be applied to tables
and images.

Levels cycle report elements through the values of a field. The results for each level field value are displayed in
order.

For example, you have a Qlik Sense app with a table listing each product you have sold in a year. The table is very
long and does not fit well on the Excel sheet. You can add that table to a Qlik NPrinting report, and add a level for
Product Category. Your generated report will have a different table for each value of Product Category, instead of
one large table.

You can create complex hierarchies with nested levels. For example, you can create a year > category hierarchy to
generate a report with sales for each product category for each year. You can nest as many levels as you want,
but performance will decrease with each addition of a level.

You can use QlikView objects that have calculated dimensions or null values as levels. However, you
cannot nest other objects inside them, except for fields from that sheet object. Qlik Sense visualizations
with calculated dimensions cannot be used as levels.

Performance
Report and preview generation slows down with the addition of levels. Charts and tables are extracted separately
for each value in the level field, so the number of exported objects can increase significantly.

Rules
Each level has an opening tag and a closing tag. These tags do not have to be in the same row or column, but
there are some rules for how you can place them:

l The opening tag must be in a row above all the rows containing tags to be cycled. It must also be in a
column to the left of, or the same as, any column containing tags to be cycled in the level.

l The closing tag must be in a row below all rows containing tags to be cycled.
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l Rows containing level tags will not be present in the report. You should not put content in the same row
as a level tag.

l Any empty rows included in the level range will be present in the report.
l You can verify the level range by clicking on the level node. The level range will be outlined and

highlighted.

If you drag and drop a level tag into the wrong cell, you can cut and paste it somewhere else.

What you will do
In this tutorial, you create a report where the QlikView objects inserted between the level opening and closing
tags are organized by two fields. You will:

1. Embed one object as a table and one as an image.

2. Add two fields as levels so that the Excel report presents three tiers of information.

3. Add titles and headings.

Adding an image and a table

You can select multiple objects or values by pressing Ctrl or Shift during the selection. For example, you
can select multiple objects when adding objects from a list, or when dragging and dropping many
columns into the template.

Do the following:

1. Create a new Excel report, or open an existing template.

2. Right-click the Images node, and select Add objects.

3. Select Top 5 Salesmen from the objects list. Click OK.
Under the Images node, you will see CH319 - Top 5 Salesmen.

4. Right-click the Tables node, and select Add objects.

5. Select Top 5 Customers. Click OK.
Under the Tables node, you will see CH318 - Top 5 Customers.

6. Drag the CH318 - Top 5 Customers and CH319 - Top 5 Salesmen tokens onto empty cells in the same
row.
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Make sure there are three or four empty columns between them.

Adding the first level
Levels have opening and closing tags that your table and image tags need to sit inside. The opening tag must be
in a row above the objects you want to cycle. The closing tag must be in a row below.

Do the following:

1. Right-click the Levels node, and select Add levels.

2. Select Year from the list. Click OK.

3. Right-click the Levels node, and select Add levels.
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4. Select CategoryName. Click OK.

5. From the left pane, drag and drop the Year_Level token onto empty cells in the worksheet.

6. Move the <Year_Level> opening tag so it is in a row above all rows you want to include in the cycle.
It must also be in the same column as (or a column to the left of) all columns to be repeated in the cycle.
Empty rows included in the level range will be reproduced in the cycle.

7. The closing level tag </Year_Level> must be in a row below any rows you want to include in the level
cycle.
You can verify which elements are included in the cycle by clicking on the Year_Level node in the left
pane. This highlights the level range.
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8. You can include a dynamic, customizable heading for the level cycle. Expand the Year_Level node and
click on the Year node token. In the Properties pane, clear the Keep Source Formats check box.

9. Drag the Year tag onto the Excel sheet, in a row below the <Year_Level> opening tag. You can format the
Year tag the same way you would format any text in Excel.

Adding the second level
We are going to add a second level, CategoryName_Level, above Year_Level. This means that your report will be
organized by product category, and then year.

Example: Product category > Year

1. Baby clothes

a. 2012

b. 2013
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c. 2014

2. Men's shoes

a. 2012

b. 2013

c. 2014

You can also do the opposite, and nest CategoryName_Level inside year.

Example: Year > Product category

1. 2012

a. Baby clothes

b. Men's shoes

2. 2013

a. Baby clothes

b. Men's shoes

3. 2014

a. Baby clothes

b. Men's shoes

Do the following:

1. From the left pane, drag the CategoryName_Level token onto an empty part of the sheet.

2. Position the <CategoryName_Level>opening tag above the <Year_Level> token.
It must also be in the same column or a column to the left of <Year_Level>. Add a new column on the left
if you need.

3. Place the </CategoryName_Level> closing tag in a row below all other objects.

4. If you want to include a dynamic CategoryName heading: in the left pane, expand the CategoryName_
Level node in the left pane by clicking on the +.

5. Drag and drop the CategoryName node token into the row directly beneath the <CategoryName_
Level>opening tag.
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You can format the tag the same way you would format any text in Excel.

Previewing the report
Do the following:

1. Click Preview.
Excel launches and displays your report.

2. You will have a report organized by your first level, and then your second level.
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3. Click Save and Close to save the template, and close the Template Editor.
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See also:
l Creating calculated columns and rows with Excel formulas (page 361)
l Creating calculated columns and rows with Excel formulas (page 361)

6.10 Excel reports with nested levels and subtotals
You can nest levels to create a hierarchy and use Excel formulas to make calculations.

For example, you can create a year > category hierarchy to obtain a report with sales for each product category
for each year. You can add summary formulas and labels to each level of the report to show which values are
displayed in that level.

You can use QlikView objects that have calculated dimensions or null values as levels. However, you
cannot nest other objects inside them, except for fields from that sheet object. Qlik Sense visualizations
with calculated dimensions cannot be used as levels.

What you will do
In this tutorial, the QlikView objects inserted between the level opening and closing tags will be sub-divided in
the final report.

You will:

1. Create a custom table by adding two table columns.

2. Add two fields as levels so that the Excel report presents three tiers of information.

3. Add SUM formulas so your tables have totals and subtotals.

4. Customize SUM formulas using Excel formatting. This tutorial has suggested formatting, but you can
customize your design to your specifications.

Creating a new Excel report
Do the following:

1. Select Reports in the Qlik NPrinting main menu, and then click Create report.

2. Enter a Title for the report. Report with nested levels and subtotals.

3. Select Excel from the Type drop-down list.

4. Select an app from the App drop-down list.

5. Click Create to create the report.

6. Click Edit template to open the Template Editor.
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Choosing levels and table objects
1. Right-click the Levels node, and select Add levels.

2. Click the objects that you want to add. For example, add the Country and CategoryName fields.
You can hold down CTRL or Shift to select multiple items.

3. Click OK.

4. Right-click the Tables node, and select Add objects.

5. Click the object that you want to add. For example, select Top 10 Products.
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6. Click OK.

Adding the table
You can add the entire table object to the template. In this example, you will only add two columns.

Do the following:

1. Under the Tables node, expand the Top 10 Products node.

2. Click on Total Sales. In the Properties pane, clear Keep Source Formats.

3. Repeat for ProductName.

4. Drag the ProductName and Total Sales nodes onto empty cells in the template.
For example, cells D6 and E6.
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5. Click on <Total Sales>, and format as currency.

6. In cell E8, enter the Excel formula: =SUM(E6:E7).
This formula includes an empty row, so Qlik NPrinting will add rows as necessary to contain all values.

7. In cell D8, type Total:.

8. Format cell E8 using Excel formatting.
For example:

l 12px bold font
l Right justified alignment
l Custom = Accounting with no digits to the right of the decimal point.

Adding the first level
Do the following:

1. Drag the Country_Level node onto cell C4.

2. Move the </Country_Level> closing tag down to C10, so that Country Level includes the cell containing
the SUM, and an empty row.

3. Click + to expand the Country_Level node.
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4. Drag the Country node token onto cell C6.
This adds a dynamic title.

5. Format cell C6 to 12px and bold.

6. In cell E11, enter the formula: =SUM(E6:E11)/2.
The sum is divided by two because the SUM function will include all values, including the sum of those
values that are in cell E8.

7. Format cell E11 to:
l 12px bold font
l Right justified alignment
l Custom = Accounting with no digits to the right of the decimal point.

Adding the second level
Do the following:
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1. Drag the CategoryName_Level node token onto cell A2.

2. Drag the </CategoryName_Level> closing tag down to A14.

3. Click + to expand the CategoryName_Level node.

4. Drag the CategoryName node token onto cell B3.
This adds a dynamic title.

5. Format cell B3 to 16px bold font.

6. Drag a second CategoryName node to cell D11. Double-click this cell and add the word "total", so the cell
displays <CategoryName> total:.

7. In cell D14, type in Grand total:.

8. In cell E14, enter the formula: =SUM(E2:E14)/3
The sum is divided by three because the SUM function will add all the values, including the subtotals in
cells E8 and E11.

9. Format cell E14 to:
l 14px bold font
l Right justified alignment
l Custom = Accounting with no digits to the right of the decimal point.
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Previewing the report
Do the following:

1. Click Preview.
Excel launches and displays your report.

2. You will have a report organized by your first level, and then your second level.

Qlik NPrinting - February 2024 358

6   Excel reports



3. Each table will have a total underneath. Each category will have a total with a dynamic label.
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4. At the bottom, there will be a grand total of all products from all countries.
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5. Click Save and Close to save the template, and close the Template Editor.

6.11 Creating calculated columns and rows with Excel formulas
Excel formulas let you add calculated columns and row totals that do not exist in your original

QlikView document or Qlik Sense app.

What you will do
You will:

1. Add row totals using the SUM function.

2. Add calculated columns. You can do this in two different ways:

a. Excel tables: You create a table using Excel table tools. This method results in better report
creation performance, but requires more advanced Excel skills. We recommend using this
approach.

b. Levels: You insert field tags in a level, and then add Excel formulas. This is easy to implement, but
using levels can impact report generation performance.

This page shows how to create calculated columns using both approaches. To demonstrate, a third
column will be calculated by subtracting the values in one column from the values in another column.
Then the derived values of the third column will be divided by the corresponding values from one of the
original two columns.
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About calculations
If you want to minimize report creation time, you can add desired calculations to the QlikView or Qlik Sense
reload script.

This example uses simple Excel formulas, but you can insert more complex formulas if needed. You can also
insert Qlik formulas.

Adding an Excel table with calculated columns and totals
This is the first way to create calculated columns. You will add the source QlikView object to the Tables node, and
then create an Excel table.

Adding the table
Do the following:

1. Create a new Excelreport, or open an existing one.

2. Right-click the Tables node, and select Add objects.

3. Select a chart from the list. For example, add Top 10 Products. Click OK.
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4. Click + on the left to expand the CH184_Table - Top 10 Products table node.

5. One at a time, select each column under CH184_Table - Top 10 Products, and clear Keep Source
Formats.

6. Hold CTRL and select the table fields you want to add to the sheet.
For example: Product Name, Total Sales and Gross Profit. Drag them onto an empty row of cells.
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7. Select the cells that contain the heading, the field tags, and one blank row below.

8. In the Excel ribbon, click the Insert tab, and then click Table.

9. Make sure that the My table has headers flag is enabled, and then click OK.

10. On the left pane, click Extras. Drag a deleterow tag onto a cell in the empty row below the table.
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This will remove the empty row from the final report.

Adding the calculated column
Do the following:

1. Select the first empty cell to the right of the field tags.

2. Insert the formula =[@[Total Sales]]-[@[Gross Profit]].
Excel will automatically add this new column to the table.

3. Type a column heading. For example: Costs.

4. Then use the Excel table design tool to apply formatting.

Qlik NPrinting - February 2024 365

6   Excel reports



Adding totals
Do the following:

1. Select an empty cell below the table. For example, D8.

2. Enter a SUM formula in the cell. The range of the SUM function needs to include:
l The address of the cell in the row containing the level opening tag.
l The cell containing the field tag.
l The address of at least one empty cell immediately below it.

In this example, the function would read: =SUM(D4:7).

3. Click and drag this formula to E8 and F8.

4. Apply Excel formatting tools to the elements of the row.
For example: Total Sales and Gross Profit totals could have the Currency format.

Previewing the report
Do the following:

1. Click Preview.
Excel launches and displays your report.

2. You will see a table, with the one column containing your calculated results. The bottom row will contain
column totals.
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3. Click Save and Close to save the template, and close the Template Editor.

Using levels to build a table with calculated columns and totals
This is the second way to add calculated columns, using levels. To learn about levels, see: Excel reports with levels
(page 344).

Adding the level
Do the following:

1. Create a new Excel report, or open an existing one.

2. Right-click the Levels node, and select Add levels.

3. Select a chart from the list. For example, add Top 10 Products. Click OK.

Qlik NPrinting - February 2024 367

6   Excel reports



4. Click the CH184_Level - Top 10 Products node, and drag it onto three empty vertically-aligned cells.
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5. Click the + on the left to expand the CH184_Level - Top 10 Products level node.

6. One at a time, select each column under CH184_Level - Top 10 Products, and clear Keep Source
Formats.

7. Hold CTRL and select the level fields you want to add to the sheet.
For example: Product Name, Total Sales, and Gross Profit. Drag them onto the empty row of cells
between the level tags.
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8. Format these fields as you prefer. For example, you could format Total Sales as currency.

Adding formulas and headings
1. Select the first empty cell to the right of the field tags. In this example, F4.

2. Click on the cell, type = then click on the Total Sales cell.

3. Type -, click on the Gross Profit cell and press Enter. This will calculate costs.
When you insert a formula between level tags, Qlik NPrinting will copy it into every row of the final table.
You can ignore the error #VALUE! in the template. This occurs because the Excel formula references cells
that contain field tags.

4. In cell G4, type =F5/D5. This will divide costs by sales.

5. Format the formula cells as you prefer using Excel formatting.
For example, costs as currency, and costs/sales as a percentage.

6. Type in headings for each column in a row located one or two rows above the row containing the Top 10
Products opening level tag.
Format these headings as desired.

Qlik NPrinting - February 2024 370

6   Excel reports



7. Select a cell below the </Top 10 Products_Level> level closing tag so that there is at least one intervening
empty cell.

8. In cell D8, enter an Excel SUM formula to create a row of column totals. The sum range should include:

a. The field tag cell address.

b. The address of the empty cell below it.

In this example, the function would read: =SUM(D4:D6).

9. Click and drag this formula to E8 and F8.

10. Apply Excel formatting tools to the elements of the row.
For example: Total Sales and Gross Profit totals could be formatted as currency.

Previewing the report
Do the following:
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1. Click Preview.
Excel launches and displays your report.

2. You will see a table, with the two new columns containing your calculated results. The bottom row will
contain column totals.

3. Click Save and Close to save the template, and close the Template Editor.

See also:
l Excel reports with levels (page 344)
l Excel reports with nested levels and subtotals (page 352)

6.12 Creating Excel charts
You can add a native Excel chart to your reports. The same chart does not need to exist in the
original document or app.
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What you will do
You will:

1. Add a QlikView table to the template as a level.

2. You will add level fields and create an Excel chart.

Creating a new Excel report
Do the following:

1. Select Reports in the Qlik NPrinting main menu, and then click Create report.

2. Enter a Title for the report. .

3. Select Excel from the Type drop-down list.

4. Select an app from the App drop-down list.

5. Click Create to create the report.

6. Click Edit template to open the Template Editor.

Adding a table as a level
Do the following:

1. Right-click the Levels node, and select Add levels.

2. Select a chart. For example: Top 10 Products. Click OK.
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3. Under Levels, click the CH184_Level - Top 10 Products node and drag it onto three empty vertically-
aligned cells.
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4. Click the + next to the CH184_Level - Top 10 Products node to expand it.

5. Click on Total Sales. In the Properties pane, clear Keep Source Formats.

6. Hold Shift and click on the ProductName and Total Sales fields. Drag them onto the empty row between
the two level tags.

7. Click on the cell containing <Total Sales>. Use the Excel ribbon to format this cell as currency.

8. In the row above the opening <CH184_Level> tag, type in heading titles.
Format these headings using the Excel ribbon.
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Creating the Excel chart
Do the following:

1. On the Excel ribbon, click Insert.

2. Click the Insert Column Charts icon, and then select 2-D Column chart.
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3. Click the Design tab, and click the Select Data icon.

4. In the Legend Entries (Series) pane, click the Add button.
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5. Click the arrow icon to the right of Series name field.
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6. Select the cell with the Total Sales heading.

7. Confirm by clicking on the arrow icon at the right of the Edit Series field.

8. Click the arrow icon to the right of Series values.

9. Select the Total Sales range by including the cells in the rows containing:
l the level opening and closing the tags
l the cell containing the <Total Sales> tag.

10. Confirm the selection by clicking on the arrow icon to the right of the Edit Series field.

11. Click OK.

12. In the Horizontal (Category) Axis Labels pane, click Edit.

13. Select the Product Name range by including the cells in the rows containing:
l the level opening and closing the tags
l the cell containing the <ProductName> tag.

14. Confirm the selection by clicking on the icon at the right end of the Axis label range field, and then click
OK.
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15. Click OK. You will see a table, and an empty chart.

Previewing the report
Do the following:

1. Click Preview.
Excel launches and displays your report.

2. You will have a report with a table and a chart.

3. Click Save and Close to save the template, and close the Template Editor.
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6.13 Creating Excel pivot tables
You can create Excel pivot tables using Excel table columns or levels.

Qlik Sense pivot tables can only be added as images in Qlik NPrinting. QlikView pivot tables can be added as
images and straight tables. Neither can be converted into an Excel pivot table in your reports. If you have a pivot
table that you want to reproduce in an Excel report, you can do one of two things:

l Convert the original pivot table to a straight table.
l Clone your pivot table and convert the clone to a straight table.

This help topic outlines the only supported ways for creating native Excel pivot tables.

Creating a pivot table using Excel table columns
We recommend using Excel table columns to create pivot tables in Excel reports. It is easier than using levels, and
does not slow down report generation.

Pivot tables cannot be placed on the side of the source data table. Place them above, below, or in a
separate sheet from data tables.

Requirements
To create a pivot table in the Qlik NPrinting Designer, you need:

l Excel 2007 or later
l A Qlik Sense or QlikView straight table

What you will do
You will:

1. Add a QlikView straight table as a table object to an Excel report.

2. Build a table column by column.

3. Convert that table to a pivot table.

Creating a new Excel report
Do the following:

1. Select Reports in the Qlik NPrinting main menu, and then click Create report.

2. Enter a Title for the report.

3. Select Excel from the Type drop-down list.

4. Select an app from the App drop-down list.
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5. Click Create to create the report.

6. Click Edit template to open the Template Editor.

Adding a chart object as a table column by column
Do the following:

1. Right-click the Tables node, and select Add objects.

2. Select the Connection that contains the straight table.

3. Select a table object. For example: Straight Country - Salesman - Year. Click OK.

4. In the Tables node, select Straight Country - Salesman - Year.

5. In the Properties pane, clear Keep Source Formats.

6. Click the + next to Straight Country - Salesman - Year.
This expands the table node, and displays all table columns.

7. Hold Shift or CTRL and select the columns you want to add. In this example, select all four table fields.

8. Drag the columns onto the template.

9. Highlight the column headings, table tags, and one empty row below.

10. On the Excel ribbon, click the Insert tab.
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11. In the Tables group, click Table .

12. Make sure the My table headers box is selected. Click OK.

13. On the left pane, click Extras. Drag a deleterow tag onto a cell in the empty row below the table.
This will remove the empty row from the final report.
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Converting to a pivot table
Do the following:

1. Highlight the heading and table field cells.

2. On the Excel ribbon, under Table Tools, click the Design tab.

3. In the Tools group, click Summarize with PivotTable.

4. In the Create PivotTable window, click OK.
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A pivot table is created in a new worksheet. You can also add the pivot table to the same worksheet and
hide the column with the data.

5. Drag the Year field into the Columns box.

6. Drag the Salesman and the Country fields into the Row Labels box.

7. Drag the Sales field into the Values box.

8. Click Count of Total sales to open the drop down menu. Select Value Field Settings.
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9. On the Summarize Values By tab, select Sum. Click OK.

10. Select the cells in the table that contain Sales values. Format them as currency.
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Ensuring data is refreshed when report is opened
If you do not perform these steps, you will see an empty pivot table in the generated report.

Do the following:

1. Under the PivotTable Tools - Analyze tab. On the left, click the Options drop down menu .

2. Select the Data tab.

3. Click the Refresh data when opening the file check box.

4. Set Number of items to retain per field to None.

Qlik NPrinting - February 2024 387

6   Excel reports



5. Click OK.

Previewing the report
Do the following:

1. Click Preview.
Excel launches and displays your report.

2. You will have a report with a pivot table.
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3. Click Save and Close to save the template, and close the Template Editor.

Creating a pivot table using levels
You can use levels to make pivot tables, but this will slow down report generation time. You should only use this
method if you have a version of Excel (2003 and earlier) that does not support adding table columns.
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What you will do
1. Add a QlikView straight table as a level object to an Excel report.

2. Build a table using levels.

3. Convert that table to a pivot table.

Adding levels to the template
Do the following:

1. Open an existing Excel report, or create a new one.
See: Creating

2. Right-click the Levels node, and select Add levels.

3. Select Straight Country - Salesman - Year in the levels list. Click OK.

4. Drag the CH205_Level - Straight Country-Salesman-Year node onto empty template cells. This will
create opening and closing tags for the level.

5. Click the + next to the CH205_Level - Straight Country-Salesman-Year node.

6. Drag the Country, Salesman, Year, and Sales nodes onto empty cells on rows between the <CH205_
Level> and </CH205_Level> tags.
In the Properties pane, ensure that Keep Sources Formats is unchecked for all four of these objects.
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7. Type in headings for the columns in the row above the <CH205_Level> tag.
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You can use QlikView objects that have calculated dimensions or null values as levels. However, you
cannot nest other objects inside them, except for fields from that sheet object. Qlik Sense visualizations
with calculated dimensions cannot be used as levels.

Creating a pivot table
Do the following:

1. Select the range of cells that includes:
l the headings
l the <CH205_Level> opening tag
l the column tags
l the </CH205_Level> closing tag

2. On the Excel ribbon, select the Insert tab. In the Tables group, select PivotTable.

3. In the Create PivotTable window, click OK.
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A pivot table is created in a new worksheet. You can also add the pivot table to the same worksheet and
hide the column with the data.

4. Drag the Country and Salesman fields into the Row Labels box.

5. Drag the Year field into the Column Labels box.

6. Drag the Sales field into the Values box.
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7. In the Active Field group, click the Field Settings button.

8. Change the value in the Summarize Values By tab to Sum. Click OK.
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9. Select the cells in the table that contain Sales values. Format them as currency.

Qlik NPrinting - February 2024 395

6   Excel reports



Ensuring data is refreshed when report is opened
If you do not perform these steps, you will see an empty pivot table in the generated report.

Do the following:

1. Under the PivotTable Tools - Analyze tab. On the left, click the Options drop down menu .

2. Select the Data tab.

3. Click the Refresh data when opening the file check box.

4. Set Number of items to retain per field to None.
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5. Click OK.

Previewing the report
Do the following:

1. Click Preview.
Excel launches and displays your report.

2. You will have a report with a pivot table.
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3. Click Save and Close to save the template, and close the Template Editor.
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7 Word reports
With Qlik NPrinting, you can create reports based on Word templates, filled with data from your
QlikView documents or Qlik Sense apps.

The templates for generating Word reports use QlikView or Qlik Sense formatting as the default formatting
setting. However, you can also use the Word formatting tools.

7.1 Creating Word reports
In Qlik NPrinting, you can create reports based on Word templates, filled with data from your
QlikView documents or Qlik Sense apps, and then export the reports as .docx, .doc, .html, or .pdf.

In this example, you will embed the data of one QlikView object and the images of two others in a Word report,
and then use two QlikView variables in a heading.

You can open an existing QlikView document or create a new one with at least one connection to the QlikView
document SalesDemo.qvw. You can also customize the connection to use your own .qvw file. Word reports
support MultiDoc.

Create new Word report
Do the following:

1. Select Reports in the Qlik NPrinting main menu, and then click Create report.

2. Enter a Title for the report.Simple Word Report

3. Select Word from the Type drop-down list.

4. Select an app from the App drop-down list.

5. Select a Template from the options available:
l Empty template - uses an empty template
l Default template - use the default template (only available if a default template has been set in

Report settings.
See Load an Office, HTML or PixelPerfect file as a template

l Custom - Choose a file to use as a template.

6. Keep the Enabled check box selected.

7. Click Create.
If you click Cancel, the settings are deleted. If you instead want to save the report for future use, clear the
Enabled check box and then click Create.

8. Click Edit template to open the Template Editor.

Select QlikView objects to add as images
Do the following:
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1. If you want to use a connection different than the default one, open the Connection drop-down list and
select the connection. You must have created the connection and the related cache to see it here.

2. Right-click the Images node, and select Add objects.

3. Select QlikView objects, for example CH186 and CH212, to be included in your template as images.
You can select multiple objects.

4. Click OK.

Embed images in template
Do the following:

1. If necessary, expand the Images node.

2. Drag the CH186 node token onto the page, and then drag the CH212 node token onto the page.

After dragging an image onto the template, Qlik NPrinting drops a standard gray-scale image with the original
object ID overlapped. You can then resize and/or move it onto the page just like in any Word document.

Add variables for heading
Do the following:

1. If necessary, change the connection to the QlikView document that contains the variables that you want
to use.

2. Right-click Variables and select Add variables. The Select Variable window appears.

3. Select the vCurrentYear and vLastYear variables from the list in the Select Variables window.

4. Click OK.

Create and format heading
Do the following:

1. Right-click anywhere at the top of the page, and then click Edit Header to start creating header content.

2. Expand the Variables node in the left pane.

3. Drag the vCurrentYear and vLastYear node tokens into the header section of the page, and then
compose the heading.

4. Highlight the heading, and then format it using the Word formatting tools.

5. Select the Design tab.

6. Click Close Header and Footer in the Close group.

Select object to add as table
Do the following:

1. If necessary, change the Connection to the QlikView document that contains the entities you want.

2. Right-click Tables in the left pane, and then select Add objects.
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3. Select the CH184 from Sales Demo in the Select Objects window.

4. Click OK.

You can use QlikView objects that have calculated dimensions or null values as levels. However, you
cannot nest other objects inside them, except for fields from that sheet object. Qlik Sense visualizations
with calculated dimensions cannot be used as levels.

Embed table
Do the following:

1. Expand the Tables node.

2. Drag the CH184 node token onto an empty space on the page.

Preview and save
Do the following:

1. Click Preview.

2. Check the report, close it, and then edit the template again if necessary.

3. Click Save and Close to save the template and close the Template Editor.

7.2 Formatting Word reports
When creating templates to generate Word reports, the default formatting setting is the QlikView or
Qlik Sense formatting. However, you can also use the Word formatting tools.

Table formatting using Word tools only works if you save your template in .docx format, and not in .doc.
Save Word templates in .doc format only if necessary for backward compatibility.

Allow application of Word formatting for whole chart
After you have added a QlikView object as a table, for example CH184 in Creating Word reports (page 399), do the
following:

1. In the Template Editor, click the CH184 node of the object that you just added.

2. In the Properties window, clear the Keep Source Formats check box.
This will cause the contents of all cells in all columns of the table to be exported from QlikView without
formatting.

3. Click the Toolbar button.
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Wrap text feature
Selecting Wrap Text causes Qlik NPrinting to automatically create two lines if the cell is too small. This works
only when Keep Source Formats is not selected. Wrap Text is a table property that affects all columns of the
table.

Apply Word formatting to entire table
Before adding the table to the template, do the following:

1. Select the Insert tab on the toolbar.

2. Select Table.

3. Select the uppermost left cell to insert a 1x1 table into the template.

Add your table to the template
Do the following:

1. Expand the CH184 node.

2. Drag and drop them into the table cell in the template. You can select multiple values by keeping Ctrl or
Shift pressed during the columns selection.
This will create all tags and insert them into a horizontal series of cells. The cells may exceed the page
layout but this will be addressed in the following subsection.

Set table to AutoFit columns
Do the following:

1. Select the Layout tab in the Table Tools section of the toolbar.

2. Click AutoFit in the Cell Size section of the toolbar.

3. Select AutoFit Contents.

Apply table style
After selecting the table, do the following:

1. Select the Design tab in the Table Tools section of the toolbar.

2. Select a general style in the Table Styles section of the toolbar.

Preview and save
Do the following:

1. Click Preview.

2. Check the report, close it, and then edit the template again if necessary.

3. Click Save and Close to save the template and close the Template Editor.
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8 PowerPoint reports
Qlik NPrinting supports exporting QlikView and Qlik Sense data to PowerPoint slides. PowerPoint
slides are automatically updated when a report is generated. Data is filtered according to recipient,
report, and task. Only filtered data is saved in generated reports.

8.1 Feature overview

PowerPoint report templates
Create reports and report templates, where you embed QlikView objects and variables. You can preview the result
and make changes before saving.

Page feature in report templates
Use the page feature to create separate slides in PowerPoint for each field value. You can have more than one
page field in a presentation, but on separate slides.

Individual slides for multiple field values
Create a PowerPoint slide for every combination of values from two or more fields. The first steps are taken in
QlikView. You can rearrange the order of the generated slides.

Native tables and charts
Embed QlikView tables and columns in your PowerPoint report templates and apply new styling. Create a
PowerPoint chart using native QlikView tables. You can create new charts, or replicate QlikView ones, by adding
column tags as the chart data source in the Table node.

8.2 Troubleshooting

Excel worksheets in PowerPoint report templates
You cannot embed an Excel worksheet in a PowerPoint report template. This will cause Qlik NPrinting Designer to
crash. You can insert the worksheet without using the Qlik NPrinting Designer.

New template
Create a .pptx file in PowerPoint without using the Qlik NPrinting Designer. Insert the worksheet and save the
.pptx. Then use the .pptx file as a report template.

Existing template
If you have already created the PowerPoint template, export it, open the .zip file generated by Qlik NPrinting and
double-click the .pptx file inside. Insert the Excel worksheet, save the resulting PowerPoint and overwrite the
exitingQlik NPrinting template by uploading the updated .zip.
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8.3 Creating PowerPoint reports
This tutorial illustrates the basics of creating PowerPoint reports. It is presumed that you are
familiar with common Qlik NPrinting procedures.

You have to first open an existing Qlik NPrinting document , or create a new one. We will use a sample QlikView
document, SalesDemo.qvw, for this tutorial.

Images of three QlikView objects and a QlikView variable will be embedded the PowerPoint report.

Create a new PowerPoint report
Do the following:

1. Select Reports in the Qlik NPrinting main menu, and then click Create report.

2. Enter a Title for the report.PowerPoint Report (Sales).

3. Select PowerPoint from the Type drop-down list.

4. Select an app from the App drop-down list.

5. Select a Template from the options available:
l Empty template - uses an empty template
l Default template - use the default template (only available if a default template has been set in

Report settings.
See Load an Office, HTML or PixelPerfect file as a template

l Custom - Choose a file to use as a template.

6. Keep the Enabled check box selected.

7. Click Create to create the report.

Create the report template
You will now create a new report template

Do the following:

1. Click Edit template to open the Template Editor.

2. Delete the title and subtitle boxes from the PowerPoint slide.

3. Right-click the Images node, and select Add objects.

4. Select QlikView objects CH16 and CH184 in the Select Objects window that opens.
Use Ctrl+Click to select more than one object.

5. Click Ok.

6. Expand the Images node in the left pane by clicking on the + to its left.

7. Drag the CH16 and CH184 node tokens and drop them onto the slide.
Arrange and format the tokens using the controls in the PowerPoint ribbon.

8. Right-click the Variables node, and then select Add variables.
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9. Enter y in the Search field, to reduce the number of candidate variables.

10. Select vCurrentYear.

11. Click Ok.

12. Drag and drop the vCurrentYear node token onto the slide in the position you require.

Preview and save
Do the following:

1. Click Preview.

2. Check the report, close it, and then edit the template again if necessary.

3. Click Save and Close to save the template and close the Template Editor.

8.4 Using the page feature in PowerPoint reports
The level feature causes cycling of a field on the same page. The page feature causes a separate
slide to be created in PowerPoint for each field value. While levels can be nested, you cannot have
more than one page per slide.

Adding a page field to the template
This report contains only one slide, so only that slide can be the active slide. If your report has more than one
slide, you must select the slide to be active and be cycled over the Page field before adding the page.

Do the following:

1. Open the PowerPoint report template you want to edit.

2. Right-click the Page node, and then select Add page to current sheet.

3. Select a field in the window that opens.

4. Click Ok.

5. Drag the field you selected onto the template, and then format the slide as desired.

6. Click on the upper part of the Preview icon.
Note that there is a labeled slide for each Salesman.

7. Close PowerPoint without saving the report.

8. Click Save and Close to save your work in the template.

Customizing the Slides property
You can have more than one page field in a presentation, but on separate slides. For example: You have a Year
field that covers 2012, 2013, and 2014. You can add the Year field on the first slide, but have each Year to span
over three slides.

Do the following:
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1. Create a new PowerPoint report template.

2. Right-click the Page node, and then select Add page to current sheet.

3. Select a field in the window that opens. For example: Year.

4. Click Ok.

5. Drag the field you selected onto the template, and then format the slide as desired.

6. Add two more blank slides.

7. Go the Slides property, and type 1-3.

8. The result will be:
l Slide 1 - 2 - 3: filtered for 2012
l Slide 4 - 5 - 6: filtered for 2013
l Slide 7 - 8 - 9: filtered for 2014

8.5 Generating individual slides for multiple field values
You can create a PowerPoint report with a slide for every combination of values from two or more
fields. This can be done with both QlikView and Qlik Sense connections.

This example illustrates the use of two fields using a QlikView connection. You can also customize the final order
of the produced slides. First, you need to do some preliminary work in QlikView, and then you’ll create a
PowerPoint report template.

Preparing the table box in QlikView
Do the following:

1. Open SalesDemo.qvw in QlikView.

2. Select the QlikView sheet where you might want the new object to appear, and then right-click any empty
part of the sheet.

3. Select New Sheet Object.

4. Click Table Box....

5. Select several fields from the list of Available Fields.
For example, select Country and Year.

6. Click Add to transfer the chosen fields to the Fields Displayed in Tablebox list.

7. Click OK at the bottom of the New Table Box window.

You can customize the sort order of slides in the final PowerPoint report by setting the sort order in the original
QlikView object.

Creating a PowerPoint report
Do the following:

1. Select Reports in the Qlik NPrinting main menu, and then click Create report.

2. Enter a Title for the report.
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3. Select PowerPoint from the Type drop-down list.

4. Select an app from the App drop-down list.

5. Click Edit template to open the Template Editor.

6. Right-click the Page node, and then select Add page to current sheet.

7. Select the Connection to the QlikView document that contains the object you want.

8. Select PageTB04.

9. Click OK.

10. Expand TB04_Page node.

11. Compose the slide title by dragging the Country and Year node tokens and dropping them in the
appropriate positions in the Title text box.

12. Add Sales by Category - CH186 to the Images node.

13. Drag the CH186 - Sales by Category node token into the template and drop it onto the slide.

14. Click Preview.
Qlik NPrinting generates a slide for each country for the years 2012 to 2014.

15. Click on Save and Close to save the template.

8.6 Inserting a native table in PowerPoint reports
You can use tables and columns in Qlik NPrinting PowerPoint reports.

Creating a new PowerPoint report
Do the following:

1. Select Reports in the Qlik NPrinting main menu, and then click Create report.

2. Enter a Title for the report. PowerPoint Native Tables.

3. Select PowerPoint from the Type drop-down list.

4. Select an app from the App drop-down list.

5. Keep the Enabled check box selected.

6. Click Create to create the report.

Adding QlikView objects as tables to the template
Do the following:

1. Click Edit template to open the Template Editor.

2. Right-click the Tables node, and select Add objects.

3. Add CH318, CH319, and CH317 from the objects list.

4. Drag and drop the CH317 node onto the first slide.

5. Insert a new slide.

6. Expand the CH318 node.

7. Select all four fields and drag and drop them onto the second slide.
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8. Select the table in the slide.

9. Select the Design ribbon tab under Table Tools.

10. Select a table style.

11. Clear the Keep Source Formats check box in the Properties section in the left pane.

12. Insert a new slide. Expand the CH319 node.

13. Drag and drop the Salesman tag onto the third slide.

14. Click Preview in the template editor, and view the results in the three slides.

15. Click Save and Close to save the template.

You can use QlikView objects that have calculated dimensions or null values as levels. However, you
cannot nest other objects inside them, except for fields from that sheet object. Qlik Sense visualizations
with calculated dimensions cannot be used as levels.

There are two useful table properties that can be used to modify QlikView data displayed in the PowerPoint
slides. They will not work with Qlik Sense data:

l Custom Rows
l Show Totals

Custom Rows is used to control the number of rows displayed in a table. For example, if you have a Sales table
in QlikView that is sorted by Sales description and has 1000 rows, you may want to reduce the number of rows
displayed in PowerPoint.

The range of rows that you want to display is entered in the format x-y (for example, 1-10 or 5-20). If y is greater
than the maximum number of rows in the table (excluding Header and Totals rows), then only the number of
rows available after x will be exported (total number of rows = 100, range 80-110, resulting rows displayed = 80-
100).

The Show Totals check box allows you to export a table with or without the totals row of the QlikView table. This
property is only available if the table has a totals row that can be detected by Qlik NPrinting.

The Custom Rows and ShowTotals properties are related to tables and are not available for single
columns.

The Custom Rows property is available for all object types except pivot tables.

8.7 Creating a PowerPoint chart using native Qlik tables
Qlik NPrinting supports PowerPoint native charts. You can create new charts, or replicate QlikView
or Qlik Sense charts.
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Limitations
l Stock charts are not supported.
l Tables are only the chart data sources.

Supported PowerPoint charts
The following PowerPoint charts can be bound to tables in a report template:

l Clustered Bar
l 3-D Clustered Bar
l 100% Stacked Bar
l 3-D 100% Stacked Bar
l Stacked Bar
l 3-D Stacked Bar
l Clustered Column
l Stacked Column
l Stacked Column 100%
l Clustered Column 3D
l Stacked Column 3D
l 100% Stacked Column 3D
l Column 3D
l Stacked Line
l Stacked Line With Markers
l Line
l Line 3D
l Line With Markers
l 100% Stacked Line
l 100% Stacked Line With Markers
l Area
l Area 3D
l 100% Stacked Area
l 100% Stacked Area 3D
l Stacked Area
l Stacked Area 3D
l Wireframe Contour
l Wireframe Surface 3D
l Surface 3D
l Contour
l Bar Of Pie
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l Pie
l Pie 3D
l Pie Of Pie
l Exploded Pie
l Exploded Pie 3D
l Doughnut
l Exploded Doughnut
l Radar
l Radar With Markers
l Filled Radar

Create a new PowerPoint report
Do the following:

1. Select Reports in the Qlik NPrinting main menu, and then click Create report.

2. Enter a Title for the report. PowerPoint Native Chart.

3. Select PowerPoint from the Type drop-down list.

4. Select an app from the App drop-down list..

5. Keep the Enabled check box selected.

6. Click Create to create the report.

Insert a PowerPoint chart in the template
Do the following:

1. Click Edit template to open the Template Editor.

2. Right-click the Tables node, and select Add objects.

3. Add CH326 - Sales by YearMonthNum from the objects list.

4. In the PowerPoint ribbon, select the Insert tab.

5. Click on Chart in the Illustrations section.

6. Select the first bar chart in the Columns option, and then click Ok.

An Excel sheet is opened and will be used as the data source for the chart. We will insert Qlik NPrinting tags into
the sheet and re-size the data to include only the correct data set.

Drag and drop the table tags into the Excel worksheet
Do the following:

1. Expand the Tables node.

2. Select the YearMonthNum and Sales tags in the Tables node.
Use Ctrl+Click to select more than one object.
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3. Drag and drop the Year MonthNum tags into the upper left corner of the Excel worksheet (cell A1) and the
Sales tags into cell B1.
Be sure to insert the column title in the first row of the worksheet, and insert the column tag in the second
row.

Delete unnecessary data
Do the following:

1. Select and delete columns C and D.

2. Select and delete 3, 4 and 5.

3. Close Excel.
The changes will automatically be saved.

Verify that the chart data sources are correct
To check that the chart data sources are correctly connected, do the following:

1. Click Select Data in the Design tab of the PowerPoint ribbon bar in the template editor.
Excel will be opened again.

2. Click Edit in the Series column to check the correct cells are shown in the Series name and Series values
fields.

3. Click Edit in the Category column to check which cells are included.

4. Modify the data source ranges, if necessary, then close the editor and Excel.

5. Click on Preview .
You will see a native chart inside the slide.

Add pages by category
All other features, like pages, can be added.

Do the following:

1. Add the CategoryName field in the Pages node.

2. Drag and drop the CategoryName tag into the slide.

3. Click Preview .
You will see a slide for each category.

4. Click on Save and Close to save the template.
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9 HTML reports
This section explains how to create HTML reports, how to add tables in HTMLreports, and how to
embed the resulting report in an email message.

You can also apply HTML styles to get the look and feel you want, and the resulting HTML code can be manually
customized.

HTML reports can contain many HTML and images files. They are delivered to users as .zip files.

HTML reports are supported for both QlikView and Qlik Sense objects.

The final output of emails with embedded HTML reports may differ depending on the email clients and
permissions of the recipient. Some systems automatically block images, or show them as attachments.

l Creating HTML reports (page 412)-->HTML reports containing tables (page 414)
l HTML reports containing tables (page 414)-->Applying HTML formatting (page 417)
l Applying HTML formatting (page 417)-.->Filters (page 304)
l Applying HTML formatting (page 417)-->Distributing reports by email (page 479)
l Filters (page 304)-.->Distributing reports by email (page 479)

9.1 Creating HTML reports
HTML reports contain HTML and image files. They are delivered to users as .zip files.

This tutorial shows how to:

l create an HTML
l embed images in an HTML report
l add a level
l add a level variable tag as a label

The end report will have an appropriate title and images in a frame for each of three years. HTML reports support
most Qlik Sense objects. See: Working with Qlik objects (page 292)

Creating a new HTML report
Do the following:

1. Select Reports in the Qlik NPrinting main menu, and then click Create report.

2. Enter a Title for the report.

3. Select HTML from the Type drop-down list.
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4. Select an app from the App drop-down list.

5. Select a Template from the options available:
l Empty template - uses an empty template
l Default template - use the default template (only available if a default template has been set in

Report settings.
See Load an Office, HTML or PixelPerfect file as a template

l Custom - Choose a file to use as a template.

6. Click Create to create the report.

Selecting connections and objects
Do the following:

1. Click Edit template to open the Template Editor.

2. Right-click the Images node, and select Add objects.

3. Select the objects you want to add as images.

4. Click OK.

5. Drag and drop your image objects onto lines between the <body> and </body> tags.

6. Click Preview.

7. Check the report, close it, and then edit the template again if necessary.

8. Click Save and Close to save the template and close the Template Editor.

Resulting report
<html>

<body Style="text-align: center;">

<h3 Style="text-align: center; font: 21px verdana;">

Top 10 countries

</h3>

<img src="%%CH320%%" alt="CH320">

<h3 Style="text-align: center; font: 21px verdana;">

Top 10 products

</h3>

<img src="%%CH184%%" alt="CH184">

</body>

</html>

Opening the select levels window
You can produce an HTML report with levels that cycle through each year.

Do the following:

1. Right-click the Levels node, and select Add levels.

2. Select Year from the levels list.

3. Click OK.

4. Expand the Levels node.
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5. Drag and drop the Year_Level node token onto a line between the <body> and </body> tags.
Add lines if necessary.

The result is three new lines, %%Year_Level%%, %%/Year_Level%%, and a blank line between the lines.

6. Arrange the %%Year_Level%% line before the elements that you want to be included in the level cycle, and
the %%Year_Level%% line after the elements that you want to be included in the level cycle.

7. Expand the Year_Level node.

8. Drag and drop the Year node token onto a line between the %%Year_Level%% and the %%Year_Level%%

lines.

9. Add inline style elements. See the code examples below.

Resulting report
The following HTML code, for example, creates a corresponding HTML report. The report will have three titled
sections, one for each year.

<html>

<body Style="text-align: center;">

%%Year_Level%%

<h2 Style="font: 24px verdana;font-weight: bold;">%%Year%%</h2>

<h3 Style="text-align: center; font: 21px verdana;">Top 10 countries</h3>

<img src="%%CH320%%" alt="CH320">

<h3 Style="text-align: center; font: 21px verdana;">Top 10 products</h3>

 <img src="%%CH184%%" alt="CH184">

%%/Year_Level%%

</body>

</html>

9.2 HTML reports containing tables
Tables exported from QlikView or Qlik Sense can be displayed with or without the original
headings. You can hide the headings that were exported, and then create your own custom
headings. This is also true for tables constructed by putting together columns generated from data
fields.

The following example shows how to create an HTML report with tables.

Adding tables to an HTML template
Do the following:

1. Click Edit template to open the Template Editor.

2. Right-click the Tables node, and select Add objects.

3. Select an object from the list.

4. Click OK.
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5. Right-click the object node, and then select Properties.

If the Properties window is already in view , the Properties option will not be shown when you
right-click a node.

6. Select the Keep Source Formats and Show Headers check boxes in the Properties panel.

7. Drag the table node tag into the template and drop it onto an empty table data container.

<html>

<body>

<table>

<tr>

<td>

<h1 style="text-align:center">

Top 10 Products<br /br>

with QlikView Heading

</h1>

%%yourtableobject%%

</td>

<td>

<h1 style="text-align:center">

Top 10 Products<br> </br>

Hidden QlikView Heading

</h1>

</td>

</tr>

</table>

...

Two versions of the table are displayed side by side. The left table has headings visible, and the right table
has the headings hidden. The table is embedded as a unit in both cases.

8. Add the same table to the template again.

9. Open the Properties pane for the new table object, and then set the Show Headers property to Hide.

10. Drag the table node tag into the template and drop it onto the appropriate empty line:
<html>

<body>

<table>

<tr>

<td>

<h1 style="text-align:center">

Top 10 Products<br /br>

with QlikView Heading

</h1>

%%yourtableobject%%

</td>

<td>

<h1 style="text-align:center">

Top 10 Products<br /br>

Hidden QlikView Heading

</h1>
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%%yourtableobject_1%%

</td>

</tr>

</table>

...

11. Expand the table node.

12. Drag and drop each column, one at a time, onto the template in the appropriate HTML container.
This third version of the table is reconstructed column-by-column in a separate HTML table. Each table
heading and table data cell can have inline style elements added individually. The inline style elements for
each table data cell will have an effect on the whole column below the heading.

13. Add custom headings.

Here is the HTML code for the reconstruction of the last version of CH184_1 - Top 10 Products in another
table:

<table>

<tr>

<th style="width:125px;">

Product

</th>

<th style="width:60px;">

Sales

</th>

<th style="width:60px;">

Profit

</th>

<th style="width:100px;">

Profit Percentage of Sales

</th>

</tr>

<tr>

<td>

</td>

<td style="width:125px;">

%%ProductName_1%%

</td>

<td style="width:60px;">

%%Total Sales_1%%

</td>

<td style="width:60px;">

%%Gross Profit_1%%

</td>

<td style="width:100px;">

%%GP%_1%%

</td>

<td>

</td>

</tr>

</table>

</body>

</html>
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You can use QlikView objects that have calculated dimensions or null values as levels. However, you
cannot nest other objects inside them, except for fields from that sheet object. Qlik Sense visualizations
with calculated dimensions cannot be used as levels.

Preview and save
Do the following:

1. Click Preview.

2. Check the report, close it, and then edit the template again if necessary.

3. Click Save and Close to save the template and close the Template Editor.

9.3 Applying HTML formatting
You can apply CSS inline style elements as you create templates in the HTML template editor.

Allow application of CSS inline style elements for a whole chart
After you have added an object as a table:

Do the following:

1. If Properties are visible, jump to step 3, otherwise right-click the Tables node.

2. Select Properties.

3. Deselect the Keep Source Formats check box.

This will cause the content for all cells in all columns of the table to be exported from QlikView without
formatting. The application of CSS inline style elements that you set in the HTML template will be applied.
Compare the output with and without Keep Source Formats selected.

Allow application of CSS inline style elements for specific columns
Be sure that your table object is a straight table in QlikView. QlikView pivot tables must be converted to straight
tables before selecting them to be included under the Qlik NPrinting Tables node or you will not have access to
individual fields/columns. If you want to keep source formatting for the majority of columns, leave the Keep
Source Formats check box selected for the table as a whole and do the following:

1. Expand the table node.

2. Click on the column(s) that you want to apply CSS inline style elements to.

3. Deselect the Keep Source Formats check box.

4. When the HTML Encode check box is selected, any non-alphanumeric symbols (such as < and />) that
could be interpreted as HTML tag elements will be converted to HTML entities.
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When the HTML Encode check box is cleared, any non-alphanumeric symbols that could be interpreted as
HTML tag elements will be rendered by the underlying HTML code used in the Qlik NPrinting HTML
template editor.

This will cause the content for all cells in the selected column of the table to be exported from QlikView
without formatting, but they will contain the application of any CSS inline style elements you have applied
within the HTML template. You can do this for as many individual columns as you need.

Apply a format to a column
Do the following:

1. In HTML Report (Sales), select Gross Profit.

2. Enter $#.##,00 in the Format field.

Build your table
Do the following:

1. Construct an HTML table with one row of data cells. The source code should looks like this:
<table>

<tr>

<td></td> <td></td> <td></td>

</tr>

</table>

2. Drag the table column node icons between the table data cell tags.
You can select multiple values by keeping Ctrl or Shift pressed during the columns selection, and then
drag and drop them into the template. This will create all tags and insert them into a horizontal series of
cells.
The Keep Source Formats check box has been cleared for the Gross Profit column.

3. Insert another row above the first.

4. Insert table heading cells in the new row.

5. Enter the headings that you want.

6. Reopen the Properties dialog window for each column that you have added to the template, one at a
time.

7. Click in the Value column of the Show Header row. The cell will have the value Show.

8. Click on the drop-down menu button that appears, and select Hide.

This is the original table with the Keep Source Formats check box cleared for two columns, a heading row
added, and the original table headings hidden for every column.

Apply inline style elements
In this case, the sample output is simple but it gives you an idea of the possibilities.

Here is the code in full:

<html>

<body>

<table cellspacing=0 style="border-collapse:collapse;">
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<tr style="width:0*;

 font-family:Verdana;

 font-size:small;

 font-variant:small-caps;">

<th style="border:grey dashed 1px;">

Product Name

</th>

<th style="border:grey dashed 1px;">

Total Sales

</th>

<th style="border:grey dashed 1px;">

Gross Profit

 </th>

<th style="border:grey dashed 1px;">

GP%

 </th>

<th style="border:grey dashed 1px;">

Quantity

 </th>

</tr>

<tr>

<td style="width:0*;

font-family:Verdana;

font-size:small;

font-weight:bold;

font-variant:small-caps;">

%%ProductName%%

 </td>

<td>

%%Total Sales%%

 </td>

<td>

%%Gross Profit%%

 </td>

<td>

%%GP%_1%%

 </td>

<td style="width:0*;

 color:red;

 font-family:Georgia;

 font-size-adjust:0.40;

 background-color:Yellow;

 border:green solid 2px;

 text-align:right;">

%%Quantity_1%%

 </td>

</tr>

</table>

</body>

</html>
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10 PixelPerfect reports
PixelPerfect lets you produce attractive reports while maintaining complete control of the printed
output.

There are a wide range of formatting options:

l Embedding and formatting data in a template
l Creating and ordering data columns
l Formatting cell contents
l Adding and nesting levels
l Rendering borders visible and eliminating white space

10.1 Limitations
l You cannot add QlikView or Qlik Sense pivot tables to PixelPerfect reports.
l Open Type Fonts (.otf) are not supported in report templates. Generated reports will use a different font,

and not look as expected.

You can use QlikView objects that have calculated dimensions or null values as levels. However, you
cannot nest other objects inside them, except for fields from that sheet object. Qlik Sense visualizations
with calculated dimensions cannot be used as levels.

10.2 Understanding PixelPerfect features
PixelPerfect is the Qlik NPrinting solution to create aesthetically perfect reports from QlikView or
Qlik Sense data, and to then export the reports to PDF. PixelPerfect is an implementation of band
reporting, which gives you pixel level control over layout and appearance.

For example, you can set font size, color, image positioning, and dimensions, chart types, options, and much
more.

10.3 Description of features

Template editor
You can use the PixelPerfect template editor to design structured templates. Using the Field list tree view, you
can drag and drop images, cells, variables, and formulas.

You can also add levels to create tables, or to repeat a segment of the report for each value of the field or the
table used as a level. Levels can be nested within one another to create a hierarchical view.
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You can configure the appearance and behavior of each object using its properties. They are entered in the
Property Grid panel in the bottom of the editor.

Level
To add levels, do the following:

1. Right-click the Levels node, and select Add levels.

2. Choose an object from the list that appears.

l If you insert a QlikView field, the report segment will be repeated for each value of the field.
For example, if you select the field Year, you will get a segment for each year that is present in your
dataset.

l If you select a QlikView table, the report segment will be repeated for each row in the table.
You can repeat a segment for many different combinations of a group of fields. For example, if you select
a table with a country and a sales representative column, you will get a segment for each combination of
Country/Sales representative values visible in the table.

Levels can be made hierarchical. To add a sub-level, do the following:

1. Right-click the name of an existing level, and then select Add Level.

2. Choose the field or the table that you want to insert.
For example, you can add a level for Year and nest the Product Category under it. You can have a
segment repeated for each year, with many segments inside repeated for each product category.

3. Before adding a level to the template, select the destination band and right-click it.

4. Click Insert Detail Report and select the name of the level you want to add.
A new band will be created and it will be cycled by each value of the level.

5. Drag and drop the level content to the band that will be transferred to the final report.
A new label containing the field information is created.

If you want to create a table in the final report, you have to use levels.

Table
In PixelPerfect templates, tables are data sources for charts and sparklines. If you want to create a table in your
report, you must use levels. You do not add the source QlikView table in the Tables node.

To add a table, do the following:

1. Right-click the Tables node, and select Add objects.

2. Click on the desired object from the list that appears.

Images
You can add QlikView objects as images to your template.

Do the following:
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1. Right-click the Images node, and select Add objects.

2. Select a QlikView object from the list that appears, and then drag and drop the new image onto the
template.
A new picture box is created.

3. To specify the image position, select the image area with the mouse and move it until you reach the
desired position.

4. To change the image area, select one of the blue squares in the corner or in the middle of a side and
adjust to desired position.

5. Use the Sizing property to set the image behavior.

Possible values are:

l Normal: the image is inserted with the original size. If the area is too small the image will be clipped,
maintaining the alignment with the upper left corner.

l Stretch Image: the image is stretched to fill the width and height of the content area. Aspect ratio will be
changed.

l AutoSize: the final image keeps the original size of the image exported from QlikView. Other data in the
final report will be moved in order to maintain integrity of the report.

l Center Image: the image is displayed in the center (horizontally and vertically) of the area with the
QlikView dimensions. If the image is larger than the area, the image is cropped.

l Zoom Image: the image is proportionally re-sized to fill the area, while keeping the aspect ratio. The
image view can zoom in or out.

l Squeeze: if the area exceeds the image size, the image is centered and shown at full-size. Otherwise, the
image is re-sized to fit into the area.

To set other properties of the image, use the Property Grid.

Variables
You can add QlikView variables to your template. QlikView variables will be replaced with their value at the time
of report generation.

Do the following:

1. Right-click the Variables node, and then select Add Objects.

2. Select the variable that you want to add from the list that appears.
A new label containing the information about the variable is created when you drag and drop the variable.

You can set other variable properties using the Property Grid.

Formulas
You can add QlikView formulas to your template.

Each formula:
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l Will be evaluated at time of report generation.
l Must use the QlikView formula syntax.
l Must return a single value.

To add a formula, do the following:

1. Right-click on the Formulas node in the Field List.

2. Choose Add Formula, then insert a name and the formula using QlikView syntax.

3. Drag and drop it onto the template.
A new label containing the information about the formula is created.

4. You can edit the formula by right-clicking on the formula name and selecting Edit Formula.

Cells
You can add specific cells from a QlikView object to your template.

Do the following:

1. Right-click the Cells node, and then select Add Cells.

2. To insert a name, click on the dots to the right of the Object label.

3. Select a QlikView object from those that appear.

4. Insert the number of desired rows on the top and bottom, in addition to the number of columns.

5. Drag and drop each cell onto the Report area.
A new label containing the information for each cell is created. You can set other cell properties using the
Property Grid.

Note that cells with a 0 in the row number refer to the QlikView table header.

If the original QlikView object has totals on the first row, the cells with 1 as the row number will contain the total.
In this case, the first cells with data are those with 2 as the row number.

Multiple drag and drop
Do the following:

1. Select more than one entity in the Field list by pressing the Shift or Ctrl buttons.

2. Drag the items onto the template.
When you drop them, a table containing your selected entities will be created.

3. To drag and drop only the column headers, select the columns and drag them by pressing Shift or by
right-clicking the mouse.

You can also use Shift and Ctrl to select multiple objects from a list to a node. For example you can add many
images by pressing Ctrl during the selection from the list of images.

Remove an entity
Do the following:
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l Right-click on the entity and select either Remove Object or Remove Levels to remove an entity from the
Field list.

Using ToolBox controls
The toolbox on the right side of the editor allows you to insert some control objects into the template. For
example, you can insert charts, sparklines, page breaks, labels, and many other objects.

To insert a control in your template, select it from the toolbox, and then drag and drop it into the template.

You can set control properties using the Property Grid.

Labels
Labels are used to insert fixed text or bind it to a source. For example, you can insert dynamic text from fields,
variables, or formulas.

To insert a new label, do the following:

1. Select the label from the Toolbar then drag and drop it into the template.

2. Insert your own text by double-clicking on the control and entering the text.
You can bind a label to a data source by selecting it and clicking on the smart tag (the small arrow in the
top right corner), then by opening the Data Binding menu. Be sure to select the proper data source. You
can set other label properties using the Property Grid.

Charts
You can develop charts from your QlikView data with PixelPerfect. A chart does not need to exist in a QlikView
document to add it. PixelPerfect uses QlikView tables as data sources for charts. You can also choose from a great
variety of chart types to customize the appearance.

To add a new chart, do the following:

1. Drag a chart object from the Toolbox onto the template.
A wizard appears. Follow the steps to select the data series and set the properties. A data series can be
bound by going to the Data tab, selecting Series Binding, and then selecting the argument and the values
for each series.

2. Click on the columns of the tables already inserted in the Field List.
Following the other steps will help you customize presentation properties. You can also change properties
by using the Property Grid panel, or by reopening the wizard and clicking on the smart tag and selecting
Run Wizard. To jump to a specific property in the wizard, click on its name on the left side column. You
can insert a chart inside a level.

Sparklines
A sparkline is a very small line chart (typically drawn without axis) that presents the variation of a measurement,
typically over time. PixelPerfect supports sparklines, so that they can be inserted into your reports.
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Sparklines need a table as the data source. You first add a table in the Tables node, select the sparkline object
from the Toolbar, and drag and drop it into the template. To bind it with your data, click on the smart tag (the
small arrow in the top right corner), and then set the Data Member and Value Member properties.

You can display a sparkline for each row of a table by inserting a sparkline inside a level.

Rich text
You can use Rich text to display information in different formats.

l Select the Rich Text button from the Toolbar, drag and drop it into your template, and then double-click
on it to input data in edit mode.

In edit mode, you can type fixed text or drag and drop entities from the Field list: a field between square brackets
will appear. Your can drag and drop variables, fields, formulas, images, and cell values. You can set other Rich
Text properties using the Property Grid or the ribbon bar. Rich Text also supports nested levels.

Other controls
Use page break, zip code, panel, or line to customize your template.

Export formats
PixelPerfect supports PDF, HTML, Xls, Xlsx, Png, Gif, jpg and Tiff formats. The default is PDF, which is the best
choice when you want total control of appearance. If your goal is to create an Excel or HTML report, we
recommend using an Excel or HTML template.

To display the preview in another format, click on the arrow under the lens, or set a specific output format in the
task.

See also:

p How to use sparklines in PixelPerfect reports
p How to create PixelPerfect charts
p How to create a well formatted PixelPerfect chart
p Properties of PixelPerfect labels, table and charts

10.4 PixelPerfect common properties
This page describes the properties for the most commonly used PixelPerfect objects. Some
properties are also available in the Formatting toolbar.

You can use this information to do the following:

l Search for the property that you want to change under Property Name, and then check for the objects for
which it is available.

l Find which properties are customizable for each object.
l Learn precisely what each specific property controls.
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Appearance

Property
name

Property explanation Label Table
Table
rows

Table
cells

Charts

Appearance
Name

Specifies one of the available
appearances, to be used to draw
the chart's elements (Diagram,
Axes, Legend, etc.).

No No No No Yes

Background
Color

Specifies the background color for
the control.

Yes Yes Yes Yes Yes

Background
Image

Allows you to load a background
image to a chart (or define its URL),
and also define whether it should
be stretched to fit the entire chart's
area.

No No No No Yes

Borders,
Border Color,
Dash Style
and Border
Width

Specifies the border settings for the
control.

Yes Yes Yes Yes Yes

Fill Style Specifies the fill style of a chart's
background (Empty, Solid,
Gradient, or Hatch) and define
other fill options as required.

No No No No Yes

Font Specifies the font settings for the
control.

Yes Yes Yes Yes No

Foreground
Color

Specifies the text color for the
control.

Yes Yes Yes Yes No

Formatting
Rules

Invokes the Formatting Rules
editor, allowing you to choose
which rules should be applied to
the control during report
generation, and define the
precedence of the applied rules.

Yes Yes Yes Yes Yes

Appearance properties
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Property
name

Property explanation Label Table
Table
rows

Table
cells

Charts

Image Type Specifies whether a chart should be
internally rendered as a meta file in
a report (the quality of the rendered
image is always good, but in
particular cases some details of the
control may be lost), or as a bitmap
(the quality of the rendered image is
sometimes poor, but it allows a
control to be drawn more precisely).

No No No No Yes

Indicators
Palette Name

Specifies the palette that is used to
paint all indicators that exist in a
chart.

No No No No Yes

Padding Specifies the indent values which
are used to render the contents of a
label.

Yes Yes Yes Yes Yes

Palette Name Specifies one of the built-in palettes
to be used to draw a chart's series.

No No No No Yes

Palette's Base
Color Number

Specifies an integer index
determining the base color for the
palette defined by the chart's
palette name property.

No No No No Yes

Style Priority Specifies the priority of various style
elements (such as Background
color, Border color, etc.).

Yes Yes Yes Yes Yes

Styles Specifies odd and even styles for
the control, as well as assigns an
existing style to the control (or a
newly created one).

Yes Yes Yes Yes No

Text
Alignment

Specifies the alignment of the
control's text.

Yes Yes Yes Yes No
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Data

Property
name

Property explanation Label Table
Table
rows

Table
cells

Charts

(Data
Bindings)

If the current report is bound to data,
this property allows you to bind some
of the control properties (Bookmark,
Navigation URL, Tag, and Text) to a
data field obtained from the data
source for a report, and to apply a
format string to it.

Yes Yes No Yes Yes

Data
Member

Specifies the data source member
which supplies data to a chart.

No No No No Yes

Data
Source

Specifies the data source for a chart. No No No No Yes

Lines Provides access to the text property of
a label in the multiline mode.

Yes No No Yes No

Data properties
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Property
name

Property explanation Label Table
Table
rows

Table
cells

Charts

Series Data
Member

Specifies the name of the data field
whose values are used to generate
and populate a series for a chart. The
template settings for the created
series are defined by the properties in
the SeriesTemplate property of a
chart. In particular, the Argument
Data Member and Value Data
Members properties specify the data
fields from which the arguments and
data values of the series data points
are obtained.

Each series gets its name from the
data field specified by the Series Data
Member property. For example, this
name is used to identify a series within
the legend for a chart control. The
names of all generated series can be
supplemented with the same prefix
and suffix defined by the settings
which are available via the series
name template property.

When chart binding is used to
generate series within a chart control
based upon the data obtained from
the associated data source (defined by
the data source property), a rule needs
to be defined that helps the chart
recognize the data records whose
values are used to construct individual
series objects. To do this, the Series
Data Member property, which
specifies the data field whose values
are used when series objects are
created and populated, can be used.

No No No No Yes
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Property
name

Property explanation Label Table
Table
rows

Table
cells

Charts

Series
name
template

Specifies the settings used to name
data bound series, defining the prefix
and suffix texts for the names of series
which are dynamically created as a
result of binding a chart to data (using
the Data Source, Series Data
Member, Argument Data Member
and Value Data Members properties).
The names of series, to which these
prefixes and suffixes are added, are
taken by each series from the data
field defined by the Series Data
Member property.

No No No No Yes

Series
sorting

Specifies the sort mode of a series for
a chart (None by default, Descending
or Ascending).

No No No No Yes

Series
template

Allows you to customize a template
for series which are created
dynamically as a result of binding a
chart to data (via the Data Source and
Series Data Member properties). The
settings, which are available via the
series template property, are common
to all such data bound series. These
settings allow you to provide
centralized customization of all
dynamically created data bound
series.

No No No No Yes

Summary Allows you to perform calculations
(Summary, Max, Min, Average, etc.)
over a data field.

Yes No No Yes No
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Property
name

Property explanation Label Table
Table
rows

Table
cells

Charts

Tag Allows you to add additional
information to the control; for
example its id, by which it can then be
accessible via scripts. If the current
report has a data source, the Tag
property can be bound to a data field
obtained from the data source. To do
this, expand the (Data Bindings)
property, and then select the required
data field in the Tag.Binding drop-
down list.

Yes Yes Yes Yes Yes

Text Allows you to define a line of static
text to be displayed. When a label is
selected in the designer, you may
simply start typing the text, and it will
be automatically entered into the In-
place editor. If the current report has
a data source, the text property can be
bound to a data field obtained from
the data source. To do this, expand
the (Data Bindings) property and in
the Text.Binding drop-down list, and
then select the required data field.

Yes No No Yes No

Xlsx Format
String

Specifies the native XLSX format string
for the content of a control, which is
preserved when the report is being
exported to XLSX. This format string is
independent from the general value
formatting.

Yes No No Yes No

Design

Property
name

Property explanation Label Table
Table
rows

Table
cells

Charts

(Name) Specifies the name for a control, by
which it can be accessed in the Report
Explorer, Property Grid, or via scripts.

Yes Yes Yes Yes Yes

Design properties
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Layout

Property
name

Property explanation Label Table
Table
rows

Table
cells

Charts

Height Specifies the height of a row, in report
measurement units.

No No Yes No No

Location Specifies the location of a control, in
report measurement units.

Yes Yes No No Yes

Size Specifies the size of a control, in report
measurement units.

Yes Yes No No Yes

Snap Line
Margin

Specifies the margin (in report
measurement units) that is preserved
around the control when it is aligned
using Snap Lines, or when other
controls are aligned next to it.

Yes Yes Yes Yes Yes

Width Specifies the width of a cell, in report
measurement units.

No No No Yes No

Layout properties

Elements

Property
name

Property explanation Label Table
Table
rows

Table
cells

Charts

Annotation
repository

Provides centralized access to all
annotations that are present in the
chart.

No No No No Yes

Annotations Provides access to the annotations
collection of the chart.

No No No No Yes

Elements properties
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Property
name

Property explanation Label Table
Table
rows

Table
cells

Charts

Diagram Allows you to customize the
diagram elements for the main and
secondary axes and panes. By
default, a chart is displayed in the
Default Pane, but if necessary, you
can display the series for each chart
in a separate pane. To do this, click
the Pane's ellipsis button to invoke
the Pane Collection editor,
allowing you to manage and
customize panes. Then, select the
required series within the chart and
set its View.Pane property to the
required pane.

No No No No Yes

Legend Allows you to customize the legend
for a chart by defining such
properties as Text alignment and
Antialiasing, Font style,
Background color or Image,
Border options, Markers' size and
Visibility, Shadow options, and so
on.

No No No No Yes

Series Invokes the Series Collection
editor, which allows you to manage
and customize the series for a chart.
Note that series which are bound

to data at the level of a chart
control (in particular, using the
Data Source, Series Data Member,
and both the Argument Data
Member and Value Data Members
properties), are created
dynamically, based upon the data
obtained from the specified data
source, and they are not presented
within the Series collection. To
perform a centralized customization
of such a series, use the settings
which are available via the Series
Template property.

No No No No Yes
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Property
name

Property explanation Label Table
Table
rows

Table
cells

Charts

Titles Invokes the Chart Title Collection
editor, which allows you to manage
and customize the titles for a chart.

No No No No Yes

Navigation

Property
name

Property explanation Label Table
Table
rows

Table
cells

Charts

Bookmark
and Parent
bookmark

Allows you to create a hierarchical
structure within a report called a
document map. If the current report
has a data source, the Bookmark
property can be bound to a data
field, obtained from the data source.
To do this, expand the (Data
Bindings) property, and then select
the required data field in the
Bookmark.Binding drop-down list.

Yes Yes No Yes Yes

Navigation properties
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Property
name

Property explanation Label Table
Table
rows

Table
cells

Charts

Navigation
URL and
Navigation
Target

Navigation URL allows you to
specify a URL for web browser
navigation when a user clicks a label.
The web browser displays a page in a
window or a frame as specified by
the Navigation Target property. A
URL should have an appropriate
prefix (e.g. "http://").

You can create cross-references
within the report by assigning the
name of the target control to the
Navigation URL property, and
setting the Navigation Target
property to _self. If the current report
has a data source, the Navigation
URL property can be bound to a data
field obtained from the data source.
To do this, expand the (Data
Bindings) property, and then select
the required data field in the
Navigation URL.Binding drop-down
list.

Yes No No Yes Yes

10.5 Creating a simple PixelPerfect report

Create a new PixelPerfect report template
Do the following:

1. Select Reports in the Qlik NPrinting main menu, and then click Create report.

2. Enter a Title for the report. Simple PixelPerfect Report.

3. Select PixelPerfect from the Type drop-down list.

4. Select an app from the App drop-down list.

5. Select a Template from the options available:
l Empty template - uses an empty template
l Default template - use the default template (only available if a default template has been set in

Report settings.
See Load an Office, HTML or PixelPerfect file as a template

l Custom - Choose a file to use as a template.

6. Click Create to create the report.
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7. Click Edit template to open the Template Editor.

8. Right-click the Levels node, and select Add levels.

Insert a QlikView table as level
Do the following:

1. Select the Connection to the QlikView document that contains the object you want.

2. Enter 1 and 8 into the search field to reduce the number of candidate objects to five.
If Top 25 Products - CH184 is the only object visible, press Enter to add it to the Levels node. Otherwise,
select it in the list.

3. Click OK.
CH184 will be added to the Levels node.

Create level details
Do the following:

1. Right-click on the Detail area in the middle of the page.

2. Select Insert Detail Report.

3. Choose CH184_Level from the list.

Create data columns
Do the following:

1. Expand the CH184 node.

2. Press Shift or Ctrl and select the four columns of the CH184 from the Levels node.

3. Drag and drop the selected columns into the DetailReport - CH184_Level area.

Columns are added to the report template in the order you select them.

Set column order
To change the order of the columns, do the following:

1. Click in a cell to select it, for instance the first GP%.

2. Click on the small arrow that appears in the upper right corner to open the Table Cell Tasks menu.

3. Open the Data Binding drop-down list and expand the CH184_Level.GP% node.

4. Select Product Name to set this field as the first column.

5. Repeat 1 through 4 for the other columns in the order Total Sales, Gross Profit and GP%.

To eliminate inter-row white space, select the dotted line below the table and overlap it with the bottom line of
the CH184_level table.
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Create table headings
Do the following:

1. To add column headings, drag and drop the Table object from the Tool Box on the right.

2. Align the new table with the upper left corner of the Detail area.

Insert a fourth column
It is necessary to create a new column to match the data structure.

Do the following:

1. Right-click the third cell, select Insert, and then click Column to Left.

2. Select the right border of the fourth cell and drag it until the guideline overlaps with the right border of
the fourth cell of the CH184_Level table.

3. Repeat this action with the other cells until they are aligned with the corresponding cells in the CH184_
Level table.

4. Double-click the first column on the left to edit the text and enter Product Name.

5. Repeat the process with the second column and enter Total Sales.

6. Enter Gross Profit in the third cell and Gross Profit % in the last cell.

7. Select the entire table by clicking on the upper left corner.

8. Set the font type, dimension, alignment, and so on, as you prefer. For example, select Sans serif, 14px,
Bold and Centered.

9. Select the row of table headings and then find Borders in the Property Grid in the lower left corner.

10. Select All in the drop-down list.

11. Click the drop-down button to accept the updated borders.

12. Select the bottom border of the Detail area and align it with the bottom border of the table to eliminate
the empty space.

Set table data borders
Do the following:

1. Select the entire data table in the DetailReport - CH184_Level area.

2. Find Borders in the Property Grid.

3. Select All in the drop-down list. The Border icons become yellow.

4. Click the drop-down list to accept the updated borders.

5. Keep the data table selected.

6. Set the font format you prefer. For example, select Sans serif, 11px.

Set data alignment
Do the following:
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1. Select the ProductName cell.

2. Find Text Alignment in the Property Grid.

3. Click the drop-down list, and then set text alignment to Middle Left.

4. Select the Total Sales cell.

5. Set text alignment to Middle Right in the Property Grid.

6. Repeat steps 5 and 6 for columns Gross Profit and Gross Profit %.

Format numbers
To set the number formatting to Dollar currency, do the following:

1. Select the Total Sales cell, and then click on the upper right arrow >.

2. Click on the dots on the right of Format String in the new window, and then select Currency.

3. Click on the Custom tab.

4. Select the $0.00 format.

5. Click OK.

6. Repeat steps 1 to 5 for the Gross Profit cell.

7. Format Gross Profit % as Percent 0.00%.

Preview and save
Do the following:

1. Click Preview.

2. Check the report, close it, and then edit the template again if necessary.

3. Click Save and Close to save the template and close the Template Editor.

See also:

p How to create Pixel Perfect reports with a level

10.6 Creating PixelPerfect reports with a level
You can create PixelPerfect reports with a level to repeat the content of a part of the report for
each value of the field or table added to the Levels node.

You can add chart objects (images, tables, and charts) in the repeated report part. In this example, you will create
a report that shows a page for each year with two different charts from QlikView.

You can use QlikView objects that have calculated dimensions or null values as levels. However, you
cannot nest other objects inside them, except for fields from that sheet object. Qlik Sense visualizations
with calculated dimensions cannot be used as levels.
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Creating a new PixelPerfect report
Do the following:

1. Select Reports in the Qlik NPrinting main menu, and then click Create report.

2. Enter a Title for the report. PixelPerfect Report with Level.

3. Select PixelPerfect from the Type drop-down list.

4. Select an app from the App drop-down list.

5. Click Create to create the report.

6. Click Edit template to open the Template Editor.

7. Right-click the Levels node, and select Add levels.

8. If necessary, select the Connection to the QlikView document that contains the object you want. In this
case, select Sales Demo.

9. Enter Year - F\Year in the Search box, and then select Year from the objects list.

10. Click OK.

11. Right-click in the Detail area.

12. Select Insert Detail Report.

13. Click Year_Level.

14. Expand the Year_Level node.

15. Drag and drop the Year field under the Levels - Year_Level node into the DetailReport - Year_Level area.

16. Configure the text by using the Font menu in the ribbon bar.
For example, set it to Open Sans,16px, Bold, Centered.

17. Center the [Year] cell between the left and right margins using either:
l the Location control under Layout in the Property Grid or;
l the Center Horizontally control in the Layout group of the toolbar.

Add two QlikView objects as images
Do the following:

1. Right-click the Images node, and select Add objects.

2. Select the Connection to the QlikView document that contains the object you want.

3. Type the number 1 in the Search field and both Top 25 Products - CH184 and Top 10 Salesmen - CH192
are visible.

4. Select Top 25 Products - CH184 and CH319 - Top 5 Salesman from the QlikView object list by holding
down the Ctrl key.

5. Click OK to add them to the Images node.

6. Select the bottom dotted line of the DetailReport - Year_Level area, and then move it down to obtain a
more ample workspace.

7. Drag the CH184 node token into the template, and then drop it flush with the left margin.

8. Open the drop-down list for the Sizing attribute under Behavior in the Property Grid, and then select
Auto-Size.
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9. Drag CH192 from the Images node and drop it under CH184, flush with the left margin.

10. Once again, select Auto-Size from the drop-down list.

11. Drag the Page Break object from the Tool Box, which is typically docked on the right side of the
Template Editor, and then drop it onto the bottom of the page.

Preview and save
Do the following:

1. Click Preview.

2. Check the report, close it, and then edit the template again if necessary.

3. Click Save and Close to save the template and close the Template Editor.

10.7 Adding totals and subtotals to PixelPerfect reports
You can add totals to columns in a PixelPerfect report with at least one table. If the report has
nested levels, you can add subtotals for some levels.

Create new PixelPerfect report
Do the following:

1. Select Reports in the Qlik NPrinting main menu, and then click Create report.

2. Enter a Title for the report. Report with Totals and SubTotals on levels.

3. Select PixelPerfect from the Type drop-down list.

4. Select an app from the App drop-down list.

5. Click Create to create the report.

6. Click Edit template to open the Template Editor.

Add levels to template
Do the following: Right-click the Levels node, and select Add levels.

Select object for level
Do the following:

1. Select the Connection to the QlikView document that contains the object you want.

2. Select CategoryName from the objects list.

3. Click OK.

Begin nesting levels
Do the following:
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1. Right-click the CategoryName_Level node, and then select Add levels.

Select object for sublevel
Do the following:

1. Select the Connection to the QlikView document that contains the object you want.

2. Select the CH184 - Top 10 Products chart.

3. Click OK.

Begin creating levels in templates
Do the following:

1. Right-click in the Detail area.

2. Select Insert Detail Report.

3. Select “CategoryName_Level”.

Embed field in Detail1 band
Do the following:

l Click and drag the CategoryName node token from the Levels hierarchy, and drop it into the
Detail1 open template area.

Format category heading
Do the following:

1. Drag the label left and right borders to cover the entire width of the range from margin to margin.

2. Set the font to Arial, 16pt, Bold, Centered, or format it as is appropriate for a category heading.

Create the CH184 sublevel
Do the following:

1. Right-click on the DetailReport - "CategoryName_Level" bar.

2. Select Insert Detail Report.

3. Select “CH184_Level”.
The DetailReport1 - CategoryName_Level.CH184_Level” bar appears.

Add group header
Do the following:

1. Right-click on the DetailReport - “CategoryName_Level.CH184_Level” bar.

2. Select Insert Band.

3. Select GroupHeader.
The GroupHeader1 bar appears.
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Add group footer
Do the following:

1. Right-click on the DetailReport - “CategoryName_Level.CH184_Level” bar.

2. Select Insert Band.

3. Select GroupFooter.
The GroupFooter1 bar appears.

Embed headings in template
Do the following:

1. Expand the CH184_Level.

2. Press the Ctrl or Shift key and select the following fields in the following order specified: ProductName,
Total Sales, Gross Profit and GP%.

3. Release the Ctrl or the Shift key.

4. Right-click the selected fields, then drag and drop them into the GroupHeader1 range so that the upper
border of the fields is aligned with the lower border of the GroupHeader1 bar.

Qlik NPrinting automatically creates a table with the column names in the selected order.

Format heading text and boarders
Do the following:

1. Select the entire header table in GroupHeader1.

2. Format the text Arial, 16px, Bold, Centered, or as appropriate.

3. Select the Borders option in Property Grid in the lower left pane.

4. Open the drop-down list by clicking on the down-pointing triangle at the right of the field.

5. Click on All to render all cell borders visible.

6. To eliminate the white space between the headings and the data in the final report, drag the Detail2 bar
upper border until it reaches with the lower border of the GroupHeader1 border.

Embed data in template
Do the following:

1. Press the Ctrl key and select the following fields from “CH184_Level” in the following order:
ProductName, Total Sales, Gross Profit and GP%.

2. Release the Ctrl key.

3. Left click and drag the collection of highlighted data fields and drop them into the Detail2 range so that
the upper border of the fields are aligned with the lower border of the Detail2 bar.

Qlik NPrinting automatically creates a table with the tags for the columns of data in the order that they
are selected.
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Format data in template
Do the following:

1. Select the entire row of data field tags.

2. Format them to Arial and 12pt.

Render borders visible and eliminate white space
Do the following:

1. Select the Borders option in Property Grid in the lower left pane.

2. Open the drop-down list by clicking on the down-pointing triangle at the right of the field.

3. Click on All to render all cell borders visible.

4. Deselect the top border.

5. To eliminate the white space between the footer and the data in the final report, drag the GroupFooter1
bar upper border until it reaches the lower border of the Detail2 range border.

Open table cell tasks and Format string editor
Do the following:

1. Select the CH184_Level.Total Sales cell by clicking on it.

2. Click on the small arrow above the upper right corner of the cell.

3. Click on the browse button at the far right of the Format String field.

Format CH184_Level.Total Sales and CH184_Level.Gross Profit cell
Do the following:

1. Select Currency.

2. Select Custom.

3. Enter $ 0.
You can use one of the preset formats or create a custom one.

4. Click OK.

5. Right-justify the text.

6. Repeat steps 1-5 for the CH184_Level.Gross Profit cell.

Format CH184_Level.GP% cell
Do the following:

1. Select the CH184_Level.GP% cell.

2. Open the Format string editor.

3. Select Percent.

4. Click on 0.00%.
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5. Click OK.

6. Right-justify the text.

Start creating subtotals
Do the following:

1. Press the Ctrl key and select the following fields from “CH184_Level” in the following order: Total Sales
and Gross Profit.

2. Release the Ctrl key.
Both fields in the level are selected.

3. Drag the collection of highlighted data field node tokens into the GroupFooter1 range so that the upper
border of the fields are aligned with the lower border of the GroupFooter1 bar.

Adapt cells
Do the following:

l Drag the left border of the CH184_Level.Total Sales cell and the right border of the CH184_Level.Gross
Profit cell in GroupFooter1 until they line up with those of the corresponding cells in Detail2.

Open summary editor for CH184_Level.Total Sales cell
Do the following:

1. Select the CH184_Level.Total Sales cell in GroupFooter1.

2. Click on the small arrow above the upper right corner of the cell.

3. Click on the browse button at the far right of the Summary field.

Set summary running and open Format string editor
Do the following:

If necessary, open the Summary function drop-down list, and then click on Sum.

With this menu, you can set the summary function from the available list.

1. Set the Summary Running radio button to Group.
This sets the level for which the summary function is calculated.

2. Click on the browse button at the far right of the Format string field.

Format cell content and close
Do the following:

1. Select Currency.

2. Select the Custom tab.

3. Choose the $0 format.

4. ClickOK.
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5. Click OK again.
Note that the cell content has become Sum([CH184_Level.Total Sales]).

6. Repeat steps from step 1 of Open summary editor for CH184_Level.Total Sales cell to the previous step for
the CH184_Level.Gross Profit cell.

Format subtotal cell content
Do the following:

1. Select the two subtotal cells by drawing a rectangle that includes both while holding the left mouse
button down.

2. Format the text as Arial, 12px, Bold, Right justified.

Render subtotal cell borders visible and eliminate white spaces
Do the following:

1. Select the Borders option in Property Grid in the lower left pane.

2. Open the drop-down list by clicking on the down-pointing triangle at the extreme right of the field.

3. Click on All to render all cell borders visible.

4. Deselect the top border.

5. To eliminate the white space below the footer in the final report, drag the GroupFooter1 range lower
border till it coincides with the lower border of the subtotal cell lower border.

Begin creating reports totals
Do the following:

1. Right click on the DetailReport - "CategoryName_Level" bar.

2. Select Insert Band.

3. Select ReportFooter.

The ReportFooter1 bar appears.

Copy and paste subtotal cells
Do the following:

1. Select both sum cells in GroupFooter1, and then copy the cells by pressing Ctrl+C.

2. Paste the cells into ReportFooter by selecting the ReportFooter range, and then pressing Ctrl+V.

Open summary editor
Do the following:

1. Select the Sum([CH184_Level.Total Sales]) cell in ReportFooter.

2. Click on the small arrow above the upper right corner of the cell.

3. Click on the browse button at the far right of the Summary field.
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Set summary running and open Format string editor
Do the following:

1. Set the Summary Running radio button to Report.

2. Click on the browse button at the far right of the Format string field.

Format cell data content
Do the following:

1. Select Currency.

2. Select the Custom tab.

3. Choose the $0 format.

4. Click OK.

Close summary editor
Do the following:

1. Click OK.

2. Repeat the process from Open summary editor for the Sum([CH184_Level.Total Sales]) cell in
ReportFooter.

Format report total cell contents
Do the following:

1. Format the text as Arial, 14px, Bold,Right justified.

2. Select the Borders option in Property Grid in the lower left pane.

3. Open the drop-down list by clicking on the down-pointing triangle at the extreme right of the field.

4. Click All to render all cell borders visible.

5. To eliminate the white space at the bottom of the report, drag the ReportFooter range lower border up to
coincide with the Report Total cell lower border.

Preview and save
Do the following:

1. Click Preview.

2. Check the report, close it, and then edit the template again if necessary.

3. Click Save and Close to save the template and close the Template Editor.
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10.8 Creating a calculated column in a PixelPerfect report
You can create a calculated column in a PixelPerfect report by creating a formula that uses data from available
fields. Note that formulas are calculated during report generation. If this takes too long, we recommend moving
the value calculations into the QlikView script.

Create new PixelPerfect report
Do the following:

1. Select Reports in the Qlik NPrinting main menu, and then click Create report.

2. Enter a Title for the report. PixelPerfect report with a calculated column.

3. Select PixelPerfect from the Type drop-down list.

4. Select an app from the App drop-down list.

5. Click Create to create the report.

6. Click Edit template to open the Template Editor.

7. Right-click the Levels node, and select Add levels.

8. Select the Connection to the QlikView document that contains the object you want.

9. Select CH184.

Add calculated field
In this example, you will create the cost column by calculating the difference between total sales and gross profit.
You can use the formula editor to create more complex formulas.

Do the following:

1. Right-click the CH184_Level, and then select Add Calculated Field from the drop-down list.

2. Enter Cost as the name in the Property Grid.

3. Click the browse button at the extreme right of the Expression field.
The Expressioneditor appears.

Enter the expression
Do the following:

1. Click Fields in the left column.
The list of available fields appears in the center column.

2. Double-click Total Sales to insert it into the expression.

3. Click on the - symbol, or type it.

4. Double-click Gross Profit to insert it into the expression.

5. The final expression is [Total Sales] - [Gross Profit]

6. Click OK.
The calculated column, Cost, appears at the top of CH184_Level list of fields.
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Create a table with CH184_Level
Do the following:

1. Right-click the Detail bar.

2. Select Insert Detail Report.

3. Select CH184_Level.
The result is the DetailReport1 - CH184_Level bar.

Create table cells
Do the following:

1. Press the Ctrl key and select the following fields in order:
l ProductName
l Total Sales
l Gross Profit
l Cost

2. Left-click the selection

3. Drag and drop the selection into the DetailReport - CH184_Level - Detail1 band.

4. Drag and drop the lower dashed line upward to the Detail1 bar, to eliminate the white space.

Format the CH184_Level cell
After clicking the desired cell, do the following:

1. Click the smart tag, which is the small arrow above the upper right corner of the cell.

2. Click the browse button at the extreme right of the Format String field.

3. Select Currency.

4. Click $0.00 from the list.

5. Click OK.

Preview and save
Do the following:

1. Click Preview.

2. Check the report, close it, and then edit the template again if necessary.

3. Click Save and Close to save the template and close the Template Editor.

10.9 Adding tables of contents to PixelPerfect reports
In PixelPerfect reports, you can add a table of contents that is linked and automatically updated. A
table of contents can also be added to existing PixelPerfect reports. You should create a report as
described in Adding totals and subtotals to PixelPerfect reports (page 440) before performing the
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procedures on this page.

Create new PixelPerfect report with two levels
You can create a new PixelPerfect report with Year and CategoryName levels by repeating the process explained
in Adding totals and subtotals to PixelPerfect reports (page 440). Level values will be rows of table of contents.

Do the following:

1. Select Reports in the Qlik NPrinting main menu, and then click Create report.

2. Enter a Title for the report. PixelPerfectReport with Table of Contents.

3. Select PixelPerfect from the Type drop-down list.

4. Select an app from the App drop-down list.

5. Click Create to create the report.

6. Click Edit template to open the Template Editor.

7. Right-click the Levels node, and select Add levels.

8. Select the Connection to the QlikView document that contains the object you want.

9. Select Year from the objects list.

10. Right-click Year_Level, click Add levels, and then select the CategoryName field.

11. Right-click CategoryName_Level, click Add levels, and then select the CH184 chart.

12. Right-click the Detail band, select Insert Detail Report, and then click Year_Level.

13. Drag and drop the Year field from the Levels node to the Detail1 band.

14. Format the cell as you prefer.

15. Right-click the Detail1 band, select Insert Detail Report, and then click CategoryName_Level.

16. Drag and drop the CategoryName field from the Levels node to the Detail2 band.

17. Format the cell as you prefer.

18. Right-click the Detail2 band, select Insert Detail Report, and then click CH184_Level.

19. If necessary, expand all Levels node details, and then select the CH184 columns, and then drag and drop
them in the Detail3 band.
Format created cells as you prefer, and then remove the white space under the cells.

20. Select the CH184 columns by keeping Shift pressed, and then do a right-click and drag and drop the
columns on the bottom of band Detail 2. This creates table headers.

21. Format the created cells as you prefer.

22. Right-click the Detail3 band, select Insert Band, and then click on GroupFooter.

23. Add Total Sales and Gross Profit totals to the GroupFooter1 band as explained in Adding totals and
subtotals to PixelPerfect reports (page 440).

24. Click Save to save the template.

Create primary and secondary bookmarks
The first task is to set the headings as bookmarks. Year will be the primary bookmark and Category Name will be
the secondary bookmark.

Do the following:

Qlik NPrinting - February 2024 449

10   PixelPerfect reports



1. Select the Year heading in the Detail1 range.

2. Find the Data group in the Property Grid in the left lower pane.

3. Expand the (Data Bindings) and Bookmark nodes.

4. Select the Binding node.

5. Open the Binding drop-down list by clicking on the down pointing triangle at the extreme right of the
Binding field.

6. Expand the Levels and Year_Level nodes.

7. Select the Year node by clicking on it.
This procedure creates a top level bookmark.

8. Select [CategoryName_Level.CategoryName] in Detail2.

9. Repeat step 1-8, adding the expansion of the CategoryName_Level node and clicking the CategoryName
node instead.

Begin defining bookmark hierarchy
This procedure defines this level as a child of Detail1. The table of contents will be indented at this level.

Do the following:

1. Scroll down the Property Grid until you reach the Navigation group.

2. Select Parent Bookmark.

3. Open the Parent Bookmark menu by clicking on the triangle pointing downwards at the far right of the
Parent Bookmark field.

4. Expand the DetailReport and Detail1 nodes.

5. Select the Label1 node by clicking on it.
The Year cell in the template will be highlighted.

Create ReportHeader bar
The table of contents must be in the ReportHeader.

Do the following:

1. Right-click the Detail bar.

2. Select Insert Band.

3. Click on ReportHeader.
This creates the ReportHeader bar and range.

Insert the table of contents into the Report header
Do the following:

1. Drag the Table of Contents icon from the ToolBox on the right into the template, and then drop it into
the ReportHeader range.
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Customize table of contents fonts
Do the following:

1. Widen the Property Grid on the left side of the window.

2. Go to the Behavior group.

3. Expand the Level Default node.

4. Click on the browse button at the far right of the Font field.

5. Set the Font to Arial, Regular, and 11pt, and then click on the OK button.
This sets the font for the rows in the table of contents.

6. Expand the Level Title node.
This sets the font for the table of contents title.

7. Set the Font to Arial, Bold and 12pt, then click on the OK button.

Customize table of contents title
Do the following:

1. In the Behavior section of the Property Grid, expand the Level Title node.

2. Enter Table of Contents in the Text form.

Preview and save
Do the following:

1. Click Preview.

2. Check the report, close it, and then edit the template again if necessary.

3. Click Save and Close to save the template and close the Template Editor.

See also:

p Adding totals and subtotals to PixelPerfect reports (page 440)

10.10 Creating PixelPerfect charts
You can create native PixelPerfect charts filled with QlikView or Qlik Sense data. In this example, the data source
is a QlikView table. It is not necessary that the chart exist in the original .qvw file.

Create new template
Do the following:

1. Select Reports in the Qlik NPrinting main menu, and then click Create report.

2. Enter a Title for the report. Top 10 Countries Sales.

3. Select PixelPerfect from the Type drop-down list.

4. Select an app from the App drop-down list.
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5. Click Create to create the report.

6. Click Edit template to open the Template Editor.

7. Click the triangle in the corner between the two rulers.

8. Open the drop-down list of the Measure Units field.

9. Select Pixels from the menu.

10. To increase the area of the report reserved for the chart, click the bottom margin dotted line and drag it to
the 550 pixel mark.

11. Read the height on the vertical ruler.

Add QlikView object
Do the following:

1. Right-click the Tables node, and select Add objects.

2. Select the Connection to the QlikView document that contains the object you want.

3. Enter 32 in the Select Tables search field.

4. Select the Top 10 Countries Sales in chart from the SalesDemo connection.

5. Click OK.

Embed new chart
Do the following:

1. Select the Chart object from the Tool box, and then drag and drop it into the Detail area.
The chart wizard will open.

2. Leave the Bar type chart selected .

3. Click the Next button at the bottom of the wizard.

4. Click the Next button again to reach the Series window.

5. Select Series 2.

6. Click the Remove button at the bottom of the Series pane.
Series 1 will be selected automatically.

7. Enter Sales as in the Series name field.

8. Click Next at the bottom of the wizard.

9. Select the Series Binding tab.

10. Open the Argument drop-down list in the Argument Properties area.

11. Expand the CH320 node, and then double-click the Country field to select it.

12. Open the Value drop-down list in the Value Properties area .

13. Double-click the Sales field.

14. Click Next.

15. Click Point Labels in the Presentation area at the left.

16. Remove the Visible flag.
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17. Click Finish in the bottom right corner.

18. Drag the bottom right corner of the chart to fill all the available space.

Preview and save
Do the following:

1. Click Preview.

2. Check the report, close it, and then edit the template again if necessary.

3. Click Save and Close to save the template and close the Template Editor.

10.11 Creating a well-formatted PixelPerfect chart
You can create PixelPerfect charts based on QlikView or Qlik Sense data. You can also create a PixelPerfect chart
if the chart does not exist in the source document. In this example, QlikView objects are used to show how to
work with advanced graphic attributes.

Create a new PixelPerfect report
Do the following:

1. Select Reports in the Qlik NPrinting main menu, and then click Create report.

2. Enter a Title for the report. Top 10 Countries Sales.

3. Select PixelPerfect from the Type drop-down list.

4. Select an app from the App drop-down list.

5. Click Create to create the report.

6. Click Edit template to open the Template Editor.

7. Open the Report Tasks window by clicking on the triangle at the corner between the two rulers.

8. In the Measure Units drop-down list, select Pixels.

Configure workspace format
Do the following:

1. Go to the Property Grid, which is typically docked at the lower left of the work area.

2. Navigate to the Page Settings group of attribute controls.

3. Change the Paper Kind to the size that you normally use.

4. Set Margins as appropriate.

5. Click the bottom margin dotted line and drag it to the 350 pixel mark.

Add object to template as table
Data sources for PixelPerfect charts are QlikView tables added to the tables node of the template editor.

Do the following:
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1. Right-click the Tables node, and select Add objects.

2. Select CH186 from the objects list.

3. Click OK.

Embed chart object
Do the following:

1. Drag the Chart object from the Tool Box into the template and drop it into the upper left corner of the
Detail range, aligned with the left margin and the bottom border of the Detail bar.
The chart wizard opens to the Chart Type page.

2. Select Bar for the Chart Type, and then click Next >> at the bottom of the window.
The Appearance window appears.

3. Open the Palette drop-down list, and then select a color palette.
To create your own palette, select Edit palettes

4. Click Next to open the Series window.

Create and configure series
Do the following:

1. In the Series window, select Series 2.

2. Click Remove at the bottom of the Series pane.

3. Enter Sales for the Series name for Series 1.

4. Click the Series Options tab.

5. Set Point sort order to Ascending.

6. Set Sort points by to Value.
You can also list points by category names in alphabetical order by setting Sort points by to Argument.

This creates a simple chart displaying one series sorted by value of sales in ascending order.

Configure legend points
You can customize the formats of the legends.

Do the following:

1. Click the Legend Point Options tab.

2. Deselect Synchronize with point options.

3. Open the Point view drop-down list, and then select Argument and Values.

4. Set Value format to Currency.

5. Set Value precision to 0.
This sets the number of significant digits to the right of the decimal point to none.

6. Click Next to open the Data window appears.
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Bind argument and value
Do the following:

1. In the Dataa window, click the Series Binding tab.

2. Open the Argument drop-down list in the Argument Properties box.

3. Expand the CH186 node.

4. Double-click the CategoryName node.

5. Open the Value field drop-down list under Value Properties.

6. Double-click the Sales node under the CH186 node.

7. Click Next to open the Chart window.

8. Click Next again to accept the default Chart settings, and to open the Diagram window.

Inspect pages
Do the following:

1. The Diagram window allows you to set options related to the diagram. For example, rotate the diagram
by checking Rotate.

2. Click Next to accept the default Diagram settings, and to open the Panes window.

3. Click Next to accept the default Panes settings, and to open the Axes window.

Label X axis
Do the following:

1. In the Axes window, click the Elements tab.

2. Select the Visible check box.
Antialiasing will also be activated automatically.

3. Enter Category in the text field.
It appears on the vertical axis because the diagram has been rotated.

Label Y axis
Do the following:

1. Change from Primary AxisX to Primary AxisY in the drop-down list at the top.

2. Make sure the Elements tab on the right is still selected.

3. Select the Visible check box.
Antialiasing will also be activated automatically.

4. Enter Sales in the text field.
It appears on the horizontal axis because the diagram has been rotated.

Format label content
Do the following:
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1. Select the Labels tab on the right.

2. Select the Auto tab.

3. Set Format to Currency.

4. Set Precision to 0.

5. Click Next >>
The Series Views window opens.

Set bar color
The Series Views window lets you customize some visualization options.

Do the following:

1. Click the Appearance tab.

2. Select pure, saturated blue (0, 0, 255) from the Color drop-down list.

3. Click Next to open the Point Labels window.

Antialias point labels
The Point Labels window lets you customize the labels of points in a chart.

Do the following:

1. In the Point Labels window, customize point display.

2. Put a check mark in the Antialiasing box under Text Settings on the General tab.

Configure point label content
Do the following:

1. Click the Point Options tab.

2. Leave Point view set to Values.

3. Select Currency for Value format.

4. Set Value precision to 0.

5. Click Next to open the Chart Titles window.

Add chart title
Do the following:

1. In the Chart Titles window, click Add to create a new title.

2. Enter Sales by Category as the heading.

3. Click Next to open the Legend window.

Configure chart legend
Do the following:
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1. Configure a chart legend in the Legend window. You can set whether or not a legend is displayed, and
how the legend is displayed. A legend is not necessary for a simple chart, so ensure that there is no check
mark in the Visible box.

2. Click the Next button to open the Annotations window. No annotations are added.

3. Click Finish button to close the chart wizard.

4. Drag the bottom right corner of the chart to fill all the available space.

Preview and save
Do the following:

1. Click Preview.

2. Check the report, close it, and then edit the template again if necessary.

3. Click Save and Close to save the template and close the Template Editor.

See also:

p Create PixelPerfect charts

10.12 Creating a PixelPerfect chart with two different scales for
the Y axis

You can use the rich options of PixelPerfect to create complex charts that do not exist in the original documents.
For example, you can display two measures with different units on the Y axis on the same chart. In this example,
QlikView objects are used to show how to create a chart to display category sales as a currency on the left scale,
and as a quantity on the right scale.

Create a new PixelPerfect template and add a chart data source
Do the following:

1. Select Reports in the Qlik NPrinting main menu, and then click Create report.

2. Enter a Title for the report. PixelPerfect Two Scales Chart.

3. Select PixelPerfect from the Type drop-down list.

4. Select an app from the App drop-down list.

5. Click Create to create the report.

6. Click Edit template to open the Template Editor.

7. Right-click the Tables node, and select Add objects.

8. Select the Connection to the QlikView document that contains the object you want.

9. Select CH184 from the objects list.

Create a new chart
Do the following:
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1. Drag and drop a Chart object from the Tool Box into the Detail area template.
The Chart Wizard opens.

2. Select the Bar chart, and then click Next.

3. In the Appearance window, click Next.

4. Change the name of Series 1 to Gross Profit $ by entering it in the Series name box.

5. Set Point sort order as Descending, and then set Sort points by to Value.

6. Change the name of Series 2 to Gross Profit % by entering it in the Series name box.

7. Click Next to open the Data window.

Bind data source
Do the following:

1. In the Data window, click the Series Binding tab.

2. Select the Gross Profit $ series.

3. On the Argument drop-down list, expand the CH184 node, and then select the ProductName column.

4. On the Value drop-down list, select the Gross Profit column.

5. Select the Gross Profit % series.

6. On the Argument drop-down list, select the ProductName column.

7. On the Value drop-down list, select the GP% column.

8. Click Next to open the Chart window.

9. Click Next again to accept the default Chart settings, and to open the Diagram window.

Create a secondary Y-axis
Do the following:

1. In the Diagram window, click the Elements tab.

2. Click Add in the Secondary Y-Axis area.
The Secondary AxisY 1 pane appears.

3. Click Next.

4. Click Next again to accept the default Panes settings, and to open the Axes window.

Set the primary X-axis options
Do the following:

1. In the Axes window, click the Elements tab.

2. Select Primary AxisX from the drop-down list.

3. Enter Product Name into the Text box.

4. Select the Visibility check box.

5. Select the Antialiasing check box.
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Set the primary Y-axis
Do the following:

1. Select Primary AxisY from the drop-down list.

2. Click the Elements tab.

3. Enter Gross Profit $ in the Text box.

4. Select the Visibility check box

5. Select the Antialiasing check box

Set the primary Y-axis number format
Do the following:

1. Click the Labels tab.

2. Select the Auto tab.

3. Select Currency from the Format drop-down list.

4. Set the Precision to 0.

Set the secondary Axis-Y 1 option
Do the following:

1. Select Secondary AxisY 1 from the drop-down list.

2. Click the Elements tab.

3. Enter Gross Profit % in the Text box.

4. Select the Visible check box.

5. Select the Antialiasing check box.

Set the secondary Axis-Y 1 number format
Do the following:

1. Click the Labels tab.

2. Click the Auto tab.

3. Select Percent from the Format drop-down list.

4. Set the Precision to 1.

5. Click Next to open the Series Views window.

Connect Total Sales series with primary Axis-Y
Do the following:

l In the Series Views window, leave the default Linked Elements for the Gross Profit $ series.
This will connect the Gross Profit $ series with Primary AxisY.
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Connect Quantity series with secondary Axis-Y 1
Do the following:

1. Select the Gross Profit % series from the drop-down list.

2. Select Secondary AxisY 1 from Axis Y drop-down list in Linked Elements.
This will connect the Gross Profit % series to the Secondary AxisY 1.

3. Click Next to open the Point Labels window.

Remove the point labels (values)
Do the following:

1. In the Point Labels window, clear the Visible check box for Gross Profit $.
This will remove the Point Labels (the values you see on the bars).

2. From the top drop-down list, select Gross Profit %.

3. Clear the Visible check box again.

4. Click Finish to close the chart wizard.

Preview and save
Do the following:

1. Click Preview.

2. Check the report, close it, and then edit the template again if necessary.

3. Click Save and Close to save the template and close the Template Editor.

See also:

p How to create PixelPerfect charts
p How to create a well formatted PixelPerfect chart
p How to create a simple PixelPerfect report

10.13 Using sparklines in PixelPerfect reports
You can create a PixelPerfect report with sparklines. A sparkline is a very small line chart, usually drawn with
neither axes nor coordinates. It presents the movement of some measurement, typically with respect to time.

Following this example, you will create a table displaying a row for each salesman, presenting the salesman's
total sales and a sparkline for monthly sales. A level for Salesman and his total sales will be added to create a
table in the report. The sparkline object will be embedded in the level details range, and will take data from a
QlikView table for sales by YearMonth.

Create a new PixelPerfect report in the report editor
Do the following:
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1. Select Reports in the Qlik NPrinting main menu, and then click Create report.

2. Enter a Title for the report. PixelPerfect Report Displaying Sparklines

3. Select PixelPerfect from the Type drop-down list.

4. Select an app from the App drop-down list.

5. Click Create to create the report.

6. Click Edit template to open the Template Editor.

Open select levels window
First, create a Salesman level.

Do the following:

1. Right-click the Levels node, and select Add levels.

2. Select the Connection to the QlikView document that contains the object you want.

3. Select Total Salesman Sales - CH327 from the objects list.

4. Click OK.

Add sparklines data source as table
Next, add the data source for the sparklines.

Do the following:

1. Right-click the Tables node, and select Add objects.

Select object as table
Do the following:

1. Select the Connection to the QlikView document that contains the object you want.

2. Select Sales by YearMonthNum - CH326.

3. Click OK.

Create detail level in template
Do the following:

1. Right-click on the Detail drop-down list in the Detail bar, and then select Insert Detail Report.

2. Select CH327_Level.

Create table header bar and range
Do the following:

1. Right-click the Detail Report - "CH327_Level" drop-down list, and then select Insert Band.

2. Click GroupHeader.
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Create table row
Do the following:

1. Expand the CH327_Level node.

2. Select the Salesman and Total Sales fields, and then drag and drop them into the Detail1 range.

3. Drag the right border of the selected block of cells to the left to leave space for a sparkline cell.

Render cell borders visible
Do the following:

1. Select the Borders attribute under Appearance in the Property Grid.

2. Open the drop-down list and clicking on the drop-down button, and then select All.

3. Click the drop-down button again to accept the change.

Open FormatString window
Do the following:

1. Select the [CH327_Level.Total Sales] cell.

2. Click the angle bracket > above the upper right corner of the cell.

3. Click the browse button at the extreme right of Format String field.

Format total sales column
Do the following:

1. Select Currency, under Category.

2. Select the Custom tab.

3. Enter $ #,##0.

4. Click OK.

Embed sparkline element
You can create a sparkline in your template by using the sparkline tool. In the Property Grid, you can customize
the appearance of the sparkline.

Do the following:

1. Select the Sparkline object from the Tool Box, which is generally docked on the right but can be floated
and positioned for convenience.

2. Drag it into the Detail range and drop it to the right of the previously embedded cells.

3. Drag the right border of the Sparkline cell to the right margin.

4. Click the angle bracket > above the upper right corner of the Sparkline cell to open the Sparkline Tasks
window.

5. Open the Data Member drop-down list, and then select CH326.
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6. Open the Value Member drop-down list, and then select Sales1 under CH326.

7. Leave View set to Line.

8. To close the Sparkline Tasks pop-up window, click again on the angle bracket < above the upper right
corner of the Sparkline cell.

Render bottom and right borders visible
Do the following:

1. Make sure the Sparkline cell is still selected.

2. Select the Borders attribute under Appearance in the Property Grid.

3. Open the drop-down list by clicking on the down-pointing triangle at the far right of the Borders field.

4. Select the Bottom and Right borders and click the drop-down button (as shown in the previous step) to
accept the changes.

Configure view
Do the following:

1. Expand the View group list of attributes in the Appearance section.

2. Set Highlight Max Point to Yes.

3. Set Highlight Min Point to Yes.

4. Set Max Point Color to Green (0, 192, 0), or the color of your choice.

5. Set Min Point Color to Red (192, 0, 0), or the color of your choice.

Create table header
Do the following:

1. Drag the Table object from the Tool Box and drop it into GroupHeader1 range.

2. Set the font to Arial, 12px, Bold, Centered.

3. Drag the cell right borders so that they line up with those in the Detail1 range.

4. Add All cell borders using the Borders property (as described earlier in this section).

5. Enter the following column headings: Salesman, Total Sales, Monthly Sales Chart.

6. Drag the lower borders of the GroupHeader1 and Detail1 ranges up to coincide with the lower border of
the Heading and Data cells, respectively, to eliminate white space in the final report.

Preview and save
Do the following:

1. Click Preview.

2. Check the report, close it, and then edit the template again if necessary.

3. Click Save and Close to save the template and close the Template Editor.
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10.14 Managing PixelPerfect conditional output using formatting
rules

You can use formatting rules to conditionally change the format of objects in a PixelPerfect report. For example,
you can create a report that shows a chart only for each country where the sales are more than a selected
threshold. You can also highlight cells in a table that match specific conditions.

When using formatting rules, you set criteria by using a formula, and then create a related format. The format
that you specified is applied when the formula is true. A rule can be associated with many different objects on the
same report, and you can also associate many rules to the same report object.

We recommend using the built-in formula editor to avoid errors when creating the criteria formulas.

Create a new filter
First create a new filter before creating the report. Filters must be created before they can be applied to a report.

Do the following:

1. Click Filters under the Apps menu.

2. Click Create filter to create a new filter.

3. Enter a name for the filter.

4. Select an app from the App drop-down list.

5. Click Create to create the filter.

6. Click Fields.

7. Click Add field.

8. Select the Connection to the QlikView document that contains the object you want.

9. Select Salesman from the Name drop-down list.

10. Select Value is from the drop-down list in the Values pane.

11. Select an existing user in the right box.
To learn how to create users, see: Creating users (page 240).

12. Click Create to confirm.

Create new PixelPerfect report
Do the following:

1. Select Reports in the Qlik NPrinting main menu, and then click Create report.

2. Enter a Title for the report. PixelPerfect Report Conditional Table Display.

3. Select PixelPerfect from the Type drop-down list.

4. Select an app from the App drop-down list.

5. Click Create to create the report.

Apply the filter
Do the following:
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1. In the report window, click Filters.

2. Move the filter you created earlier from Available Items to Selected Items.

3. Click Add Filters.

4. Click Overview to return to report overview window.

Create a new PixelPerfect report template
Do the following:

1. Click Edit template to open the Template Editor.

2. Right-click the Levels node, and select Add levels.

Insert a QlikView table as a level
Do the following:

1. Select the Connection to the QlikView document that contains the object you want.

2. Select Sales by Country - CH304 from the objects list.

3. Click OK.

Change the visible property in the details band
Do the following:

1. Create a new table, as you would normally in a PixelPerfect report, based on CH304.

2. Select DetailReport - "CH304_Level".

3. Change the Visible property from Yes to No.

The detail band will not normally be visible. The formatting rule will make the band visible only for countries with
sales over the selected threshold.

Create new rule and apply it to the table
This form shows all the available rules in a report.

Do the following:

1. Click the smart tag arrow > of the Detail1 band.

2. Click the three dots on the right of Formatting Rules.
The Formatting Rules Editor window appears.

3. Click Edit Rule Sheet to open the Formatting Rule Sheet Editor.

4. Click the + button to add a new rule.

5. Select CH304_Level from the Data Member drop-down list.

6. Click the Condition form, and then open the Conditional Editor by clicking on the dots that appear on
the right.
In the bottom left column, you can see the list of categories of objects that you can use to create the
condition
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7. Click on Fields to see the list of fields available in the Data Member.

8. Double-click Sales to add it to the condition.

9. Click on the > symbol to add it.

10. Type 30000, so the final formula will be [Sales] > 30000.
Only charts related to countries with sales over 30000 will be displayed.

11. You can also insert [Sales] > 30000 by typing it in the Condition property.

12. Set the Visible property to Yes from the drop-down list.
The objects with the condition applied will be made visible when the condition is true.

13. Click OK to confirm the condition.

14. Enter ShowSalesOverThreshold as the Name.
Use a meaningful name for when you need to maintain the report template. Spaces are not allowed.

15. Click Close.

Apply the formatting rule to the report object
Do the following:

1. Click on ShowSalesOverThreshold in the Rules available in a report column to select it.

2. Move the rule to the Rules applied to a control column by clicking on the > arrow.
Only formatting rules added to this column will be applied to the control.

3. Click OK.

Add the chart as an image
Do the following:

1. Add the Sales by Categories - CH212 to the Images node.

2. Increase the height of the Detail1 band by selecting the bottom border line and dragging it down.

3. Drag and drop the CH212 into the Detail1 band, and then enlarge its dimensions by selecting and
dragging the bottom right corner.

4. Click the smart tag arrow > to open the Picture Box Tasks.

5. Select Squeeze from the Sizing drop-down list to fill the available space with the chart image.

6. Close the Picture Box Tasks window by clicking on the template area.

Preview and save
Do the following:

1. Click Preview.

2. Check the report, close it, and then edit the template again if necessary.

3. Click Save and Close to save the template and close the Template Editor.
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10 QlikEntity reports
You can create reports based on QlikView and Qlik Sense chart objects. You can also export specific
objects as images to .csv files.

You can use existing entities like reports, tables, or charts and distribute them as .pdfs or images.

10.15 Creating QlikEntity reports
You can distribute visualizations from QlikView and Qlik Sense as .pdf or image files.

You can add filters to QlikEntity reports. Because they are .pdf or image files, you cannot edit or preview an entity
report in Qlik NPrinting Designer.

Output formats
The available outputs depend on your reports and objects:

l QlikView reports: .pdf or .tiff.
l QlikView objects (such as charts, sheets, or text boxes): .bmp, .gif, .jpeg, .csv, .skv, .tab, and .png.

If objects are printable in QlikView, they can also be exported as: .pdf or .tiff.
l Qlik Sense objects: .bmp, .gif, .jpeg, .csv, .skv, .tab, and .png.

See: Report output formats (page 469) and Working with Qlik objects (page 292).

Creating a new QlikEntity report
Do the following:

1. Select Reports in the Qlik NPrinting main menu, and then click Create report.

2. Enter a Title for the report.

3. Select QlikEntity from the Type drop-down list.
Related fields appear.

4. Select an app from the App drop-down list.

5. Select a Connection.

6. Open the Qlik object id drop-down list, and then select an object.

7. Leave the Enable check box selected.
If you clear the check box, the report will be ignored by the Qlik NPrinting scheduler service.

8. The following selections are optional:
l Enable On-Demand and API report generation: allows your report to be created using On-

Demand. See: On-Demand reports (page 490)
l Enable cycle: allows your report to be cycled. See: Cycling your reports (page 324)
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l Enable dynamic naming: allows your report to have dynamically generated custom names. See:
Dynamic report names (page 322)

9. Click Create.

Your report is ready to be added to a publish task. See: Creating publish tasks (page 471).

See also:

l Embedding sheets in reports (page 468)

10.16 Embedding sheets in reports
QlikView and Qlik Sense sheets can be added as images to Qlik NPrinting reports.

Sheets can be added as images to Microsoft Office, HTML, or PixelPerfect report templates. Supported formats
are .bmp, .gif, .jpeg, and .png. QlikView and Qlik Sense set the image dimensions to include the entire sheet.

Limitations
Qlik Sense custom size sheets and extended sheet features will not be maintained on export.

Adding a sheet to a report
Do the following:

1. Select Reports in the Qlik NPrinting main menu, and then click Create report.

2. Enter a Title for the report.

3. From the Type drop down, select a report type.

4. Select an app from the App drop-down list.

5. Leave the Enabled flag checked.

6. Click Create to create the report.

7. Click Edit template to open the Template Editor.

8. Right-click the Images node, and select Add objects.

9. Select a sheet from the list. Click OK.

10. Drag the sheet onto the template.

11. To check the result, click Preview.
The sheet will be exported as a single image.

The aspect ratio and content of the preview image depends on the aspect ratio and visible
content of the sheet in QlikView or Qlik Sense.

12. To store the template in the repository, click Save and Close.
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11 Publishing reports
Qlik NPrinting generates reports based on templates, or on QlikView and Qlik Sense entities. You
can deliver reports at scheduled times or when they are requested by individual users. Final reports
are static files that contain copies of the original QlikView and Qlik Sense data as it was at the time
the report was generated.

Qlik NPrinting can distribute the workload across multiple multi-threaded engines to ensure high availability and
fast performance. All metadata is saved in a database system that makes it easy to manage backups, and allows
multiple developers to work concurrently. Qlik NPrinting applies task, report, and user filters before distributing
reports. Each recipient receives reports with data that has been filtered for them.

11.1 Report output formats
The output format of a published report depends on a number of factors. Each report type has
different output format options. If a report is cycled, it will be published as a .zip file.

Single reports
A single uncompressed report will be published as a filename.format file. For example, you have an Excel report
called GlobalSales with the output format set to PDF in the publish task. The output file will be global sales.pdf.
The same filename.format naming structure applies to compressed files, except that .zip is added as the file
extension: global sales.pdf.zip.

Each report type has different output format options:

l Excel: .xlsx, .xls, .xlsm, .tiff, .pdf, .html
l Word: .docx, .doc, .html, .pdf
l PowerPoint: .pptx, .pdf
l HTML: .html, .htm
l PixelPerfect: .pdf, .html, .xls, .xlsx, .png, .gif, .jpeg, .tiff
l QlikEntity: .bmp, .gif, .jpeg, .png, .csv, .skv, .tab

If they are printable in QlikView, they can also be exported as .pdf or .tiff.

If you choose .htm or .html as your output, you will always receive a .zip file containing all the file types
needed to generate HTML.

Cycled reports
Cycled reports are compressed as .zip files, regardless of report type. For example, you have an Excel report
called SalesData that you want to cycle by country and year. Your data covers 3 countries and 2 years, and the
output format is set to .xlsx. You will get 6 .xlsx files in a zip file:
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1. SalesData_Country1_Year1.xlsx

2. SalesData_Country1_Year2.xlsx

3. SalesData_Country2_Year1.xlsx

4. SalesData_Country2_Year2.xlsx

5. SalesData_Country3_Year1.xlsx

6. SalesData_Country3_Year2.xlsx

Cycled HTML reports are processed a little differently. When HTML reports have cycling enabled, the output
format is one .zip file for each report cycle. For example, you have a report with three fiscal years, and you set the
Field to cycle in the publish task to fiscal year, you will get three filename.html.zip published reports.

Adding password protection to reports
You can password protect the following report output types. The original template type does not matter:

l .pptx
l .doc, .docx
l .xls, .xlsx, .xlsm
l .pdf

If you password protect cycled reports, the reports will be password protected, but not the .zip archive.

Published output type by report type

Type Folder Email NewsStand Hub

Single filename.format filename.format filename.format filename.format

Cycled filename.format .zip .zip .zip

Excel reports

Type Folder Email NewsStand Hub

Single filename.format filename.format filename.format filename.format

Cycled filename.format .zip .zip .zip

Word reports

Type Folder Email NewsStand Hub

Single filename.format filename.format filename.format filename.format

Cycled filename.format .zip .zip .zip

PowerPoint reports
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Type Folder Email NewsStand Hub

Single .zip .zip .zip .zip

Cycled .zip .zip .zip .zip

HTML reports

Type Folder Email NewsStand Hub

Single filename.format filename.format filename.format filename.format

Cycled filename.format .zip .zip .zip

PixelPerfect reports

Type Folder Email NewsStand Hub

Single filename.format filename.format filename.format filename.format

Cycled filename.format .zip .zip .zip

Qlik entity reports

11.2 Creating publish tasks
Publish tasks ensure that your reports are distributed to the right place and the right people.

Qlik NPrinting can apply task, report, and user filters before distributing reports. Each recipient receives reports
with data that has been filtered for them. Reports can be published to the NewsStand, folders, Qlik Sense hub,
and by email. You can also set up an automatic distribution schedule.

On the Publish tasks page, you can click the black triangles next to the header titles of any column to sort
column items alphabetically.

Publish task times are displayed relative to the time zone of the logged in user. These may be different than the
time zone of the Qlik NPrinting Server. You can change your time zone by clicking on your user name in the top
right, and selecting Settings.

Reloading connection metadata
Metadata must be updated whenever you change the data structure or content of QlikView documents or Qlik
Sense apps connected to Qlik NPrinting. This ensures that Qlik NPrinting is aware of these changes.

In order to have correct, up-to-date data in your reports, you must schedule a reload of the metadata
before running the publish task. This can be done with a scheduled trigger, see Creating publish tasks
(page 471). You can also call an API from a Qlik Sense app.

Creating new publish tasks
Do the following:
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1. Select Tasks, and then select Publish tasks.

2. Click Create task.

3. Enter a Name for the task.

4. Select an App from the drop-down list.

5. Leave Days to keep as 1.
This is the number of days that reports are kept on the server.

6. Leave Reports to keep as 1.
This is the number of versions of the reports that are kept on the server.

7. Under Report security, you can input a Password to open, a Password to write, or both.

8. Under Notifications, you can select Send task notifications. See: Task execution notifications (page 268)

9. Click Create.
More task buttons appear.

Understanding Days to keep and Reports to keep
Days to keep and Reports to keep control how many copies of a report stay visible on the NewsStand, and for
how long.

Rules:

l Every 30 minutes Qlik NPrinting searches for reports to be deleted, and removes them if needed.
l If within the Days to keep more reports are produced than Reports to keep, a deletion will be performed

on the first check after midnight of the Days to keep plus one.
l If within the Days to keep fewer reports are produced than Reports to keep, a deletion will be performed

on the first check after reaching Reports to keep plus one.
l If fewer reports are produced than Reports to keep, they will all be kept, even after the limit of Days to

keep is reached.
l The oldest reports that exceed the maximum amount of Reports to keep are deleted.
l You cannot manually delete reports stored in the NewsStand. Deleting the file of reports from the storage

folder does not remove reports from the NewsStand. You have to wait for automatic deletion.
l A report in different formats is considered as a single report. For example, if a task runs the same report in

PDF and Excel format and Reports to keep is set to 1, only one of the reports will be saved on the
NewsStand. The other report is considered a copy of the same report. To publish both reports, the
Reports to keep option must be set to 2.

Example
l One task with one report which is run manually multiple times a day.
l Days to keep is set to 2.
l Reports to keep is set to 50.
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Number of
reports

Day 1 Day 2 Day 3 Day 4

Reports
produced
during the day

30 30 20 10

Total reports in
NewsStand

30 60 70 60

Deleted reports 0 0 10 20

Action
None None Oldest 10 reports produced in Day

1 are deleted because total
exceeds 50.

Oldest 20 reports produced in
Day 1 deleted because total
exceeds 50.

Scenario 1: Reports to keep is exceeded

Number of reports Day 1 Day 2 Day 3 Day 4

Reports produced
during the day

10 10 10 10

Total reports in
NewsStand

10 20 30 40

Deleted reports 0 0 0 0

Action
None None Total number of reports is under 50, so no reports are

deleted even if the 2 days to keep limit is reached.
Same
as Day
3

Scenario 2: Reports to keep is not exceeded

Selecting reports to add
Do the following:

1. Click Reports in the main task menu.

2. Click Add report on the right.

3. Select a report from the Choose reports drop-down list.

4. Leave the proposed Friendly name.
This is the text that will be displayed in the user interface to identify this report for this task.

5. Select an Output format. The drop-down list displays only formats that are compatible with the type of
the report selected.

6. Use Quality to set the overall report quality.

7. Leave the Attach to email check box selected if you want to send this report as an email attachment.
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By default, Qlik NPrinting will attach all reports to the email message, including those with Attach to
email disabled. To force Qlik NPrinting to attach only reports with the Attach to email check box
selected, you must select Choose attachments in the Attachments drop-down list of the Email tab.
You can disable attachments, for example, if you are adding an HTML report that will be embedded in the
email body.

8. Leave the Enabled check box selected.
If you clear the check box, the report will be added, but will be ignored by the scheduler.

9. Click Add report to confirm.

You can add as many reports as you want. You can also add the same report many times in different output
formats or quality levels.

Adding users and groups
You can add as many users and groups to a task as you want. Output that is filtered for each recipient will be
created. You have to create users or groups prior to performing this procedure. See: Creating users (page 240).

If you want to use a Qlik NPrinting user as a recipient of reports in Qlik Sense hub, you must connect it with a
domain account to grant it access to the Qlik Sense apps. This is mandatory because Qlik Sense relies on the
domain account to identify the user and Qlik NPrinting needs to impersonate the Qlik Sense user when opening
the apps (apply security settings, section access, etc).

Do the following:

1. Click Users/groups in the main task menu.

2. Click Add user or group.

3. Select a user or a group from the Choose recipient drop-down list.

4. Leave the Enabled check box selected.
If you clear the check box, the user or group will be added, but will be ignored by the scheduler.

5. Leave the NewsStand destination check box selected if you want to publish the report into the
NewsStand profile of the selected user and group.

6. Select the Email destination check box to send the report via email to the selected user and group.

7. Click Add recipient.

Adding filters
You can add as many filters to your task as needed. All task output will be filtered using the task filters. This is in
addition to report filters and user filters which are applied to specific reports or users.

You have to create filters before performing this procedure.

Do the following:

1. Click Filters in the main task menu.

2. Select one or more filters in the Available items column. You can use Shift or Ctrl for multiple selections.

3. Click the to move selected filters into the Selected items column.
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4. Filter priority lets you to set the order in which Qlik NPrinting will apply filters.
Note that applying the same filters in a different order could produce different results.
To verify, open the .qvw with QlikView Desktop and apply the filters manually to test the result. Select the
filter that you want to move and drag and drop it in its final position.

5. Click Add filters to store the filters.

Setting destinations
The Destinations tab lets you customize how reports will be delivered to each user or group. The page has at
least two columns, NewsStand and Email, and a row for each user and group selected. Select or clear check
boxes to enable or disable how reports are delivered to each user or group.

These are the available report destinations:

l NewsStand overview (page 476)
l Distributing reports by email (page 479)
l Distributing reports to folders (page 485)
l Distributing reports to the Qlik Sense hub (page 487)

Creating a distribution schedule
You can create triggers to schedule the automatic execution of publish tasks.

Your metadata connection reload triggers must finish running before your publish tasks are set to
trigger.

Do the following:

1. Click Triggers in the main task menu.

2. Click Create trigger.

3. Enter a Name.

4. In the Schedule section, select the Schedule type:
l Once: The task will be executed once as specified by Time and Start Date.
l Daily: The task will be executed every (n) days, or every weekday, at time specified in Daily

frequency section:
o Once: The task will be executed at the specified hour.
o Multiple times: The task will be executed after the specified time, between the starting and

finishing hours.
l Weekly: The task will be executed on the specified days of the week.
l Monthly: The task will be executed on the specified day of the month.
l Yearly: The task will be executed on the specified day of the year.

5. In the Start section, you can set the Start date and Time zone of the hours specified in the trigger.
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6. In the End section, you can set when to stop the task execution:
l Event count: The schedule will be stopped after the specified number of executions.

Enabling, disabling, or changing the event count for a task does not reset the count of
how many times the task was triggered. If you want to increase the number of times a
task runs, you must increment the current number by the additional number of times you
want the task to run.

l End date and End time: The schedule will be stopped at the specified date and time.

7. Click Create to save the new trigger in the repository.

You can add as many triggers as you want to a task.

Running the publish task manually
You can publish your reports manually. This can be done in addition to publishing tasks that you have scheduled.

Do the following:

1. Click Overview in the task main menu.

2. Click Run now. A message indicates when the task is started.

Testing a publish task
You may want to test a publish task before you send reports to recipients. For example, you may want to ensure
permissions are working.

11.3 NewsStand overview
Qlik NPrinting NewsStand is a web portal that allows users to preview and download reports. Users
can also subscribe to automatic updates.

Opening NewsStand
The NewsStand web portal uses the generic web address, https://YourServerName:4994. In a web browser, replace
YourServerName with the name or the IP address of the server where NewsStand is installed. You must use the
HTTPS protocol and port number 4994 for the standard installation.

The SSL web certificates distributed with the Qlik NPrinting setup are not valid and should be used for
demonstration purposes only. You can also use your own certificates. Your browser may notify you of a possible
security issue. You must accept the SSL certificate to be able to open the website. See: Installing Qlik NPrinting
certificates (page 206).

NewsStand supports Windows and Qlik NPrinting authentication.
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Report access
Administrators can control user report access. Access control in Qlik NPrinting is defined at the app level.

The default NewsStand user role can access all apps and can subscribe to all reports. Administrators can restrict
access by creating new user roles that only have permission to access certain apps. You can also block users from
creating subscriptions.

Do the following:

1. Go to Admin > Security roles.

2. Open a role, or create a new one.

3. Under Apps, deselect the All apps check box.

4. Move the apps these users should access from Available items to Selected items.

5. To block users from creating subscriptions, scroll down to the Reports list box and deselect Subscribe.

6. Click Save.

Downloading a report
To log into NewsStand using Qlik NPrinting authentication, you need to be given access by a Qlik NPrinting
administrator. See: Defining user roles (page 243)

Do the following:

1. Enter your user name.

2. Enter your password.

3. Click Qlik NPrinting login.
The Qlik NPrinting NewsStand homepage appears, with list of your reports.

4. Click a report title to open the preview window. You can scroll down by clicking the >I arrow.

5. Click Download to download a report.
You can then open the report as you would any other file.

Subscribing to a report
You can create personal subscriptions to the reports that you are allowed to see. Subscriptions are publish tasks
owned by you, the NewsStand user.

Do the following:

1. Click Subscriptions in the top menu.

2. Click Create subscription.

3. Use the Report drop-down list to select a report.

1. Use Format to choose the output format.

4. Use Quality to set the image resolution.

5. Enter a Name for your subscription.
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6. Under Schedule, set a Schedule type:
l Once
l Daily
l Weekly
l Monthly
l Yearly

7. Set your Repeat every, Daily frequency, Start, and End options. These options will change slightly
depending on Schedule type.

8. You can set your subscription to stop based on the following criteria:
l Event count: the subscription is executed for the number of times specified.

Enabling, disabling, or changing the event count for a task does not reset the count of
how many times the task was triggered. If you want to increase the number of times a
task runs, you must increment the current number by the additional number of times you
want the task to run.

l End date and End time: the subscription is executed until the date and time specified is reached.
In this case, leave the options blank.

9. Click Create.

Filtering the subscription list
In the View list for subscriptions, you have the following filter options:

l All: includes all "My subscriptions" and "Corporate subscriptions".
l My subscriptions: reports that you have personally subscribed to through the NewsStand.
l Corporate subscriptions: reports that a Qlik NPrinting Administrator has subscribed you to.

Deleting a report
You can delete reports from the Reports list, if the reports fail to publish, or if you do not need them.

Do the following:

1. Click Reports in the top menu.

2. Click the check box next to a report preview to select it for deletion.
You can select multiple reports, or click the check box above the list header to select all reports. The
number of selected reports will be indicated next to the check box.

3. Click the icon above the list header to delete the selected reports.

Qlik NPrinting - February 2024 478

11   Publishing reports



Troubleshooting

There is a warning sign in the Preview section of a NewsStand report

Possible cause

The report has not been correctly generated.

Proposed action

l Verify that the scheduler and engine services are running correctly. Restart them and check if the warning
message disappears.

l Verify that one or more templates have been added to your report. You cannot create a new report, and
leave it empty without adding a template.

11.4 Distributing reports by email
Emails can be customized so that your reporting is personalized, consistent, and easy to maintain.
Recipients can access reports directly from their inbox, without having to log into the NewsStand.

You can distribute all report types as email attachments. HTML reports and QlikEntity reports can be embedded
directly into the body of emails. This means users can quickly scan your report without having to download and
open an attachment. You can also embed a summary of your data in the email body, and include the full report
as an attachment.

Limitations
l You must configure your SMTP mail server in order to send emails from Qlik NPrinting. See: Configuring

SMTP server (page 268).
l By default, the To, CC, and BCC fields can only contain 100 email addresses. You can change this limitation

by editing the webengine.config file. See: Configuring the email address limits (page 485).
l If you want to configure a custom sender address, your SMTP server settings must allow users to send

emails using addresses other than their assigned ones.
l Users that are exclusively members of the Developer role cannot receive emails.
l By default, Qlik NPrinting will attach all reports to email messages, including those with Attach to email

disabled. To force Qlik NPrinting to only attach reports with the Attach to email check box selected, you
must select Choose attachments in the Attachments drop-down list of the Email tab.

Some SMTP providers impose size limits on email attachments. The maximum allowed size
varies among providers. If the size of an attached file exceeds the limit, the email is not
delivered. A warning is added in the logs.
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Due to Windows file systems limitations, you cannot attach files with file names longer than 255
characters to Qlik NPrinting emails. If you attach a file with a name that is too long, recipients
will see a message listing which reports failed to be generated. The following error message is
added to the Qlik NPrinting logs: "Path with value name is exceeding windows limitations, the
fully qualified file name must be less than 260 characters."

About dynamic text and variables in emails

Variables
You can add variables to the following fields:

l To
l CC
l BCC
l Subject
l Body

You can insert variables created in Qlik Sense or QlikView. The Qlik NPrinting app that contains the publish task
must also contain connections to the Qlik Sense app or QlikView document that contains the variable. If you
create a new variable, you will have to reload your connection metadata.

Variable strings are automatically replaced with the values of corresponding variables when emails are
generated. This replacement happens after the filters associated with users and tasks have been applied.

In Recipient fields
You can click the Add variable button next to the To, CC, and BCC fields. You can choose the following from the
drop down:

l User email: Taken from user profiles.
l Alternate email 1: Taken from user profiles.
l Alternate email 2: Taken from user profiles.
l Alternate email 3: Taken from user profiles.
l Qlik variable: This will display variables created in Qlik Sense or QlikView. See: Variables (page 317)

For information on creating or editing user profiles, see: Creating users (page 240).
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In Subject and Body fields
When you add a variable to an email, you can use the search box to find a variable from the list. You can also
apply a user or task filter to the variable.

For example:

You have a QlikView variable called vTotalSales with a value of =money(sum(Sales),'$ #,##0.00'). You add the
variable %%Variable_User_SalesDemo_vTotalSales%% to an email message. When you send the email
to your recipients, recipient filters will be applied before the value of the variable is calculated. If your recipients
have filters based on their sales territories, then the expression =money(sum(Sales),'$ #,##0.00') will show sales in
the appropriate territory for each sales person.

When a variable value is extracted from QlikView or Qlik Sense, the following settings are used depending on the
selection made by the user:

Variable filter settings Applied filters Applied identity

No filter Empty filter
sequence

Connection default identity.

Task filter Task filters Connection default identity.

User filter Task filters and
user filters

If "use section access for reports" is selected: user domain
account. Otherwise: connection default identity.

Identity and filter settings for variables

You cannot add report filters, because multiple reports can be added to the same task.

Dynamic text
You can add dynamic text related to user profiles or report names to the email subject or body.
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For example, if you add the User tag "User company", you will see this string: %%User_Company%%. It is
replaced with the name of the recipient's company when the email is generated.

Report name tags are based on your report name settings. For example, you have a "Sales Demo" report that
uses dynamic naming that includes report name, date, and user name. The dynamic name will look like this:
%%Report_Name%%YYYY-MM-DD%%User_Name%%. You will see this string when you embed the report name

in the email body: %%ReportName_SalesDemo_f7a6494a-d5d6-4d3f-a363-e5605fdb9d10%%. But
your recipient Jane Doe will see "SalesDemo_20190524_JaneDoe" in the email. See: Dynamic report names (page
322).

Creating an email message
You can customize emails that are sent to users and groups. You can include dynamic text using tags and
variables.

Do the following:

1. From the top menu, select Tasks, and then select Publish tasks.

2. Choose an existing publish task, or create a new one.

3. Click Reports in the main task menu.

4. Click Add report on the right.

a. Select a report from the Choose reports drop-down list.

b. The Friendly name is the file name recipients see. It can be customized.

c. Select an Output format. The drop-down list only displays formats that are compatible with the
type of report selected.

d. Use Quality to set the image resolution.

e. Leave the Attach to email check box selected.

f. Leave the Enabled check box selected.
If you clear the check box, the report will be added, but will be ignored by the scheduler.

g. Click Add report to confirm.

5. Click Email message in the main task menu.

a. Under From, select one of the following:
l Default sender: Administrators can set the Default sender under Admin > Settings >

Email.
l User: Select a sender email from the drop-down list. You can also use the search form to

filter the list.
l Custom: Enter a valid email address.

b. Under To, CC, and BCC you can input email addresses manually, separated by a semicolon. Or you
can click Add variable to add a dynamic email list or variable.

c. Enter a Subject.

d. Select the email Format by clicking on HTML, which supports formatted text, or Text.
You must select HTMLif you want to add dynamic text, or variables, or if you want to embed HTML
reports and QlikEntity reports.
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e. Under Body, you will see formatting tools, and the following options:
l Toggle HTML/Rich Text: switch between HTML and rich text editor.
l Insert image: insert an image into the email text. You can only insert an image as URL

address.
l Insert/edit link: insert a URL address.
l Words and Characters count

f. You can add dynamic tags and variables:
l Users: insert a dynamic User tag from a list.
l Reports: insert a dynamic Report name tag. Select one of the available tags under Embed

report names.
l Variables: insert a variable from a Qlik Sense or QlikView connection that exists in your Qlik

NPrinting app.

You can insert dynamic tags and variables in the email subject. Once you select the
desired tag or variable, copy it from the email body to the subject field. Make sure to
include the %% deliminators.

g. Under Attachments, you can select:
l All reports attached
l No reports attached
l Selected attachments

Click the paperclip on the left to select which attachments to include. Click Close when
finished. You will see the included attachments listed below.

6. Click Save.

You will now be in the Overview menu, where you can click the Run now button to publish your report.

Embedding HTML and QlikEntity reports in emails
You can embed HTML reports and QlikEntity reports directly in emails. The same report can be embedded several
times. For example, you may want to embed a report in .jpg and .png, at different DPI levels.

Cycled reports can be embedded in emails. However, cycling can create a large number of reports, and
embedding them may make email size too large for some email clients. See: Cycling your reports (page 324).

The final output of emails with embedded HTML reports may differ depending on the email clients and
permissions of the recipient. Some systems automatically block images, or show them as attachments.

The procedure for creating emails with embedded objects is similar to the one above, with some exceptions.

Do the following:
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1. Select Tasks, and then select Publish tasks.

2. Choose an existing publish task, or create a new one.

3. Click Reports in the main task menu.

4. Click Add report on the right.

a. Select a report from the Choose reports drop-down list. You must select an HTML or QlikEntity
report.

b. The Friendly name is the file name recipients see. It can be customized.

c. Select an Output format.
l For HTML reports: select HTML or HTM.
l For QlikEntity reports: select JPEG or PNG.

d. Use Quality to set the image resolution.

e. Leave the Attach to email check box selected if you also want to send this report as an email
attachment. You may want to disable this if you are embedding a large report directly into the
email body.

f. Leave the Enabled check box selected.

g. Click Add report to confirm.

5. Click Email message in the main task menu.

a. Fill out the fields the same as above. Make sure to select HTML under Format.

b. Click on the body of your email where you would like to embed your report. Click the Reports
button.

c. Under Embed reports, click on the report that you want. This screen will only show compatible
reports.
You will see a string of code in your email. This will either display as an image or HTML/HTM when
the email is sent. You cannot format this string with the email formatting tools. For example, you
cannot use the Center button to center a QlikEntity .jpeg.

d. To embed the report name, click the Reports button again, and then click on Embed report
name.
You will see a string of code in your email. This will be replaced by the report name.

e. Under Attachments, your options are the same as above.

f. Click Save.

You will now be on the Overview menu, where you can click the Run now button to publish your report.

Sending emails if reports fail
By default, if report generation fails, recipients still receive scheduled emails. Instead of the report, users see an
error message and instructions to contact an administrator. Administrators can disable this behavior so that
emails are not sent when reports fail. Report failure appears as an error in the log files.

If you disable this behavior, emails are still sent if at least one report was created successfully.

For example:

You have 3 users in a single task. The task has 2 reports for each user, which are sent via e-mail.
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l User A: report generation successful.
l User B: one report fails to generate.
l User C: all reports fail to generate.

In this case:

l User A receives the email with the two attachments.
l User B receives the email with a single attachment. There will be no mention of the report that failed.
l User C will not receive any email.

Do the following:

1. In the main menu, go to Admin > Settings.

2. Click the Task button.

3. Under Email distribution errors, go to When a publish task cannot generate one or more reports.
Choose from the following options:

l Recipients will receive successful reports, with a message listing reports that failed
l Recipients will receive successful reports, with no error message

If all reports fail, recipients will not receive an email.

4. Click Update.

Configuring the email address limits
By default, you can only insert 100 email addresses in the To, CC, and BCC fields. You can change this by editing a
config file.

Do the following:

1. Open the webengine.config file.
By default it is stored under: %Program Files%\NPrintingServer\NPrinting\WebEngine\webengine.config.

2. Find this section:
<!-- The maximum number of emails on email list input fields. The value 0 means

unlimited. -->

<!--<add key="email-list-limit" value="100"/>-->

3. Change the number after value="

4. Save the file, and restart the web engine service.

11.5 Distributing reports to folders
The Qlik NPrinting Server can deliver reports to a specified folder location.

You can create destination folders and use them in publish tasks. All folder paths are referenced to the Qlik
NPrinting Server hard disks.
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Requirements
l Your Qlik NPrinting user account which runs the Qlik NPrinting scheduler service must have full NTFS file

and folder network access in order to share network folder resources.
l The Qlik NPrinting user must have the Developer or Administrator security role to create destination

folders.

Mapped network drives, like Z:\NPrintingServer\QlikViewDocuments, are not supported by Qlik
NPrinting. You must use Universal Naming Convention (UNC) paths, such as
\\ServerName\NPrintingServer\QlikViewDocuments.

Entering user folder and subfolder
Do the following:

1. Select Admin from the Qlik NPrinting main menu, and then select Users.

2. Select the user that should receive the report.
To learn how to create users, see Creating users (page 240).

3. In the Folder field, enter C:\QlikReportingTraining\Output\<username>.

4. In the Subfolder field, enter the name of the user that should receive the report.
This value will be concatenated with another parameter to obtain the complete final path.

5. Save the changes.

Creating a new destination folder
Do the following:

1. Select Destinations in the main menu, and then select Folders.

2. Click Create folder.

3. Type a folder name.

4. In the App drop-down list, select an app.

Folder path options
In the drop-down list, under the Path option, you can select which parts to use for the final path. The following
options are available:

l Custom path: type a fixed part of the path.
l Separator: insert a separator between the folders.
l User name: insert a user name.
l User folder: use the path entered in the Folder field of the user profile.
l User subfolder: use the path entered in the Subfolder field of the user profile.
l Qlik variable: the list of available Qlik variables in all .qvw files connected to the app.

You can use the plus sign (+) to concatenate other parts of the final path.
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ClickingÖ removes the related part of the path.

Setting the folder path
Do the following:

1. In the Path section, click Select type, and then select Custom path in the drop-down list.

2. Enter C:\QlikReportingTraining\Output\ in the text box.

3. Click the plus sign (+) to add a new piece of the path.

4. Click Select type, and then select User subfolder from the drop-down list.
%%User_Subfolder%% is inserted automatically. The Preview field shows the final structure of the folder.

5. Click Create to confirm and save.

Adding destination folders in the task
Do the following:

1. In the main menu bar, click Tasks, and then select Publish task.

2. Click on the task you want to edit.

3. Click the Destinations tab.

4. Click the plus sign (+) to add a folder column.

5. Click Select folder, and then select the destination folder.

6. Click Add to confirm the new destination.
The name of the destination folder is displayed in the user interface.

By selecting the check boxes for NewsStand, Email, and <destination folder>, you can specify which
folders will contain the final reports.

7. Click Save.

8. Click Overview in the Taskmain menu. Click Run now to run the task manually.

The reports are available in their designated folders.

Note: If you publish one report with two different Image quality (page 302) levels to a folder, the newer
file will overwrite the older one. This can be avoided by applying a Friendly name via Dynamic report
names (page 322).

11.6 Distributing reports to the Qlik Sense hub
You can distribute Qlik NPrinting reports to the Qlik Sense hub for Windows domain users who
have been configured in both Qlik NPrinting and Qlik Sense.
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Limitations
l Reports are private and can only be viewed by the intended user.
l You can have only one Qlik Sense hub destination for a Qlik NPrinting deployment.
l In the Qlik Sense hub, users will only see the latest version of a report. They will not be able to access

older versions of reports like they can in the NewsStand.

Requirements
To enable distribution of Qlik NPrinting reports to the Qlik Sense hub the following is required:

l Recipients must be Windows domain users configured in both Qlik NPrinting and Qlik Sense.
l Qlik Sense certificates exported from the Qlik Management Console (QMC) and installed on Qlik NPrinting

Server and all Qlik NPrinting Engine machines. For more information, see Validating the connection to Qlik
Sense (page 173).

l The central node computer name of the Qlik Sense installation.
This information is available in the QMC, in the Nodes tab.

Setting the Qlik Sense hub as a destination
Do the following:

1. Select Destinations in the main menu, and then select Hub.

2. Type a name for the hub.

3. Under Central node address, enter the central node computer name of the Qlik Sense hub.

4. Click Save.

Opening the Publish tasks page
Do the following:

1. In the main menu bar, click Tasks, and then select Publish task.

2. Create a new publish task, or click an existing publish task to edit it.

3. Type a name for the task.

4. Select a Qlik NPrinting app from the App drop-down list.

5. Set Days to keep and Reports to keep.
See: Understanding Days to keep and Reports to keep (page 472).

6. Click Create.

Adding reports
Do the following:

1. Click the Reports tab.

2. Choose a report, and then configure the output format.

3. Click Add report.
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Adding users
To distribute reports to a Qlik Sense hub user, you must add the user to the Publish task. The user must be a
Windows domain user who has been configured in both Qlik NPrinting and Qlik Sense.

Do the following:

1. Click the Users/groups tab.

2. Click Add user or group, and then add a user.

3. Click Add recipient.

Adding the hub as a destination in the publish task
Do the following:

1. Click the Destinations tab.

2. Select a Recipient and then select the Hub check box.
To distribute reports for all users, select the Upload for all Hub check box.

3. Click Save.

4. Click the Overview tab, and then click Run now to manually run the task.

You can open the Qlik Sense hub to verify that the report has been delivered.

Scheduling distribution
You can create triggers to schedule the execution of publish tasks.

Do the following:

1. Click the Triggers tab.

2. Configure a schedule.

3. Click the Enabled button.

4. Click the Create button.
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12 On-Demand reports
You can generate On-Demand reports using the QlikView AccessPoint interface or the Qlik Sense
reporting control. On-Demand reports are created in Qlik NPrinting.

You can download reports directly from the On-Demand interface.

12.1 Install
Deploy and configure On-Demand components.

12.2 Generate
Learn how to generate On-Demand reports.

12.3 Administer
Learn how to change report generation settings.

12.4 Installing On-Demand Add-on on a Microsoft IIS hosted
QlikView AccessPoint

You must install the Qlik NPrinting On-Demand Add-on on your QlikView Web Service to create On-
Demand reports from the QlikView AccessPoint interface.

If your QlikView Servers are in a cluster, or you performed a custom installation of QlikView Server components,
you must install On-Demand on each QlikView Web Service in the cluster.

On-Demand reports in Qlik Sense are created using the reporting control.

Requirements
l QlikView Server May 2021 or later.

If you are using QlikView Server May 2024, then Qlik NPrinting February 2024 SR2 or later is
required.

l QlikView Server is installed and configured to use Microsoft IIS with ASP.NET 4.5 (or higher) as web server.
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l Qlik NPrinting is configured to use JWT authentication. See: JWT authentication (page 222).
The certificate with private key used to configure JWT authentication must be installed on the Microsoft
IIS local machine personal certificate store. Certificates generated using CNG compatible algorithms are
not compatible with the On-Demand Add-on.

l Microsoft Internet Explorer is not supported by Qlik NPrinting. However, if Microsoft Internet Explorer
Enhanced Security Configuration is turned on, it may cause errors. For more information, see Microsoft
Internet Explorer Enhanced Security Configuration is blocking QV.exe (QlikView) and reporting_web_
renderer.exe (Qlik Sense) (page 551).

l The domain user account used to run the Qlik NPrinting services must be a member of the following two
local user groups on each machine that is running a QlikView service:

l QlikView Administrators
l QlikView Management API (this group must be created manually)

For more granular settings, this is required on each machine running QlikView Server,
QlikView Management Service and/or the QlikView Settings Service (The IIS counterpart
for the AccessPoint service).

After changing the account groups, you should restart the QlikView services. NPrinting
services do not need to be restarted as they should not be running on the QlikView
machines.

l QVP and QMS connections are supported for the reports and they should point to the same QlikView
environment where the On-Demand Add-on is running.

JWT settings
JWT must be configured as specified:

Attribute Configuration

JWT attribute mapping Match user by Domain\Name

JWT attribute for user ID uid

JWT attribute for user directory dom

JWT attribute configurations

Downloading the installation file
Download Qlik NPrinting On-Demand Add-on.exe from≤ Product Downloads and save it to a folder on the IIS
server.

Downloading installation files (page 155)

Installing On-Demand
Do the following:
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1. Double-click Qlik NPrinting On-Demand Add-on.exe to launch the installation.

2. If the QlikView Server requirements are not met, you will see an error message. Check the logs for more
information.

3. Click Install to proceed.

4. If the User Account Control window appears, click Yes.

5. Click Next when the welcome message appears.

6. Accept the terms and conditions.

7. Click Next to proceed.

8. Enter your Qlik NPrinting Server URL in the following format: https://YourServerName:PortNumber.

Make sure there is no slash (the character “/”) following the port number. The default port
number is 4993.

If your Qlik NPrinting Server and Qlik NPrinting Engine are installed on different computers, use
the Qlik NPrinting Server URL.

9. Enter the certificate thumbprint used to configure JWT authentication on the Qlik NPrinting Server. To
find the certificate thumbprint:

a. Navigate to the location where the certificate is installed.

b. Double-click on the certificate and go to the details page.

c. Copy the value from the certificate thumbprint, and paste it into the field in the Qlik NPrinting On-
Demand Add-on setup.
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10. Click Next.

11. Click Install.

12. Click Finish to close the setup window.

Configuring On-Demand settings on Qlik NPrinting Server
You must configure these settings on your Qlik NPrinting Server:

l You must have a connection to a QlikView Server or a Qlik Sense server.
QlikView Server and QlikView Cluster connections are supported with On-Demand. Local connections are
not supported. See: Creating connections.

l If you are connecting to a QlikView Server or Cluster with a QlikView Server Extranet License, the following
options must be enabled when configuring the connection:

o Connection requires authentication
o Apply user section access for reports

l You must enable your Qlik NPrinting reports for On-Demand.
l You can limit On-Demand report creation through security roles. See: Role based security.
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On-Demand is compatible with Chrome, Firefox, and Explorer. It will not run in Microsoft Edge, because
the certificates will not download.

Enabling Qlik NPrinting reports for On-Demand creation
Qlik NPrinting reports must be manually enabled for On-Demand creation. Reports must be assigned to the
QlikView document or Qlik Sense app with which you want to generate On-Demand reports. On-Demand creation
can be enabled during the creation of a new report.

Do the following:

1. In Qlik NPrinting web console, click Reports.

2. Open a report or create a new report.

3. Select an app from the App drop-down list is connected to the QlikView document or Qlik Sense app for
which you want to generate a report.

On-Demand requests only work with reports based on a single connection. MultiDoc reports are
not supported.

4. Select the Enable On-Demand check box.

5. Click Save.

The report template is now available.

12.5 Installing On-Demand on a QlikView Web Server
You can install the On-Demand Add-on on a QlikView Web Server hosted QlikView AccessPoint.

As a best practice, you should install On-Demand on a Microsoft IIS hosted QlikView AccessPoint. It is a
simpler and more secure deployment. See: Installing On-Demand Add-on on a Microsoft IIS hosted
QlikView AccessPoint (page 490).

You must install the Qlik NPrinting On-Demand Add-on on your QlikView Web Service to create On-Demand
reports from the QlikView AccessPoint interface.

If your QlikView Servers are in a cluster, or you performed a custom installation of QlikView Server components,
you must install On-Demand on each QlikView Web Service in the cluster.

On-Demand reports in Qlik Sense are created using the reporting control.
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Requirements
l The following versions of QlikView are supported for connection with Qlik NPrinting. Note that your Qlik

NPrinting version must be equal to or higher than your QlikView version:
o QlikView April 2020 SR2 (12.50 SR2) or later
o QlikView May 2021 (12.60) or higher
o QlikView May 2022 (12.70) or higher

l Windows login must be enabled, working, and used as the authentication system in Qlik NPrinting.
l NTFS must be enabled on the QlikView Server or QlikView Server cluster that serves the QlikView Web

Server where you are installing On-Demand.
l QlikView Server is installed and configured to use QlikView Webserver.
l QlikView Server is connected to Qlik NPrinting. See: Connecting Qlik NPrinting with QlikView (page 178).
l In a multi-server environment, On-Demand needs to be installed on all servers running QlikView Web

Server (QVWS) services in the environment.
l Microsoft Internet Explorer is not supported by Qlik NPrinting. However, if Microsoft Internet Explorer

Enhanced Security Configuration is turned on, it may cause errors. For more information, see Microsoft
Internet Explorer Enhanced Security Configuration is blocking QV.exe (QlikView) and reporting_web_
renderer.exe (Qlik Sense) (page 551).

l The Qlik NPrinting services Windows domain user must be a member of two groups on the QlikView
Server (as well as the AccessPoint server, if installed on a separate computer):

l QlikView Administrators
l QlikView Management API

You must restart QlikView and Qlik NPrinting services after adding the Qlik NPrinting services
Windows domain user to the QlikView Administrators and QlikView Management API groups.

Downloading the installation file
Download Qlik NPrinting On-Demand Add-on.exe from≤ Product Downloads and save it to a folder on the
server.

Downloading installation files (page 155)

Installing On-Demand
Do the following:

1. Double-click Qlik NPrinting On-Demand Add-on.exe to launch the installation.

2. If the QlikView Server requirements are not met, you will see an error message. Check the logs for more
information.

3. Click Install to proceed.

4. If the User Account Control window appears, click Yes to proceed.

5. Click Next when the welcome message appears.
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6. Accept the terms and conditions.

7. Click Next to proceed. Setup progress will start.

8. Enter your Qlik NPrinting Server URL in the following format: https://YourServerName:PortNumber.

Make sure there is no slash (the character “/”) following the port number. The default port
number is 4993.

If your Qlik NPrinting Server and Qlik NPrinting Engine are installed on different computers, use
the Qlik NPrinting Server URL.

9. Click Next to proceed.

10. Click Install to begin the installation.

11. When complete, click Finish to close the setup window.

Adding a server as a trusted origin
If you are creating On-Demand reports in Qlik Sense or a QlikView Web Server hosted QlikView AccessPoint, you
must add these servers as a trusted origin in Qlik NPrinting web console.

For each server path used to access the Qlik NPrinting web console, you must add a trusted origin. For example, if
your server can be accessed through a local domain, a shortened host, or fully qualified URLs, a trusted origin
must be added for each of those server paths.
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How you enter the server paths in the Address field of the trusted origin depends on your security configuration.

Configuration 1: SSL security not setup with Qlik NPrinting web console
A trusted origin is required for each server path used to log onto the Qlik NPrinting web console. For example, if
your server is qlikserver1 and has an IP address of 192.168.0.101, you would add the following trusted origins:

l http://qlikserver1
l http://qlikserver1.domain.local
l http://192.168.0.101

Configuration 2: SSL security setup with Qlik NPrinting web console and third-party
A trusted origin is required for each server path used to log onto the Qlik NPrinting web console. URLs must use
HTTPS. For example, if your server is qlikserver1 and has an IP address of 192.168.0.101, you would add the
following trusted origins:

l https://qlikserver1
l https://qlikserver1.domain.local
l https://192.168.0.101

Adding a trusted origin
Do the following:

1. In Qlik NPrinting, click Admin > Settings.

2. Click On-Demand Settings.

3. Click Add trusted origin.

4. After Name, enter a name for the trusted origin.

5. After Description, enter a description for the trusted origin.

6. After Address, enter the URL for the QlikView Server.
The URL must be the base URL (scheme and host) only. For example, http://qlikserver1 rather than
http://qlikserver1/qlikview/index.htm.

7. Click Create.

Configuring On-Demand settings on Qlik NPrinting Server
You must configure these settings on your Qlik NPrinting Server:

l You must have a connection to a QlikView Server or a Qlik Sense server.
QlikView Server and QlikView Cluster connections are supported with On-Demand. Local connections are
not supported. See: Creating connections.

l If you are connecting to a QlikView Server or Cluster with a QlikView Server Extranet License, the following
options must be enabled when configuring the connection:

o Connection requires authentication
o Apply user section access for reports
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l You must enable your Qlik NPrinting reports for On-Demand.
l You can limit On-Demand report creation through security roles. See: Role based security.

On-Demand is compatible with Chrome, Firefox, and Explorer. It will not run in Microsoft Edge, because
the certificates will not download.

Enabling Qlik NPrinting reports for On-Demand creation
Qlik NPrinting reports must be manually enabled for On-Demand creation. Reports must be assigned to the
QlikView document or Qlik Sense app with which you want to generate On-Demand reports. On-Demand creation
can be enabled during the creation of a new report.

Do the following:

1. In Qlik NPrinting web console, click Reports.

2. Open a report or create a new report.

3. Select an app from the App drop-down list is connected to the QlikView document or Qlik Sense app for
which you want to generate a report.

On-Demand requests only work with reports based on a single connection. MultiDoc reports are
not supported.

4. Select the Enable On-Demand check box.

5. Click Save.

The report template is now available.

12.6 Installing Qlik Sense On-Demand reporting control
The On-Demand reporting control adds a button that generates Qlik NPrinting reports on demand.
It is included in Dashboard bundle.

The On-Demand reporting control is useful when you want the user to be able to print predefined Qlik NPrinting
reports within Qlik Sense, using their selections in the app as a filter.

Requirements
l Qlik NPrinting Server (September 2019 or later) with a Qlik NPrinting app that is connected to the Qlik

Sense app that you are designing. This Qlik NPrinting app contains your report templates.
l Qlik Sense Enterprise on Windows September 2019 or later.
l All users generating On-Demand reports need to be added as users in Qlik NPrinting, with a security role

that supports running On-Demand reports.
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l Users must be logged into Qlik Sense via NTML (Windows) authentication in order to generate reports or
create reporting buttons.

You must enable Windows authentication to use the Qlik NPrinting On-Demand Add-on on QlikView Web
server and Qlik Sense.

If you only want to use JWT authentication, then you must install the Qlik NPrinting On-Demand Add-on
on a QlikView Server configured on a Microsoft IIS Web Server.

Installing On-Demand Add-on on a Microsoft IIS hosted QlikView AccessPoint (page 490)

Limitations
l If the Qlik NPrinting report template contains a filter, you cannot make conflicting selections in the Qlik

Sense app, or the report will fail.

Installing the Dashboard bundle
You can install the Dashboard bundle when you install Qlik Sense.

You can add or remove object bundles from your Qlik Sense deployment at any moment. If you have a multi-
node installation, object bundles are installed on the central node.

You can see which extensions are installed in your deployment by checking the Extensions section in the
Qlik Management Console (QMC).

Do the following:

1. In Windows Control Panel, open Programs and Features.

2. In the list of programs, double-click the object bundle that you want to modify.

3. The Object Bundle Setup Wizard opens. Click Next.
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4. Select Change.

5. On the Custom setup screen, click on the bundle icon to select how to modify the bundle installation:
o If the bundle is installed, select Entire feature will be unavailable to uninstall it.
o If the bundle is not installed, select Entire feature will be installed on local hard drive to install

it.

Then, click Next.

6. Click Change.
Once the modification if complete, you are required to manually restart the Qlik Sense Repository Service.

7. Click Finish to close the Object Bundle Setup Wizard.

8. Manually restart the Qlik Sense Repository Service to apply the changes.

You can verify that the changes have been correctly applied by checking the Extensions section in the QMC.

Adding a server as a trusted origin
If you are creating On-Demand reports in Qlik Sense or a QlikView Web Server hosted QlikView AccessPoint, you
must add these servers as a trusted origin in Qlik NPrinting web console.

For each server path used to access the Qlik NPrinting web console, you must add a trusted origin. For example, if
your server can be accessed through a local domain, a shortened host, or fully qualified URLs, a trusted origin
must be added for each of those server paths.

How you enter the server paths in the Address field of the trusted origin depends on your security configuration.

Configuration 1: SSL security not setup with Qlik NPrinting web console
A trusted origin is required for each server path used to log onto the Qlik NPrinting web console. For example, if
your server is qlikserver1 and has an IP address of 192.168.0.101, you would add the following trusted origins:

l http://qlikserver1
l http://qlikserver1.domain.local
l http://192.168.0.101

Configuration 2: SSL security setup with Qlik NPrinting web console and third-party
A trusted origin is required for each server path used to log onto the Qlik NPrinting web console. URLs must use
HTTPS. For example, if your server is qlikserver1 and has an IP address of 192.168.0.101, you would add the
following trusted origins:

l https://qlikserver1
l https://qlikserver1.domain.local
l https://192.168.0.101

Adding a trusted origin
Do the following:
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1. In Qlik NPrinting, click Admin > Settings.

2. Click On-Demand Settings.

3. Click Add trusted origin.

4. After Name, enter a name for the trusted origin.

5. After Description, enter a description for the trusted origin.

6. After Address, enter the URL for the QlikView Server.
The URL must be the base URL (scheme and host) only. For example, http://qlikserver1 rather than
http://qlikserver1/qlikview/index.htm.

7. Click Create.

Configuring On-Demand settings on Qlik NPrinting Server
You must configure these settings on your Qlik NPrinting Server:

l You must have a connection to a QlikView Server or a Qlik Sense server.
QlikView Server and QlikView Cluster connections are supported with On-Demand. Local connections are
not supported. See: Creating connections.

l If you are connecting to a QlikView Server or Cluster with a QlikView Server Extranet License, the following
options must be enabled when configuring the connection:

o Connection requires authentication
o Apply user section access for reports

l You must enable your Qlik NPrinting reports for On-Demand.
l You can limit On-Demand report creation through security roles. See: Role based security.

On-Demand is compatible with Chrome, Firefox, and Explorer. It will not run in Microsoft Edge, because
the certificates will not download.

Enabling Qlik NPrinting reports for On-Demand creation
Qlik NPrinting reports must be manually enabled for On-Demand creation. Reports must be assigned to the
QlikView document or Qlik Sense app with which you want to generate On-Demand reports. On-Demand creation
can be enabled during the creation of a new report.

Do the following:

1. In Qlik NPrinting web console, click Reports.

2. Open a report or create a new report.

3. Select an app from the App drop-down list is connected to the QlikView document or Qlik Sense app for
which you want to generate a report.

On-Demand requests only work with reports based on a single connection. MultiDoc reports are
not supported.
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4. Select the Enable On-Demand check box.

5. Click Save.

The report template is now available.

12.7 Generating On-Demand reports in QlikView AccessPoint
On-Demand reports are created in the Qlik NPrinting window in the QlikView AccessPoint
interface. The Qlik NPrinting window also displays completed reports for download and reports in
queue.

When you create an On-Demand report, the report is added to the report creation queue on the Qlik NPrinting
Server. Once a report is complete, it is stored in the Qlik NPrinting repository, but can be downloaded in QlikView.
Reports can be accessed from the Qlik NPrinting window in QlikView AccessPoint until deleted. Reports and
reports in queue are automatically deleted from the Qlik NPrinting Server after 30 days. Failed reports are deleted
after 6 days.

On-Demand reports in Qlik Sense are created using the reporting control.

You can access all reports enabled for On-Demand on the Qlik NPrinting Server, prepared on the QlikView
document you are using in QlikView AccessPoint.

You should use a different Qlik NPrinting app on the Qlik NPrinting Server for each QlikView document. If
you use one app for multiple documents, you will be able to see reports from other QlikView documents,
but they will fail.

Access to On-Demand reporting is set via security roles and is applied at the app level. This limits access
to On-Demand reports on an app-by-app basis.

On-Demand requests only work with reports based on a single connection. MultiDoc reports are not
supported.

Requirements
l Qlik NPrinting On-Demand Add-on must be installed on the QlikView Server. See: Installing On-Demand

Add-on on a Microsoft IIS hosted QlikView AccessPoint (page 490).
l Qlik NPrinting administrator must assign On-Demand users a security role with On-Demand Create

authorization.
l Users creating On-Demand reports in QlikView must have their Windows Active Directory user account

associated with their Qlik NPrinting web console user account.
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Creating users (page 240).
l Users creating On-Demand reports in QlikView must have a domain and user associated to their Qlik

NPrinting web console user account that matches the domain and user of their QlikView Server Windows
Active Directory user account.

l Users working on a QlikView Server or Cluster with a QV Server Extranet License must be correctly
configured with an Identity, and must be logged into both Qlik NPrinting and QlikView AccessPoint.
Otherwise, bookmarks will not be available.

l Applying section access and current selections present in the QlikView document is supported.
l On-Demand sessions appear in the QVS Statistics tab of the QlikView Server, but do not count against

session CAL totals.
l On-Demand will not work with locally saved .qvw files. Files must be available on a QlikView Publisher

(QVP) connection.
l On-Demand requests only work with reports based on a single connection. MultiDoc reports are not

supported.

Accepting the Qlik NPrinting web console certificate
The default installation certificate for Qlik NPrinting web console may be registered as invalid by your browser. If
your browser registers the Qlik NPrinting web console certificate as invalid, you must accept the certificate before
you can use On-Demand in QlikView AccessPoint or Qlik Sense.

If you switch to a different browser or clear your browser’s cache, you will have to re-accept the Qlik
NPrinting certificate. On-Demand works in Chrome, Firefox, and Explorer. It does not run in Microsoft
Edge, because the certificates will not download.

Do the following:

1. Open the Qlik NPrinting web console.

2. Depending on your browser, do one of the following:
l Choose to continue to the Qlik NPrinting web console.
l Add a security exception and continue to the Qlik NPrinting web console.

3. Log into your Qlik NPrinting web console.

You can now use Qlik NPrintingOn-Demand using this browser.

Creating a Qlik NPrinting report in QlikView
Do the following:

1. In the QlikView AccessPoint interface, click the On-Demand button in the toolbar.
The Qlik NPrinting window opens.

2. Click Create a report.

3. Click a report to select the Qlik NPrinting report template that you want to use.
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4. Select an export format for the report.
Any QlikView Server selections you have made will be applied to your report output. For example, if you
set a filter to only show sales in a certain region, only that region's data will appear.

5. Click Generate report.

The report status will be listed as In queue. When the report is complete, you can download a copy to your
computer. You can cancel a report while it is In queue.

Your report may have object or report filters in Qlik NPrinting Server. These filters are also applied to your On-
Demand report, in addition to the filters in the QlikView document.

Downloading an On-Demand report
Do the following:

1. In the Qlik NPrinting window, click the report you want to download.

2. Click Download.

Deleting and canceling reports in queue
Finished reports can be deleted. Deleting a report removes it from the available reports to download in On-
Demand. Reports in queue can be canceled.

Deleting an On-Demand report
Do the following:

1. In the Qlik NPrinting window, click the report you want to delete.

2. Click .

Canceling a single report in queue
Do the following:

1. In the Qlik NPrinting window, click the report you want to cancel.

2. Click the X button.

3. Click Abort task.

Canceling all reports in queue
Do the following:

1. In the Qlik NPrinting window, click Abort all.

2. Click Abort all tasks.

Administrators with access to the Qlik NPrinting web console can manage On-Demand report requests from all
users. See: Managing On-Demand requests (page 508).
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12.8 Generating On-Demand reports in Qlik Sense
On-Demand reports are created using the On-Demand reporting button.

When you create an On-Demand report, the report is added to the report creation queue on the Qlik NPrinting
Server. Once a report is complete, it is stored in the Qlik NPrinting repository. Reports can be accessed from the
Qlik NPrinting window in QlikView AccessPoint until deleted. Reports and reports in queue are automatically
deleted from the Qlik NPrinting Server after 30 days. Failed reports are deleted after 6 days.

To enable On-Demand reporting in Qlik Sense, see: Installing Qlik Sense On-Demand reporting control (page 498).

On-Demand requests only work with reports based on a single connection. MultiDoc reports are not
supported.

Documentation for the Qlik Sense On-Demand reporting control
For documentation describing the On-Demand reporting control in Qlik Sense, including limitations and other
considerations, see On-Demand reporting control.

Requirements
l Users must be logged into Qlik Sense via NTML (Windows) authentication in order to generate reports or

create reporting buttons.

Accepting the Qlik NPrinting web console certificate
The default installation certificate for Qlik NPrinting web console may be registered as invalid by your browser. If
your browser registers the Qlik NPrinting web console certificate as invalid, you must accept the certificate before
you can use On-Demand in QlikView AccessPoint or Qlik Sense.

If you switch to a different browser or clear your browser’s cache, you will have to re-accept the Qlik
NPrinting certificate. On-Demand works in Chrome, Firefox, and Explorer. It does not run in Microsoft
Edge, because the certificates will not download.

Do the following:

1. Open the Qlik NPrinting web console.

2. Depending on your browser, do one of the following:
l Choose to continue to the Qlik NPrinting web console.
l Add a security exception and continue to the Qlik NPrinting web console.

3. Log into your Qlik NPrinting web console.

You can now use Qlik NPrintingOn-Demand using this browser.
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Creating an On-Demand reporting button
You can create an On-Demand reporting button on the sheet you are editing.

Do the following:

1. From the assets panel, under Custom objects > Dashboard bundle drag On-demand reporting to the
sheet.

2. In the property panel, under NPrinting Connection > NPrinting server URL, set the server connection.
The URL must end with /.
For example: https://<server name>:4993/

3. Under NPrinting App, select the Qlik NPrinting app that contains the report template.

4. Under NPrinting connection, select the Qlik NPrinting connection.
As the default, the list only shows Qlik NPrinting connections to the Qlik Sense app you are working in.
You can use the App/Connection filter toggle to display connections not associated with the current Qlik
Sense app.

5. Under Report Configuration > Choose Report, select the report you want to connect to the button.

6. In Default Export Format, select a default export format.

7. Under Appearances > Button Label, set the button label. For example: Generate report.

You have now created an On-Demand reporting button.

Generating a report
You can generate a report that is filtered according to the current selections in the Qlik Sense app. You need to be
in analysis mode.

You can only filter on fields that are included in the Qlik NPrinting report template, or the report will fail.
It is not possible to filter on selections using an expression.

Do the following:

1. Click on the button that you created.
The Export dialog opens.

2. There are two buttons to choose from:

a. Quick Report: generates a single report with the default output format.

b. New Report: choose from a list of reports that have been made available to you. You can also
choose the output format.

3. When the report is generated a download button is activated. Click the Download button to download the
report.

12.9 Administering On-Demand Add-on
Administrators can configure Qlik NPrinting On-Demand Add-on settings.
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Administrators with access to the Qlik NPrinting web console can manage On-Demand report requests from all
users. See: Managing On-Demand requests (page 508).

Security roles
Access to On-Demand reporting is set via security roles and is applied at the app level. This limits access to On-
Demand reports on an app-by-app basis.

For information on creating security roles, see Setting app permissions (page 230).

An admin that manages On-Demand requests needs the following rights:

l Admin > On-Demand requests. This will automatically select:
o View
o Abort
o Delete

l The role will also automatically get Apps > View access. This is required.

Configuring image quality in On-Demand reports
You can update the scheduler.config file to change the image quality of your On-Demand reports.

You can set your On-Demand reports to have higher image quality, the same as from a publish task. As soon as
you change this, all On-Demand reports will be affected. This will also affect report previews in Qlik NPrinting
Designer. Task reports will not be affected.

Report type and output format combinations that are not supported in tasks are still not supported in this case.
For example, you cannot set an image quality level on a report from a task if you are exporting a PixelPerfect
report as a .jpeg. If you run an On-Demand PixelPerfect report, setting this flag to "Veryhigh", it will look the same
as a "Normal" report. See: Image quality (page 302).

The following combinations are not supported:

l Excel to .tiff
l PixelPerfect to .gif, .jpeg, .png, .tiff
l QlikEntiy to .csv, .skv, .tab, .tiff

You should always backup your Qlik NPrinting repository before editing a .config file. For more
information, see Backing up Qlik NPrinting (page 193).

Do the following:

1. Stop the Qlik NPrinting scheduler service.

2. Open the scheduler.config configuration file.
The default path is: C:\Program Files\NPrintingServer\NPrinting\Scheduler\scheduler.config

3. Uncomment the following string: <!-- <add key="ondemand-image-quality" value="Normal" /> -->
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"Normal" is the default value.

4. You can set value to: "Normal", "High", or "Veryhigh". These are case sensitive, and have the following DPI
values:

a. Normal: 96 DPI

b. High: 192 DPI

c. Veryhigh: 384 DPI

5. Save the file and restart the service.

Configuring automatic report deletion
When you create an On-Demand report, it is added to the report creation queue on the Qlik NPrinting Server.
Once a report is complete, it is stored in the Qlik NPrinting repository, but can be downloaded in QlikView.
Reports can be accessed from the Qlik NPrinting window in QlikView AccessPoint until deleted. Reports and
reports in queue are automatically deleted from the Qlik NPrinting Server after 30 days. Failed reports are deleted
after 6 days. They can also be deleted manually.

You can change how long reports are saved by editing scheduler.config.

You should always backup your Qlik NPrinting repository before editing a .config file. For more
information, see Backing up Qlik NPrinting (page 193).

Do the following:

1. Stop the Qlik NPrinting scheduler service.

2. Open the scheduler.config configuration file.
The default path is: C:\Program Files\NPrintingServer\NPrinting\Scheduler\scheduler.config

3. Add the following two strings to file. They are not present in the default file, and can be inserted at any
point:

l <add key="completed-days-to-keep" value="30" />

l <add key="aborted-days-to-keep" value="6" />

4. You can set value to any number.

5. Save the file and restart the service.

12.10 Managing On-Demand requests
Administrators can manage the execution of On-Demand report requests.

You can open the On-Demand requests page by clicking on Admin and selecting On-Demand requests, or by
typing the URL https://YourServer:4993/#/admin/ondemand in your browser.
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Filtering requests
By default, all in-progress or finished requests are displayed. You can filter requests by View or Date range. You
can also search by user name. Clicking the black triangles next to the header titles of any column will sort column
items alphabetically.

The View drop-down list has the following options:

l All executions
l In progress
l Finished

There are two Date range drop-down lists:

l Created:
o Created

l All time:
o All time
o Today
o Yesterday
o This week
o This month
o Last 7 days
o Last 30 days
o Custom: Lets you set a specific date range.

To search by user, type the user name you are looking for into the search form on the right. The list of requests
will be dynamically filtered.

Request status

Field Description

Report The name of the report.

User The name of the user.

Status A blinking status means that the request is running. A fixed status means that the
request has finished, or stopped with Warning, Failed, or Aborted.

Created Date and time the request was created.

Elapsed time The amount of time the request has been processing.

Actions An Abort button will appear in this field when a report is running.

Request fields

You can change the number of visible rows by clicking on the numbered buttons at the bottom of the page.
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There are several types of Status:

l Warning: some reports are created correctly, but some have problems.
l Failed: all reports have problems.
l Running (only blinking): everything is going well, but the request is still in execution.
l Completed (only fixed): all reports have been correctly created and delivered.
l Queued: request is waiting to start its execution.
l Aborted: request execution was manually stopped because the user pressed the Abort button in the

request detail page.

Aborting requests
To abort a single running request, go to Actions, and click Abort.

You can also abort several requests at once.

Do the following:

1. Select one or more boxes to the left of the report names.
To select all reports, click the top or bottom box.

2. At the bottom of the list, click the Abort drop-down.

3. Click Go.
This will abort all selected requests. A green message for each request appears above the request list.
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13 Extending Qlik NPrinting
Qlik NPrinting exposes a set of REST APIs that enables you to generate reports from other software.
For example, the QlikView user interface (On-Demand), or software that is developed by a third
party.

13.1 User settings
A Qlik NPrinting administrator can configure the API user with Windows NTLM authentication. This is done by
adding the Domain account in the format <Domain>\<Username> in the user profile. The Qlik NPrinting users can
only perform the actions that are defined in their profiles. For example, in the list of apps you will see only the
apps for which the connected user is authorized. If the user is not authorized to any app, you will get an error
message or an empty list.

The API user can also be set up with JWT authentication. However, JWT authentication only works with
Qlik NPrinting and is not supported for the Qlik Sense On-Demand reporting control.

For more information on:

l Using JWT authentication with NPrinting, see JWT authentication (page 222).
l Using JWT as an API authentication method, see≤ How to configure and call APIs with JWT

authentication.
l Using Qlik Sense On-Demand reporting control, see On-Demand reporting control.

Required role
Set the privileges for On-Demand reports in the Roles administration page:

l Create: user can request the creation of reports using APIs.

APIs are always enabled for all users and roles. You cannot disable APIs.

13.2 Report settings
The Enable On-Demand check box must be selected to run a report using APIs.

13.3 APIs capabilities
Available APIs are a subset of the user interface features that allows the implementation of the On-Demand
reporting. So, On-Demand addon uses APIs.

With Qlik NPrinting APIs you can:
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l Get the list of all available apps with descriptions.
l Get the list of all available reports with descriptions.
l Get the list of all available filters with descriptions.
l Use the On-Demand feature.

Lists are filtered based on user's roles rights. For example, the list of apps contains only apps that the user is
authorized to see.

13.4 Requests and response details
All API requests require the content-type application/x-www-form-urlencoded unless otherwise specified.

All responses will be in JSON format.

All endpoints also support the HTTP OPTIONS verb, and will respond with the correct CORS headers (cross-origin
resource sharing) based on the Qlik NPrinting Server settings.

13.5 Date and time format
Qlik NPrinting APIs supports the ISO 8601 (RfC 3339) date and time format for requests and responses.

13.6 Detailed documentation for developers
Detailed Qlik NPrinting APIs documentation for developers is available.

13.7 Getting started
The Qlik NPrinting API is a REST API that you use to manage your Qlik NPrinting objects
programmatically. A subset of the functionality that you find in the Qlik NPrinting Web Console is
available through the API.

The objects you manipulate in the Qlik NPrinting Web Console are represented in the API as JSON entities. These
entities have properties that correspond to the settings you find in the Qlik NPrinting Web Console. The API has a
set of endpoints that allow you to create, retrieve, update, and delete entities for apps, users, groups, reports,
and so on. For all requests, the data returned is filtered based on user permissions, that is, if a user is not
authorized to access a certain entity, that entity is not returned in the response.

A user must have an associated domain account to log into the API as an authenticated Windows user. For more
information about configuring a domain account, see Creating users (page 240).

To help familiarize you with the API, we will walk through some simple examples using a REST client called
Postman. You will learn how to:

l Connect and authenticate your user credentials
l Retrieve a list of apps
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l Update an entity
l Create a filter

Before you start, you will need to:

l Install Postman from:
≤ http://www.getpostman.com/

l Know the URL for the computer where Qlik NPrinting Server is installed.

Depending on your environment, you may need to configure Chrome to accept self-signed certificates.
See the Chrome documentation for additional information and instructions.

Windows authentication
Windows authentication must be turned on in order to allow external connections such as GET and POST REST
connections to work normally. This setting can be toggled in the Qlik NPrinting web console under Admin>
Settings > Authentication.

Connecting to Qlik NPrinting APIs
By default, Qlik NPrinting Server listens for REST requests on port 4993, so the URL is:

https://NPrinting.server.name:4993/api/v1/<path>

Authenticating your user credentials
Before you do anything with the NPrinting API, you must authenticate your user credentials.

In the example that follows, we will authenticate with the current Windows user name.

Open Postman and fill in the fields as shown below. Replace NPrinting.server.name with the URL of the
computer where your Qlik NPrinting Server is installed.

{

"result": "ae2f7261-7a1c-4f2f-8b5f-bf4247940dd5",

"code":0,

"message":null

}
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Retrieving a list of apps
The following endpoint returns a complete list of Qlik NPrinting apps that the current user has permission to see.

Open Postman and fill in the fields as shown below, replacing NPrinting.server.name with the URL of the
computer where your Qlik NPrinting Server is installed:

{

"data": {

"items": [

{

"id": "270f21ea-98eb-471c-8338-5e2ad2c39e",

"name": "Global Sales Report",

"description": null,

"created": "2018-03-05T18:50:16z",

"lastUpdate": "2018-03-05T18:50:16z"

},

{

"id": "450f21ea-78eh-432c-8338-5e233p9e",

"name": Sales&Shipping",

"description": null,

"created": "2018-04-05T18:50:16z",

"lastUpdate": "2019-04-05T18:50:16z"

}

],

"totalItems": 2,

"offset": 0,

"limit": 50

}

}
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The response includes the ID, title, and other details about each app.

Updating an entity
You can update certain entities through the API by using the PUT method. When you update an entity, Qlik
NPrinting Server may substitute default values for omitted properties, so we recommend that you always include
the entire entity when you perform an update.

In this example, we will update the email property of the users entity.

To update the entity:

1. If you do not know the ID of the user you want to update, enter the following path in Postman and send a
GET request:
/users

Search for the user ID in the response.

2. Append the user ID to the users path in Postman and send a GET request:
/users/{id}
The response should look something like this:
{

"data": {

"id": "113ac265-163e-4feb-854e-ade3cdafc837",
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"email": "abc@example.com",

"created": "2018-02-22T16:17:18Z",

"lastUpdate": "2018-02-28T18:20:57Z",

"enabled": true,

"userName": "Test",

"domainAccount": "domain\\test",

"timezone": "Europe/Rome",

"locale": "En",

"folder": "test folder",

"subFolder": "test subFolder"

}

}

3. Copy the content surrounded by the inner parentheses from the returned entity and paste it into the body
of a new PUT request.

4. Change the value of email.

5. Add the password property and corresponding value to the entity. The body of the request should look
something like this:
{

"password": "test",

"id": "113ac265-163e-4feb-854e-ade3cdafc837",

"email": "xyz@example.com",

"created": "2018-02-22T16:17:18Z",

"lastUpdate": "2018-02-28T18:20:57Z",

"enabled": true,

"userName": "Test",

"domainAccount": "domain\\test",

"timezone": "Europe/Rome",

"locale": "En",

"folder": "test folder",

"subFolder": "test subFolder"

}

6. With the updated entity in the body, send a PUT request using the following path:
users/{id}

In this example, {id} would be 113ac265-163e-4feb-854e-ade3cdafc837.

7. Send a GET request using the same path to verify the change.

Creating a filter
You can create filters for tasks, reports, users, and objects through the API by using the POST method. In this
example, we create a simple filter for CategoryName, which is a field in the data source of a sales application.

1. To create a filter, you need to know the IDs of the app and connection that you want to apply the filter to.
To retrieve the IDs, send a GET request using Postman to each of the following paths:
/apps

/connections
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For example, to get the app ID, send a GET request to NPrinting.server.name:4993/api/v1/apps.
Search for the IDs in the responses.

2. Here is an example of the code that includes the app and connection IDs in the body of a POST /filters

request:
{

"appId": "de867383-3d6a-4f37-8fe5-387552c60d3f",

"enabled": true,

"name": "AverageSaleByCategory",

"description": null,

"fields": [

{

"connectionId": "9a7b1016-8d22-46ac-a384-158f715547a7",

"name": "CategoryName",

"overrideValues": false,

"values": [

{

"value": "Bath Clothes",

"type": "text"

},

{

"value": "Men´s Clothes",

"type": "text"

}]

}]

}

The response includes the ID of the newly created filter, which is returned in the location header.

What to do next
Now that you have seen some requests in the Qlik NPrinting API, try some of the other API endpoints, for
example, to start a new task execution.

13.8 Connecting using Microsoft .NET Framework
The Microsoft .NET Framework features a number of languages that have native functions for connecting to web
services.

The examples in this section show how to use .NET with C# to connect to the Qlik NPrinting API and retrieve a list
of apps in JSON format

A trusted SSL certificate is required to establish an SSL/TLS connection to the server.

Qlik NPrinting - February 2024 517

13   Extending Qlik NPrinting



Connecting using Microsoft Windows authentication
The following example shows one way of connecting to the Qlik NPrinting Server using Microsoft Windows
authentication in a .NET console application. Remember to substitute server.name.com with your actual Qlik
NPrinting Server name.

static void Main(string[] args)

{

//Create the HTTP Request (authenticate) and add required headers

ServicePointManager.SecurityProtocol = SecurityProtocolType.Tls12;

HttpWebRequest request = (HttpWebRequest)WebRequest.Create(@

"https://server.name.com:4993/api/v1/login/ntlm");

request.Method = "GET";

request.UserAgent = "Windows";

request.Accept = "application/json";

// specify to run as the current Microsoft Windows user

request.UseDefaultCredentials = true;

try

{

// make the web request and return the content

HttpWebResponse response = (HttpWebResponse)request.GetResponse();

StreamReader responseReader = new StreamReader

(response.GetResponseStream());

string sResponseHTML = responseReader.ReadToEnd();

Console.WriteLine(sResponseHTML);

}

catch (Exception ex)

{

Console.WriteLine(ex.Message);

}

Console.Read();

}

Retrieving a list of Qlik NPrinting apps
The following code extends the previous example of a .NET console application by creating an
authenticated connection and retrieving a list of Qlik NPrinting apps. Remember to substitute
server.name.com with your actual Qlik NPrinting Server name.

The JSON deserialization method in this example uses a third-party library from Newtonsoft to convert
JSON to an object.
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static void Main(string[] args)

{

//Create the HTTP Request (authenticate) and add required headers

ServicePointManager.SecurityProtocol = SecurityProtocolType.Tls12;

HttpWebRequest request = (HttpWebRequest)WebRequest.Create(@

"https://server.name.com:4993/api/v1/login/ntlm");

CookieContainer cookies = new CookieContainer();

request.CookieContainer = cookies;

request.Method = "GET";

request.UserAgent = "Windows";

request.Accept = "application/json";

// specify to run as the current Microsoft Windows user

request.UseDefaultCredentials = true;

try

{

// make the web request and return the content

HttpWebResponse response = (HttpWebResponse)request.GetResponse();

StreamReader responseReader = new StreamReader

(response.GetResponseStream());

string sResponseHTML = responseReader.ReadToEnd();

Console.WriteLine(sResponseHTML);

}

catch (Exception ex)

{

Console.WriteLine(ex.Message);

}

//Create second HTTP request (get list of apps) and add required headers

HttpWebRequest secondRequest = (HttpWebRequest)WebRequest.Create(@

"https://server.name.com:4993/api/v1/apps");

//assign cookie to request to maintain session

secondRequest.CookieContainer = cookies;

secondRequest.Method = "GET";

secondRequest.UserAgent = "Windows";

secondRequest.Accept = "application/json";

// specify to run as the current Microsoft Windows user

secondRequest.UseDefaultCredentials = true;

try

{

HttpWebResponse response2 = (HttpWebResponse)secondRequest.GetResponse

();

StreamReader responseReader2 = new StreamReader

(response2.GetResponseStream());

string sResponseHTML2 = responseReader2.ReadToEnd();
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dynamic jsonObj = JsonConvert.DeserializeObject(sResponseHTML2);

foreach (var app in jsonObj.data.items)

{

Console.WriteLine(app.name);

}

}

catch (Exception ex)

{

Console.WriteLine(ex.Message);

}

Console.Read();

}

Adding a new user
The following C# code creates an authenticated connection and then adds a new user to the Qlik NPrinting Server
Repository database. Remember to substitute server.name.com with your actual Qlik NPrinting Server name.

The JSON serialization method in this example uses a third-party library from Newtonsoft to convert an
object to JSON.

static void Main(string[] args)

{

//Create the HTTP Request (authenticate) and add required headers

ServicePointManager.SecurityProtocol = SecurityProtocolType.Tls12;

HttpWebRequest request = (HttpWebRequest)WebRequest.Create

(@"https://server.name.com:4993/api/v1/login/ntlm");

//Assign custom SSL certificate validation method if certificate is

untrusted

//request.ServerCertificateValidationCallback += (sender, certificate,

chain, sslPolicyErrors) => true;

CookieContainer cookies = new CookieContainer();

request.CookieContainer = cookies;

request.Method = "GET";

request.UserAgent = "Windows";

request.Accept = "application/json";

//Specify to run as the current Microsoft Windows user

request.UseDefaultCredentials = true;

try

{

// make the web request and return the content

HttpWebResponse response = (HttpWebResponse)request.GetResponse();

StreamReader responseReader = new StreamReader

(response.GetResponseStream());
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string sResponseHTML = responseReader.ReadToEnd();

Console.WriteLine(sResponseHTML);

}

catch (Exception ex)

{

Console.WriteLine(ex.Message);

}

//Create second HTTP request to add a new user and required headers

HttpWebRequest secondRequest = (HttpWebRequest)WebRequest.Create

(@"https://server.name.com:4993/api/v1/users");

//Assign custom SSL certificate validation method if certificate is

untrusted

//secondRequest.ServerCertificateValidationCallback += (sender, certificate,

chain, sslPolicyErrors) => true;

//Add the XSRF token

secondRequest.Headers.Add("X-XSRF-TOKEN", cookies.GetCookies

(request.RequestUri)["NPWEBCONSOLE_XSRF-TOKEN"].Value);

secondRequest.CookieContainer = cookies;

secondRequest.Method = "POST";

secondRequest.UserAgent = "Windows";

secondRequest.Accept = "application/json";

secondRequest.ContentType = "application/json";

//Specify to run as the current Microsoft Windows user

secondRequest.UseDefaultCredentials = true;

//Prepare JSON object to send to the remote server

JsonUser user = new JsonUser();

user.Email = "name@domain.com";

user.Enabled = "true";

user.UserName = "NewUser";

user.DomainAccount = "domain\\user";

user.Timezone = "CET";

user.Locale = "En";

user.Folder = "NewUser";

user.SubFolder = "NewUser";

user.Password = "Password123";

string jUserString = JsonConvert.SerializeObject(user);

using (var streamWriter = new StreamWriter(secondRequest.GetRequestStream

()))

{

streamWriter.Write(jUserString);

streamWriter.Flush();

streamWriter.Close();
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}

try

{

HttpWebResponse response2 = (HttpWebResponse)secondRequest.GetResponse

();

StreamReader responseReader2 = new StreamReader

(response2.GetResponseStream());

string sResponseHTML2 = responseReader2.ReadToEnd();

}

catch (Exception ex)

{

Console.WriteLine(ex.Message);

}

}

public class JsonUser

{

public string Email { get; set; }

public string Enabled { get; set; }

public string UserName { get; set; }

public string DomainAccount { get; set; }

public string Timezone { get; set; }

public string Locale { get; set; }

public string Folder { get; set; }

public string SubFolder { get; set; }

public string Password { get; set; }

}

13.9 Qlik NPrinting API reference

Access the Qlik NPrinting API reference documentation.
≤ Qlik NPrinting - API reference
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14 Troubleshooting
There are several things you can do to troubleshoot and resolve problems before logging a case
with product support. The guidance here is designed to help you understand the problem, and
learn where to look for possible errors and potential solutions.

Before you call support:

l Understand the problem (page 523)
l Use the log files (page 524)
l Study the Qlik NPrinting help
l Read the troubleshooting topics in this section.

If you cannot find a solution in the product help, then follow the general guidance in this topic.

14.1 Understand the problem
Understanding the problem may help you to find a solution, and will enable you to provide Qlik support with the
information needed to process your case more effectively. Ensure that you understand the problem and can
describe it as fully as possible before seeking further support:

Questions to ask Answers

Who experienced the problem? What type of users were affected and how many?
This can help you to determine if it is a global issue, a
configuration problem, a component problem, or due to
user configuration.

What happened after an action was performed? Pay attention to any symptoms, behavior, and error
messages.

This can help you to identify which component is causing
the error, and which log files to use.

When did the problem first occur? When is it triggered, and what user action or system action
causes it?
For example, a scheduled Qlik NPrinting task fails, an error
is thrown when attempting to edit a template, or document
metadata is not generated.

Have you experienced this issue before? If yes, how often has the problem occurred?

Troubleshooting questions
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Questions to ask Answers

Where did the problem occur first? Describe where in the system or environment the problem
appears?
For example, in the Qlik NPrinting Designer frontend, or in
the backend (scheduler or engine).

Why do you think it happened? Gather the relevant log files. Compare log files that include
the problem with those that do not.
For example, compare a successful, and unsuccessful task
execution of the same report. For log file locations, see the
individual product help pages.

14.2 Use the log files
To troubleshoot and resolve issues effectively you need to understand how to use the log files. You also need to
know when to use the default logs, and when to use the archived log files.

When you get an error message, the following steps can help you to identify which component has failed:

1. Read the error message carefully as it can tell you which component has failed.

2. Navigate to the default log files for the failed component.

3. When you have found the correct log file, search for errors to identify the issue.

Default log files
These log files are stored in C:\ProgramData\NPrinting\Logs:

l nprinting_scheduler.log - log files for scheduled tasks, and scheduled reloads.
l nprinting_webengine.log - log files for connections to apps and Qlik Sense, QlikView servers,

authentication, and licensing issues.
l nprinting_engine.log - log files for connections to apps, licensing issues, and metadata generation.

14.3 Qlik NPrinting application problems
l Was Qlik NPrinting working before the problem occurred?
l Have you reloaded the metadata?

See: Working with apps (page 20)
l In Qlik NPrinting, navigate to C:\ProgramData\NPrinting\Logs to view the log files.

See: Logging (page 270)
l Check that your Qlik NPrinting users have the appropriate users rights.

See: Creating connections (page 21)
l Check if the Qlik NPrinting version is compatible with your QlikView, or Qlik Sense installation.

See: System requirements for Qlik NPrinting Engine (page 125)
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14.4 Troubleshooting logs
The log messages produced by Qlik NPrinting provide important information that can be used to
detect security incidents, operational problems, and policy violations.

Where are the log files stored?
Logs are stored in the %ProgramData%\Nprinting\Logs folder. The default location is
C:\ProgramData\NPrinting\Logs.

How to change the log level
The log level is set to INFO by default. You can change the log level to DEBUG of a Windows service.

Do the following:

1. Open the appropriate configuration file with a text editor:
l C:\Program Files\NPrintingServer\NPrinting\Engine\Qlik.NPrinting.Engine.exe.config
l C:\Program Files\NPrintingServer\NPrinting\Scheduler\Qlik.NPrinting.Scheduler.exe.config
l C:\Program Files\NPrintingServer\NPrinting\WebEngine\Qlik.NPrinting.WebEngine.exe.config

Where C:\Program Files\NPrintingServer is the Qlik NPrinting Server installation path. Adapt it to your
installation if necessary.
If you want to view Qlik NPrinting On-Demand logs, you need to set Qlik.NPrinting.Engine.exe.config to
DEBUG.

2. Search for:
<root>

<level value="INFO" />

<appender-ref ref="LogFileAppender" />

<!--Uncomment the row below and set the level value above to obtain the logs in the file

nprinting_engine_dev.log-->

<!--<appender-ref ref="LogFileAppenderDev" />-->

<appender-ref ref="LogFileAppender" />

</root>

3. Change level value to "DEBUG":
<root>

<level value="DEBUG" />

<appender-ref ref="LogFileAppender" />

<!--Uncomment the row below and set the level value above to obtain the logs in the file

nprinting_engine_dev.log-->

<!--<appender-ref ref="LogFileAppenderDev" />-->

<appender-ref ref="LogFileAppender" />

</root>

4. Uncomment: <!--<appender-ref ref="LogFileAppenderDev" />-->

5. Save the edited files.

6. Restart the corresponding Windows service.

When you change a log level to DEBUG, a new log file is created. The new log file has the same name as the log
file with INFO details level followed by _dev. For example:
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l nprinting_scheduler_dev.log
l nprinting_webengine_dev.log
l nprinting_engine_dev.log

The default log files will still be present and will continue to only have INFO level information.

14.5 Qlik NPrinting License activation error

Possible cause

The Qlik NPrinting 17 and newer license has not been activated correctly.

If after installation, the license has not been activated, the following message is displayed in the scheduler log
file:

FATAL Qlik.NPrinting.Repo.Service.LicenseService - !!!!!!!!!!!!!!!! LICENSE VIOLATIONS DETECTED

FATAL Qlik.NPrinting.Repo.Service.LicenseService - The number of USERS exceeds the current license limit (1 found,
but 0 allowed).

INFO Qlik.NPrinting.Scheduler.SchedulerHttpService - Scheduler service started successfully

INFO Qlik.NPrinting.Repo.Service.LicenseService - License expiration is close. Checking for license update...

ERROR Qlik.NPrinting.Repo.Service.SessionManager - Error within WithSession method of SessionManager.

ERROR Qlik.NPrinting.Repo.Service.SessionManager - Invalid License key

ERROR Qlik.NPrinting.Repo.Service.LicenseService - Qlik.NPrinting.Repo.ServiceException: Invalid License key

at Qlik.NPrinting.Repo.Service.LicenseService.UpdateLicense() in
c:\Users\LED\Desktop\repo\opera\server\NPrinting\src\Repo\Service\LicenseService.cs:line 243

at Qlik.NPrinting.Repo.Service.LicenseService.AutoUpdateIfCloseToExpiration() in
c:\Users\LED\Desktop\repo\opera\server\NPrinting\src\Repo\Service\LicenseService.cs:line 331

at Qlik.NPrinting.Repo.Service.SessionManager.<>c__DisplayClass7.<WithSession>b__6(ISession s) in
c:\Users\LED\Desktop\repo\opera\server\NPrinting\src\Repo\Service\SessionManager.cs:line 57

at Qlik.NPrinting.Repo.Service.SessionManager.WithSession[T](Func`2 body, IsolationLevel isolationLevel, Boolean
readOnly) in c:\Users\LED\Desktop\repo\opera\server\NPrinting\src\Repo\Service\SessionManager.cs:line 116

at Qlik.NPrinting.Repo.Service.LicenseService.<Start>b__5() in
c:\Users\LED\Desktop\repo\opera\server\NPrinting\src\Repo\Service\LicenseService.cs:line 301

Proposed action

Log into the web console as an administrator, enter https://YourServer:4993, and then activate your license.

Qlik NPrinting - February 2024 526

14   Troubleshooting



14.6 Qlik NPrinting Engine with QlikView Desktop license error

Possible cause

The Qlik NPrinting Engine needs QlikView Desktop installed, with a license activated for the Windows user that
runs the service.

Proposed action

Activate one of the allowed QlikView Desktop licenses.

If you use assigned CALs, you need to connect the QlikView Desktop to the QlikView Server at least once, at the
beginning, using the same Windows user and computer as the Qlik NPrinting Engine service. A Named CAL
license, taken from a QlikView Server, is valid only for a single QlikView Desktop user. In the case of a multiple
Qlik NPrinting Engine installation, you must set a different Windows user and a different QlikView Desktop Named
CAL license for each Qlik NPrinting Engine. If you use the same QlikView Desktop Named CAL license two or more
times, the QlikView Server will disconnect all QlikView Desktops but one, and report generation will fail. System
requirements for Qlik NPrinting Engine

Do the following:

1. Find Qv.exe in the installation path.

2. Press and hold SHIFT, right-click Qv.exe, and then select Run as different user.

3. Open a .qvw document in the QlikView Server by using qvp. This will bind the license.

4. Close QlikView Desktop.

5. Restart the Qlik NPrinting Engine service.

Check also that the engine is enabled.

Do the following:

1. Open the Qlik NPrinting web console.

2. Select Admin.

3. Click Engine manager.

4. Select the Enabled check box.

14.7 Qlik NPrinting Engine Offline status

Possible cause

The status of a Qlik NPrinting Engine is always "Offline" on the Engine manager page.

Proposed action

Do the following:
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1. If an engine goes offline a few seconds after starting, check the nprinting_engine.log file stored on the
computer. The text QlikView license violation detected means that you have to activate a QlikView Desktop
license for the Windows user who runs the service.

2. Check that the Qlik NPrinting Engine and the Qlik NPrinting scheduler service services and processes are
running. A failure of the Qlik NPrinting scheduler service can cause the engine status to not be updated.

3. If Qlik NPrinting scheduler service and Qlik NPrinting Engine are running on different computers, or if you
provided a computer name or a fully qualified domain name (FQDN) to the Qlik NPrinting Engine installer
(including localhost), check that port 5672 is open for inbound connections on the Qlik NPrinting
scheduler service computer.

4. If you used localhost for the computer name during the engine installation, open a command prompt
(cmd.exe) and check that ping localhost works. Some DNS configurations prevent localhost from being
resolved to the loopback network interface.

5. Check that the computer name is correct on the Engine manager page. Do not use a fully qualified
domain name (FQDN) or localhost.

6. Check the engine and scheduler logs for connection errors or other failures. If failures appear in the logs,
refer to their troubleshooting help to resolve the failure, then restart the services.

Possible cause

Your engine is "Offline" and you recently did all of the following:

l Upgraded to Qlik NPrinting September 2019 or higher, from one of the following versions:
o November 2018
o February 2019
o April 2019
o June 2019

l Changed the services user accounts. See: User accounts (page 136)

Proposed action

Do the following:

1. In the Qlik NPrinting web console, go to Admin > Engine manager.

2. Remove and recreate the related engine entry.

3. Fill out the certificate form to send the new certificates to the engine.

14.8 Qlik NPrinting Engine Error status

Possible cause

The QlikView Desktop license for the Windows user who runs Qlik NPrinting services is not activated. An engine
displays an Error status on the Engine manager page. In a single engine installation, reports are not produced.
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Proposed action

Activate the QlikView Desktop license for the Windows user who runs Qlik NPrinting services.

Also check the Qlik NPrinting log files to be sure there are no other errors.

14.9 Qlik NPrinting messaging service (RabbitMQ) start up and
connection problems

The steps below work for Qlik NPrinting versions embedding RabbitMQ version 3.8.3. You can check the correct
path for your installation.

Do the following:

1. Open a new command prompt, by selecting Run as Administrator. Run:
l cd %ProgramFiles%\NPrintingServer
l dir

2. Note the RabbitMQ installation folder. It starts with rabbitmq_server.

3. Replace the folder name with the correct folder, including the correct version number in all
troubleshooting commands.

Possible cause

If reports are not produced, or engines never go to Online status, or if the Qlik NPrinting scheduler service stops
after about one minute from start up, the Qlik NPrinting messaging service (RabbitMQ) may have stopped or it
may be unreachable.

The scheduler log shows a message like:

*********************************************

Error: RabbitMQ message broker is unreachable

Shutting down scheduler service

*********************************************

Or like:

*********************************************

RabbitMQ service is not connected - trying again in 3 seconds

*********************************************

Proposed action

Check the service status

1. Check that Qlik NPrinting messaging service is running.

Check the messaging service users and permissions

1. Copy the .erlang.cookie file from the system profile folder (C:\WINDOWS\system32\config\systemprofile\)
and replace it in the %USERPROFILE% folder (C:\Users\npadmin).
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2. Open a new command prompt as Administrator.

3. Navigate to the RabbitMQ sbin folder: %ProgramFiles%\NPrintingServer\rabbitmq_server-3.8.3\sbin.

4. Run the following command:
rabbitmqctl.bat list_permissions

The output should be:
Listing permissions for vhost "/" ...

user configure write read

client_engine .* .* .*

client_webengine .* .* .*

remote .* .* .*

client_audit .* .* .*

client_scheduler .* .* .*

5. If the ouput is different go to Fix the messaging service users and permissions.

Check the service certificates

1. Open a new command prompt as Administrator.

2. Navigate to the certificates generator folder:
%ProgramFiles%\NPrintingServer\NPrinting\RabbitMQCertificatesGenerator.

3. Run the following command:
RabbitMQCertificatesGenerator.exe -d -c

"C:\ProgramData\NPrinting\certificates"

4. If the output has warnings or errors due to missing or invalid certificates go to Recreate the messaging
service certificates.

Check the node status on the RabbitMQ console

1. Copy the .erlang.cookie file from the system profile folder (C:\WINDOWS\system32\config\systemprofile\)
and replace it in the %USERPROFILE% folder (C:\Users\npadmin).

2. Open a new command prompt as Administrator.

3. Navigate to the RabbitMQ sbin folder: %ProgramFiles%\NPrintingServer\rabbitmq_server-3.8.3\sbin.

4. Run the following command:
rabbitmqctl.bat status

5. Check the output. The main sections to check are the following:
Runtime

OS PID: 12128

OS: Windows

Uptime (seconds): 23801

RabbitMQ version: 3.8.3

Node name: rabbit@localhost

Erlang configuration: Erlang/OTP 22 [erts-10.6] [64-bit] [smp:12:12] [ds:12:12:10] [async-

threads:64]

Erlang processes: 316 used, 1048576 limit

Scheduler run queue: 1

Cluster heartbeat timeout (net_ticktime): 60

Plugins

Enabled plugin file: C:/ProgramData/NPrinting/RabbitMQ/enabled_plugins
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Enabled plugins:

* rabbitmq_auth_mechanism_ssl

Data directory

Node data directory: c:/ProgramData/NPrinting/RabbitMQ/db/rabbit@localhost-mnesia

Config files

* c:/ProgramData/NPrinting/RabbitMQ/advanced.config

Listeners

Interface: [::], port: 25672, protocol: clustering, purpose: inter-node and CLI tool

communication

Interface: 0.0.0.0, port: 5672, protocol: amqp/ssl, purpose: AMQP 0-9-1 and AMQP 1.0 over

TLS

Interface: [::], port: 5672, protocol: amqp/ssl, purpose: AMQP 0-9-1 and AMQP 1.0 over TLS

6. If the command fails or if the output is different from the expected, go to Recreate the Qlik NPrinting
messaging service.

7. If you encounter command errors you can run the following command to get a more detailed error:
rabbitmq-server.bat

Fix the messaging service users and permissions

1. Copy the .erlang.cookie file from the system profile folder (C:\WINDOWS\system32\config\systemprofile\)
and replace it in the %USERPROFILE% folder (C:\Users\npadmin).

2. Open a new command prompt as Administrator.

3. Navigate to the certificates generator folder:
%ProgramFiles%\NPrintingServer\NPrinting\RabbitMQCertificatesGenerator

4. Run the following command:
RabbitMQCertificatesGenerator.exe -p

"%ProgramFiles%\NPrintingServer\rabbitmq_server-3.8.3"

5. Restart the services

Recreate the Qlik NPrinting messaging service

1. Take a backup of folder C:\Programdata\NPrinting\RabbitMQ and place it in another location

2. Copy the .erlang.cookie file from the system profile folder (C:\WINDOWS\system32\config\systemprofile\)
and replace it in the %USERPROFILE% folder (C:\Users\npadmin).

3. Open a new command prompt as Administrator.

4. Stop all services, and close the services.msc window.

5. Stop the epmd.exe process by running the following command: taskkill /f /im epmd.exe

6. Navigate to the RabbitMQ sbin folder: %ProgramFiles%\NPrintingServer\rabbitmq_server-3.8.3\sbin

7. Remove everything inside the folder C:\ProgramData\NPrinting\RabbitMQ except for the files enabled_
plugins and advanced.config.

8. Run the following command: rabbitmq-service.bat remove
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9. Add the system environment variable ERLANG_HOME (if missing) with the path to the Erlang base folder
(C:\Program Files\erl10.6)

10. Close the command prompt and open a new one as Administrator.

11. Navigate to the RabbitMQ sbin folder: %ProgramFiles%\NPrintingServer\rabbitmq_server-3.8.3\sbin

12. Run the following command:
rabbitmq-service.bat install

13. Run the following command:
rabbitmq-service.bat start

14. If the service doesn't start you can try running this command to get a more detailed error: rabbitmq-
server.bat

15. Go to Recreate the messaging service certificates and complete the steps.

Recreate the messaging service certificates

1. Open a new command prompt as Administrator.

2. Navigate to the certificates generator folder:
%ProgramFiles%\NPrintingServer\NPrinting\RabbitMQCertificatesGenerator

3. Run the following command: RabbitMQCertificatesGenerator.exe -f -c
"C:\ProgramData\NPrinting\certificates" -p

"%ProgramFiles%\NPrintingServer\rabbitmq_server-3.8.3"

This step also fixes the messaging service users and permissions

4. Reinstall the Qlik NPrinting Engines and reconfigures them from the Qlik NPrinting web console. Go to
Admin > Engine manager) to work with the new certificates.

5. Restart the services

14.10 Qlik NPrinting RepoService service won't start

Possible cause

The Qlik NPrintingRepoService may not start after restarting the host machine, or after a forced system
shutdown, if the PostgreSQL file postmaster.pid is corrupted.

Proposed action

If you encounter problems starting the Qlik NPrintingRepoService, complete following steps.

1. Stop all of the Qlik NPrinting services. For more information about services, see Architecture (page 131).

2. Delete the postmaster.pid file from the C:\ProgramData\NPrinting\data folder.

3. Start the Qlik NPrinting services.
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14.11 Qlik NPrinting Engine service logout failure

Possible cause

If an Qlik NPrinting Engine uninstall fails, after the rollback, the Qlik NPrinting Engine service may be unable to
start. The Windows Services page shows the following error:

The service did not start due to a login failure.

Proposed action

To fix this issue the service credentials must to be re-entered.

Do the following:

1. Open the Windows Services page.

2. Right click on the Qlik NPrinting Engine service and select Properties.

3. Click the Log On tab.

4. Enter the service user account name and the password.

5. Click OK.

6. Start the service.

14.12 Firefox browsers not working with Kerberos authentication

Possible cause

Firefox will not work correctly with Kerberos authentication if the default browser settings are applied.

Proposed action

To enable the Kerberos authentication on Firefox you must customize the configuration.

Do the following:

1. Open your Firefox browser and enter about:config in the address bar.

2. In the Filter field, enter negotiate.

3. Double-click network.negotiate-auth.trusted-uris. This preference lists the trusted sites for Kerberos
authentication.

4. Enter your domain.

5. Click OK.

The domain that you entered in the network.negotiate-auth.trusted-uris should now appear in Value column.

If you have not installed the Qlik NPrinting certificates, you should also toggle the network.negotiate-
auth.allow-non-fqdn option from false to true.
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14.13 Connection timeouts and long running tasks

Possible cause

In heavy loading scenarios, several report generation tasks are scheduled every second. If you experience long
run times or timeouts, it could mean that there are not enough available connections to the PostgreSQL
database.

Proposed action

Check the Qlik NPrinting scheduler service nprinting_scheduler.log file for connection errors. If you have limit
problems, you will find errors related to:

l database connection issues
l timeouts during wait from pooled connections

This means you need to increase the maximum number of connections to the PostgreSQL database.

Do the following:

1. Log into the computer where the Qlik NPrinting scheduler service is running. The PostgreSQL database is
located on this computer.

2. Open the %ProgramData%\NPrinting\data folder.

3. Open the postgresql.conf file with a text editor.

4. Find the parameter max_connections. The parameter is set to 100 by default.

5. Set max_connections to a greater value.

6. Restart the Qlik NPrinting scheduler service.

14.14 Connection status not shown in Qlik NPrinting web console

Possible cause

The connection status is set the first time you open a QlikView document to generate the connection cache, or a
report. If a task is already in progress on the same connection, the status is not shown straight away. The task is
queued and you must wait a short time before the status is updated.

Proposed action

Typically, a status update takes 15-30 seconds after the first task has started. It can take longer if other reports
are already running on other Qlik NPrinting Engines.

14.15 Connection status error

Possible cause

The Qlik NPrinting Engine is unable to open a document, and you get a connection status error.
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Proposed action

If you encounter problems when creating connections, perform the following steps.

1. Check that the local path and name of the .qvw file are correct. Remember to use the full path including
the drive and file extension. Open QlikView Desktop, and then open the .qvw file by copying and pasting
the path.

It does not matter if the .qvw file is local, on a network folder, or on a server. You must be able to
open the document from the QlikView Desktop.

2. If you are using a local connection and a local path to the document, check that the document has been
copied to the computer that the engine is running on and not to another scheduler or engine computer.

3. If you are using a network path in the connection, check the network share is reachable from the engine.

4. Mapping a network drive is not supported. You must use a UNC (Universal Naming Convention). For
example: \\ServerName\DocumentFolder\document.qvw.

5. If you are using a server connection, check that the server path is correct. Remember to include any
folders that are on the server in the server path.

6. If you are using a server connection, ensure that the server is reachable from the Qlik NPrinting Engine.

7. If you are using a server connection, always use the same versions of both QlikView Server and QlikView
Desktop on the engine computer. If you use different versions, you may be able to open the document
manually on the QlikView Desktop on the engine, but cache generation will fail.

8. Check that the QlikView Desktop has an active license for the Windows user that is running the engine
service. Find the Qv.exe file in its installation path. Hold down SHIFT, and then right-click the file. Select
Run as a different user, and then enter the credentials of the Qlik NPrinting Windows user.

QlikViewPersonal Edition is not supported.

9. If you have Windows Interactive Service Detection active, click View the message, and then check the
status of QlikView open in session zero. Messages may contain useful information, such as a request to
execute a macro in the source .qvw file.

10. Check the logs in the %ProgramData%\NPrinting\Logs folder for errors.

14.16 Connection status Warning: One or more engines are not
working

Possible cause

A Warning connection status with the message One or more engines are not working happens in a multi-
engine environment when the connection fails in one of the engines. Other engines may be working correctly on
the same connection, or have not tried to open the connection yet.

Proposed action

Check the engine logs on the computers where the engines are installed to find out which one is failing.
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Perform connection troubleshooting on the failing engine. Be sure that QlikView documents and network shares
are accessible or QlikView Server are reachable from that particular computer.

14.17 Initial error in the Qlik NPrinting web engine log file
(parameterless constructor)

Possible cause

The following error appears in the Qlik NPrinting web engine log file nprinting_webengine.log:

2016-01-11 17:39:50,430 [19] ERROR Qlik.NPrinting.WebEngine.ExceptionHandling.GenericTextExceptionHandler -
Unhandled exception in request:http://c4w07345.itcs.hpecorp.net:4996/npe/tasks/publish?count=5&orderBy=-
lastUpdate&page=1.

Exception: An error occurred when trying to create a controller of type 'PublishReportTasksController'. Make sure
that the controller has a parameterless public constructor.

It is due to a path in the home page that is not accessible by users that are not logged in.

The error appears when a user that has not logged in attempts to access the Qlik NPrinting web console.

Proposed action

Log in to the Qlik NPrinting web console and the error should disappear. This error does not cause report
creation failure.

14.18 QlikView Navigator process stuck messages

Possible cause

A QlikView process health check generates a report if there are processing errors that cause excessive CPU usage.
When this happens, the process is monitored and terminated if it appears locked.

Example error state messages:

2015-12-02 18:13:58,935 [34] WARN Engine.Navigator.QlikView.QV11.QlikViewNavigator.

[25064]::navigator=qlikview;documentpath=C:\nprinting\global\dashboard.qvw - QlikView CPU

monitor: process seems stuck due to cpu usage of 76.05 % in 1238ms. Waiting for idle for 2000ms

2015-12-02 18:13:59,111 [34] WARN Engine.Navigator.QlikView.QV11.QlikViewNavigator.

[25064]::navigator=qlikview;documentpath=C:\nprinting\global\dashboard.qvw - QlikView CPU

monitor: process is stuck due to cpu usage of 65.00 % in 1414ms

Back to normal message:

2015-12-02 18:13:59,111 [34] WARN Engine.Navigator.QlikView.QV11.QlikViewNavigator.

[25064]::navigator=qlikview;documentpath=C:\nprinting\global\dashboard.qvw - QlikView CPU

monitor: process returned to normal a normal cpu usage of 12.06 % in 1302ms
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Proposed action

This situation is expected to correct itself. If the monitor shows normal usage, nothing is performed, otherwise
QlikView is closed and reopened to allow further report generation. If you continue to get error messages for the
same document, check that the connected QlikView documents are accessible by the Qlik NPrinting Engine. Also
check that no errors occur when you open the document in QlikView manually.

14.19 Qlik NPrinting Designer error: The RPC server is unavailable

Possible cause

You opened a Microsoft Excel template in the Qlik NPrinting Designer while there was another Microsoft Excel file
open with a cell in edit mode.

Complete error message:

Qlik NPrinting can't find a supported reporting template editor for the file <File path/File name>

Error message:

The RPC server is unavailable.

Proposed action

Do the following:

1. Close the error message pop-up window and Qlik NPrinting Designer.

2. Exit from cell in edit mode in the other Microsoft Excel worksheet, or close Microsoft Excel.

3. Re-open the Qlik NPrinting Designer.

14.20 Qlik NPrinting Designer crashes when inserting spreadsheet
in PowerPoint

Possible cause

If you are working in a PowerPoint report template and click Insert Excel spreadsheet, Qlik NPrinting Designer
may become unresponsive. It must be shut down forcefully. This issue is due to a third-party component that is
used to embed PowerPoint in Qlik NPrinting Designer.

Qlik NPrinting cannot render Qlik Sense or QlikView objects inside an embedded spreadsheet.

Proposed action

There are two workarounds.

If you are creating a new report
Do the following:
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1. Create a new .pptx file using Microsoft PowerPoint.

2. Embed the spreadsheet .

3. Save the file.

4. In Qlik NPrinting web console, create a new report. Select custom template.

5. Select the file previously created.

If you are modifying an existing report
Do the following:

1. In Qlik NPrinting web console, export the report from the Reports page.

2. Extract all files from the .zip file.

3. Open the "templates" folder.

4. Open the .pptx file with Microsoft PowerPoint.

5. Embed the spreadsheet.

6. Save the file.

7. Go back to the report folder in Windows Explorer.

8. Create a new .zip file that contains the "templates" folder and the "metadata.json" file.

9. In the Qlik NPrinting web console, go to the Reports page.

10. Execute the Replace function.

14.21 Connection to Qlik NPrinting Server fails during Qlik
NPrinting On-Demand Add-on installation

The Qlik NPrinting Server URL entered during the Qlik NPrinting On-Demand Add-on installation must be
formatted correctly to be recognized.

Possible cause

The Qlik NPrinting Server URL contains a slash (the character “/”) after the port number.

Proposed action

Remove the slash after the Qlik NPrinting Server URL and try again.
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A correctly formatted Qlik NPrinting Server URL

14.22 No connection with Qlik NPrinting Server error occurs when
On-Demand is clicked in the QlikView Access Point

I installed the Qlik NPrinting On-Demand add-on and configured the On-Demand settings on the Qlik NPrinting
Server. When I click On-Demand in the QlikView Access Point, I get the error message "No connection with
NPrinting server. Please check your network settings or contact the administrator."

Possible cause

The Qlik NPrinting web console is not trusted because you have not logged in with the Qlik NPrinting services
Window domain user, and accepted the certificate.

Proposed action

Log into the Qlik NPrinting web console using the Qlik NPrinting services Window domain user and accept the
certificate.

14.23 On-Demand objects do not appear in AccessPoint
I cannot see any On-Demand objects in AccessPoint.
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Possible cause

After upgrading QlikView, you need to add two missing mime types in order to make On-Demand work. This can
happen when you upgrade from:

l An earlier version of QlikView 11.20 to SR15 or SR16.
l A major new QlikView version, such as 11.20 to 12.0.

Proposed action

Add the two new mime types in the Qlik Management Console (QMC).

Do the following:

1. In the QMC, open the System tab.

2. Click Setup.

3. Expand the QlikView Web Server node.

4. Click on QVWS@YourServer.

5. Click the Web tab.

6. In the Mime Types section, click the Add icon in the upper right corner.

7. Add the following rows:
l .JSON application/json
l .TTF application/x-font-truetype

14.24 On-Demand reports work in one QlikView Access Point app
but not in another

I can create On-Demand reports in one QlikView Access Point app but not another QlikView Access Point app to
which I have access.

Possible cause

Access to On-Demand reporting is set on an app-by-app basis in security roles. You may not have permission to
create On-Demand reports in all QlikView Access Point apps to which you have access.

Proposed action

If you require access to On-Demand reports, contact your Qlik NPrinting administrator.

14.25 Qlik Sense third-party extension does not export correctly
My visualization extension exports incorrectly, or my visualization extension works in the client, but
exports incorrectly.
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Possible cause

l You may have used an undocumented Asynchronous Module Definition (AMD).
l You may have used external resources from the internet (for example JavaScript files or images).

Proposed action

l Do not use external requireJS modules in the visualization extension.
l Ensure all JavaScript code has been evaluated before resolving the promise in the paint method.

14.26 Verify connection errors when setting up a connection to
QlikView documents

When you create a connection to a QlikView document, use the Verify connection button to check
that your connection is valid.

A list of checks performed will appear under Details. If a test fails, you will see a red X next to that item in the list.

Troubleshooting QlikView Desktop verification errors
The connection parameters are formally valid.
One or more connection parameters are incorrect or missing.

QlikView Desktop is installed.
Verify that QlikView Desktop is installed locally.

The QlikView Desktop license is valid.
Verify that the QlikView Desktop license is not missing or expired.

The Windows user running the Qlik NPrinting Engine is a local administrator.
Add the user to the Administrators group in Windows if they are not already a local administrator.

The document exists.
The document specified does not exist. Verify that the document and path are entered correctly.

The specified identity can open the document.
The specified user does not have access to the document. Verify user permissions in QlikView.

You can also check the connection requirements for QlikView Desktop (page 178)

Troubleshooting QlikView Server verification errors
The connection parameters are formally valid.
One or more connection parameters are incorrect or missing.

QlikView Desktop is installed.
Verify that QlikView Desktop is installed locally.
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The QlikView Desktop license is valid.
Verify that the QlikView Desktop license is not missing or expired.

The Windows user running the Qlik NPrinting Engine is a local administrator.
Ensure that the Windows user running the Qlik NPrinting Engine is a local administrator. Add the user to the
Administrators group in Windows if they are not already a local administrator.

The QlikView Server is reachable.
If the QlikView Server cannot be reached, verify that the port is open.

The QlikView Server version is compatible with installed QlikView Desktop
Verify that both QlikView Server and QlikView Desktop are the same version, including SR.

The account used to run Qlik NPrinting Engine belongs to the QlikViewAdministrators Windows group on the
QlikView Server.
Ensure that the Windows user running Qlik NPrinting Engine is part of the QlikViewAdministrators local group on
the QlikView Server computer.

The specified QlikView Server has a valid license, and contains at least one document.
l Verify that the QlikView Server license is not missing or expired.
l Ensure that QlikView Server has at least one document.

The document exists.
The document specified does not exist. Verify that the document and path are entered correctly.

The specified identity can open the document.
The specified user does not have access to the document. Verify user permissions in QlikView.

You can also check the connection requirements for QlikView Server (page 179).

Troubleshooting QlikView cluster verification errors
The connection parameters are formally valid.
One or more connection parameters are wrong or missing.

QlikView Desktop is installed.
Verify that QlikView Desktop is installed locally.

The QlikView Desktop license is valid.
Verify that the QlikView Desktop license is not missing or expired.

The Windows account used to run the Qlik NPrinting Engine is a local administrator.
Ensure that the Windows user running the Qlik NPrinting Engine is a local administrator. Add the user to the
Administrators group in Windows if they are not already a local administrator.

The QlikViewManagement Service is reachable.
If the QlikViewManagement Service cannot be reached, verify that the port (default is 4799) is open.
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The QlikView Server version is compatible with installed QlikView Desktop
Verify that both QlikView Server and QlikView Desktop are the same version, including SR.

The Windows account used to run the Qlik NPrinting Engine has access to QlikViewManagement Service.
Ensure that the Windows user running the Qlik NPrinting Engine is in the QlikView Management API group, and
part of the QlikView Administrators local group on the QlikView Management Service computer.

The Cluster ID is valid.
The Cluster ID as entered does not exist. Verify the Cluster ID and try again.

At least one QlikView Server in the cluster can open the specified document.
Verify that at least one of the QlikView Servers in the cluster can open the specified document.

The QlikView Server is reachable.
If the QlikView Server cannot be reached, verify that the port is open.

The account used to run Qlik NPrinting Engine belongs to the QlikView Administrators Windows group on the
QlikView Server.
Ensure that the Windows user running Qlik NPrinting Engine is part of the QlikView Administrators local group on
the QlikView Server computer.

The specified QlikView Server has a valid license, and contains at least one document.
l Verify that the QlikView Server license is not missing or expired.
l Ensure that QlikView Server has at least one document.

The document exists.
The document specified does not exist. Verify that the document and path are entered correctly.

The specified identity can open the document.
The specified user does not have access to the document. Verify user permissions in QlikView.

You can also check the connection requirements for QlikView Cluster (page 179).

14.27 Verify connection errors when setting up a connection to
Qlik Sense apps

When you create a connection to a Qlik Sense app, use the Verify connection button to check that
your connection is valid.

A list of checks performed will appear under Details. If a test fails, you will see a red X next to that item in the list.

Troubleshooting connection verification errors
The connection parameters are formally valid.
One or more connection parameters are incorrect or missing.
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The QRS is reachable at the port 4242 of the "Proxy Address".
Verify that the Qlik Sense proxy address is correct and no firewalls are preventing the Qlik NPrinting Engine from
reaching the Qlik Sense Repository Service on port 4242.

The http/https protocol in the Proxy address is correct.
Verify that the proxy address entered starts with either http:// or https://.

Installed certificates are valid to connect to Qlik Sense.
l Certificates must be exported from Qlik Sense using the Qlik Management Console on the Qlik Sense

Server, and installed on the Qlik NPrinting Engine computers. For more information, see Validating the
connection to Qlik Sense (page 173).

l For Qlik Sense certificates exported from the Qlik Management Console (QMC) and installed on all Qlik
NPrinting Engine computers:

o Ensure that the correct Qlik Sense certificates for the server and version that you are connecting to
are installed. If Qlik Sense server certificate validation is enabled, make sure that the root.cer file
has been correctly installed in the certificate storage. For more information, see Configuring server
certificate validation for Qlik Sense connections (page 175).

o Ensure that the correct user account was used to install the Qlik Sense certificates.
o Ensure that you are using the Fully Qualified Domain Name for the Qlik Sense server.

The Identity and the Qlik NPrinting Engine service account are a Windows domain user.
l The user in the Identity field must be a Windows domain user, and it must be enabled in Active Directory.
l The Qlik NPrinting Engine service account is a Windows domain user.
l Qlik NPrinting and Qlik Sense must be installed on the same domain.

Get the version, proxyId, and a list of all apps from QRS on the "Proxy Address".
l Verify that the Qlik Sense proxy address is correct and no firewalls are preventing the Qlik NPrinting

Engine from reaching the Qlik Sense Repository Service on port 4242.
l TLS 1.2 must be enabled on both the Qlik NPrinting Engine client and the Qlik Sense server.
l Verify that the Qlik Sense user specified in the Identity field is allowed to retrieve the apps list.

The Sense App ID is available.
Verify the Qlik Sense app ID is available in the QMC.

The user running the Qlik NPrinting Engine Windows service is a Qlik Sense RootAdmin.
Verify that the Qlik NPrinting Engine Windows service user is a RootAdmin in the QMC.

Get App information from QRS on the "Proxy Address" for the "Sense App ID".
Verify that the user in the Identity field is authorized in Qlik Sense to access the app.

The Proxy Address, Sense App ID and Identity can be used for a connection to a Qlik Sense Engine.
l Verify that there are no rules in the Qlik Management Console (QMC) preventing the Windows user running

the Qlik NPrinting Engine service, and the user specified in the Identity field, from accessing the specified
app.
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l In the Qlik Management Console (QMC), the Virtual Proxy used in the Qlik NPrinting connection to Qlik
Sense must have at least one Load balancing node.

l In the Qlik Management Console (QMC), the Virtual Proxy used in the Qlik NPrinting connection to Qlik
Sense must have the node that is used in Qlik NPrinting in its Proxy list.

l Verify that in Active Directory the user defined as the Identity is enabled.
l You might need to manually synchronize Active Directory users.
l Qlik NPrinting and Qlik Sense must be installed in the same domain.
l Verify in the Qlik SenseQlik Management Console (QMC) that the user who is running the Qlik NPrinting

Engine service is in the RootAdmin group.

All Qlik Sense engines are reachable from the Qlik NPrinting Engine computers.
l Verify that the Qlik Sense proxy address is correct and no firewalls are preventing the Qlik NPrinting

Engine from reaching the Qlik Sense Engine service. This Qlik Sense Engine service usually uses port 4747
(either on the Qlik Sense central node, or on dedicated Qlik Sense Engine nodes). This port can be
configured in the Qlik Management Console (QMC).

l Qlik NPrinting and Qlik Sense must be installed in the same domain.
l Verify in Qlik Management Console (QMC) that the user who is running the Qlik NPrinting Engine service is

in the RootAdmin group.

Lookup the Qlik Sense Proxy port from QRS on the "Proxy Address".
Verify that the Qlik Sense user in the Identity field is allowed to look up the Qlik Sense proxy address.

The Qlik Sense Proxy port is reachable on the "Proxy Address".
Verify that the Qlik Sense proxy address is correct and no firewalls are preventing the Qlik NPrinting Engine from
reaching the Qlik SenseProxy Service. The Qlik SenseProxy Service usually uses port 4243 (usually on the Qlik
Sense central node). This port can be configured in the Qlik Management Console (QMC).

Perform a GetTicket request to the Qlik Sense Proxy on the "Proxy Address".
Verify that user in the Identity field is valid, the Qlik Sense proxy address is correct, and no firewalls are
preventing the Qlik NPrinting Engine from reaching the Qlik Sense Proxy Service. The Qlik Sense Proxy Service
usually uses port 4243 (usually on the Qlik Sense central node). This port can be configured in the Qlik
Management Console (QMC).

Qlik NPrinting webrenderer can reach Qlik Sense hub.
Verify that Qlik Sense hub is reachable by Qlik NPrinting webrenderer. The Qlik Sense hub usually uses port 443.
This port can be configured in the Qlik Management Console (QMC).

14.28 Qlik NPrinting will not read Qlik Sense certificates
You have added your Qlik Sense certificates to the correct folder on your Qlik NPrinting Server and
Qlik NPrinting Engine machines. However, Qlik NPrinting services will not read them.

Qlik NPrinting - February 2024 545

14   Troubleshooting



Possible cause

l The Qlik Sense certificates did not export properly.
l Your security settings require certificates to be stored in the user certificates store.
l Your intranet security settings may need to be changed.

Proposed action

Make sure that you have followed the requirements on Connecting Qlik NPrinting with Qlik Sense (page 172). If that
does not solve the issue, re-export your certificates and update your intranet security settings.

Re-exporting the certificates
A Qlik Sense administrator or a user with a RootAdmin account should follow these export instructions: Exporting
the certificates from the QMC (page 173).

Installing the certificates in the user certificates store
Qlik Sense only needs the client.pfx certificate file to accept connections. If this certificate is copied to the Qlik
NPrinting installation folder (C:\Program Files\NPrintingServer\Settings\SenseCertificates), it will be read and used
to sign requests to the Qlik Sense server. There is no need for the server.pfx and root.cercertificates.

If your security policies require that certificates not be stored in a file system, Qlik NPrinting can read certificates
from the user certificates store. You need all three certificates: client.pfx, server.pfx, and root.cer. You must use the
QmcCertificatesInstaller.exe tool to install certificates in the store. It combines all three into a trust chain, and
stores them in the certificate store.

You can only connect to one Qlik Sense server if you use the certificates store. You need to install
certificates to the file system if you want to connect to multiple servers.

Do the following:

1. Receive the exported and renamed Qlik Sense certificates from your Qlik Sense system administrator.

2. Log into the Qlik NPrinting Server running the Qlik NPrinting scheduler service, as the Windows Qlik
NPrinting Server services administrator.

3. Add the certificates to C:\Program Files\NPrintingServer\Settings\SenseCertificates. Qlik NPrinting will
automatically identify the correct one to be used for each connection.

You should only keep active Qlik Sense certificates used by Qlik NPrinting connections in the
C:\Program Files\NPrintingServer\Settings\SenseCertificates folder.
We recommend you remove any certificates that are not in use.

4. Repeat this process on each Qlik NPrinting Engine running the Qlik NPrinting Engine service, using the
Windows Qlik NPrinting Engine services administrator.

Additional user access allocation in Qlik Sense is not required for a user to view reports in the Qlik Sense hub.
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Understanding error logs for server certificate validation
If you use server certificate validation, the error logs include troubleshooting instructions for the most common
configuration errors. Logs are stored in the %ProgramData%\Nprinting\Logs folder. The default location is
C:\ProgramData\NPrinting\Logs.

Here are some examples:

Qlik Sense remote server certificate validation failed with SslPolicyErrors
RemoteCertificateChainErrors and ChainStatus with 1 element(s):
[Status=UntrustedRoot, Info=A certificate chain processed, but terminated in a root
certificate which is not trusted by the trust provider.]
Please be sure to have exported Sense 'root.cer' certificate from Sense server QMC (this must be

repeated for each Sense server NPrinting is connected to, eventually also the one used as hub

destination), then, on the NPrinting Server (if Sense hub destination is used) and on each

NPrinting Engine(s), to have installed 'root.cer' certificate in the Trusted Root Certification

Authorities store of NPrinting Scheduler and NPrinting Engine service user account(s) (or to the

Local Machine's Trusted Root Certification Authorities store).

Qlik Sense remote server certificate validation failed with SslPolicyErrors
RemoteCertificateNameMismatch
Please notice that certificate subject distinguished name CN=myserver.mydomain.com and Sense

server proxy address set on NPrinting QMC must be the same. This usually means to have full FQDN

set as NPrinting Sense connection proxy address (and NPrinting Sense hub central node, if hub

destination is used) so that it matches the subject distinguished name of the certificate.

Qlik Sense remote server certificate validation failed with SslPolicyErrors
RemoteCertificateNameMismatch, RemoteCertificateChainErrors and ChainStatus with
1 element(s): [Status=UntrustedRoot, Info=A certificate chain processed, but
terminated in a root certificate which is not trusted by the trust provider.]
Please be sure to have exported Sense 'root.cer' certificate from Sense server QMC (this must be

repeated for each Sense server NPrinting is connected to, eventually also the one used as hub

destination), then, on the NPrinting Server (if Sense hub destination is used) and on each

NPrinting Engine(s), to have installed 'root.cer' certificate in the Trusted Root Certification

Authorities store of NPrinting Scheduler and NPrinting Engine service user account(s) (or to the

Local Machine's Trusted Root Certification Authorities store). Please notice that certificate

subject distinguished name CN=rd-repo26.rdlund.qliktech.com and Sense server proxy address set on

NPrinting QMC must be the same. This usually means to have full FQDN set as NPrinting Sense

connection proxy address (and NPrinting Sense hub central node, if hub destination is used) so

that it matches the subject distinguished name of the certificate.

Updating your intranet security settings
Certain intranet settings may block connections to Qlik Sense servers. If a server is not responding, you should
change the intranet settings.

Do the following:
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1. Log into the Qlik NPrinting Server using the Qlik NPrinting Domain User Service Account credentials that
run the Qlik NPrinting scheduler service.

2. Open the Windows Control Panel.

3. Go to Internet Options.

4. Click Change security settings.

5. Click the Security tab.

6. Select Local Intranet.

7. Click the Sites button, click the Advanced button.

8. Add all of the Qlik Sense Proxy Server computer names to the list, including the domain name:
https://sense_proxy_computer_name.domain_name.

9. Click Close.

10. Click Ok twice to close the Internet Properties window.

11. If the Qlik NPrinting Engine is installed on the same machine but running under a different service
account, repeat the above procedures, logging in as the Service Account credentials that run the Qlik
NPrinting Engine service.

12. Repeat this process on each Qlik NPrinting Engine running the Qlik NPrinting Engine service, using the
Windows Qlik NPrinting Engine services administrator.

14.29 Emails are not using the default or custom sender
Emails sent by my task are sent using the email address of the user authenticated to the SMTP service rather than
the default sender specified in Email settings or the custom sender specified in my task.

Possible cause

Your SMTP server authentication does not permit users to override their email address and send emails using
another email address.

Proposed action

Change your SMTP server settings to permit users to override their email addresses and send emails using other
email addresses.

14.30 Variables do not expand before calculating

Possible cause

Your variables may be missing an = sign at the beginning.

Proposed action

The proposed action depends on where and how you are using the variable.

Qlik NPrinting - February 2024 548

14   Troubleshooting



Scenario 1: Variable is being used in Qlik NPrinting Designer

Qlik NPrinting, Qlik Sense, and QlikView treat variables the same way when used without a dollar-sign expansion.
Therefore, if you need to use the evaluated result of the variable, there must be an = sign at the start of the
variable definition. If the variable does not appear in a Scenario 2 case, you can modify its definition accordingly.
This is valid for:

l Dynamic naming
l Conditions
l Variables in email
l Qlik NPrinting Designer variables

Scenario 2: Variable is used in a dollar-sign expansion in Qlik Sense or QlikView

Dollar-sign expansion works by inserting the evaluated value of a variable as-is, in place of the full dollar-sign
expansion . The value of a variable is the interpreted string inserted in the definition. It could be:

l a string of text
l a number (if the text is compatible with a number format)
l a date (if it is a date)
l the evaluated result of an expression, if it begins with =.

This means that an expression inserted in a variable definition, that does not begin with an equal sign, is in fact
text.

If the variable is used within a dollar-sign expansion in Qlik Sense or QlikView, then you cannot change its
definition. This would change the way the dollar-sign expansion works: it would insert the evaluated value
instead of the text. In this case, you must create a second, identical variable with the same formula, but a
different name. Use this new variable as you would in Scenario 1.

For example:

l VarApp1: where sum(sales) is the variable definition. This is the original variable, and remains
unchanged.

l VarApp1b: where =sum(sales) is the variable definition. This new variable can be used in Qlik NPrinting
in the cases described in Scenario 1.

If you do not want to define a new variable, but you need to use it in Qlik NPrinting Designer, you can use a
formula to expand the variable as you would do in Qlik Sense or QlikView. For example =$(VarApp1).

Scenario 3: Variable has a condition applied to it

If you applied a condition to a variable, and the variable does not calculate, the issue could be with the condition.
Add the variable to a report without the condition, and run the publish task.

In the produced report you will see what value is being extracted. You can quickly verify if the variable resolves to
a string or if a value is in fact being calculated.
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14.31 Fonts do not display properly in reports

Possible cause

l The font is an Open Type Font (.otf). Qlik NPrinting only supports True Type Fonts (.ttf).
l The font is not installed on all Qlik NPrinting Engine computers and all Qlik NPrinting Designer computers.

Proposed action

Ensure that all fonts are True Type Fonts (.ttf). Check that all report fonts are installed on all Qlik NPrinting
Engine computers and all Qlik NPrinting Designer computers.

14.32 Unstable web interface with error: Session cookie signature
failed

Possible cause

The Qlik NPrinting web console or NewsStand interface become unstable if there are old cookies.

Proposed action

If your web browser is reading old cookies, clear the browser cache.

14.33 Qlik NPrinting re-installation errors

Possible cause

Incomplete uninstallation of third-party software can introduce errors during re-installation of Qlik NPrinting on
the same computer.

Proposed action

Do the following:

1. Run the uninstallation tool provided by Microsoft. See≤ Fix problems that block programs from being
installed or removed for details. Launch the tool and choose the Installation option. Run it for all
NPrinting programs in case you see one of them in the list.

2. Open the Microsoft Windows Control Panel and navigate to Program and Features. Uninstall Erlang
OTP. To uninstall the program, right-click it and select Uninstall. Wait until the uninstall finishes.

3. Remove the Erlang cookie and close processes.

1. Open the C:\Windows folder. Remove the .erlang.cookie file.

2. Remove the copy of the .erlang.cookie file saved in C:\Windows\System32\config\systemprofile.
The .erlang.cookie files are created during the installation of Rabbit. The files are used to enable a
communication between Rabbit and Erlang.

3. Open the command line as admin and run the following commands:
taskkill /IM epmd.exe /F
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taskkill /IM erl.exe /F
The above commands close Erlang processes that may be still active. Notice that sometimes they
are not active, in which case you get an error saying that the process was not found.​

4. Remove the Erlang and NPrinting folders.

1. Open the folder C:\Program Files and delete the erlXX.0 folder, if present. XX is the version number,
which depends on the installed NPrinting release.
You may not be able to delete this folder because the OS shows an error message saying that there
is a file in use by another process. If so, you have to reboot the computer and then you will be able
to remove the folder.

2. If present, remove the folder C:\Program Files\NPrintingServer.

3. If present, remove the folder C:\Program Files\Common Files\DESIGNER.

4. If present, remove the folder C:\Program Files (x86)\NPrinting.

5. If present, remove the folder C:\ProgramData\NPrinting.

6. Open the folder C:\Users\<user doing the installation>\AppData\Roaming and delete the NPrinting
Server subfolder, if present.

5. In the registry key editor (regedit), open the HKEY_LOCAL MACHINE folder > SOFTWARE and remove the
Ericsson folder.

14.34 Microsoft Internet Explorer Enhanced Security
Configuration is blocking QV.exe (QlikView) and reporting_
web_renderer.exe (Qlik Sense)

Microsoft Internet Explorer is not supported by Qlik NPrinting.

Possible cause

QV.exe and reporting_web_renderer.exe is blocked. You receive an error message stating that Microsoft Internet
Explorer Enhanced Security Configuration is turned on and blocking your application.

This can occur even if you are not using Internet Explorer as your browser.

To prevent these types of blocking errors, which prevent NPrinting from generating reports normally, IE
Enhanced Security Configuration must be turned off via Windows Server Manager.

Proposed action

1. Close all instances of Microsoft Internet Explorer.

2. Go to Control Panel > Administrative Tools, and then click Server Manager.

3. If a User Account Control dialog is displayed, click Continue.

4. Under Security Summary, click Configure IE ESC.

5. Under Administrators, click Off.
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6. Under Users, click Off.

7. Click OK.
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